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Introduction
ManageEngine ServiceDesk Plus - MSP is a comprehensive help desk and asset management
software that provides Service Provider an integrated console to monitor and maintain the assets and
IT requests generated from their Account's users of the IT resources. The IT help desk plays an
important part in the provision of IT Services. It is very often the first contact the users have in their
use of IT Services when something does not work as expected. The IT help desk is a single point of
contact for end-users who need help. Without this, an organization could certainly face losses due to
inefficiencies.
The two main focuses of the ManageEngine ServiceDesk Plus - MSP are IT Request tracking and
Asset Management. Using the following modules of ServiceDesk, technicians and system
administrators can resolve issues of complex nature in no time and thus reduce the end-user
frustration arising due to time consuming issue resolving process. They can also keep track of the
needs of the organization with the help of asset management and proactively allocate resources to
the right user/departments, thus increasing the productivity of the organization.
•

Requests

•

Problem

•

Change

•

Solutions

•

Assets

•

Purchase

•

Contract

The request module functions as the Help Desk where requests are fetched and necessary solutions
provided by assigning technicians to resolve issues reported.
When you log in to ManageEngine ServiceDesk Plus - MSP, the application displays the ServiceDesk
Plus - MSP home page that contains information on pending requests, overdue requests, requests
assigned to the user who has logged in, individual user's task list, and depending on the user login,
the other dash board views such as Contract and Purchase Order summary also may be displayed.

Requests
Clicking on the Requests tab on the header pane takes you to the request module. This serves as the
IT help desk module where the IT requests from individual users are fetched, tracked, technicians are
assigned, and a solution is provided.

Problems
The objective of Problem Management is to minimize the adverse impact of Incidents and Problems
on business that are caused by errors within the IT infrastructure, and to prevent recurrence of
Incidents related to these errors. In order to achieve this goal, Problem Management seeks to get to
the root cause of Incidents and then initiate actions to improve or correct the situation.

Change
The goal of Change Management is to ensure that standardized methods and procedures are used
for efficient and prompt handling of all Changes, in order to minimize the impact of change-related
incidents upon service quality and consequently to improve the day-to-day operations of the
organization.
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Solutions
This module serves as a knowledge base for your IT help desk team as well as your users. Users can
search this for solutions for issues and solve them themselves. Also when technicians resolve issues,
they can directly convert these resolutions as knowledge base articles. To view the solutions, click the
Solutions tab in the header pane.

Assets
Assets tab helps you to track & manage assets efficiently. It tracks all newly added assets, and have a
record of all the assets across accounts. Assets can be categorized as IT, Non IT Assets & Asset
Components. This includes Workstations, Printers, Routers, Software Licenses, Scanners, Projectors
and even air conditioning systems. Thus it offers a single view to track and manage all the assets
across accounts.

Purchase
Here you can create new purchase orders and track them till the order has been delivered. The same
details can also be maintained for future reference. Clicking the Purchase tab takes you to the
Purchase module.

Contract
This module holds the details regarding the maintenance contracts between an account and the
vendor(s) from whom the assets of the account have been purchased. Clicking the Contracts tab in
the header pane takes you to the contract module.
In addition to these, ServiceDesk Plus - MSP has GUI-rich reports for requests and Assets modules.
There are predefined sets of reports that help you evaluate the efficiency and productivity of your IT
help desk team, the load of requests handled by the team, the assets distribution, and many more.
Also, the ServiceDesk administrator can configure various helpdesk, asset, and enterprise-related
settings, such as the working hours of the organization, service-level agreements, user roles,
departments and many more.
Based on the permissions provided by the ServiceDesk Plus administrator to each of the users of the
application, you will be able to access the above modules. If you do not have the access permission,
contact your ServiceDesk Plus administrator.
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System Requirements
Hardware
The following table lists the hardware installation according to the number of Technician Logins.

Technician
Logins

No of Nodes

5-20

50-200

20-50

200-500

Processor
Type

Processor
Speed

RAM

Free Hard
Disk

1.7 GHz

1GB

20GB

3.4 GHz

2GB

40GB

Core Duo
50-100

500-2000

2*3.4 GHz

4GB

40GB

100-200

1000-5000

4*3.4 GHz

4GB

80GB

Operating System
Windows
•

Windows 2008 Server

•

Windows 7

•

Windows 2000 + SP4

•

Windows 2000 / 2003 Server

•

Windows XP Professional

Linux
•

RHEL Linux 5.4 and above

•

Linux Debian 3.0

Supported Database
•

Postgre SQL 9.2

•

MySQL 4.1.18

•

MS SQL 2000, MS SQL 2005, MS SQL 2008

Supported Browsers
•

Internet Explorer: v7, v8 and v9

•

Firefox: v3.6 up to v10

•

Google Chrome
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Installation and Getting Started

•

In Windows

•

In Linux

In Windows
Follow the steps given below to install and set up the ManageEngine ServiceDesk Plus - MSP
application:
1. Download the ManageEngine_ServiceDeskPlus_MSP.exe file.
2. Click the exe file to start the installation. The ServiceDesk Plus - MSP installation wizard
appears as shown below,

3. Click Next to proceed with the installation.
4. The second screen displays the License Agreement. You need to accept the license
agreement to proceed with the installation. Click Yes to accept.
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5. On accepting the license agreement, choose the installation directory. By default, the
application is installed in C:\ManageEngine\ServiceDeskPlus-Msp directory.
If you want to change the installation directory, then, click the Browse button beside the
directory path. From the file chooser window, choose the directory of your choice and click Ok.
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Note: The installation directory or its parent directories must not have any space
character in its name.
6. In the next screen, enter the folder name that will be displayed in Programs in your windows
menu. By default it is ManageEngine ServiceDesk Plus - MSP Click Next to continue.
7. Enter the port number that has to be used to run the web server. The default port number
provided is 8080. If you already have any application running in that port, then enter the
number of the port that is free and can be used by the web server to run the ServiceDesk
Plus - MSP application server and click Next.

8. Choose the Database between PostgreSQL, MS SQL and MY SQL . By default ServiceDesk
Plus supports Postgre SQL database. To switch over to MS SQL database/MY SQL
database you need to configure the respective server to establish connection. Enter the
database details as given below,
•

Host Name: Enter the IP Address/host name in which the database is available. The
default host name is 'localhost'.

•

Port: Specify the port in the given text field. The default value is 1433.

•

Database: By default the database name will be Servicedesk in non-editable format.

•

User Name: Specify the user name to login to the server in the given text field.

•

Password: Specify the password for the username in the given text field. Click Next.
Note: To switch over to SQL database, you need to enable SQL authentication.
Window authentication will not work.

9. The Registration for Technical Support form is displayed. This is an optional form and it
enables you to register for technical assistance. By registering, it helps the technical support
Zoho Corporation Pvt. Ltd.
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team to be better informed about your organization and its specific needs and hence provide
a more focused support. Enter the details such as Name, contact E-mail ID, Phone Number
(helps in making calls for immediate support), Company Name, and Country. Click Next.

10. The details that you have provided till now will be displayed as below for your confirmation:
Installation Directory : C:\ManageEngine\ServiceDesk-Msp
Folder Name : ManageEngine ServiceDesk Plus - MSP
WebServer Port : 8080
If the displayed information is correct, then click the Next button, or else click the Back button
and make the necessary changes and proceed with the installation.
11. After you confirm the above details, the application is installed. On successful installation, the
following screen is displayed.
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If you choose to start the ServiceDesk as Service, then the ServiceDesk Server is started
automatically and the client window opens. If you do not wish to view the readme file or start
ServiceDesk as a windows service, de-select the options provided.
13. Click Finish to complete the installation.
If you had followed the instructions in the wizard and installed the application with the default settings
suggested by the wizard, the ManageEngine ServiceDesk Plus - MSP program group is created in
the Start menu. Also, the ServiceDesk server will be started and the client window opens with the
login page. Enter the user name and password to log in to the application.
To manually start the ServiceDesk Plus - MSP application
1. Click Start -> Programs -> ManageEngine ServiceDesk Plus - MSP -> ServiceDesk - MSP
Server to start the web server. This takes approximately 2 minutes in a Windows XP, 512 MB
RAM, and 1.0 GHZ processor. Generally, the server is started and the web client is also
launched in the default browser.
2. If the web client is not launched automatically, then click Start -> Programs ->
ManageEngine ServiceDesk Plus - MSP -> ServiceDesk - MSP Web Client to start the
web client. The application opens the login page in your default web browser.
3. Enter your user name "administrator" and password "administrator" to log in to ServiceDesk
Plus - MSP. As soon as you log in the configuration wizard home page is displayed. Follow
the instructions provided in the wizard and click the Next button.
To configure your application settings, refer to the Configurations section.
To shut down the ServiceDesk Plus - MSP application
1. Click Start -> Programs -> ManageEngine ServiceDesk Plus - MSP -> Shutdown
ServiceDeskPlus - MSP. A confirmation message is displayed.
2. Click OK to proceed with the shut down.
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and choose Shut down Server. A
Alternatively, you can also right-click on the system tray icon
confirmation message is displayed. Click OK to shut down ServiceDesk Plus - MSP.
To reinitialize the server
1. Go to <ServiceDesk>\bin directory.
2. Execute reinitializeDB.bat to reinitialize the server. Please note that all the data in the
server will be lost when you reinitialize.

In Linux
Follow the steps given below to install and setup the ManageEngine ServiceDesk Plus - MSP
application:
1. Download the ManageEngine_ServiceDeskPlus_MSP.bin file.
2. Execute the .bin as given below, at your command prompt:
./ManageEngine_ServiceDeskPlus_MSP.bin

Note: You need to have execute permissions for executing the .bin type files.
3. The following screen of the installation wizard is opened and then you will be guided through
the installation process.
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4. Click Next and follow the steps given in the installation wizard.
5. The second screen displays the License Agreement. You need to accept the license
agreement to proceed with the installation. Click Yes to accept.
6. On accepting the license agreement, choose the installation directory. By default, the
application is installed in home/<user>/ManageEngine/ServiceDeskPlus-Msp directory. If you
want to change the installation directory, then, click the Browse button beside the directory
path.
7. From the file chooser window, choose the directory of your choice and click Next.
8. Enter the port number that has to be used to run the web server. The default port number
provided is 8080. If you already have any application running in that port, then enter the
number of the port that is free and can be used by the web server to run the ServiceDesk
Plus - MSP application server and click Next.

Note: If you wish to provide a port number lesser than 1024 as the web server port,
then you need to be the super-user of the system to successfully install and run
ServiceDesk Plus - MSP application.
9. The Registration for Technical Support form is displayed. This is an optional form and this
enables you to register for technical assistance. By registering, it helps the technical support
team to be better informed about your organization and its specific needs and hence provide
a more focused support. Enter the details such as Name, contact E-mail ID, Phone Number
(helps in making calls for immediate support), Company Name, and Country. Click Next.
10. The details that you have provided till now will be displayed as below for your confirmation:
Details of Installation
Installation Directory: home/<user>/AdventNet/ME/ServiceDesk
Product Size

: 62.8 MB.

If the displayed information is correct, then click the Next button, or else click the Back button
and make the necessary changes and proceed with the installation.
11. After you confirm the above details, the application is installed. On successful installation, the
following screen is displayed.
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If you do not wish to view the Readme file, de-select the check box.
12. Click Finish to complete the installation.
To manually start the ServiceDesk Plus - MSP application
1. Go to the <ServiceDesk Plus-Msp>/bin directory and execute the run.sh file as given below:
$ sh run.sh
2. To start the web client, open a web browser and type the following in the address field:
http://localhost:8080
Here, you need to replace the localhost with the corresponding server name where the
ServiceDesk Plus - MSP web server is running and the port number 8080 should be replaced
with the actual port where the server is running. The application opens the login page in your
default web browser.
3. Enter your user name "administrator" and password "administrator" to log in to ServiceDesk
Plus - MSP. As soon as you login the configuration wizard home page is displayed. Follow
the instructions provided in the wizard and click the Next button.
To configure your application settings, refer to the Configurations section.
To shutdown the ServiceDesk Plus - MSP application
execute shutdown.sh file from the bin directory as below:
sh shutdown.sh -S
To reinitialize the server
1. Go to <ServiceDesk Plus - MSP>/bin directory.
2. Execute reinitializeDB.sh to reinitialize the server. Please note that all the data in the
server will be lost when you reinitialize.
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Database Configuration
•

Configure the Database
o

Configure PostgreSQL Server

o

Configuring MS SQL Server

o

Configuring MY SQL Server

•

Non GUI Users

•

Connect to PostgreSQL Server

•

Connect to My SQL Server

•

Troubleshooting Tips

Configure the Database
By default ServiceDesk Plus - MSP supports PostgreSQL database, to switch over to SQL
database, you need to configure SQL server credentials to establish connection and start the server.
Configuring PostgreSQL Server
1. Execute the changeDBServer.bat [changeDBServer.sh for Linux] file presented under the
ServiceDesk Plus - MSP Home. This opens the Database Setup Wizard page. Fill in the
details of the form to configure SQL server.
o

Server Type: Select the server type from the combo box. Say, PostgreSQL

o

Host Name: Enter the IP Address/ host name in which the database is available. The
default host name is 'localhost'.

o

Port: Specify the Port. The default port is 1433.

o

Database: By default the database name will be servicedesk in non-editable format.

o

User Name: Specify the User Name to login to the server

o

Password: Specify the Password.

Zoho Corporation Pvt. Ltd.
24

ManageEngine ServiceDesk Plus MSP – Admin Guide

2. To check the availability of connection, click the Test button. A pop up window pops up
showing 'Connection Established' message.
3. Click OK to proceed.
4. Click Save button to save the SQL server settings.
Configuring MSSQL Server
1. If you are using a remote MSSql server and do not want to use the inbuilt server then,
2. Select Server Type as MSSql server. This opens the database wizard page.
3. Specify the Host Name, Port, User Name & Password.
4. Click Test button and check the availability of the connection.
5. Once the connections are established, save the details and start the server.
Configuring MYSQL Server
1. If you are using a remote MySql server and do not want to use the inbuilt server then,
2. Select Server Type as MySql server. This opens the database wizard page.
3. Specify the Host Name, Port, User Name & Password.
4. Click Test button and check the availability of the connection.
5. Once the connections are established, save the details and start the server.

Non GUI Users
Run the changeDBServer.bat [changeDBServer.sh for Linux] under command prompt by passing
parameter as given below,
C:\[ServiceDesk Plus - MSP Home]\bin>changeDBServer.bat --console
It will get the DB Server necessary information from the console.
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Connect to PostgreSQL Server
ServiceDesk Plus - MSP uses PostgreSQL as its default database.
Connect to PostgreSQL Server in Windows
1. Go to [ServiceDesk Plus - MSP Home] \ pgsql \ bin in the command prompt.
C:\> cd ManageEngine\ServiceDeskPlus - MSP\pgsql\bin
2. Enter the command: pgsql.exe -U postgres -p 65432 -w servicedesk
C:\> cd ManageEngine\ServiceDeskPlus - MSP\pgsql\bin>
psql.exe -U postgres -p 65432 -w servicedesk
ServiceDesk is the name of the database. 65432 is the port on which ServiceDesk Plus - MSP
database runs. ServiceDesk Plus - MSP uses root account to connect to the database and does not
use any password. You can connect to PostgreSQL database only from the server console.

Connect to PostgreSQL Server in Linux
1. Install the PostgreSQL client which supports your Linux version.
2. Once this is accomplished, make sure that the command "psql" is in path. (Most often, mysql
should be under path, if not, you may add the complete path to psql command under PATH
variable in the bashrc file.
3. Go to [ServiceDesk Plus - MSP Home] \ pgsql \ bin in the command prompt.
# cd [ServiceDesk Plus - MSP Home]/pgsql/bin
4. Enter the command: pgsql.exe -U postgres -h localhost -p 65432 servicedesk

Connect to MY SQL Server
ServiceDesk Plus - MSP uses MYSQL as its default database.
Connect to MYSQL Server in Windows
1. Go to [ServiceDesk Plus - MSP Home] \ mysql \ bin in the command prompt.
C:\> cd ManageEngine\ServiceDeskPlus - MSP\mysql\bin
2. Enter the command: mysql.exe -u root -P 33366 servicedesk
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C:\> cd ManageEngine\ServiceDeskPlus - MSP\mysql\bin>
mysql.exe -u root -P 33366 servicedesk
ServiceDesk is the name of the database. 33366 is the port on which ServiceDesk Plus - MSP
database runs. ServiceDesk Plus - MSP uses root account to connect to the database and does not
use any password. You can connect to MYSQL database only from the server console.

Connect to MYSQL Server in Linux
1. Install the MYSQL client which supports your Linux version.
2. Once this is accomplished, make sure that the command "mysql" is in path. (Most often,
mysql should be under path, if not, you may add the complete path to mysql command under
PATH variable in the bashrc file.
3. Go to [ServiceDesk Plus - MSP Home] \ mysql \ bin in the command prompt.
# cd [ServiceDesk Plus - MSP Home]/mysql/bin
4. Enter the command: # mysql -u root -S ../tmp/mysql.sock servicedesk A

Troubleshooting Tips
PostgreSQL Connection Resolution
Verify the following,
o

Check if PostgreSQL server is running.

o

Check if the server name or the port number is misspelled or incorrect.

o

If the PostgreSQL server is running in a remote machine then there may be a firewall
blocking the port number you have entered.

o

If none of the above mentioned issues matches then contact your system
administrator.

Zoho Corporation Pvt. Ltd.
27

ManageEngine ServiceDesk Plus MSP – Admin Guide

MY SQL Connection Resolution
Verify the following,
o

Check if MY SQL server is running.

o

Check if the server name or the port number is misspelled or incorrect.

o

If the MY SQL server is running in a remote machine then there may be a firewall
blocking the port number you have entered.

o

If none of the above mentioned issues matches then contact your system
administrator.

MS SQL Connection Resolution
If a connection is refused and an exception is thrown by SQL Server as 'unable to connect
the server' then there could be following reasons why this could happen such as,
o

The server name is misspelled or the port number is incorrect

o

The SQL server may not configured to use TCP/IP. In this case, enable TCP/IP from
SQL server's network utility application.

o

If there is a firewall blocking the port 1433 on the server then you will not be able to
connect to the server.

o

To confirm the firewall block connect to TCP/IP use \"telnet<server_host>1433\"\n to
confirm the block.

o

SQL Server Instance is not currently supported by ServiceDesk and will be available
in the feature release. You can also connect to SQL Server named instance once if
you know the machine name and port of the named instance.

o

Create new user with full privileges as shown below,

o

While configuring SQL server properties select the authentication type as SQL server
as shown below. Windows authentication is not supported by ServiceDesk Plus MSP currently.
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Uninstalling ServiceDesk Plus - MSP
•

In Windows

•

In Linux

In Windows
To uninstall ServiceDesk Plus - MSP from Windows
1. Click Start -> Programs -> ManageEngine ServiceDeskPlus-MSP -> Uninstall
ServiceDeskPlus - MSP.

In Linux
To uninstall ServiceDesk Plus - MSP from Linux
1. Go to <ServiceDesk>/_uninst directory.
2. Execute uninstaller.bin as below:
$ ./uninstaller.bin
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Registering ServiceDesk Plus - MSP
Once your trial evaluation period is over, you need to register the ServiceDesk Plus - MSP
application. To purchase the application, please contact sales@manageengine.com. They will send
you the registered license file. Using this license file, you can register the ServiceDesk Plus - MSP
application.
To register ServiceDesk Plus - MSP
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the License link available at the right top of the application. The License window is
opened.
3. Click the Browse button to locate the license file sent to you when you purchased the
application.
4. From the file chooser window, select the license file and click Open.
5. Click Upgrade.
The registration of the ServiceDesk Plus - MSP application is complete. You can continue using the
application.

Zoho Corporation Pvt. Ltd.
31

ManageEngine ServiceDesk Plus MSP – Admin Guide

Contacting ManageEngine
•

Contact Information

•

Sales

•

Technical Support

Contact Information

Web site

www.zohocorp.com
ZOHO Corporation
4141, Hacienda Drive
Pleasanton, CA 94588, USA
Phone: +1-925-924-9500
Fax: +1-925-924-9600
E-mail Address: info@manageengine.com
ZOHO Corporation Private Limited
DLF IT Park, Block 7, Ground Floor, No. 1/124,
Shivaji Garden, Nandambakkam Post,
Mount PH Road, Ramapuram
Chennai 600 089

Corporate Office

Phone: +91-44-22707070
Fax: +91-44-22707172
E-mail Address: info@manageengine.com
Zoho Corporation Pte Ltd
C/o Cananex Singapore Pte Ltd
Block 1003 Bukit Merah Central #05-23
Inno-Center, Singapore 159836
Main Line: 63344486
Fax: 62819188
Mobile: 97552882
Contact Person: Ong Yang Peng
E-mail Address: yangpeng.ong@cananex.com.sg
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Sales
For purchasing ManageEngine ServiceDesk Plus - MSP from any part of the world, fill out the Sales
Request Form. A sales person will contact you shortly. You can also send us e-mail at
sales@manageengine.com.
You can also call the Corporate office of ZOHO Corporation at the following numbers:
Phone: +1-925-924-9500
Fax: +1-925-924-9600 and request for Sales
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Technical Support
One of the value propositions of ZOHO Corp. to its customers is excellent support. During the
evaluation phase, the support program is extended to users free of charge.
For support, please mail to msp-servicedeskplus-support@manageengine.com.
Alternatively, you can submit your feedback from the ServiceDesk Plus - MSP product by clicking the
Feedback link at the top right corner just above the header tabs after logging in to the application.
Your feedback will be sent to the ServiceDesk Plus - MSP Support Team and they will get in touch
with you. Do not forget to provide your e-mail ID or your contact information for the team to get in
touch with you.
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Home
Login Home page
The login home page of ServiceDesk Plus - MSP has various useful information displayed that
enables an administrator, a technician, or a requester to take necessary action.
The user you are logged in as is the Administrator and the following are available in home page,
1. My View
2. Service Catalog
3. Scheduler
4. Quick Create - New Incident
5. Search
6. Recent Items
7. New Incident drop down
8. Service Catalog drop down
9. Quick Actions drop down
10. Feedback
11. Personalize
If you are on a Trail version, then the following links will appear along with the above,
1. License Expiry Alert
2. Get Quote

Zoho Corporation Pvt. Ltd.
35

ManageEngine ServiceDesk Plus MSP – Admin Guide

My View
The My View tab displays the following information,
•

My Approvals

•

My Summary

•

My Tasks

•

Announcements

My Approvals
This block lists all the approval actions to be taken by you for a service request, incident request or
purchase order. To approve or reject, click on Take Actions button. The approval for service requests
and purchase orders are listed only if you have the approval permission.
My Summary
This block displays the summary of requests, problem and changes assigned to the logged in
technician.
•

Request Overdue - Number of requests assigned to the logged in technician that are
overdue.

•

Requests Due Today - Number of requests assigned to the logged in technician that are due
for that day.

•

Pending Requests - Number of pending requests that are assigned to him/her.

•

Approved Changes - Number of changes assigned to the logged in technician that are
approved.

•

Unapproved Changes - Number of changes assigned to the logged in technician that are
unapproved.

•

Pending Problems - Number of Open problems assigned to the logged in technician.

•

Unassigned Problems - Number of problems that are unassigned to technicians.

Service Catalog
If you have customized the Service Catalog in the product, then the Service Catalog tab and Service
Catalog drop down appears. The Service Catalog tab consists of the configured service items that are
grouped and classified according to the service categories. From the service catalog tab, you can
raise a service request instantly.
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Scheduler
Scheduler gives a calender view of the number of open requests, problems, changes, task and
reminder for a technician in a given month. Using the Technician Availability Chart, the availability of a
technician on a given date can be viewed, based on which requests can be assigned to other
technicians (backup technician).
•

My Scheduler

•

Technician Availability Chart

Quick Create - New Incident
Quick Create - New Incident is an instant mode to create new incident when you are on a call with a
or enter the
requester. You can either conduct a search for the existing requesters using the icon
requesters name in the field provided. Next, all you need to do is enter Request Title and Description.
If you require additional details such as category, priority or assign a technician, click Add More
Details >> link. This takes you to the New Incident form. This section is available only when the
'Quick Create Settings' is enabled in the Self-Service Portal.

Search
You can search for Requests, Archived Requests, Problem, Change, Assets, Workstation, Software,
Purchase, Contract, Solutions, System Log and Requester from the home page. You can further
enhance the request search by drilling it down to sub modules. You can search for notes, worklog,
resolution and request ID. Conducting a search using the request ID takes you to the request details
page of the specified request ID.
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Recent Item
While using ManageEngine ServiceDesk Plus - MSP, the application tracks your last viewed items
and lists them in the Recent Items block. The items can comprise of requests, problems, changes,
solution, purchase, contract and workstations that was last viewed. It lists the last 10 items with the
latest viewed item appearing on the top of the list. Clicking on the item takes you directly to the item's
details.
New Incident drop down
The incident templates made available to you are grouped based on the Service Category and listed
in the New Incident drop down. Click on New Incident link to access the default incident template.
Service Catalog drop down
The service categories and the service items available to you are listed in the Service Catalog drop
down. The list is organized to view the service items under each service category. All you need to do
is browse for the available services in the catalog and submit a request.
Quick Actions drop down
Quick Actions functions as an instant navigator to add new form, scheduler, tasks, reminders, asset groups, scanning inventories and archived requests.
Feedback
Send a feedback immediately to our support team from the application.
Personalize
You can change the language and time zone displayed in the application, customize your signature,
and change your password from the Personalize link.
License Expiry Alert
The license expiry alert shows the number of days for the existing license to get expired. In addition, it
also provides the date within which the license should be renewed and the contact information of the
support team.
Get Quote
The Get Quote link is visible to users using the Demo or Trial version. Clicking on the Get Quote link
navigates the page to the Get Quote form in the website. Entering the specifications in the form will
help us to provide you with the exact details of your requirement. Click Submit on specifying the
details and our sales team will contact you on receiving the e-mail.
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My Tasks
My Tasks on the right hand side of the home page -> under my view tab-> next to the my requests
summary block, shows all the Tasks assigned to you. These tasks could be added by you as a
personal reminder of the due by tasks. Or it can be the tasks assigned to you by other technicians.
You can also assign tasks to other technicians through this option. On adding the tasks to other
technicians, the added tasks will be listed in their home page under the My Tasks block and the
technicians will be able to view the tasks immediately on logging in to ServiceDesk Plus - MSP
application.
All your tasks including the requests assigned on your name can be added to this list as My Tasks,
but you cannot maintain the log for the requests entered under my tasks list.

To add My Tasks
From the ServiceDesk Plus - MSP login home page, you have My Tasks block on the right hand side
of the home page. Click the Add New button at the down left corner of the My Tasks block. This opens
the Tasks page. Alternatively, you can also add tasks by clicking
-> Add Task
under the Task block. From the add task form, you can either select the task template or add a new
task. To add a new task,
1. Specify the Title of the task in the given text field. This is a mandatory field.
2. Specify relevant information about the tasks in the Description field.
3. Select the Scheduled Start Time from the calendar button. Also select the Scheduled End
Time for the task from the calendar button.
4. The Actual Start Time and End Time of the task will be entered by the technician doing
(owning) the task.
5. The actual start time and end time is the real time schedule of the task. The scheduled start
time and end time specified by the task owner is a tentative time schedule.
6. Select the Owner (technician) of the task from the combo box.
7. Specify the Status of the task. By default the Status of the task is Open.
8. Specify any relevant comment about the task in the Comments field.
9. Save the values. You can see the added tasks getting listed under My Tasks block in the
home page as shown below. The tasks will be listed under the tasks tab in ascending order
based on the scheduled start time.
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To view the details of the tasks click the title of the task to be viewed. This opens the Tasks page and
you can view the details.
When you have completed the task, you can just close the task by selecting the radio button
the task. Alternatively,

beside

1. Click the Show All link on the right hand side of the block. The Show all Tasks page opens.
2. Select the tasks which have been completed by enabling the check box.
3. Click the Close button to close the task. You can see the tasks moved under closed status
and in the home page you can see the tasks deleted from the My task block.

To view all the added Tasks
To view all the tasks added to the list, click the >Show All button on the down right hand side of the
My Tasks block. This opens the Show all Tasks page as shown below,

You can also add new task through this page by clicking on the New Task button available on the top
right corner of the page.
To view the tasks based on the status-> click the Filter Showing combo box and select the task
status from the list. You can see the tasks getting listed based on the selected status.
Alternatively, you can view All tasks and tasks assigned to you in Quick Actions under the Task
block.

To Delete Tasks
1. Click the >Show All button on the down right hand side of the My Tasks block. This opens
the Show all Tasks page as shown above.
2. Click the Delete button. A confirmation message pops up asking you confirm on the delete
process.
3. Click Yes to proceed. You can see the task deleted from the Show all Tasks list as well as
from the home page.
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Publishing Announcements
ServiceDesk Plus - MSP allows you to publish announcements to all requesters or to the technicians.
The announcement board is available in the login home page of the my view tab, below the My
Summary block. Any technician can add, edit, and delete announcements.

The recent announcements will be displayed in the box. To view all the announcements (even
completed ones), click the Show All button. This will display the list of all announcements added till
date.
To view an announcement, click the Announcement Title to open the complete announcement
details in a pop-up. If there are more than one announcements, then you will notice a Previous and
Next button in the pop-up. Using this you can navigate through the announcements list and view all
the announcements without closing the pop-up window.

Add a New Announcement
To add a new announcement,
1. Login to ServiceDesk Plus - MSP using the administrator / technician user name and
password.
2. In the login home page, if you have permissions to add an announcement, you will notice the
Add New button in the announcements box as shown above. Click the button. The Add New
Announcement dialog pops up.
3. Enter the Announcement Title. This can be a short statement that describes the
announcement. This is mandatory field.
4. Type the Announcement Content in the text box provided for the same.
5. Select the From date and To date using the calender icon beside the respective fields.
6. You can make this announcement available to specific accounts. To do that, select the
accounts for which you want to show this announcement from the Available Accounts
column. Select >> button to move the selected accounts to the Associated Accounts
column.
7. By default, the announcement is available to technicians. If you wish to publish the
announcement in requester login, enable Show to Requester check box.
If you have configured User Groups for the accounts selected in Step 6, then you can publish
the announcement to requesters under the user group. Select the User Group from the
available list, select >> button to move the list to the selected user group. The announcement
indicating that the announcement is available
is displayed in the home page with the icon
to certain user groups.
8. If you wish to Send this announcement as mail then select the corresponding option by
enabling the check box.
9. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.
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The announcement will be added and the pop-up will display the announcement details as entered by
you. The announcement title will be displayed in the login home in bold text in the announcement box
with a new icon beside it.

Edit an Announcement
To edit an announcement
1. Login to ServiceDesk Plus - MSP using the administrator / technician user name and
password.
2. In the login home page, click the title of the announcement that you wish to edit. The
announcement details are displayed in a View Announcement pop-up. If you have
permissions to edit / delete the announcements, you will see an Edit and Delete button.
3. Click Edit button.
4. You can change all the fields of the announcement in the Edit Announcement form.
5. Click Save. At any point of time, you do not wish to edit the announcement, click Cancel.
All the changes made in the announcement will be saved.

Delete an Announcement
To delete an announcement,
1. Login to ServiceDesk Plus - MSP using the administrator / technician user name and
password.
2. In the login home page, click the title of the announcement that you wish to delete. The
announcement details are displayed in a View Announcement pop-up. If you have
permissions to edit / delete the announcements, you will see an Edit and Delete button.
3. Click Delete button. A confirmation dialog pops up.
4. Click OK to delete, and Cancel to retain the announcement.
Alternatively,
1. Login to ServiceDesk Plus - MSP using the administrator / technician user name and
password.
2. In the login home page, click Show All button in the Announcements box.
3. In the announcements list view, select check boxes beside the announcement Title which you
wish to delete.
4. Click Delete. A confirmation dialog pops up.
5. Click OK to delete, and Cancel to retain the announcements.

Note: If the announcements are open for everyone to view and not restricted to the
technicians alone, the requesters will also be able to view the announcements by clicking the
title of the announcements. Only announcements that have a completion time beyond the
current date will be visible for the requesters.
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Scheduler
ServiceDesk Plus - MSP gives the provision of providing a schedule calender showing the number of
open requests, task and reminder for a technician in a given month. The availability of a technician
can be viewed from the technician availability chart, depending on which, the task and requests can
be re-assigned to other technicians.

The following are available under Scheduler,
• My Schedule
• Technician Availability Chart
• Mark Unavailability
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My Schedule
My Schedule is a calender view displaying the number of open requests, tasks and reminders
assigned to a technician for a given month. The calender also shows the availability of the technician
for a specific day in a given month.

Note: The My Schedule calender can be viewed by All Technicians.
•
•
•
•

The administrator has the ability to view the number of open requests/ tasks and
availability of All Technicians in All Site.
The Account Admin has the privilege to view the number of open requests/tasks and
availability of technicians of All Site associated to his account.
The Site Admin has the privilege to view the number of open requests/tasks and
availability of technicians only in his site.
The Technician can view only his open requests/ tasks availability.

To view the My Schedule calender,
1. Login to ServiceDesk Plus - MSP application using your username and password.
2. In the home page, click Scheduler tab beside My View tab (OR) Click Quick Actions -> My
Schedule under the schedule block. This opens the Schedule Calender. By default, the
calender shows the number of open requests, tasks and reminders assigned to you as shown
below,

Schedule Calender
• The Schedule Calender shows the current month and year along with the navigation buttons
on the left hand side of the page.
• The Navigation buttons helps to navigate to the previous and the forth coming months.
• The current date is marked in separate border.
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•

•
•
•

For an administrator all the sites should be listed along with its corresponding groups and
technicians loaded in the drop down field.
For Account Admin and Site Admin, the site for which he is the administrator gets listed in
the drop down box along with its corresponding groups and technicians.
Technician can view only his open requests, tasks and reminders.
The number of Open Requests and task assigned to the technicians for a specific date in a
given month can be viewed.
The unavailability of the technician is indicated in a different color.
The company holidays and weekends is marked in a separate.

Using My Schedule, you can perform actions such as,
•
•
•
•
•
•

Mark Leave
Edit/Cancel Leave
Add Task
Add Reminders
Viewing requests/task/problems/changes
Re-assigning requests/task/problems/changes

Mark Leave
It is essential to keep a track of technicians on leave so that work is not assigned to them for that
particular day. To mark leave,
1. From My Schedule, hover over the day on which you want to mark leave. The list of icons
gets displayed on the right hand side below the date. Click Mark Leave
the Mark Unavailability pop-up window as shown below,

2.
3.
4.
5.
6.

icon. This opens

The name of the Technician is displayed in non-editable text.
Select the Leave Type from the combo box. For ex. Casual Leave, Sick Leave etc.
Select the From and To date of leave from the calender icon.
Specify any relevant Comments regarding the leave.
Click Save. The technicians’ holiday is indicated in a different color.
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Leave can be marked to other technicians using Technician Availability Chart. You can configure your
leave by clicking Quick Actions -> Mark Unavailability under the scheduler block. This opens the
Mark Unavailability pop up window. Follow the above steps to mark leave.

Edit/Cancel Leave
If you wish to edit or cancel a leave then,
1. From the schedule calender, hover over on the day the technician is on leave. Click on the
icon on the right hand side below the date. This opens the Mark
Edit leave
Unavailability pop-up window.
2. Click Save on making the changes.
3. If you wish to Cancel the leave then click Cancel Leave. The leave gets cancelled.
Note: For continuous holidays, the entire series gets cancelled.

Add Task
You can also add, view and re-assign the tasks to other technicians. The tasks can be added to
technicians for the current day and the forth coming days. To add task refer Add Tasks.

Viewing Requests/Tasks/Problems/Changes
The number open requests, tasks, problems and changes assigned to you get listed in the calender,
by default. To view the details of the request/tasks,
1. Click the link corresponding to the requests/task/problems/changes to be viewed for a specific
day. The details of requests/tasks/problems/changes gets listed for the particular day as
shown below,

Re-assigning Requests/Tasks/Problems/Changes
The requests, tasks, problems and changes assigned to a particular technician can be re-assigned to
other technicians. For ex. If requests are assigned to a technician for a specific day and if the
technician is unavailable on that day, then the request can be re-assigned to other technicians.
Similarly tasks, problems and changes can be re-assigned.
To re-assign requests/tasks/problems/changes,
1. Click the requests/tasks/problems/changes on the day, of the corresponding technician you
want to re-assign from the Schedule Calender. This lists out all the open request for that day.
2. Enable the check box adjacent to the request which you want to re-assign.
3. Select the technician from the combo box to whom the task is re-assigned. Click Re-assign
button. The task is re-assigned to the technician.
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Reminders
The reminder option is available only for the logged in technician, that is, if the logged in technician is
an administrator then the reminders of other technicians cannot be viewed by him. To know more on
reminders refer Reminders.
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Technician Availability Chart
The Technician Availability Chart displays the list of technicians, along with the number of open
requests assigned to them and their availability for a given month. The chart is a matrix view,
indicating the availability of the technician for a specific day, so that any request due on that day can
be re-assigned to other technicians.
Note: The Technician Availability Chart is available only for technicians with Admin privileges
such as an administrator, Account Admin and Site Admin.
•
•
•

The administrator has the ability to view the availability and the number of open
requests assigned to All Technicians in All Site.
The Account Admin has the privilege to view the availability and the number of open
requests of technicians of All Sites in his Account.
The Site Admin has the privilege to view the availability and the number of open
requests of technicians only in his site.

To view the Technician Availability Chart,
1. Login to ServiceDesk Plus - MSP application using the username and password.
2. In the home page, click Scheduler tab. This opens the Schedule Calender displaying the
number of open requests, task and reminders assigned to you. Click the Tech Availability
Chart link on the right hand side of the page. (OR)
Click Quick Actions under the header pane -> Tech Availability Chart under Scheduler
block. This opens the Technician Availability Chart. By default, the list of all the technicians
gets listed as shown below,

Technician Availability Chart
•

The Technician Availability Chart shows the current month and year along with the
navigation buttons on the left hand side of the page.

•

The Navigation buttons help to navigate to the previous and the forth coming
months.

•

The current date is marked in separate border.

•

For an administrator, the list of all the technicians gets displayed irrespective of the
Site and Group, by default. Hence the Site along with the group can be chosen from
the combo box to view the availability of a technician in specific site.
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For a Account Admin and Site Admin, the technicians available in his site gets
listed irrespective of the group.
•

The number of Open Requests assigned to the technicians for a specific date can
be viewed.

•

The unavailability of the technician is indicated in a different colour.

•

The company holidays and weekends is marked in a separate colours.

Using the Technician Availability Chart, you can perform actions such as,
•

Mark Leave

•

Configuring Backup Technician

•

Re-assign Requests

•

Edit/Cancel Leave

•

View Request

•

Backup Tech Chart

Mark Leave
You can mark the unavailability of a technician using the technician availability chart. This is essential
so that work is not assigned to the particular technician for that day and can be re-assigned to other
technicians.
To mark leave,
1. From the Technician Availability Chart click the day corresponding to the technician on
leave. This opens the Mark Unavailability pop-up window as shown below,

2.
3.
4.
5.

The name of the Technician is displayed in a non-editable text.
Select the Leave Type from the combo box. For ex. Casual Leave, Sick Leave etc.
Select the From and To date of leave by invoking the calender icon.
Specify any relevant Comments regarding the leave.
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6. Click Save. The technicians holiday is indicated in a different colour.
You can configure your leave by clicking Quick Actions -> Mark Unavailability under the scheduler
block. This opens the Mark Unavailability pop up window. Follow the above steps to mark leave.
Notifications rules can be configured to keep other technicians informed about the leave of absence of
a technician. Once the technician applies leave, selected technicians or the group in which the
technician is present will be notified about the leave when it is added, modified or cancelled.

Configure Backup Technician:
To configure a Backup Technician on the day of unavailability of a technician,
1. Click on the name of the technician who will be on leave in the Technician Availability Chart.
This opens the Technician Calendar for that month with the technician's days of
unavailability indicated in a different shade.

2. Click on Backup Tech link displayed in a different colour. This opens Backup Technician
Assignment screen.

3. Choose one of the 3 options provided to handle the upcoming requests assigned to the
unavailable technician.
o

Move requests to unassigned state - The requests assigned to the technician on
leave are moved to an unassigned state, which means, it is assigned to no
technician. This is done so that the unassigned requests can be re-assigned to
another available technician by the administrator or help desk coordinator.

o

Assign to following technician - This option allows you to configure a Backup
Technician throughout the absence of a particular technician. On choosing this
option, one can select the Backup Tech from the list of technicians displayed in the
drop down box. If Sites are configured, this drop down box displays only the
names of the technician who are associated with the same site as that of the
technician who is on leave.
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o

Don't take any action on the requests - This is the default option visible in the
Backup Technician Assignment screen. In this case, no action is taken on the
requests that is assigned to the technician. The request is assigned to the technician
even if he is on leave.

4. Click on Save after configuring the Backup Tech.
5. Once the Backup Tech is configured, an icon appears in the calendar indicating that the
backup technician has been configured. By hovering the mouse pointer over the icon, a
description box appears (as shown below) indicating the status of the backup technician
configuration.
If notification rules are configured, Once the backup technician is configured, notification e-mails will
be sent to selected technicians or the group in which the unavailable technician is present.

Note: Backup Technicians can be configured only up to one level. This means, if the backup
technician is on leave, another backup technician cannot be configured.

All information relating to unavailability of a technician, including the period of leave and backup
technicians (if configured) are displayed in the Backup Tech Chart.

Re-assigning Requests
Requests assigned to a technician can be re-assigned to another technician through the Technician
Calendar.

To re-assign requests to another technician,
1. Click on the number of requests and this opens the Backup Technician Assignment screen
along with the list of requests in the second half of the screen.
2. Select the requests that need to be re-assigned by clicking on the check boxes.
3. Select the Technician from the Technician drop down box.
4. Click on Re-Assign button to assign the requests to another technician.
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5. Click on Calendar View to go back to the Technician Calendar.
6. You can also re-assign requests by clicking on the requests in the Technician Availability
Chart and selecting View Details from pop-up. Follow the above steps to re-assign the
requests.
Note: Re-assigning requests is different from assigning requests through Backup Tech.
Although Backup Tech can be configured only up to one level, in the absence of the backup
technician, the pending requests can be assigned to another technician through this feature.

Edit/Cancel Leave
If you wish to edit or cancel a leave then,
1. Click on the leave of the technician which you want to edit from the Technician Availability
Chart. This opens the Mark Unavailability pop-up window.
2. Click Save on making the changes.
3. If you wish to Cancel the leave then click Cancel Leave. The leave gets cancelled.
Note: For continuous holidays, the entire series gets cancelled.

Viewing Requests
The requests assigned to a technician for a particular can be viewed by,
1. Click on the day of the requests, of the corresponding technician which you want to view from
the Technician Availability Chart.

2. From the drop down box,
request due for that day.

select View Details. This opens the list of all open

Backup Tech Chart:
Backup Technician Chart displays information such as absence of leave of a technician, name of the
technician and the backup technician configured through the period. This chart helps to keep a check
on the backup technicians whenever a technician applies for leave. To view the Backup Technician
Chart, click on the Backup Tech Chart link next to the My Schedule link.
Using the Navigation buttons at the left top of the screen one can navigate to the previous and the
forth coming months to get a broader idea about the technicians on leave, their period of absence and
the backup technicians configured for that period.
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Reminders
ManageEngine ServiceDesk Plus - MSP provides you with the option of tracking your tasks everyday.
The tasks that you add to the My Reminders list act as substitute for your sticky notes or post-it notes
which you would use to remember your tasks for the day.

Add Reminders
To add new reminders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click Quick Actions
just below the header tabs -> Add New under the
Reminders block. The Reminders form pops up.
Alternatively, you can add a new reminder by clicking Quick Actions -> My Reminder (s).
The My Reminder (s) form pops up as shown below,

Click +Add New link at the bottom of the my reminders form. This opens Reminders page.
3. Enter the task summary in the text field provided.
4. Select the Date & Time for the reminder. The date field is set to the today's date and the time
is set by default as 11:00 AM. Change the date and time settings. To change the date, click
the calender icon beside the date field and choose the date of your choice. From the time
combo box, choose the time at which the task is scheduled. The values in the combo box are
available in a gap of 5 min time interval.
5. Click Add. The new reminder is added and is listed along with the already existing reminders
in the ascending order based on date and time.

Changing Status
When you have completed a reminder, you can just strike the reminder to indicate that it is completed
by selecting the radio button beside the reminder.
to change the task status from
1. From the My Reminders form, click the status radio button
incomplete to Completed. The task is struck through to indicate that it is completed.
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2. Alternatively, you can also change the task state by executing the following steps :
1. Click Show all at the bottom right of the My Reminders pop up window. The All
Reminders window opens as shown below,

2. Select the check boxes beside the Reminder Summary for which you wish to
change the state.
3. Select the state from the Change Reminder State To combo box, select the
reminder state to Completed.
4. Click Change button to change the status of the task. To indicate the change the task
would be striked of.

Deleting Reminders
The reminders can be deleted by,
1. From the My Reminders form, click Delete this reminder radio button
the status radio button. The reminder gets deleted from the list.

available beside

2. Alternatively, from All Reminders window, enable the check box beside the Reminder
summary to be deleted. Click Delete. A pop up window confirming the delete operation
appears. Click Ok to proceed. The reminder gets deleted from the list.
The advantage of moving the reminder to completed state instead of deleting it completely is that, you
can revert the state of the reminder to Open again and edit its attributes. But once you delete the
reminder, it is completely removed from the application and cannot be retrieved.
Note: The Reminders option is available under Quick Actions link for requesters accessing
ServiceDesk Plus - MSP through Self-Service Portal, provided the option is enabled.
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License Expiry Alert
Just above the header tabs the license expiry alert will be displayed as show below,

Click on click here link to view the licence expiry alert. The license expiry alert provides remaining
number of days for the existing license to get expired. And also it provides the date by which the
license has to be renewed. The option to purchase the license such as sales contact email ID, link to
apply the upgraded license are also provided as shown below,

To register ServiceDesk Plus - MSP, you can just click the link click here to apply in the license alert
box. This opens the license upgrade window. To apply the license, refer to the topic Registering
ServiceDesk Plus - MSP.
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Dashboard
The Dashboard is a visual display of real-time information, consolidated and arranged in a single view
so that it can be easily monitored. The Dashboard displays various statistical data related to number
of requests, changes, problems, assets, software, POs and contracts based on various criteria.

Note: Information displayed on the Dashboard largely depends on the site and roles
associated to the technician.

Data shown in the Dashboard is restricted to the site the technician is associated to. When a
technician is associated to multiple sites, then a drop down option with sites he is associated to
appear. By choosing the site, information and data associated with that site are displayed to the
technician.
Similarly, data displayed on the dashboard is also restricted based on the roles associated to the
technician.
Dashboards contain the following sub tabs :
1. Helpdesk
2. Problem & Change
3. Assets

Helpdesk:
Under the Helpdesk tab, 8 small widgets are available to provide request based information at one
glance.
•

The first widget displays a matrix chart. It shows the total number of requests in Open, On
Hold and OverDue statuses. This information can be viewed based on the criteria provided in
the drop down box. Number of requests can be viewed based on Technician, Category,
Level, Priority and Mode. Clicking on the numbers in the chart opens the corresponding list of
requests.

•

The second widget displays a pie chart. It shows the number of open requests that can be
viewed based on Level, Mode, Priority and Category. By clicking on the graph, you can view
the requests corresponding to each shaded criteria.

•

The third widget displays a bar graph. It shows the number of SLA violated requests. A drop
down box provided allows you to view the number of SLA violated requests based on Priority,
Group, Level, Technician and Category. By clicking on each bar, you can view the SLA
violated requests corresponding to the selected criteria.
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•

The next 3 are angular charts that show the number of unassigned and open requests,
number of SLA violated open requests, and number of requests nearing SLA violation in the
next 60, 120 and 180 minutes. Clicking on the number of requests present in the bottom of
the widget opens the corresponding list of requests for viewing.

•

The last 2 bar graphs show the number of requests that were created and closed in the last
20 days. Clicking on the bars on the graph opens the corresponding requests for view.

Problem & Change:
Technicians who have permission to view the Problem and Change module can also view the
Problem & Change widgets in the Dashboard.
•

The first widget in the dashboard is a pie chart that shows all the scheduled upcoming
changes that are to be rolled out. The changes that are scheduled to be rolled out in the
following time period (This week, Next week, This month and so on) by selecting the time
period from the first drop down box. The changes can also be viewed based on criteria such
as Change Type, Priority, Urgency and Impact.

•

The second widget shows a list of Approved changes that are scheduled to be rolled out. The
list can be viewed based on the time period during which the changes are scheduled to be
rolled out (This week, Next week, This month and so on). The list indicates the Title of the
change along with the Change Type. Clicking on the title of the change opens a pop-up with
the change details. By clicking on the title of the change in the pop-up, the complete change
details page can be viewed.
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•

The third widget shows a list of unapproved changes along with the change type. Clicking on
the title of the change opens a pop-up with the change details. By clicking on the title of the
change in the pop-up, the complete change details page can be viewed.

•

The last widget is a pie chart displaying the problems. The chart can be customized to be
displayed based on Priority, Urgency and Impact.

Assets:
Technicians who have permission to view Asset module can also view the Asset Dashboard and
monitor the statistical data displayed on it. The widgets in the Asset Dashboard give complete
summary of all physical assets (IT and non-IT), software assets, workstations and POs & contracts.
•

The first widget shows a summary of all physical assets in the organization including IT and
non-IT assets. By default only number of Workstations, Printers, Routers, Servers and Others
are displayed. By clicking on "View All", the Others category is expanded and other IT and
non-IT assets such as Access points, Switches are displayed. The number of workstations
failed to be scanned is also indicated in this widget along with the option to Troubleshoot the
failure operation. By clicking on the number displayed next to the assets, one can view the list
of those assets under the Asset module.

•

The second widget displays a bar graph indicating the number of workstations depending on
various criteria. These criteria can be selected by clicking on the red drop down arrow at the
top of the widget. By clicking on "View All", a pop-up showing the extended graph is
displayed. Set of graph that is not included in the original widget is displayed in this pop-up.
Mouse hovering over each bar displays the number of workstations corresponding to the
selected criteria. By clicking on the bar, the list of workstations is displayed under the Asset
module.
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•

The third widget shows software related information in a combination of pie chats and bar
graphs. By clicking on the red drop-down arrow below the widget title, one can select the
criteria based on which the graph should be displayed. By clicking on "View All", a pop-up
showing the extended graph is displayed. Set of graph that is not included in the original
widget is displayed in this pop-up. Mouse hovering over each bar/pie region displays the
number of software corresponding to the selected criteria. By clicking on the bar/pie region,
the list of software is displayed under the Asset module.

•

The fourth widget shows a summary of Purchase Orders (POs) and Contracts. By selecting
Purchase Order summary from the drop down, one can view the overdue POs, POs due in
the next 7 days and the POs due in the next 30 days. By Selecting Contracts summary, one
can view the contracts that have expired in the last 30 days, contracts expiring in the next 7
days and contracts expiring in the next 30 days.
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Request
Requests
The numerous help desk tickets raised in your organization are organized and tracked in the
Requests module. The Requests module enables you to handle tickets promptly, assign tickets to
technicians, merge similar requests and so on.
By keeping track of the outstanding and overdue requests, the Request module helps to improve the
response time and resolution time by your IT help desk team. The Requests raised by your users are
of two types namely, Incident Requests and Service Requests.
•

Incident Requests are requests that denote the failure or degradation of an IT service. For
example, Unable to print, unable to fetch mails and so on.

•

Service Requests on the other hand are requests raised by the user for support, delivery,
information, advice or documentation. Some examples are installing software in workstations,
resetting lost password, requesting for hardware device and so on.
NOTE: Please note that a Service Request is not an Incident.

The Requests module allows you to add relevant notes pertaining to the request that is being
handled. The notes may contain information like, the exact scenario of the request or how the issue
was resolved. Also, every action performed on the request in the ServiceDesk Plus is stored in the
Request History.
Clicking the Requests tab takes you to the request module. Here the term request denotes any
service (both incident requests and service requests) that is requested by a user from the internal IT
services team. The request is submitted to the system via mail or a web-based form. Sometimes, the
request can also be placed through a phone call during which, the help desk agent has to record the
details of the phone call in the web-based form, and assign priority and technician based on the
urgency of the request. The various actions that one can perform in the request module are explained
in the respective sections.
To ease the process of tracking the requests posted by individual requesters, a Self Service Portal
has been provided. The Self Service Portal is used by the individual requesters to track the status of
their requests and to look up solutions from the online knowledge base. To access the self-service
portal, the requesters need to log in to the ServiceDesk Plus application using their respective user
name and password.
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Request List View
Request List View page organizes and maintain the list of all the issues raised into ServiceDesk Plus MSP. You have the facility to
•

customize the page to display the requests

•

options to view the requests for the selected account based on filters

•

view archived requests

•

customize columns in the list view

•

set the number of requests to be displayed per page and

•

perform major operations on request from the list view

On clicking the Request tab in the header pane, the page redirects to the request list view page
displaying all the Open Requests by default.

Whenever the allowance for an account is consumed and if the service plan allowance option is set to
block requests once the allowance is consumed, then all the requests in that account will be shown in
strike out style in request list view. Also when the contract for an account is expired, all the requests of
that account will be shown in strike out style. When you view the details of such a request in the
Request Details page, a notification will be displayed alerting the technician.
1. Archived Requests: Move all the closed/resolved requests from the active state to an
archive state so that accumulation of millions of active requests can be avoided and the
helpdesk performance increase. If required, export the requests as Html files, pdf files, xls file
or csv file. To know more on configuring a schedule data archiving click here.
2. Refresh this page: Set time frame to auto refresh the request list view page from every 3
minutes to every 30 minutes.
3. Custom and Manage View:
•
•

create filters to customize and organize your request list view The filters created
can be made public or private.
View, edit and delete your customized view. Know more
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4. Request based on Filter: Classify your request list view and view specific set of requests for
the selected account under three categories namely, My Group, Requests and My Views.
Know more
5. Set the number of requests per page and navigation buttons: View the entire set of
requests available in ServiceDesk Plus - MSP application by settings the number of requests
to be viewed per page. Navigate through the pages using the next and previous navigation
buttons.
6. New Request: Create new requests on specifying the detail information of the request such
as, request type, priority, urgency, group, category, sub category and items.
7. Search: Search for requests with specific request Id, subject, requesters name, group and so
on.
8. Bulk Operation:
•

Edit Request: Bulk edit the requests with similar information.

•

Delete: Delete bulk requests.

•

Pick up: Pick up bulk requests.

•

Close: Close bulk requests on completion.

•

Merge: Merge two or more similar requests.

•

Assign: Assign bulk requests to the selected technician.
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Creating a New Request
When system users need a service from the system administration team relating to the assets or any
other service such as software installation and so on, they can send a request to the team. There are
different modes of placing a request to the system administration team, such as web-based form, email notification, phone call and so on. ServiceDesk Plus - MSP provides options to log details of a
request originating in any of the above-mentioned forms.
To create a new request using the web-based form
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the New Request link available just below the tabs in the header pane or click the New
Request button in the Request index page. This opens the 'Default Request' Template form,
You can also create new requests quickly and easily through Quick Create and Change
Template explained later in the page.

Providing Request Details
1. In the default request form, select the Request Type from the combo box. The three default
request types are,
o

Incident : Failure of a business service or degradation of a service for one or more
users. E.g. Unable to print

o

Service Request: A standard request for some kind of service. E.g. Installing
software, move from one place to another, reset password etc. A Service Request is
not an Incident.

o

Request For Information: Request for information is basically in need of some
information or knowledge.

The request type can be configured in Request Type under the Admin tab.
2. Select the Status of the request. The default entry of the Status of the request will be Open.
3. Select the Mode of request submission, request Level and Priority of the request from the
combo box.
4. Select the Impact, Impact Details and Urgency of the request from the combo box.

Selecting the Requester
You can select the requester from the list of users using the ServiceDesk Plus - MSP application.
5. In the Requester Details block of the Request form, beside the name field, click the
). The Requester List window pops up as shown below,
requester lookup button (
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Note:
1. The requesters are populated based on the logged in technicians associated
sites/accounts.

1. From the above list of requesters, click the hyper-linked requester Name to choose
the requester.
2. If the requester list is huge, then you can choose to view only a select group of
requesters by clicking the alphabets at the top, or by entering a search string and
clicking Go. Now choose the requester name. The name of the requester is displayed
in the Name field in the Requester Details block. If there are any other details
associated with the requester, such as Contact Number, Department, Site and
Workstation, then the relevant details will be populated in the respective fields.
3. You can also add new requester directly by clicking the Add Requester button from
the requester list page.
4. And also you can edit the requester details directly from this page by clicking the edit
icon beside each of the requester name in the list.
6. By default, the location of the requester gets populated in the Site text field. The requester
can raise a request from a one site to a problem in a different site. In this case the site needs
to be selected from combo box by the technician handling the request.

Assigning Request to Group/Technician
7. On selecting the site, the groups corresponding to the site gets populated under the Group
field. The request is routed to the particular group by selecting the Group name from the
combo box.
8. On selecting the Group , technicians associated with the Group alone will be listed in the
Technician drop down list. Select the Technician for the request from the combo box.

Classifying Request Category
9. The request can be classified under various categories. Select the relevant category under
which your request can be classified under the Category drop-down box.
10. Select the relevant Sub-Category from the combo box. Also select the relevant Item from the
combo box.
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11. Specify the subject line to be displayed while sending the request in the Subject text field. The
subject line will be displayed as the request title hence this is a mandatory field.

Describe Request
12. Once you have specified the details for the request, you need to describe the request in
detail. Provide a detailed description with any other associated details relevant to the request
in the Description text box.

Add Attachments to the Request
13. In the Task Details block, below the Description text box, click the Attach file button beside
the Attachments field to attach attachments. This opens an Attach File pop-up window as
shown below,

1. Click the Browse button and select the file to be attached from the file chooser
window and click the Open button.
2. Click the Attach file button. The selected file will be listed below the Attachments
heading. If you have more files to choose, follow steps 2 and 3 repeatedly till you
have attached all the relevant files. Please ensure that the total size of the
attachments does not exceed 10 MB.
The attached documents can be indicated with an attachment icon beside the title of the request in
the request list view page.

Adding Resolution for a Request
You also have an option to add Resolution to the request in the new request form. If you have an
answer or solution for the request you can quickly add in the resolution text field and add it to the
request.
The purpose of having resolution in the new request form is, when a technician is reported about a
problem which has been already cleared by him/her then, in this case he can create a new request,
specify the solution in the resolution field, set the status as closed and he can close the request. Thus
this option makes the job easier for the technician to specify the resolution and close the request
immediately. To add resolution,
beside Resolution title in the new request form. This opens the
14. Click the button
Resolution text field. Specify the solution in the given text field and add to the request. The
resolution can be viewed by click the Resolution tab while viewing the request.
15. Once you have done all the above, click the Add request button. The request gets added to
the list of requests and can be viewed from the request list view which can be invoked by
clicking the Request tab in the header pane.

Additional Request Details
You can define your own organization-specific fields that do not appear in the New Request
form, from the Admin module. Depending on the fields, enter the required values for the fields.
To know more about how to add user-defined fields in the new request form, refer to the
Configuring Additional Fields section in the request form under the Helpdesk configurations.
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The newly created fields needs to be configured in 'Default Request' under Request
Template.

Quick Create
Quick Create is optional and can be enabled under Self Service Portal Settings. Using the Quick
Create - New Request form, you can create a request instantly. This form is available in the
ServiceDesk Plus - MSP home page and in requests list page as shown below,
Enter the Requester Name, Request Title, and Description in this form and click Save. You can
beside the requester name field. If
select the requester name by clicking the user look up button
you feel you want to add more details before submitting, then you can do so by clicking the Add more
Details link beside the Save button.

The Quick Create - New Request form comes in handy when help desk agent is loaded with work.
He/she just has to enter the requester name, request title, and description. The other details can be
filled in by the technician who handles the request.

Change Template
A request can be created instantly using request template. The request form can be customised
thereby creating individual request template for the most frequently raised requests.
Select any one the template relevant to the request from the Change Template combo box in the
new request form. The default request is the default template in the new request form. You also have
the same templates listed under the New Request link. On selecting the template a request form with
pre-filled values will be displayed, you have to just specify the Name in the form and click Add
Request button to create a request.
If the required request template is not listed in the combo box, then create a new request. Also you
can create a new request template using Request Template option in the admin tab.

Modes of Creating a Request
You can create a new request in one of the following methods:
1. E-mail the request to the Support e-mail address configured for the requesters account.
The Support e-mail address would be aliased with the Mail account specified in Incoming
Mail Server Settings. The e-mail will be automatically converted to a new request in the
ServiceDesk Plus - MSP application.
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2. Call up the help desk agent and report an issue or explain the nature of your request. The
help desk agent will manually feed in the details into the application through the web-based
New Request form available in the Request module.
3. Log in to the ServiceDesk Plus - MSP application using your own user name and password
and fill in the New Request form or Quick Create - New Request yourself and submit your
request.
There can be other modes of requests also by which requests can get created. For more information
on how to add additional modes, refer to Configuring Mode section.
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Raise a Service Request
Service Requests are requests raised by the user for support, delivery, information, advice or
documentation, and is not related to any failure in the IT structure. The two modes through which
requesters can raise service requests to the system administration team are:
•

Requesters can call up the help desk agent and request for service. The help desk agent will
in turn raise a service request by conducting a search for the service item from the list and
manually feed in the users details. OR,

•

Requesters can log into the Self Service Portal and raise the service request by themselves.

The Service Catalog list
Similarly to the New Incident drop down menu, the Service Catalog drop-down menu lists all the
service items configured in the application. The service items are grouped under a service category
for easy reference and identification. From the list of service items available to you, you can browse
and raise a service request.
Alternatively, you can also select a service from Home tab -> Service Catalog. The list is organized to
view the service items under each service category. From this page, you can conduct a search for the
desired service item using Search Service Catalog field.

Raise a Service Request
Raising a new service request is as simple as creating a new incident request from the available
templates. Browse through the Template List and select a service that is relevant to your needs.
1. Select the service item from the catalog. This takes you to the New Service Request form.
The delivery time frame of the service is displayed. The delivery time frame is displayed only
if an SLA is assigned to the service request.
2. Select the parameters such as Status, Level, Mode, Priority, Category, Sub category and so
on, that is available in the template.
3. To select a Requester from the list of users configured in the application, click requester
beside the requester name field. The Requester List window pops up. Click
lookup icon
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the hyper-linked requester Name. The requester name and details associated with the
requester are populated in the requester details block.

1. If the requester list is huge, then click on the Alphabets at the top of the
page to view only a selected group of requesters.
2. Conduct an instant search for the requester by entering the search string in
Search Requester List field and click Go.
3. If you are aware of any requesters details such as name, login name,
department, email and so on, then conduct a column-wise search using the
search icon .
4. In addition, add new requester directly by clicking the Add Requester button
from the requester list page.
5. Also, you have an option to edit the requester details directly from this page.
beside the requester name to perform the edit
Click the edit icon
operation.
4. The assets associated to the requester are populated in the Asset drop down. Select the
.
Asset from the drop down. You can also select assets by clicking the icon
In Select Assets pop-up window, you can filter the assets by selecting the Type of assets
such as, access point, routers, workstation and so on, from the drop-down. Selecting All
Assets lists all the assets available in the application, irrespective of the asset type. You can
further filter the assets according to sites associated to the logged in technician using the Site
drop-down. Selecting a site lists the assets from that particular site.
Say, for instance, if the site selected is "New York" and the asset type is "Access Point", then
all the access points associated to the site New York are listed.

Tip:

If the Service Request is "Installing Software", then select the workstation in
which the software should be installed.

5. By default, if the site location of the requester is configured in the application, then the same
is populated in the Site field.
6. On selecting the site, the groups corresponding to the site gets populated under the Group
field. The request is routed to the particular group by selecting the Group name from the drop
down.
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7. On selecting the Group, technicians associated with the Group alone are listed in the
Technician drop down list. Select a Technician to handle the request from the drop down.
8. For a service request template, the subject line is already specified. You can change or
modify the subject. The subject line is displayed as the request title and is a mandatory field.
9. Provide a detailed description with any other associated details relevant to the request in the
Description text box.
10. To add any attachments relevant to the service request, click the Attach file button in the
Attachments block. The Attach File pops up as shown below,

1. Click the Browse button and select the file to be attached from the file
chooser window and click the Open button.
2. Click the Attach file button. The selected file is listed below the
Attachments heading. If you have more files to choose, follow steps 2 and 3
repeatedly till you have attached all the relevant files. Please ensure that the
maximum size of the attachment is 10 MB.
The attached document is indicated with an attachment icon beside the title
of the request in the request list view page.
11. While entering the request details, if you have a solution for the service request, then the
same can be entered in the Resolution field.
12. Click Add New Request button. The request details page is displayed from where you can
perform further actions on the service request.
NOTE

Please note that the following operations cannot be performed on a service request Merging requests, Duplicating requests, Associating Problems to a request
and Associating Changes to a request.
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Creating Custom Views
You can create your own customized page to display the requests using Custom View option. You
can specify the criteria to filter the selected requests that have accumulated in your requests list view
page. This helps you to sort & view requests of your priority and requirement. To create your own
custom view,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens Requests list view page.
3. Click Create Custom View icon

. This opens Add Custom View page as shown below,

4. Specify the View Name in the given text field. This is a mandatory field.
5. The administrators can make their views as private view or public view. By default the view
will be public but to make this view as private custom view then select Make this view as
private custom view check box.
By default the technician without administrator log-in permissions can create only private views.
Hence the above shown 'Make this view as a private custom view' option will not be
available for the technician log-in.
6. Specify the filter criteria by selecting the column and its matching criteria from the combo
box. And select the matching data for the column by clicking the Choose button. Also select
the AND or OR conditions by enabling either of the two radio buttons.
7. Click Add to Filter button to save the filter criteria details. The filter criteria details will be
listed in the Filter Set block.
8. If you wish to add more filter conditions to this view then, select the required column, criteria &
conditions of the filter.
9. Save the filter criteria details. To add another custom view click Save and Add New button.
Custom views will be listed in the Filter showing combo box in the Requests home page at the top
below the title. On clicking the combo box the views marked as private will be listed under My View
list and the public views will be listed under Requests list.

Manage Custom Views
You can view all your customized view using this option. You can also edit, delete, add new custom
views using this option.
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens Requests list view page.
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3. Click Manage Custom View icon
of all the created custom views.

. This opens Manage Custom View page with the list

Editing Custom Views,
1. Click the custom view title or click the edit icon. This opens Edit Custom View page.
2. Edit the details and save the changes.

Deleting Custom Views,
1. Select the custom views to be deleted by enabling the check box. The public views can be
deleted only by the administrators (ie: Only the administrators can make their view public
other technicians without admin permissions can only create a private view).
2. Click the Delete button to delete the views. A pop up window pops up to get your confirmation
on the delete operation.
3. Click Yes to proceed. You can see the view deleted from the list.
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Viewing a Request
To view a request available in the ServiceDesk Plus - MSP Request module
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Requests tab in the header pane. The next page lists all the requests associated to
the accounts of the logged in technician in the ServiceDesk Plus - MSP application in the
Open status. Unassigned and assigned requests that have not yet been viewed by the
corresponding technician even once will be in bold text, while the viewed requests will be in
regular font.
3. Click on the Title of the request that you want to view. This opens the View Request page.
By default the page displays Request, Resolution, and History tabs.
From the request details page, you can navigate to the previous or the next request using the
navigation buttons on the top right hand side corner. Using this, you need not return back to
the list view page to view the next request.
If the contract added to the account under contract billing expires, and whenever the allowance for an
account is consumed and if the service plan additional usage option is set to block requests once the
allowance is consumed, an alert message can be viewed at the top of the request details page. The
alert messages seen in the Request Details page are: notification stating that the allowance has been
consumed or contract expiry notification.

In the request tab, the data is grouped in a logical manner. By default this page displays Subject of
the request & Description of the request, Request Details, Requester Details and Time Elasped.
The Request ID is displayed on the top left corner of the page below the tabs. The Status, Priority,
Billable, and Contract Status of the request is displayed on the top right corner of the page.
Note: You also have other blocks displayed in this page such as Conversations, Discussion
Notes & Time Spent blocks. These blocks gets displayed on adding the same to the request.
If the request is submitted for approval then the Approvals tab is viewed along with the
Request, Resolution and the History tabs. The Approval Status is shown on the top right
corner of the page below the Status and Priority. To know more refer Submit For Approval.
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Viewing Request Details
The Request Details block displays the Status, Group, Category, Sub Category, Item, Workstation,
Created Date, Created By, Technician, Priority, Mode, Level and Due Date of the request. You have
inline edit option to edit all the request details under this block. To edit the details click the link
available for each of the request details against each field. Say for ex. If you wish to change the
technician Jeniffer Doe to John Abraham for Request ID 14 then click the name of the technician and
select the technician name from the list.

Viewing Requester Details
In the Requester Details block, the details of the requester such as the Requester Name, Contact
Number, Department, Email Address & Mobile Number of the requester are displayed. You have
inline edit option to edit all the requester details under this block. To edit the details click the link
available for each of the requester details against each field.

Viewing Conversations
Next is the Conversations block, which displays the mail transactions / threads that have been
exchanged between the technician and the requester, related to the request.
Click the View Requester Conversations link to view the history of all the conversations.
Conversations are listed in the ascending order of the time. The conversation block is visible only if
there have been any mail transactions between the requester and the technician.
Note: If any mail transactions/ threads has an attachment, then the same can be viewed
under View Requester Conversation block. To know more refer Request Conversation.

Viewing Discussion Notes
Once you add a note to the request the Discussion notes gets displayed in descending order of their
date of creation just below the Requester Details block. If you select the option "Show this notes to
requester" then the note will be displayed as Public. Else will be listed as private.
You also have an option to edit or delete the discussion notes.
Asset belonging to the User, while adding users to ServiceDesk Plus - MSP in the Admin tab, you
have an option to Associate Workstation to the user. If you have associated workstation to the user,
you can view the list of all associated workstations under this block.

Cost of a Request
Finally, you can enter the time spent details for the request.
1. Click Work log tab in the Request Details page. Click Add Work Log button. (OR)
Alternatively, you can enter the time spend details for a request by clicking Add Work Log
option under Actions combo box from the request details page. The Add Work Log dialog
pops up with the subject and request id of the request mentioned.
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2. The Subject and Request ID is displayed at the top of the page.
3. By default, the technician assigned to the request is displayed in the Technician Resolving
This Request drop down box. If required, you can choose the technician from the drop down
list. This field is mandatory.
4. Select the date and time when the request was Executed using the calender icon. This field is
mandatory.
5. On selecting the executed time, the number of hours is automatically calculated as a
difference between the executed time and the time when the request is created or the
executed time of the last added worklog. If you have specified any additional usage charges
under Service Plan, then the differential cost per hour specified and added to the Service Plan
is displayed automatically. These hours can be modified by the technician, if 'Allow
technician to overwrite the time taken to resolve' option is selected under Service Plan
page.
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6. If there are any Additional Cost, then the same can be provided by clicking the Add Cost
button. Specify the Item, Quantity and Price in the fields provided.
NOTE: The availability of Additional Cost field is based on the settings under Service Plan.
7. Using the above two data, the Total Worklog Cost ($) (Incident Cost + Additional Cost)
will be calculated and displayed automatically.
8. Specify the Description about the time spent details in the given text box.
9. If you wish to make this time entry as non-billable, select the Mark this worklog as nonbillable check box. The worklog will be marked as non-billable.
NOTE: When a worklog is marked as non-billable, only the additional charges will be
considered for billing.
10. Click Save.
The Created Date field displays the time when the request was created. Based on the priority of the
request and SLA that is associated with the requester/workstation/department, the Due By Date is
calculated. If you have responded to the requester then you will see the Responded Date displayed
just below the Priority field in the Request Details block. When you add any notes to the request, it
gets appended below the Task Details block. The Time Spent on the request will also be calculated
and displayed. The total time spent will exclude the time that the request was on hold and then
calculate the total time from the time of creation till the request was closed.
If any notes are added to the request, they will be available below the description of the request. The
notes are displayed in the descending order, with the latest added note displayed first and the rest
below that. The notes can usually be added to convey any technical information related to the request
or to convey the request status.
If there are any additional user-defined fields that have been added to the new request form, they are
grouped under the Additional Request Details head and displayed just below the Request Details
block.

Viewing Resolution
To view the resolution for the request in the view request page
1. Click the Resolution tab next to the request tab.
2. The current available resolution for the request is displayed in this page. You have an edit
option on the right side of the resolution. If there are no resolutions available for the request,
then the blank text is shown for you to add the resolution if needed. To search for resolutions
from the solutions database, click Search Solutions button.
3. The resolution is a documented information of how the issue was resolved. This documented
information can be very useful for future reference. This resolution can also be added to the
knowledge base as an article which can be searched by requesters for resolving issues faced
by them.
4. The status of the request can be modified while adding a resolution on selecting the status
from Change Status To combo box.
5. You also have an option to Add Time Entry to the resolution. Select Add Time Entry option
by enabling the check box and specify the details.
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Viewing History
To view the request history from the time of its creation, click the History tab in the view request
page. The details that are displayed in the history are in the ascending order with the earliest
performed action shown at the top of the page and the latest action at the bottom of the page.

Viewing Account Details
The account details tab displays the Account Details, Contract Details and the Billing Details
associated with the Account. The Account details includes the Phone Number, E-mail ID, Fax
Number, Web URL and any attachments added to the account. Contract details such as contract start
date and expiry date are displayed. The number of hours consumed for an account and the remaining
allowance hours are displayed under Billing Details block.

Zoho Corporation Pvt. Ltd.
77

ManageEngine ServiceDesk Plus MSP – Admin Guide

Editing a Request
To edit a request available in the ServiceDesk Plus - MSP Request module
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Requests tab in the header pane. This opens the Requests list.
3. Click the Title of the request which you want to edit from the view list page. This opens the
View Request page. Click the Edit tab on the top of the page to modify the request details.
(OR)
beside the request to be edit. This
From the request list view page, click the edit icon
opens the Edit Request form where you can add resolution while editing, change the status
of the request from open to close, and so on.
Alternatively, you also have an inline edit option to modify the request details in the view
request page. Click the edit button beside each block which opens the request form fields in
editable format. This comes in handy when you need to edit the values of the entire block say
Request Details one by one.
Note : While editing the request details block, the SLA, department and the template is in non
editable mode. The SLA of the corresponding site selected on editing the request gets applied.
The department of the corresponding technician selected on editing the request gets displayed.
4. On modifying the values, click Update Request to save the changes. If you do not want to
save the changes, click Cancel.

Editing more than one Requests
You have an option to edit more than one requests simultaneously.
1. Select the check box beside the requests to be edited from the request list view page.
2. Click Edit Request button. This opens Edit Requests page. The title displays the requests
number that are grouped together to edit. Edit the Request, Owner & Category details of
the requests.
3. Specify the Reason for Updating the request in the given text field.
4. Click Update button to save the changes.
This comes very useful when there are group of requests of same issue wherein the technician can
select all the requests and edit the details in a single shot without editing each request one by one.
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Closing Requests
When a requester is completely satisfied that his/her request has been completely attended to and the
reported problem has been solved, then the request can be closed.
To close a request,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request in the Requests list page.
4. Click the Close tab under the Tasks block. The Close Request dialog box appears. Enable
the 'Yes' radio button if the resolution has been acknowledged. else enable 'No' radio button.
Enter relevant Comments in the field provided. Click Close to close the request. If you do not
wish to close the request then click Cancel. (OR)
Alternatively, change the status field to Closed when the request is in editable mode.
You can reopen a request from the closed state. To do this, open the closed request that you wish to
reopen in the editable mode and change the status field from Closed to Open. When a request is
opened from the closed state, you can change the Due By time of the request when it is in the
editable mode. Also, the closed date is removed once the request is reopened. When this request is
finally closed, the completed date is updated and the Time taken to close is recalculated taking the
reopened period into account.
To close more than one request at a time,
1. In the Request list view page, select the check boxes available beside the Requester Name
field of the requests that you wish to close.
2. Now click the Close button. The Close Request dialog box appears. Enable the 'Yes' radio
button if the resolution has been acknowledged. else enable 'No' radio button. Enter relevant
Comments in the field provided. Click Close to close the request. If you do not wish to close
the request then click Cancel.
To view the closed requests
1. From the Request list page, select Closed Requests from the Filter drop-down menu. This
lists all the closed requests.
2. To view the closed requests which were assigned to you, select My Closed Requests.
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Picking up Requests
ManageEngine ServiceDesk Plus - MSP provides the option of self-pick up of requests that are
received in the requests module. If there are unassigned requests in the application, then the
technicians can themselves pick up requests. This increases the efficiency in the turnaround time of
the IT help desk team as the requests are assigned and answered sooner and waiting time of the
request till it is assigned is reduced.
To pick up requests
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Requests tab in the header pane. The unassigned requests will be in bold font.
3. Select the requests you would like to pick up by enabling the check box. Click Pick up button.
The selected request will be assigned to you. (Or)
4. You can also pick up requests after viewing the request details. Click the title of the request to
open View Request page.
5. Click Assign tab. Select Pick Up option to pick up the request.
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Assigning a Technician for the Request
Each request will be owned by a technician, who would be responsible for handling the request till it is
closed.
To assign a technician,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the Requests list.
3. Click the Title of the request for which you have to assign a technician. This opens the view
request page.
4. The View Request page lists the Tasks that can be performed on the requests on top of the
page. Here click the Assign link and select the assign option. This opens Assign Group and
Technician page as shown below.
Based on the issue you can assign this request to the appropriate Group and as well as to the
Technician who belongs to that group. Or you can select either of the one. If you wish to select
the technician alone then choose the technician from the list and click Assign button to assign
the technician to handle the request. And when the technician logs into ServiceDesk Plus MSP, he/she would see this request in the My Open Requests list.

5. Alternatively, you can also assign technician using inline edit option. Click the technician
name shown in the request details block. This opens the drop down box as shown below.
icon to select the technician name else
Select the technician from the list and click the
click cancel icon.
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Note:
The Groups/Technicians are populated based on the site to which the request
belongs.

Bulk assign requests to technicians
You can also assign more than one request at a time to a technician.
1. In the Requests list page, select the requests to be assigned a technician by enabling the
check box beside left side of each of the request title.

2. Select the Assign to check box. Select the technician from the drop down list.
3. Click Assign button to assign the technician.
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Unassigning a Technician from a Request
Each request will be owned by a technician, who would be responsible for handling the request till it is
closed. You can unassign a request from the request and move it back to unassigned status.
To unassign a technician
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the Requests list.
3. Click the Title of the request for which you have to unassign a technician. This opens the
view request page.
4. The View Request page lists the Tasks that can be performed on the requests on top of the
page. Click the Assign link and select the Assign option from the list. Alternatively, you can
also unassign technician using inline edit option. Click the technician name shown in the
request details block. This opens the drop down box as shown below. Select the technician
name from the list and click the icon to select the technician else click cancel icon.

5. Now select the NONE option and click Assign. The request will be unassigned. If you do not
wish to unassign the technician then you can just close the pop-up by clicking Cancel.
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Start / Stop Request Timer
If a technician is unable to close a request then, it could be for many reasons such as, lack of
necessary information or and so on. If the technician is unable to continue the work then he/she can
move the request to on hold status.
If this is not done, then the request will remain in open state idly which will lead to the violation of SLA
that governs the request. Also, it will show that the time taken to close the request was high and will
reflect on the efficiency of the technician (s) handling the request. To avoid all these, move the
request to on hold state till the time you are ready to resume work on the same.
Alternatively, you can stop the timer when you are not working on the request.

Stop Timer
To stop the request timer,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request in the Requests list page.
4. Click the Stop Timer under Actions combo box. A pop-up window opens requesting you for
the reason for stopping the timer.
5. Enter the relevant reason to stop timer in the text area provided for the same.
6. Click Add.
The status of the request will be changed to On hold and the reason gets appended to the request
history.

Start Timer
To restart the request timer,
1. In the request details page, click Start Timer link under Actions combo box. A pop-up window
opens requesting you for the reason for starting the timer.
2. Enter the relevant reason to stop timer in the text area provided for the same.
3. Click Add.
The status of the request will be changed to Open and the reason gets appended to the request
history.

Note: You can stop and start timer for requests that are not overdue.
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Adding Notes
When you would like to add some additional information including technical information to a particular
request based on your observations, you can use Add Notes. You can also use notes to update the
status of the request.
To add a note to a request,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request to which you would like to add a note.
4. Click the Actions menu -> Select Add Notes option. This opens Add Note page as shown
below,

5. Enter your content in the text box below the Request ID.
6. There are two types of notes that can be added to the request such as, public & private.
Public Notes: Public notes can be viewed by the requesters & technicians.
Private Notes: Private notes can be viewed only by the technicians (all the technicians).
These notes can be added to the request by both the technician and the requester. By default
the requester can add only public notes.
By default the technician can add only a private note but the technician also has an option to
make his notes public.
If you want the notes to be visible to the requesters (public), then select the Show this notes
to Requester also check box. Else only the technicians will be able to view the notes (private).
7. If you want to notify the technician about the addition of the note, then select the check box,
E-mail the technician for notes addition.
8. Click the Add Note button. The note is added at the bottom of the request along with a date
and time stamp. The name of the person who added the note is also displayed.
You can add any number of notes to a request. The added notes will be displayed in the descending
order with recently added note first. You can also edit or delete the notes that have been added.
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Tasks
Sometimes, a request might involve multiple technician work. In that case, the request can be divided
into several tasks and each task can be assigned to a technician/group.
For example, consider a scenario where a new employee joins the organization. There is a list of
tasks that need to be performed such as seating location, providing a computer/laptop, installing
necessary software, connecting telephone links, entering his/her name in the active entry and so on.
These operations can be considered as separate tasks and be can assigned to different technicians.

Adding tasks:
To add tasks,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request to which you would like to add tasks.
4. Click the Actions menu -> select Add Tasks option. This opens the Tasks window.
5. Select the Task Template from Select Template drop down menu.
6. Specify the Title of the task in the given text field. This is a mandatory field.
7. Specify relevant information about the tasks in the Description field.
8. Select the Scheduled Start Time for the task based on the SLA from the calendar button.
Also select the Scheduled End Time for the task from the calendar button.
9. The Actual Start Time and Actual End Time of the task can be selected later by the
technician who works on the task..
10. Select the Group to which task has to be assigned. Select the Technician of the task from
the combo box. Tasks can be assigned either:
•

to a Group alone,

•

to a Group and a specific Technician in the group,

•

to a Technician alone without selecting the group,

•

to no Group and no Technician.

11. In some cases, the implementation of one task depends on the completion of one or more
other tasks. Dependencies on tasks can be captured by clicking on the relevant tasks in the
Depends on Task List. In the snapshot below, Task "Setting up user computer" doesn't
depend on any other task so the Depends on Task List is not checked. However, the task
"Installing softwares" depends on the current task "Setting up user computer". It is therefore
marked in the Dependents List.
For example, the same scenario where a new employee joins the organization. The list of tasks
that need to be performed such as seating location, providing a computer/laptop, installing
necessary software, connecting telephone links, entering his/her name in the active entry and
so on. Some of these tasks are dependent on the other, like installing necessary software can
happen only after providing computer/laptop.
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12. Specify the Status of the task.
13. Specify any relevant comment about the task in the Comments field.
14. If you wish to be reminded of the task previously then select the time duration from the
Remind me before combo box.
15. Save the values. You can see a Tasks tab getting created next to the Resolution tab. All the
tasks created for the request will be listed under the tasks tab in descending order. The tasks
assigned to other technicians can be viewed in their Task summary list in the home page.
16. When a task is completed, email notification will be sent to group/technician of the next
dependent task to alert them about the completion of the previous task.

Editing tasks:
Task editing consists of capturing dependencies among tasks, and appending/removing/changing
other task parameters.
To edit tasks,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request under which the task to be edited is present.
4. Click on Tasks tab. This will show the list of tasks for the particular request.
5. Click on the task that you need to edit. The task configuration window opens.
6. Edit the necessary task parameters.
7. Save the parameters.
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Organizing tasks:
In specific cases, certain tasks have to be completed in a hierarchical order either depending on
priority or on dependency. This can be done by the administrator after the creation of the tasks.
To organize tasks,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request under which the task to be organized is present.
4. Click on Tasks tab. This will show the list of tasks for the particular request.
5. Click on Organize Tasks. This opens the Organize Tasks window with the list of tasks.
6. In the Organize Tasks window, click on the task that has to be moved. Re-organize the task
by clicking on the Up or Down Arrow buttons and change the order of the tasks in the list.
7. Re-ordering tasks will remove all dependencies associated with that task.

Deleting tasks:
To delete tasks,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request under which the task to be deleted is present.
4. Click on Tasks tab. This will show the list of tasks for the particular request.
5. Click on the check boxes next to the tasks that need to be deleted.
6. Click on Delete.
7. Deleting a task will also delete all the dependencies associated with the task.
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Merging a Request
When two or more requests are related to each other and are from the same requester, and can be
handled by the same technician, you can merge these requests as one and assign a single technician
for that request.
To merge one or more requests
1. Login to the ServiceDesk Plus - MSP application with the user name and password of the
administrator or technician. This opens the request list view page.
2. From the request list view page select the requests to be merged by enabling the check box.
Click Merge button to merge the requests. All the merged requests appear as a single
request. (Or)
3. Click the Title of the request that you wish to merge in the request list view page.
4. Click Actions link -> Click Merge Request option. This opens Merge this Request form as
shown below,

5. You can search for specific request by providing a search string in the field provided above.
6. To confirm if the request that you want to merge is the correct one, you can view the request
by clicking the title of the request.
7. Click the Merge Request icon

to merge the two requests. A dialog box pops up asking

for your confirmation to merge requests.
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8. Click OK to merge request. All the merged requests will be displayed in the Conversations
block of the view list page. And if you have attached notes, conversations and time-spent
entry for the requests all the said information will be moved to the parent request.
9. Else if you wish to cancel merging click Cancel in both the dialogs to exit the Merge Request
form.
You can split a thread of a request into a new request. For more information on this, kindly refer to the
section Request Conversations.
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Link Requests
Linking Requests is a feature that primarily provides an option to relate requests to one another and
set some references between them. Secondly, certain common operations such as adding notes,
creating resolutions and adding work logs can also be linked between them.
When two or more requests are linked, one of the requests becomes the "Reference request" and the
other requests are the "Linked requests".

Link requests from the Request List View page
To link two or more requests from the Request List view page,
1. Click Requests tab in the header pane.
2. From the Request List View page, select the requests that need to be linked by enabling the
check boxes.
3. Click Actions drop-down menu -> Link Requests option.

Here, among the selected requests, the oldest created request becomes the
"Reference request" and the other requests become the "Linked requests".
In the above example, the oldest request (Request ID 25) is the Reference request while the other
requests later created (Request ID 26, 27 and 28) become its Linked requests.

Link requests from the Request Details page
To link two or more requests from the Request details page,
1. Click the Subject link of the request you want to link. This opens the Request Details page.
2. In the request details page, click Actions drop-down menu and select the Link Requests
option. This opens a pop-up window with a list of requests.
3. Select the requests that need to be linked by enabling the check boxes.
4. Click the Link Requests button to link the requests.
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In this case, the request through which the linking is done becomes the "Reference
request" and other requests are its "Linked requests". This option is useful when you
want to choose a specific request as the Reference request instead of the oldest created
request. A relatively new request can be made as Reference request with older requests
related to it as Linked requests.
In the above example, linking is done through the details page of Request ID 27 and so it is
made as the Reference request. Other older and newer requests (18, 25 and 28) linked to it are
its Linked requests.
Note: Linking requests is different from "Tasks" that are created within requests. Tasks are
created in a request so that the request can be split into various activities and can be assigned
to different technicians. All the tasks inside a request will be considered as a single request.
However, Reference requests and the Linked requests are independent requests with only
references set between them.

Attributes of Reference Request and Linked Requests:
1. Any Linked request can be associated with only one Reference request at any time.
2. Even though Linked requests are linked to a Reference request, they will still be considered
as independent requests with their own SLA, Business Rules, and so on.
3. If a Reference request (A) is made as the Linked request of a new Reference request (B),
then all the Linked requests earlier associated to Reference request A will be linked the new
Reference request B.
4. Linked requests have their own independent work logs, resolutions and notes. Operations
performed over the Linked requests have no impact over the Reference request. However,
any work log, resolution or note added to the Reference request can be linked to all the
Linked requests by enabling corresponding check boxes.
5. Notes added to a Reference request can be made available to the Linked requests by
enabling the Add notes to all linked requests check box. The Discussions Notes section
in the Linked request details page will show its own notes and the notes that have been linked
from the Reference request. Editing notes in the Reference request has no impact on the
notes that have been earlier linked to the Linked requests.
6. Similarly, work logs added to a Reference request can be made available to the Linked
requests by enabling the Add work log to all linked requests check box. When work log
from a Reference request is added to the Linked requests, the Time Elapsed section in the
Linked request details page will show sum of time elapsed and sum of charges for the Linked
request and the Reference request. However, any changes made to the work log in the
Reference request will not change the work logs that were earlier linked to the Linked
requests.
7. If a resolution written for a Reference request is linked to the Linked requests, then it
overwrites any resolutions earlier added to the Linked requests. Editing resolutions for a
Reference request will change the same in the Linked requests. All resolutions written for a
particular Linked request can be viewed under the History tab of that Linked request. The
Click here link opens a pop-up with all resolutions associated with that request. Also,
Change Status to option applies only to the Reference request and does not have any
impact on Linked requests upon linking.

Zoho Corporation Pvt. Ltd.
92

ManageEngine ServiceDesk Plus MSP – Admin Guide

8. While viewing a request's details page, indications are shown if there are any requests linked
to the current request. By clicking on this indication, a description box opens and by clicking
on the Request ID of the linked requests, one can navigate to the requests linked to the
current request. Options to remove links between requests are also provided here.

9. Links between requests can be added, modified and also removed. Each of these operations
will be recorded in the request History.
10. Links can be created between requests belonging to different request templates and even
different sites. But, if the technician who has permissions in the site where the Base request is
present does not have permission in the sites where the Linked requests are present, then
the technician will not be able to perform operations on those Linked requests.
11. Closing and re-opening of requests is independent to both Reference and Linked requests.
12. Requests cannot be linked through API or E-Mail Command features.
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Copying a Request
When a single request has multiple issues in it that requires more than a single technician to handle
them, then the request can be duplicated and each of the duplicated requests can have only one
issue. This makes it easier for the technician to take ownership and complete the task independently.
To make multiple copies of the request,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request that you want to duplicate in the view list page. This
opens the Request details page.
4. Click Duplicate Request option under Actions combo box. A Duplicate Request pop-up
window opens, requesting you to give the number of copies.

5. Enter the number of copies in the text field provided beside the Number of Copies label. The
maximum value you can enter is 9. If you need more than 9 copies of the request, then you
need to invoke Copy Request again.
6. Click Copy to make the copies of the request. The new copies of the request will be assigned
new request ID that will uniquely identify them. The rest of the information such as the request
details and description remains as it is.
Once you have created the copies of the request, you can edit the same to contain only the necessary
information and assign appropriate technicians. You can modify the request copies by editing the
copy of the request.
While copying the request, the Notes, Tasks, Reminders, Resolution and Approval status of the
original request (if any) will not be present in the duplicated requests. Also, the Created Date and
Due by Date will be different from that of the original request.
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Deleting Requests
You may receive lots of mails of which some may not qualify as requests at all and hence need to be
removed from the ServiceDesk Plus - MSP application completely. In such cases, you can delete
those individual requests in the view request page or select a group of requests in the list view page
and delete them together.
To delete individual requests,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request that you want to delete. This opens the request details
page.
4. Click Actions combo box -> Delete option. A confirmation dialog pops up.
5. Click OK to proceed deleting. The notes, work logs and conversations ( if any ) added to the
request gets deleted. Click Cancel to abort deletion.
To delete more than one request at a time
1. In the requests list view page, select the check boxes beside the request that you wish to
delete.
2. Click the Delete button. A confirmation dialog pops up.
3. Click OK to proceed deleting. Click Cancel to abort deletion.
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Add/Associate Change to Requests
You have an option to add, associate, view and detach change to requests. Similar change occurred
to Incidents ( requests ) can be associated in order to track the change occurred for the same request.
You can also add new change or detach the existing change to a request. While
adding/associating/detaching a change the approval status of the request does not change.

•
•
•
•

Associating Change to request
Add Change to request
Viewing Associated Change
Detach Request from Change

Associate Change to Requests
You can also associate the existing change to the request. To associate change,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request for which you want to add a change. This opens the
request details page.
4. Click the Actions combo box on the top right side of the page. Click Search Changes option.
This opens Associate Change to Incident page as shown below,
5. Select the type of change to be displayed by selecting from the Filter Showing combo box on
the top left hand side of the page. Ex: Open Change or All Change and so on. On selecting
the change type the corresponding changes gets listed.
6. Select any one change to be associated with the request by enabling the radio button beside
the title of the change.
7. Click Associate button to associate respective change to the request (particular selected
request). You can associate the same change to different requests.
Once the problem is associated to the request, the View Change and Detach from Change
option appears under Actions combo box.

Add Change to requests
You can add new change to requests. To add new change,
1. From the request list view page, click on the subject link of the request you wish to add
change. This opens the request details page.
2. Click New Change button on the right hand side of the description field. This opens the New
Change form. (OR)
Alternatively, you add a new change from the Associate Change to Incident pop up page.
Click New Change button below the filter showing combo box.
3. The details such as Status, Impact, Urgency, Priority, Category, Sub category, Item along
with Subject and Description remains the same as of the request. If required, you can modify
the same on selecting from the combo box.
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.This
4. Select the Reported By requester from the list by clicking on the Requester icon
opens the requester list page and click the requester title.
5. Select the Technician from the combo box.
6. Select the Schedule Start Time and the Schedule End Time from the calender button.
.This opens the
7. Select the affected IT Services from the list by clicking on the icon
Services Affected pop up box. Select the affected IT services and Save the changes.
.This opens the Select
8. Select the Assets Involved with the problem by clicking the icon
Assets page. Select the Type of Assets or the category of assets to be involved from the
combo box. Ex: Workstations, Routers, Switches and so on. Select the Available Assets
under the selected type from the list and move to Assets involved using >> button. And
Save the changes.
9. If you have any file attachments for the problem click the Attach File button and attach files.
Note: Maximum size of an attachment can be 10MB.
10. Click Save. A new change gets added in the change list view page.

View Associated Change
You have an option to view the newly added change or the change associated to the request.
To view the change,
1. From the request list view page, click on the request for which you wish to view the change.
This opens the request details page.
2. Click View Change button on the right hand side of the request description. (OR)
Click Actions combo box -> View Change option. This displays the Problems Details page of
the change added/associated to the request.

Detach Request from change
If you want to add another change to the request then the existing change has to be detached.
To detach a change,
1. From the request list view page, click the request you wish to detach the change. This open
the request details page.
2. Click Actions combo box -> Detach from Change option. The request is detached from the
change.
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Convert Incident to Service Request
The incident request can be converted to a service request. On converting the incident request, you
will have the option to select Service Category and Service Template to be applied to the request.
To convert incident to service,
1.
2.
3.
4.

Log in to the ServiceDesk Plus - MSP application using your user name and password.
Click the Request tab in the header pane.
Click the Title of the request to which you would like to convert as service request.
Click the Actions menu -> Select Convert Incident to Service option. This opens Convert
Incident to Service dialog as shown below,

5. Select Service Category from the drop down.
6. Select Service Template from the drop down to be applied to the request.
7. If you wish to Overwrite the incident field values with the template values then select the
corresponding option by enabling the check box.
8. If you would like to Create the tasks present in the Service Template then select the
corresponding option by enabling the check box.
9. Click Convert button. This displays the message stating that the Incident has been modified
to Service Request.

NOTE
1. The incident associated to problem will be removed during the
conversion.
2. The approvals made for the incident will also be removed.
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Printing the Request
To print a request
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request that you want to print.
4. Click Actions drop down list -> Print Preview option. The print preview of the request opens
in a pop-up window.
5. By default, all the check box is enable under Select the required information block. To
customize the print preview, disable the check box of the information that is not required. The
disabled information disappears from the print preview.
6. Click the Print menu item from the browser File menu.
7. The default printer associated with your workstation is invoked. Set the required options and
click OK. You can collect the printed copy of the request at the printer that is linked to your
workstation.
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Adding a Resolution
You can add resolutions for the issues reported in the requests.
To add a new resolution,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Requests tab in the header pane. This opens the request list view page.
3. Click the request Title for which you want to add the resolution.
4. Check if a resolution already exists for the request by clicking the Resolution tab in the
Request details page.
5. If no resolution is available for the request, then the plain html text page is displayed. Specify
the resolution in the text field.
6. On specifying the resolution the status can be changed by selecting the status from the
combo box.
7. You can also add Time Spent Entry details for the request in this page.
8. Save the resolution. You can see the resolution is displayed in this page.
9. If you wish to add the specified resolution to the solutions database, then click Save and Add
to Solutions, or else click Save.
10. On selecting Save and Add to Solutions, you get a New Solution form. The title of the
solution is automatically filled with the title of the request. The Contents is filled with the
resolution. If you wish you can edit the contents.
11. Select the Account(s) for which the solution should be available.
12. From the Topic drop-down list which contains all the available topics, select the relevant
parent topic for the solution.
13. Enter relevant keywords for the solution in the Keywords text box. Separate each keyword by
a comma. This option is provided for the users to improve the search capability and get
appropriate solution for the problem.
14. If needed you can also attach files to the solution.
15. Click Add. This also adds the resolution to the list of solutions.
These added resolutions can be used for various purposes. One of them is to add these resolutions
as knowledge base articles which can be used for future reference to solve the same issue if reported.
The resolution of the request also helps other technicians to know the kind of solution provided to the
reported issue. This serves as a documented proof of the way a reported issues was resolved.
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Searching Solutions
From the request, you can search for solutions that might help you solve the issue described in the
request.
To search for solutions,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Requests tab in the header pane. This opens the request list view page.
3. Click the request Title for which you need to look up the solution.
4. In the View Request page, click the Resolution tab.
5. Click Search Solution link. Alternatively, you can also click the Search Solutions option
under Actions combo box in the task block.
6. In the Search Solutions page, provide a search string in the Search field and click Search or
press Enter. The solutions that match the search string are displayed.

Note:
The solution(s) which belongs to the logged in user associated accounts alone would
be displayed.
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Submit For Approval
You can submit the request for approval to the manager using this option. To submit for approval,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Title of a request which you want to submit for approval. This opens View Request
page.
4. Click the Actions tab -> select Submit For Approval option. Submit For Approval page pops
up.
5. Specify the To address. This is a mandatory field.
6. Edit the Subject and specify relevant subject in the given field. This is a mandatory field.
7. Specify the relevant Description in the given text field. $ApprovalLink is a variable. It should
be available with the mail to replace the variable with the link where you have the request
details.
8. And send the mail for approval.

The manager gets the Request for approval mail with the link. On clicking the link it opens a form with
approve or reject option & request details as shown below,
The manager has to approve or reject the request based on the requirement. And save the details. On
Saving the decision you get a thank you message.
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A notification mail will be sent to you along with the request id, approval status for request and
comments. This is fundamental as you need not revisit the request at periodic intervals to check the
approval status.
In the Request Details page, the Approvals tab getting displayed next to History tab. It displays all
the mails sent for approval in descending order with Sent On, Sent To & Status details of the
requests.
Once the request is approved by the manager the status of the request changes to Approved. If
rejected by the manager the status of the request changes to Denied as shown below,
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Viewing Requester Details
When attending to a request, you may want to contact the requester to get additional information. To
view the requester's contact details,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Title of a request. This opens the View Request page.
4. Click on the requester name link just below the request tab as shown below,

Requester Details pops up where you can view details, such as name, designation,
employee ID, department to which the requester belongs, e-mail ID, and phone and mobile
numbers. Any additional fields configured will be able to view in the requester details page.
Alternatively, you can also click the View Requester Details option available under Actions
combo box in the task block.

5. Once you have finished viewing the details, click the Close link available at the top right
corner of the pop-up.
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E-mail the Requester
Sending a response to the requester is required when a new request is received. Also, when a
technician is ready to close a request, the same can be notified to the requester so that if the
requester has any concerns about the same, he/she can raise. The technician can then address the
same and close the request after the requester is completely satisfied with the way his/her request
has been attended to.
To respond to the requester
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request in the requests list page.
4. In the View Request page, click Reply button just below the Request Description or the
Reply the Requester link on the right-side Tasks block, under Notify. This opens the Mail to
the Requester form.

5. Edit the Subject and Description of the e-mail.
6. Click Attach a File button to add files as attachments to the mail
7. Click Send. An e-mail is sent to the requester. If you want to send the same information to
more than one person, then enter the e-mail IDs of those people in the To or CC field with
comma as a separator.
The responses that have been sent to the requester can be viewed as conversations in the request
details view.
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By default, the email editor will be in HTML format. If you do not want the mail in HTML format, then
select the radio button Plain Text. A confirmation dialog will open. Click OK to continue changing the
editor to plain text.

Note: While editing the subject of the e-mail, ensure that the request ID value remains intact
with the # symbols beside it. Else, the threading of requests may not be proper.
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Forward the Request
To forward a request,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Title of the request in the requests list page.
4. In the View Request page, click Forward button just below the Request Description.
Alternatively, you can click Forward the Request option under Reply combo box. This opens
the Forward Request form.

5. Enter the e-mail ID of the person to whom you wish to forward the request in the To field. You
can also mark a copy of the forward to others. To do this, enter their e-mail IDs in the CC
field.
6. Edit the Subject and Description of the e-mail.
7. Click Attach a File button to add files as attachments to the mail
8. Click Send. The request is sent to all those whose e-mail ID is mentioned in the To and CC
field. The forwarded requests will be shown in the conversation block.
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E-mail the Technician
To e-mail a technician
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request from the requests list page.
4. In the View Request page, on the right-side Tasks block, under Notify, click E-mail the
Technician. This opens the Mail to Technician form.

5. Enter the E-mail ID in the To field. This is a mandatory field.
6. Edit the Subject and Description of the e-mail.
7. Click Attach a File button to add files as attachments to the mail. All the newly attached files
will be listed in the Newly attached files field.
8. Click Send. An e-mail is sent to the technician. To send the information to more people, enter
their e-mail IDs in the To field or CC separated by comma.
9. You also have an option to Save the mail as draft copy for later use.
10. If you wish to send the drafted mail for review to the higher authority then click Send for
review button.
A technician can be notified when a new request is assigned or an already existing request is
reassigned to him/her.
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SMS the Technician
ManageEngine ServiceDesk Plus - MSP enables you to notify a technician through SMS also. This
option is available only to technician assigned requests.
To send an SMS to a technician
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Requests tab in the header pane.
3. Click the request Title which is assigned to the technician whom you wish to notify through an
SMS.
4. In the View Request page, on the right side under Reply, click SMS the Technician. The
Mail to Technician window opens with the To address displayed as <mobile
number>@<service provider>.com. You can configure the service provider details in the
admin configurations.
5. You can add your message to this or edit the description to contain only those information
that you wish to send.
6. Click Send. A message is displayed in the window, stating that the SMS is sent.
7. Click Close. This closes the notification window.
The SMS notification is also available under the Notifications tab of the request. You can view the
contents of the notification by clicking the View Details link beside the notification information.
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Request Conversations
ServiceDesk Plus - MSP displays the mail transactions happening between the technician handling a
request and the requester, as conversations. At times, the technicians can converse with other
technicians regarding the request which also gets listed in the conversation block. The conversations
are listed one below the other in the ascending order of the time when the notification (response) was
sent (received). You can choose to view either All conversation or Requester conversations.

To view all the conversation details, click the View All Conversation link at the top of this block. This
shows all the conversation between the technician and the requester and between the technicians. If
the conversation has any attachments, then the attachment icon can be viewed in this block. To view
only the requester conversation, click View Requester Conversation link.

Split As New Request
You can choose to split the requesters conversations into a new request. To split the conversation as
a new request,
1. Expand the conversations by clicking on the View All Conversation link or by clicking the
button on the left of the row which you wish to expand.
2. Click Split as New request button at the right bottom of that conversation.
This splits the conversation into a new request.

Delete Conversation
You can delete a specific requesters conversation. To delete a conversation,
1. Expand the conversations by clicking on the Expand all link or by clicking the > button on the
left of the row which you wish to expand.
2. Click Delete button at the right bottom of that conversation. A confirmation pop-up opens.
3. Click OK in the confirmation pop-up to delete the thread/conversation.
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Viewing Requests Based on Filters
ManageEngine ServiceDesk Plus - MSP allows you to view the list of requests and also set a time
period for auto refreshing the request list view page.

Auto Refresh of RequestList page
To auto refresh the list view page
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Requests tab in the header pane. In the Requests list page, just below the header
links, top right corner, you will see an editable field, Refresh this page. By default, the value
is set to Never.
3. Click the edit icon

beside the value Never.

4. From the drop down list select the frequency of refreshing the page.
5. Click Set.
You can also apply various filters to this list and view only a specific group of requests that you would
like to view. This filtering helps you focus on just the requests that you wish to look at.
To view the whole list of requests available in the ServiceDesk Plus - MSP application, click the
Request tab in the header pane. This lists all the open requests available in the ServiceDesk Plus MSP application. You can set the number of requests that you would like to view in a single page:
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Requests tab in the header pane.
3. In the Requests list page, click the drop-down box (shown in the figure below):

4. From the drop-down list, select the number of records that should be displayed in a single
page.
You have three different filter categories to view the specific set of requests. The filter categories are,
My Group, Requests & My Views. To view the requests listed under these specified filter categories,
1) Click the Requests tab in the header pane. This opens the Requests list page.
2) Select the Filter Showing combo box. You can see the list of all filters. Select the filter from the list
based on your priority.

My Group
All your incoming requests can be grouped under different groups based on the classification set by
the help desk team. The groups are created using the groups option in the admin tab. The requests
which matches the group criteria will be listed under the particular group option as shown below,
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Requests
All the incoming requests will be classified under different titles. These request titles are listed under
the Requests option. On selecting the specific title of the request, corresponding set of requests gets
listed.

Note:
The requesters are populated based on the logged in technicians associated
sites/accounts.

My Open Or Unassigned Requests
All your open requests & the requests that are not assigned to any technicians will be listed
under this option.

Zoho Corporation Pvt. Ltd.
112

ManageEngine ServiceDesk Plus MSP – Admin Guide

Unassigned Requests
All the requests that have not been assigned to any technician will be listed under this
option.

Unassigned Due Requests
All the requests that have not been assigned to any technician and which have passed due
by time will be listed under this option.

My Open Requests
When you click the requests tab, this filter is selected by default and lists all the request that
are assigned to you in the open status.
In addition to this if you have any requests placed in Groups, then you will also have option
to filter the requests based on a specific Group alone. You can also perform a column sort of
the requests.

My Requests On Hold
All your assigned requests that are kept on hold will be listed under this option.

My Overdue Requests
All your assigned requests that have crossed the scheduled time will be listed under this
option.

My Pending Requests
All your assigned unfinished requests are listed under this option.

My Requests Due Today
All your assigned requests that are due for the current day will be listed under this option.

My Completed Requests
All your assigned requests that are closed will be listed under this option.

Open Requests
All the open requests irrelevant of the technician will be listed under this option.

Requests On Hold
All the requests that are kept on hold irrelevant of the technician will be listed under this
option.
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Overdue Requests
All the requests that have passed due by time irrelevant of the technician will be listed under
this option.

Requests Due Today
All the requests that are due for the day irrelevant of the technician will be listed under this
option.

Pending Requests
All the unfinished requests irrelevant of the technician will be listed under this option.

Completed Requests
All the closed requests irrelevant of the technician will be listed under this option.

All Requests
All requests on all status say (closed, pending, open) will be listed under this option.

My Hardware View
All the requests that are assigned to you and has hardware issues will be listed under this
option.

My View
All your customized views gets listed under the my view list.
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Sorting Requests by Column
To sort request by column, click the column header. Clicking it once will sort it in ascending order.
Clicking twice will sort the column in descending order.
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Customizing Request List View
ManageEngine ServiceDesk Plus - MSP allows you to customize the request list view to include
columns of your choice.

Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.
To customize the list view
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Requests tab in the header pane.
3. Click the column edit icon available at the corner of the request list headers. This opens the
available columns that can be displayed in the list view. All those that are visible currently, will
have the check box beside them selected.

4. To remove a column, remove the selection from the respective check box beside the column
name.
5. To add a column to the list view, select the unchecked select box beside the column name.
6. To change the column order, click the up and down arrow after selecting the column that you
wish to move.
7. Click Save.
This will add only those columns which you have chosen in the list view.
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Searching Requests
ManageEngine ServiceDesk Plus - MSP gives you an option to search for requests using a keyword
search. All requests that match the keyword that you have provided in the search will be displayed.
To do a keyword search in requests
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. On the left hand side web client, there is a Search block as shown in the figure below:

In Search in drop-down box, select Requests. In the home page and the
requests module, this is selected by default.
3. In the Enter Keyword text field, type the search string that you wish search for in the
requests.
4. Click Go or press the Enter key on your keyboard. All the requests that match the search
string are listed.
You can also do a column-wise search of the requests. To perform a column-wise search
1. Click the search icon at the end of the request list view headers. This opens the search field
just below every column that is visible in the list view.
2. Enter the search key in field under the column of your choice.
3. Click Go. The search results matching the search string(s) are displayed.
Note:
The requests are populated based on the logged in users associated sites/accounts.
The search would return the results for any of the text fields of the request. You will not be able
to search for a request based on any of the date fields of the request.
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Multi site on Requests
An Account can have branches spread across different regions and sites of the globe to handle
various specialized activities. In this globally distributed environment, a request can be raised from
any site of the account. The request is resolved based on the admin configurations (operational hours,
holidays, SLA and business rules) of the site from which the request was raised. Hence with site base
configuration, the request module experiences an immense change.

Key entities in Request module
Creating Requests
•

The admin configurations of the selected site in the new request form will get applied
to the request.

•

The Groups and Technicians corresponding to the selected site will be listed. Groups
acts as a filter in choosing the technician to resolve the request.

•

A request template with the group and technician pre filled with values needs to be
re-selected on choosing the requester, if the group/technician is not associated to the
requester's site.

Editing Requests
If a request needs to be changed to another site, then on selecting the site, the SLAs
and business rules for the site will be applied and the due by time recalculated
accordingly.

Viewing Requests
Technicians can view all the requests of a site if,
•

the technician is associated to the site and have the viewing permission as
'All' in Configuring Roles.

•

the technician is associated to the site with the viewing permission as 'All in
associated accounts'.

•

the technician is associated to the site with the viewing permission as 'All in
associated sites'.
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Assigning Technicians
ServiceDesk Plus - MSP provides you with an option to bulk assign requests to
technicians. The request can be assigned to the technician if,
•

The technician is associated to the site where the problem persist.

•

The technician has the permission to view the requests in all sites. This can
be done in Configuring Roles.
If the technician is not associated to the site where the problem persist and if
the technician has restricted view permissions then an error message occurs
while assigning the request to the technician as shown below,

Scenario : Roles on Requests
A requester from London raises a demo related request persisting in Sydney through self service
portal of the ServiceDesk Plus - MSP application. By default, the admin configurations for London will
be applied to the request. The request is handled by John, a technician in London. John can view and
re-assign the request,
•

If John is only associated to London with the viewing permissions as 'All', then he will be able
to view the requests in all the sites across accounts.

•

If John is associated with the viewing permissions as 'All in associated accounts', then he
will be able to view all the requests raised in sites that belong to his associated Accounts. He
will not have the privilege to re-assign the request to technicians in other sites.

•

If John is only associated to London with the viewing permissions as 'All in associated
sites', then he will be able to view all the requests raised in London. He will not have the
privilege to re-assign the request to technicians in other sites.

•

If John is associated to London and Sydney with the viewing permissions as 'All in associated
sites', then he will be able to view all the requests raised in London and Sydney.

On assigning the request to Amy, the technician in Sydney, the SLAs and business rules configurated
for Sydney will be applied to the request and the due by time re-calculated. If Amy is assigned to a
Group say, Support, then she can view and re-assign the request,
•

If Amy is associated to Sydney along with the viewing permissions as 'All in Group and
assigned to him', then she will be able to view all the requests raised in the groups to which
she is assigned.

•

If Amy is associated to Sydney and London with the viewing permission 'All his requests',
then she will be able to view only the requests assigned to her. She will be able to re-assign
the requests to other technicians in London and Sydney but will not be able to view the
request as it does not fall under their permitted scope.
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Importing Requests from XLS file
ManageEngine ServiceDesk Plus - MSP provides an easy-to-use XLS import option to import bulk
requests from your existing application or even from other applications. The total size of the XLS file
that you are importing should not exceed 20 MB.

To import requests from XLS file,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click Import Requests button to import requests from XLS. This opens the Requests Import
Wizard.

Step 1: Upload XLS file
1. Click on Choose File button to select the XLS file.
2. On choosing the XLS file from the File Upload window, click Open. The name of the file
appears automatically beside the Choose File button.

3. Click Next button.
NOTE: A sample XLS file can be downloaded by clicking on the click here link.

Step 2: Map fields
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In this step you can map the SDP MSP fields with the corresponding XLS fields to make sure the
request values are transferred properly. The field names of the XLS file are populated in the drop
down boxes beside the each field label in SDP MSP.
To map fields,
1. Select the XLS Sheet No. from the drop down. The total row count of the selected sheet will
be displayed beside the Data count field. If the selected sheet contains no rows, then an alert
message will be displayed.
2. Map the application request fields with the field names from (selected sheet) the XLS file. Any
additional fields added for the request will also be displayed.

3. The date and time format available in the Date Fields is alone supported in the XLS file.
4. Click Next button to go the next page. Click Previous button to go back to Step 1.
Note: 1. There are some system-defined mandatory fields that need to be mapped before
import. For example, Subject, Requester Name, Account and Site. Importing request is not
possible if these system-defined mandatory fields are not mapped.
2. The default request template will be applied to the imported requests.
5. On clicking the Next button, a warning message will be displayed stating to disable
Notification Rules and Request Closure Rules before importing request.
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6. Click Proceed button to import request.

Step 3: Import Status
This section appears whenever a new field value is available for the mapped field in the XLS file. For
example, if a new priority 'Urgent' is available in the XLS file, then the field name 'Priority' with the new
value 'Urgent' will be displayed in this section. To get the new values imported, you will have to add
the new values under Admin module prior to the import. You can also skip adding the new values by
selecting Import without adding the above field values check box. Click Import button. The
requests are imported from the XLS file.
NOTE: Requests cannot be imported unless you add the new values or skip adding the new values.

Import Summary
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On completion of the import, the total records on the selected sheet, the number of records imported
and the number of records failed to import are displayed under this section. A list of failed records and
the reason for failure are represented in the form of a link. You can click the ‘Failed XLS File’ to view
the list of failed requests. To view the reasons for import failure, click ‘Failed Records’ link.
The possible reasons for request import failure are as follows:
•
•

The mandatory fields such as Subject and Contact Name could be empty in the XLS file.
Closed/Resolved request date could be earlier than the Request Created date.

Click Finish button to view the imported requests in the Request List view.

Warning: If there are any failure records while importing the requests from XLS, do not re-import the
same XLS file. Instead, download the failedRequestsList.xls by clicking on the Failed XLS File link
available in the Import Summary page, correct the errors and then import to avoid duplicate requests.
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Mobile Client
ManageEngine ServiceDesk Plus - MSP mobile client improves the efficiency and productivity of your
helpdesk system by providing technicians with the ability to instantly access their tickets while they
are away from their desk through their mobile devices. It is a complete browser based web application
supporting various request features like viewing tickets, adding a new ticket, closing resolved tickets,
assigning tickets, adding work Log, adding resolution and deleting a ticket.
ServiceDesk MSP Mobile Client is compatible with mobile devices such as Blackberry and iPhone,
and is accessed through the mobile browser on typing the url http://<machine-name>:<port-number>,
which redirects to the 'mc' context.
Features
•

A browser based web application to access tickets from any location.

•

Supports request module features such as, creating new request, viewing request details,
adding resolution to a request, adding worklog, assigning technician to a request, closing
completed requests and deleting requests.

•

Any actions performed on the requests are based on the Roles assigned to the technicians.

Limitations
•

Currently, ServiceDesk Plus - MSP Mobile Client supports only request module.

•

Editing/Modifying requests cannot be performed.

•

Only Technicians can access ServiceDesk Plus - MSP mobile client through their hand-held
devices.

•

Compatible with mobile devices such as Blackberry and iPhone.

Getting Started
On connecting your mobile device to http://<machine-name>:<port-number>, the screen opens to
displays the login page.
•

Username: Username of the technician for the logged server.

•

Password: Password of the technician for the logged server.

•

For Domain: Choose the domain of the logged in technician. If the domain is not selected
then it is considered as 'Not in any domain'.

•

Is AD Auth: Select the check box for AD authentication.

Click Login button.

Note: ServiceDesk Plus - MSP Mobile Client does not support Single Sign-On (SSO).
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On logging into the application from your mobile device, the home page displays the Dashboard,
Requests and Logout options.

•

Dashboard displays the number of Overdue Requests, Requests Due Today and Pending
Requests of the logged in technician.
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•

•

Requests displays the request list view with options to select, My Pending requests, All
Pending requests and All Requests.
Log out: to log out from the mobile client.

Dashboard
The dashboard of the logged in technician comprises of the number of all overdue requests, requests
due to be completed today and the pending requests. Click on a section to display the list of request
under it.

Note: If there are no requests under any section say, there are no pending requests for the logged in
technician, then the link to view the pending requests is not available.
To revert back to the Home page click on Home > link or the home icon
the page.

on the top right corner of

Requests
Selecting Requests from the dashboard takes you to 'My Pending' requests by default. The requests
view options comprises of My Pending Requests, All Pending Requests and All Requests.
Note: The request list view and the actions performed on the requests is based on the roles
assigned to the logged in technician.
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Request List View

Request List View displays the title of the request, requester, status of the request, created date and
time, technician assign icon, priority color code, first response time overdue flag, request overdue flag,
and first response and resolution overdue flag.
•

Search - Search for requests on entering the Request ID in the Search text field.

•

New - Create new requests instantly and with ease.

•

Pick - Pick requests which are unassigned or assigned to other technicians on enabling the
check box and selecting Pick.

•

Assign - Assign requests to other technicians.

•

Close - Close requests on completion by enabling the check box and selecting Close.

•

- indicates that first response time of the request is overdue. The first response time is
configured in Service Level Agreement.

•
•
•

- indicates that the request is overdue.
- indicates the first response time and the resolution are overdue.
Technician Assign Icons
- unassigned requests i.e., request is not assigned to any technician.
- request is assigned to a technician.
- request assigned to the logged in technician.
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The request list view displays a total of five requests in a page. You can navigate to other pages using
the navigation options below the page. To revert back to the Home page, click the Home > link or the
home icon

on the top right corner of the page.

Creating a New Request
Requests raised through phone calls can now be instantly created from your hand-held device on
entering details such as, requester name, account and site, request title and description.
Click New in the request list view page.

•

Requester Name - name of the requester raising the request. To select and search for
available requesters, click Select.

•

Account, Site Name - Account and Site name for which the request is created.

•

Request Title - a brief summary of the request raised.

•

Description - a detail description of the request.

Click Add to save and add the request in the request list view.
Note:
•

Requests cannot be created through Request Template though templates are configured in
the server.

•

Request details such as request type, priority, urgency, group, category, sub category and
item cannot be added while creating a new request.
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Viewing Request Details
Click on the request you wish to view from the request list view page. The request details page
displays the Request ID, Requester, Status of the request along with the overdue flag, Technician
assigned to the request, Due by Time of the request along with the priority color code, Subject and
Description.

Click More details... link to get the entire detail of the request such as, request type, impact, status,
account, site, due by time, response due by time and so on.
If the description exceeds 250 characters then (More...) link appears. Click the link to view the entire
description.
Click More.. button to add resolution and work Log.
If the request is resolved, click Close. Click Delete to discard the request completely from the
application.

Assigning requests to technicians
If you are assigning requests to technicians using your mobile device, then the list of all the available
technicians are displayed. Requests can be assigned to technicians provided the technician is
associated to the site where the issue exists.
1. Select the check box beside the request.
2. Click Assign. Select the radio button beside the technician.
3. Click Assign.
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Note: An error message does not occur if a request is assigned to a technician with restricted access
permission and if the technician is not associated to the site. Instead the request is not assigned to
the technician.

Adding Resolution to a request
1. From the request details page, click More..
2. Click Add beside Resolutions. Enter the resolution in the text field.
3. You can also change the status of the resolution from Change State to drop down list.
4. Click Save.
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Note:
•

Resolutions can be added only as plain text.

•

Resolutions cannot be created through resolution templates though the templates are
configured in the server.

•

Resolutions cannot be searched from Solutions module.

Viewing/Editing Resolutions for a request
1. Click More.. from the request details page.
2. If the resolution is added to the request then the Edit and View link appears.
3. Click View to view the resolution. The resolution along with the technician submitted the
resolution is displayed.
4. From the view resolution page, click Edit to modify the resolution. You can edit the request
from More.. -> Edit link.
4. Edit the content and if necessary change the status.
5. Click Save.

Adding Work Log for a request
You can add the time spent details for a request from your mobile device.
Click More.. from the request details page.
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•

Technician - the name of the logged in technician is displayed in a non editable text by
default.

•

Time Taken - the time taken to resolve the request in hours and minutes.

•

Incident Cost - the Incident Cost is taken from the Time Taken x Technician's cost per
hour. The Technician Cost per hour is mentioned while adding a technician under Admin ->
Technician.

•

Execution Time - by default, the execution time displays the current date. Select the date
and month from the drop down box.

•

Description - a description about the time spent entry.

Click Save. The name of the technician along with the time taken to resolve the request and the cost
is displayed. To know more on Adding Work Log refer Cost of Request.
Note:
•

Work Log cannot be added for other technicians.

•

The logged in Technician's Cost per hour should be configured in the server.
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Problems
Problem Management
This module will be available only in the ServiceDesk Plus - MSP Enterprise edition of the product.
A problem is an unknown underlying cause of one or more Incidents. The objective of Problem
Management is to minimize the adverse impact of incidents and problems on business that are
caused by errors within the IT infrastructure, and to prevent recurrence of Incidents related to these
errors. In order to achieve this goal, Problem Management seeks to get to the root cause of Incidents
and then initiate actions to improve or correct the situation.
The Problem Management process has both reactive and proactive aspects. The reactive aspect is
concerned with solving Problems in response to one or more Incidents. Proactive Problem
Management is concerned with identifying and solving problems and known errors before incidents
occur.
•

Creating a New Problem

•

Viewing Problem Details

•

Editing a Problem

•

Closing a Problem

•

Picking a Problem

•

Assigning Technicians to a Problem

•

Problem Analysis

•

Problem Solutions

•

Adding Notes

•

Adding Tasks

•

Adding Work Logs

•

Deleting Problem

•

Associating Incidents to Problem

•

Associating Changes to Problem

•

Adding Reminders

•

Viewing Reminders

•

Publishing Announcements

•

Send Notification

•

Printing Problem
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Creating a New Problem
The goal of problem management is to minimize the adverse impact of incidents and problems on the
business that are caused by errors within the IT infrastructure and to prevent recurrence of incidents
related to these errors.
To create a new problem,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the New Problem button. This opens the New Problem form. Or click the Create New
link at the left hand side of the page below the tabs then select the Problem option.
4. Select the Reported By requester from the list by clicking on the Requester icon
opens the requester list page and click the requester title.

.This

5. Select the Technician from the combo box.
6. Select the Category, Sub Category and Item from the combo box.
7. Select the Status of the problem say Open from the combo box.
8. Select the Impact, Urgency and Priority of the problem from the combo box.
9. Select the Due by Date and the Closed Date from the calender button.
.This opens the
10. Select the affected IT Services from the list by clicking on the icon
Services Affected pop up box as shown below. Select the affected IT services and Save the
changes.

.This opens the Select
11. Select the Assets Involved with the problem by clicking the icon
Assets page. Select the Type of Assets or the category of assets to be involved from the
combo box. Ex: Workstations, Routers, Switches and so on. Select the Available Assets
under the selected type from the list and move to Assets involved using >> button. And
Save the changes.
12. Specify the Title of the problem in the given text field. This is a mandatory field.
13. Specify the details about the problem in the Description field.
14. If you have any file attachments for the problem click the Attach File button and attach files.
Note: Maximum size of an attachment can be 10MB.
15. Save the changes.
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Viewing Problem Details
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab. This opens the problems list view page.
3. Select the required account using the Accounts combo box.
4. Click the Title of the problem to view the problem details. This opens the problem details
page. By default the problem details page opens in the Problem tab.
From the problem details page, you can navigate to the previous or the next problem using
the navigation buttons on the top right hand side corner. Using this, you need not return back
to the list view page to view the next problem.

Problem Tab
The problem tab shows general details of the problem such as, Category, Technician, Status, Priority,
Urgency, Impact, Requester, Reported Date, Due By Date, Closed Date, affected IT Services and
Assets Involved.
Click the Edit button to edit all the details of the change. You also have inline edit option for all the
details. To modify the details of the problem click the details and choose the option from the combo
box.

Analysis Tab
In the Analysis tab the technicians analyze the root cause and impact of the problem and attach the
same in SDP as part of the problem. Also they specify the symptoms of the problem to identify the
same problem in the future.

Solution Tab
In the solutions tab resolution for the problem is given as Work Arounds and Solutions. Work Arounds
are temporary solutions that can be used by the technician till the actual solution is ready. Solutions
are the permanent fixes to the problems raised.

Incidents Tab
The incidents tab shows the list of all associated incidents with the problem. You have Attach option
to attach the incident with the problem. And the Detach Incidents option to detach associated
incidents with the problem.

History Tab
The History tab shows the problem history from the time of its creation. It shows all the actions
performed in the problem. The history tab also shows the incidents and the changes associated to the
problem on clicking the Property View link available on the right hand side. The details that are
displayed in the history are in the ascending order with the earliest performed action shown at the top
of the page and the latest action at the bottom of the page.
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Editing a Problem
To edit a problem available in the ServiceDesk Plus - MSP Problem module
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane. This opens the problems list view page.
3. Click the Title of the problem which you want to edit. This opens the Problem details page
which list the Tasks that can be performed on the problem.
4. Click the Edit link on the top of the page to modify the problem details. This opens the Edit
Problem page. From this page you can add status of the problem from open to close, and
also change the entire template to a new one apart from the regular editing of the problem
details.
Alternatively, you also have an inline edit option to modify the problem details in the view
on the right side of each block which opens the problem
problem page. Click the edit icon
form fields in editable format. After modifying the values, save the changes. This comes in
handy when you need to edit the values of the entire block say Problem Details one by one.

Modifying the Problem Details
In the editable problem form you can change the problem details, such as Status of the problem as
Closed or Open, Impact details, Urgency and Priority details. You can also modify affected IT
Services and Assets Involved in the problem.

Modifying Owner Details
You can modify the owner details and technician details of the problem. You can also edit the
Reported Date and Due by Date of the problem. If the problem has been closed, then the Closed
date will be displayed beside this due by date.

Modifying the Problem Category
You can change the Category, Sub Category and Item of the problem. If the same was not
appropriately chosen at the time of submitting then the problem can be selected now from the drop
down list.

Modifying the Problem Description
You can modify the title and description of the problem to completely capture the actual nature of the
task at hand.

Appending Attachments
If you wish to attach more files to the problem, click the Attach a File button and attach as many files
as you wish and click Done. You can also delete the attachments previously added to the problem by
clicking the delete icon available beside the attachment.
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Closing Problem
If a requester is completely satisfied that his/her problem has been attended and completely solved,
then the problem can be closed.
To close a problem
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem in the Problems list page. This opens the problem details page.
4. Click the Close Problem link under the Tasks block. This closes the problem.
Note: If the mandatory fields are not entered then an error message is shown asking you to enter the
value in the fields.
You can reopen a problem from the closed state to open state. To do this, open the closed problem
that you wish to reopen by clicking the edit button. Then change the status field from Closed to Open
and save the changes. When a problem is opened from the closed state, you can change the Due By
time of the problem. Also, the closed date is removed once the request is reopened. When this
request is finally closed, the completed date is updated and the time taken to close is recalculated
taking the reopened period into account.
To close more than one problem at a time
1. In the Problem list page, select the problem from the list by enabling the check boxes
available beside the Problem Name.
2. Now click the Close button.
To view the closed requests
1. From the Problem list page, select Closed Problems from the Filter drop-down menu. This
lists all the closed problems.
2. To view the closed problems which were assigned to you, select My Closed Problems.
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Picking Up Problem
ServiceDesk Plus - MSP provides an option to the technicians to pick-up problem(s). If there are
unassigned problems, the technicians can pick up any of the unassigned problems from the list. As
the problems are picked up and answered quickly the waiting time to assign the problem to each
technician and then closing the problem will be reduced. This in turn will increases the turnaround
time and the efficiency of the IT help desk team.
To pick up problems,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane. The unassigned problems will be in bold font.
3. Select the problems you would like to pick up by enabling the check box. Click Pick up
button. The selected problem will be assigned to you. (Or)
4. You can also pick up problems after viewing the problem details. Click the title of the problem
to open View Problem page.
5. Click Assign tab. Select Pick Up option to pick up the problem.

Zoho Corporation Pvt. Ltd.
138

ManageEngine ServiceDesk Plus MSP – Admin Guide

Assigning Technician
Each problem is handled by a technician, who is responsible for closing the problem.

To assign a technician to the problem,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problem tab in the header pane. This opens the Problems list page.
3. Click the Title of the problem for which you have to assign a technician. This opens the
problem details page.
4. Click the Actions combo box on the right hand side of the page ->Click Assign Technician
link from the list. This opens Assign Technician to this Problem pop up page as shown
below. Select the technician from the list and Assign the problem to the technician.

5. Alternatively, you can also assign technician using inline edit option. Click the technician
name shown in the problem details block. This opens the drop down box as shown below.
Select the technician from the list and click the
click cancel icon.

icon to select the technician name else

You can also assign more than one problem at a time to a technician.
To bulk assign problems to technicians
1. In the Problems list page, select the problems to be assigned a technician by enabling the
check box beside left side each of the problem title.
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2. Click the Select Technician check box. Select the technician from the drop down list.
3. Assign the technician.
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Problem Analysis
The goal of Problem Management is to find the root cause of the incidents and reduce the impact on
the business by providing solutions and workarounds. In the problem analysis the technicians analyze
the root cause and impact of the problem and attach the same in SDP as part of the problem. Also
they can specify the symptoms of the problem to identify the same problem in the future. The
following are the steps to understanding the cause of the problem,
•

Symptoms - Evidences helping in identifying the problem.

•

Root Cause - Detecting the underlying cause of the incident.

•

Impact - Adverse effect of the problem on the business.

To specify the Problem Analysis,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab -> click the title of the problem for which you need to specify the
analysis. This opens the problem details page.
3. Click the Analysis tab.

Adding Impact details,
1. Click the Add button. You can see the text area getting displayed for the impact
details.
2. Specify the impact details in the text field and Save the changes. You can see the
details getting displayed below the title. (OR)
3. If you like to attach a file on the impact details instead of entering the details in the
text field then click Attach File button to attach a file for the impact details. The
maximum size of the attachment is 10MB.

Adding Root Cause,
1. Click the Add button. A text area is displayed for entering the root cause.
2. Specify the root cause in the given text field and Save the changes. The details get
displayed below the title. (OR)
3. If you like to attach a file on the root cause, then click Attach File button to attach a
file for the root cause. The maximum size of the attachment can be 10MB.

Adding Symptoms,
1. Click the Add button. A text area gets displayed for entering the symptoms.
2. Specify the symptoms in the given text field and Save the changes. The details get
displayed below the title. (OR)
3. If you like to attach a file on the symptoms instead of entering it in the text field then
click Attach File button to attach a file for the symptoms. The maximum size of the
attachment is 10MB.
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Problem Solutions
Resolution for the problem can be given as Work Arounds and Solutions in ServiceDesk Plus - MSP.
Workarounds are temporary solutions that can be used by the technician till the actual solution is
ready. Solutions are the permanent fixes to the problems raised. The problem is considered as a
known error when a solution or work around is added to a problem.
To add resolution,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab. This opens the problems list page.
3. Click the Title of the problem for which you like to view the reminder. This opens the problem
details page.
4. Click the Solution tab.

To Add Work Around,
1. Click the Add button. A new page for entering WorkAround details is openend. Enter the
required details.
2. Save the details.
3. Click Attach File button to attach a file for the impact details. The maximum size of the
attachment is 10MB.

To Add Solution
1. Click the Add button. A pop-up for entering the Solution is displayed. Enter the required
details.
2. Save the details.
3. Click Attach File button to attach a file for the impact details. The maximum size of the
attachment is 10MB.
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Adding Notes
If you like to add additional information including technical information based on your observations to
a particular problem, then you can Add Notes to that problem. You can also use notes to update the
status of the problem.
To add a note to the problem,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem to which you would like to add a note. This opens the problem
details page.
4. Click the Add New combo box -> Select Note option. This opens Add Notes page as shown
below,

5. Enter your content in the text box. These notes are public.
6. Save the details. The note is added at the bottom of the problem along with a date and time
stamp. The name of the person who added the note is also displayed.
You can add any number of notes to a problem. The added notes will be displayed in the
ascending order. You can also edit or delete the notes that have been added.
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Adding Tasks
Using this option you can assign different tasks to different technicians. Task is a sub-unit of an
activity. If a problem involves multiple technicians work, then the technician whoever receives the
problem (owner of the problem) can assign different tasks to different technicians.
To add tasks,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem to which you would like to add tasks.
4. Click the Add New menu -> select Task option. This opens the Tasks window.
5. You can either select the task template from Select Template drop down list or you can add
a new task.
6. Specify the Title of the task in the given text field. This is a mandatory field.
7. Specify relevant information about the tasks in the Description field.
8. Select the Scheduled Start Time from the calendar button. Also select the Scheduled End
Time for the task from the calendar button.
9. The Actual Start Time and End Time of the task will be entered by the technician doing
(owning) the task.
The actual start time and end time is the real time schedule of the task. The scheduled start
time and end time specified by the problem owner is a tentative time schedule.
10. Select the Group to which the task needs to be assigned. Select the Technician of the task
from the combo box. Tasks can be assigned either:
•

to a Group alone,

•

to a Group and corresponding technician from the group,

•

to a Technician alone,

•

to no Group and Technician.

11. Specify the Status of the task.
12. Specify any relevant comment about the task in the Comments field.
13. If you wish to be reminded of the task previously then select the Email me before option and
select the number of days from the combo box. This option will be selected based on the
scheduled start time.
14. Save the values. You can see a Tasks tab getting created next to the solution tab. All the
tasks created for the problem will be listed under the tasks tab in descending order. The tasks
assigned to other technicians can be viewed in their Task summary list in the home page.

Adding Bulk Task to a problem
Certain problem may require more than one task involving different technicians. In this case, rather
than adding tasks one by one, you can add bulk tasks to the problem from the task template.
1. From the problem details page, click the Task tab. The task details page opens.
2. Click Add Task from Template button. The Task Template window pops up listing all the
active templates.
3. Select the check box beside the templates and click Add Template button. The tasks
selected are added under Task Details.
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Deleting Tasks
1. From the tasks details page, select the check box beside the task you wish to delete.
2. Click the Delete button. A confirmation message appears.
3. Click Ok to continue. The task is deleted from the list.
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Adding Work Logs
You can enter the details of time spent by technicians in addressing the problem using this option.
The total time spent will exclude the time that the problem was kept on hold. It takes the time of
creation to till the problem was closed.
To Add Work Logs,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Select the Technician Name from the combo box.
3. Specify the Executed Time (date & time) taken to resolve the problem from the calender
button.
4. The Technician Cost per hour will be fetched automatically from the technician details,
which is a non-editable field. If you have already entered the per hour cost of the technician
while adding the technician details, then the details will be fetched automatically. If you wish
to change these values, you can do so manually.
5. The Incident Cost will be automatically calculated taking the (total time spent to resolve the
problem * Technician's cost per hour).
6. If there are any extra charges specify in the Other Charges field.
7. Using the above two data the Total Charges (Technician Charges + Other Charges) will be
displayed automatically.
8. Specify any relevant information about the time spent in the description field.
9. Save the details.
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Deleting Problem
You have an option to delete individual problems or group of problems together.
To delete individual problems
1. Log in to the ServiceDesk - MSP Plus application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem to be deleted in the problems list view page. This opens the
Problem Details page.
4. Click the Actions combo box on the top right hand side of the page.
5. Click the Delete link from the list. A dialog pops up asking you to confirm on the delete
process.
6. Click OK to proceed. You can see the problem deleted from the list.
To delete more than one problem at a time
1. In the Problem list view page, select the problems to be deleted by enabling the check boxes.
2. Click the Delete button. A dialog pops up asking you to confirm on the delete process.
3. Click OK to proceed deleting Or click Cancel to abort deletion.
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Associating Incidents to a Problem
You have an option to associate Incidents to a problem. Similar Incidents can be associated to a
problem. This allows us to track the severity of a problem.
To Associate Incidents,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab. This opens the Problem List View page. Click the problem title to be
associated with the Incidents. This opens the problem details page.
3. Click the Actions combo box on the top right side of the page. Click Associate Incidents
option. This opens Associate Incidents to problem page as shown below,

4. Select the type of requests to be displayed by selecting from the Show combo box on the top
left hand side of the page. Ex: Open Requests or All Requests and so on. On selecting the
request type the corresponding requests gets listed.
5. Select the Incidents from the list by enabling the check box beside each incident.
6. Click Associate Incidents to associate respective requests to the problem (particular
selected problem). The associated incidents gets listed in the Incidents tab in the problem
details page as shown below,
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Associating Changes to Problem
You have an option to associate Changes to the problem. This allows us to track the change that has
occured for a problem.
To Associate Changes,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab. This opens the Problem List View page.
3. Click the problem Title to be associated with the Change. This opens the problem details
page.
4. Click the Actions combo box on the top right side of the page. Click Search Changes option.
This opens Associate Problem to Changes page as shown below,

Select the type of change to be displayed by selecting from the Filter Showing combo box on the top
left hand side of the page. Ex: Open Change or All Change and so on. On selecting the change type
the corresponding changes gets listed.
Select the Change from the list by enabling the check box beside the change.
Click Associate button to associate respective change to the problem.
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Adding Reminders
You can add reminders to the problems using this option. All the pending tasks specific to the problem
can be added as reminders. The technician can add these task list as a personal reminder to
himself/herself. On adding these reminders they get displayed in My Reminder(s) under Quick
Actions.
To add reminders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane. This opens the problems list page.
3. Click the Title of the problems from the list. This opens the problems details page.
4. Click on the Add New combo box on the top right side of the page. Click the Reminder link.
This opens the Reminders page. Specify the content in the given text field.
5. Select the reminder Date and Time by invoking the calendar icon.
6. To be reminded of the task in advance, select the time from the Email me before combo box.
7. The problem id is shown in non editable mode.
8. Click Add button to add the reminder. You can see the reminder getting listed in the My
Reminder(s) pop up window in ascending order.
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Viewing Reminders
You can view the reminders specific to each problem in this module.
To view reminders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab. This opens the problems list page.
3. Click the Title of the problem for which you like to view the reminder. This opens the problem
details page.
4. Click the Actions combo box -> Click the View Reminders option. This opens the Showing
All Reminders Page as shown below. This lists all the reminders in ascending order based
on the date.

5. Once the task is completed you can change the state of the reminder from open to
completed. To do this, select the reminder from the list to be closed by enabling the check
box beside each of the reminder.
6. Select the Change Reminder State To Completed then -> click Change button to change
the state. You can see the reminder striked off to indicate the change.
Alternatively, you can also view the reminders by, clicking Quick Actions link
-> My Reminder(s) option under the Reminders block. This opens the My
Reminders pop up window as shown below. This shows all your reminders irrespective any
specific module.

You can also add new reminders by clicking + Add New link at the bottom of the my reminders form.
The new task is added and is listed along with the already existing tasks in the ascending order based
on date and time.
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When you have completed the task, you can just strike out the task to indicate that it is completed by
selecting the radio button beside the task summary.
You can also delete the task by clicking the delete icon beside

the task.
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Publishing Announcements
ServiceDesk Plus - MSP gives you an option to publish announcements while fixing the problem
without breaking the work flow. Say if you want to inform the company that, the mail server will be
down for next five hours and your are fixing the problem then in this case you need not go to the
home page to make an announcement you can publish the announcement from the problem module.
To Publish Announcements,
1. In the Problem details page click the Actions combo box and select the Make an
announcement option. This opens the Add New page.
2. The announcement Title and Description of the problem gets displayed automatically. This
is a mandatory field. You can also modify the title and description of the problem.
3. Specify any relevant information about the announcement in the Description field. Also
specify the result under the Resolution title.
4. Specify the date and time to Show this announcement, between these dates from the
calender button. If this field is not entered the announcement will be displayed in the
dashboard for ever.
5. To Show this announcement only to technicians select the check box.
6. To Send this announcement as mail select the check box.
7. Save the changes. You can see the announcement page as shown below. To view the next
and previous announcement in the dash board click the Next and Previous buttons on the
right side of the page.

You can also edit and delete the announcement in the same page.
To edit the announcement,
1. Click Edit button. This opens the Edit Announcement form.
2. Change the details of the announcement in form.
3. Save the changes. All the changes made in the announcement will be saved.
To delete an announcement,
1. To delete the announcement click Delete button. A dialog pops up asking you confirm on the
delete operation.
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2. Click OK to delete. Or click Cancel to retain the announcement.
Alternatively you can also publish announcements to all requesters across accounts or only to the
technicians group from the Home page. The announcements are displayed just below the my view
requests tab in the home page as shown below,
All recent announcements will be displayed first based on the date. To view all the announcements
(even completed ones), click the Show All button on the right side of the page.

To add a new announcement
1. Login to ServiceDesk Plus - MSP using the administrator / technician user name and
password.
2. In the login home page, if you have permissions to add an announcement, you will notice the
Add New button in the announcements box as shown above. Click the button. The Add New
Announcement dialog pops up.
3. Enter the Announcement Title. This can be a short statement that describes the
announcement.
4. Type the Announcement Content in the text box provided for the same.
5. Select the From date and To date using the calender icon beside the respective fields.
6. If you wish to publish the announcement only to the technicians and do not wish to expose it
to your requesters, then select the check box Show this announcement only to
technicians. The announcement will be displayed in the home page with a lock beside it.
7. If you wish to Send this announcement as mail then select the corresponding option by
enabling the check box.
8. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.
The announcement will be added and the pop-up will display the announcement details as entered by
you. The announcement title will be displayed in the login home in bold text in the announcement box
with a new icon beside it.
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Send Notifications
To send notifications specific to the problem to the requester who raised the problem or to any person
concerned,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane. This opens the problem list view page.
3. Click the title of the problem to which the notification has to be sent. This opens the problem
details page.
4. Click the Actions combo box and select the Send Notification link. This opens the Send
Notification page.
5. Specify the To and CC address in the given text field.
6. Specify the Subject of the notification in the given text field.
7. Specify relevant information about the notification in the Description field.
8. Send the notification.
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Printing Problem
To print a problem,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem you would like to print.
4. Click the Print Preview link on the right side Tasks block. The print preview page of the
problem opens in a pop-up window.
In the print preview page you can view the Impact Analysis, Root Cause, Symptoms,
WorkAround, Solution, Problem Details Notes and their attachments.
5. Click the Print menu item from the browser File menu.
6. The default printer associated with your workstation is invoked. Set the required options and
click OK. You can collect the printed copy of the problem at the printer that is linked to your
workstation.
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Changes
Change Management
Changes arise as a result of problems, but many changes can come from proactively seeking
business benefits such as reducing costs or improving services. The goal of Change Management is
to ensure that standardised methods and procedures are used for efficient and prompt handling of all
Changes in order to minimise the impact of change-related incidents upon service quality and
consequently to improve the day-to-day operations of the organization.
A change request entails a considered approach to assessment of risk and business continuity,
change impact, resource requirements and change approval. This approach is important to maintain
the balance between the need for change against the impact of change.
•

Creating a New Change

•

Forward Schedule Change ( Calender View )

•

Viewing Change Details

•

Editing a Change

•

Printing Change

•

Adding Notes

•

Adding Reminders

•

Viewing Reminders

•

Adding Tasks

•

Adding Work logs

•

Assigning Technician to a Change

•

Closing a Change

•

Deleting a Change

•

Associating Incidents to a Change

•

Associating Problems to a Change

•

Publishing Announcements

•

Send Notification

•

Change Planning

•

Recommending Change for CAB

•

Approving Change by the Change Manager
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Creating New Change
There can be different types of changes that can happen in an organization. It can be a Major, Minor
or Standard change. For any change a request for change has to be sent to the change management
team by creating a New Change.
To create a new change,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Create New link at the top left hand side of the page ->and select the Change
option. This opens the New Change form. Or click the Changes tab and select the New
Change button to open the New Change form.
3. Select the Requested By requester from the list by clicking on the Requester icon
opens the requester list page and click the requester title.

. This

4. Select the Technician from the combo box.
5. Select the Category, Sub Category and Item from the combo box.
6. Select the Status of the change say Open from the combo box.
7. Select the Impact, Urgency and Priority of the change from the combo box.
8. Select the Change Type from the combo box. Say Major.
9. Select the Scheduled Start Time and Scheduled End Time from the calender button.
. This
10. Select the affected IT Services by the change from the list by clicking on the icon
opens the Services Affected pop up box as shown below. Select the affected IT services
and Save the changes.

. This opens the Select
11. Select the Assets Involved with the change by clicking the icon
Assets page. Select the Type of Assets or the category of assets to be involved from the
combo box. Ex: Workstations, Routers, Switches and so on. Select the Available Assets
under the selected type from the list and move to Assets involved using >> button. And
Save the changes.
12. Specify the Title of the change in the given text field. This is a mandatory field.
13. Specify the details about the change in the Description field.
14. If you have any file attachments for the change click the Attach File button and attach files.
Note: Maximum size of an attachment file can be 10MB.
15. Save the changes. You can see the new change created in the change list view page.
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Forward Schedule of Change
The change home page shows two types of views, List View and Calendar View. The list view
shows the list of all changes to be made. And the Calender View shows the changes with start & end
schedule time marked in different colors based on the type.
To view the schedule,
1. Log into ServiceDesk Plus - MSP using your user name and password.
2. Click the Changes tab in the header pane. This opens the change list view page by default as
shown below.

List View

Forward Schedule of Change (Calender View)
1. Click the Calendar View tab next to the list view tab in the home page. This opens the
calender view of change as shown below.
To display the changes in the Calender View, the changes should have the scheduled start
time and end time.
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•

The Calender View displays all the scheduled changes for the entire month. Click the forward
arrow

to go to the next month. Click the backward arrow

to go to the previous month.

•

You can choose the type of change from the Filter Showing combo box. Hence you can view
the Open Changes, Approved Open Changes, All Changes and Completed Changes.

•

A thick strip will be running across the scheduled start date and end date of the change. The
at the beginning of the strip indicates the start date.
outward curve (
at the end of the strip indicates the end date.
And the inward curve )

•

The color of the strip depends on the type of the change. Say standard, major,minor and so
on.

•

At the bottom of the page you have all the four change types with one N/A type displayed
along with the check boxes. For ex: If you wish to view only the standard changes for the
month in the calender view, then select the Standard check box and de-select the other
change types. If you wish to view all the change types then select all the change type by
enabling the check box.

•

The backward arrow in the strip
continuation of the change.

•

And the forward arrow in the strip
continued for the next week.

•

On clicking at any part of the strip you will be able to view the change details page as shown
below.

indicates the previous week
indicates that the change will be

In the change details page,


If there are any tasks associated with the change then the task status bar will also be
displayed.



If all the tasks are completed then the status bar would be in green color.



Out of two tasks, if One task is complete and the other task is incomplete then the
status bar would show half green color.



You will be able to view the number of tasks completed / the total number of tasks.
Say 1tasks completed out of 2 tasks.
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You will also be able to see the Status of the task and owner at the bottom of the
page. If the status is completed then the bullet point would be in green color. If the
status of the task is incomplete then the bullet point would be in red color.

•

The calender can show only three changes in a particular date. If there are more than three
changes in a date, then the calender will show the other changes in the text form as +n more
as shown below.

•

Clicking the + n more text link, will list all the displayed changes in the calender on the left
hand side of the page as shown below. They can also be viewed by clicking the dates of the
marked changes in the calender. Say by clicking the date
list.

you will be able to view the

•

A calender on the top left hand side of the page, shows the current date marked in a box. All
the changes in the current month will be underlined and bold. On clicking any of the
underlined date will list all the scheduled change for the particular date below the calender.

•

Click the Week link at the Top of the page to view the weekly change schedule as shown
below. Click the forward arrow
arrow

to view next week change schedules. Click the backward

to view the previous week change schedules.
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Viewing Change Details
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the changes list page. Select the Account for which you
wish to view changes using the 'Accounts' combo box.
3. Click the title of the change to view the change details. This opens the change details page.
By default the change details page opens in the General tab.

General Tab
The general tab shows general details of the change such as, Category, Technician, Status, Priority,
Urgency, Type, Impact, Requester, Start Time, End Time, affected IT Services. The Status field holds
the state of the change such as Requested, Approved, Implemented, Reviewed and Closed The
approval status denotes whether the change is approved or rejected. The change will be considered
as approved and listed in the change calender only if the Approval Status is 'Approved'. The
approval status is given in non-editable mode.
Click the Edit button to edit all the details of the change. You also have inline edit option for all the
details. To modify the details of the change click the details and choose the option from the combo
box.

Problems Tab
The problems tab shows the list of all the associated problems with the change. You have Attach
option to attach the problem with the change. And the Detach Problem option to detach associated
problem with the change.

Incidents Tab
The incidents tab shows the list of all associated incidents with the change. You have Attach option to
attach the incident with the change. And the Detach Incidents option to detach associated incidents
with the change.

Planning Tab
The planning tab shows the planning phase of the change on how to go about the change. It shows
the Impact details, Roll Out, Back Out plan and finally the Check List for the plan.

Approvals Tab
From the Approvals tab, the administrator can Add CAB Members and Send the change for
Recommendation to the CAB members. Thus it helps to show the approval status of the change.
Refer

Implementation Tab
Implementation page shows the task details of the change and the work log details of the change.
You can also add, edit and delete new Task and new Work Log details.

Review Tab
From the review tab you can add post change assessment details or the evaluation results on how the
change is made details are specified. It is basically a recap of the change.
To add review details Click the Add button. This opens the review text box.
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Specify the details in the text box and Save the details. You can see review details getting displayed
under the title. And the name of the person who entered the details with date and time will be
displayed on the right hand side of the page.
To edit the review details click the Edit button next to the title. Edit the details and save the changes.
If you would like to attach a file on the review details of the change, click Attach a File option and
attach files.

History Tab
The History tab shows the change history from the time of its creation. It shows all the actions
performed in the change. The history tab also shows the incidents and the changes associated to the
problem on clicking the Property View link available on the right hand side. The details that are
displayed in the history are in the ascending order with the earliest performed action shown at the top
of the page and the latest action at the bottom of the page.
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Editing a Change
To edit the change available in the ServiceDesk Plus - MSP,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the changes tab in the header pane. This opens the changes list view page.
3. Click the Title of the change to be edited. This opens the change details page which list the
Tasks that can be performed on the change.
4. Click the Edit link on the top of the page to modify the change details. This opens the Edit
change page. From this page you can add status of the change from open to close, and also
change the entire template to a new one apart from the regular editing of the change details.
Alternatively, you also have an inline edit option to modify the change details in the view
on the right side of each block which opens the change
change page. Click the edit icon
form fields in editable format. After modifying the values, save the changes. This comes in
handy when you need to edit the values of the entire block say change Details one by one.

Modifying the Change Details
In the editable change form you can change the change details, such as Status of the change as
Closed or Open, Impact details, Urgency, Priority and Change Type details. You can also modify
affected IT Services and Assets Involved in the change.

Modifying Owner Details
You can modify the Requested by details and Technician details of the change. You can also edit
the Scheduled Start Time and Scheduled End Time of the change.

Modifying the Change Category
You can change the Category, Sub Category and Item of the change. If the same was not
appropriately chosen at the time of submitting then the change can be selected now from the drop
down list.

Modifying the Change Description
You can modify the title and description of the change to completely capture the actual nature of the
task at hand.

Appending Attachments
If you wish to attach more files to the change, click the Attach a File button and attach as many files
as you wish and click Done. You can also delete the attachments that were added previously in the
change by clicking the delete icon available beside the attachment.
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Printing Change
To print a change,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab in the header pane.
3. Click the Title of the change you would like to print.
4. Click the Print Preview link on the right side Tasks block.
In the print preview page you can view the Impact Analysis, Roll Out Plan, Back Out Plan,
Checklist and Review. Then the Change details, Approval status and Notes and their
attachments.
5. The print preview page of the change opens in a pop-up window. Click the Print menu item
from the browser File menu.
6. The default printer associated with your workstation is invoked. Set the required options and
click OK. You can collect the printed copy of the change at the printer that is linked to your
workstation.
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Adding Notes
If you would like to add additional information including technical information based on your
observations to a particular change, then you can Add Notes to that change. You can also use it to
update the status of the change. These notes cannot be added by the requesters. The requesters can
only view the notes.
To add a note to the change,
1. Log in to ServiceDesk Plus - MSP Plus application.
2. Click the Change tab in the header pane.
3. Click the Title of the change to which you would like to add a note. This opens the change
details page.
4. Click the Add New combo box -> Select Note option. This opens Add Notes page as shown
below,

5. Enter your content in the text box. These notes will be added to the change only by the
technicians. The requesters will not be able to add the notes. These notes are public.
6. Save the details. The note is added at the bottom of the change along with a date and time
stamp. The name of the person who added the note will also be displayed.
You can also add any number of notes to a change. The added notes will be displayed in the
descending order with recently added note first. You can also edit or delete the notes that have
been added.
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Adding Reminders
You can add reminders to the changes using this option. All the pending tasks specific to the change
can be added as reminders. The technician can add these task list as a personal reminder to
himself/her. On adding these reminders they get displayed in My Reminder(s) under Quick Actions.
To add reminders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab in the header pane. This opens the changes list page.
3. Click the Title of the change from the list. This opens the change details page.
4. Click on the Add New combo box on the top right side of the page. Click the Reminder link.
This opens the Reminders page. Specify the content in the given text field.
5. Select the reminder Date and Time by invoking the calendar icon.
6. To be reminded of the task in advance, select the time from the Email me before combo box.
7. The change id is shown in non editable mode.
8. Click Add button to add the reminder. You can see the reminder getting listed in the My
Reminder(s) pop up window in ascending order.
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Viewing Reminders
You can view the reminders specific to each change.
To view reminders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the changes list page.
3. Click the title of the change for which you like to view the reminder. This opens the change
details page.
4. Click the Actions tab -> Click the View Reminders option. This opens the Showing All
Reminders page as shown below. This lists all the reminders in ascending order based on
the date.

5. Once the task is completed you can change the state of the reminder from open to
completed. To do this, select the reminder to be closed from the list by enabling the check
box on the left side of each reminder.
6. Select the Change Reminder State To Completed then -> click Change button to change
the state. You can see the reminder striked off to indicate the change.
Alternatively, you can also view the reminders by, clicking Quick Actions link
-> My Reminder(s) option under the Reminders block. This opens the My
Reminders pop up window as shown below. This shows all your reminders irrespective any
specific module.

You can also add new reminders by clicking + Add New link at the bottom of the my reminders form.
The new task is added and is listed along with the already existing tasks in the ascending order based
on date and time.
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When you have completed the task, you can just strike out the task to indicate that it is completed by
selecting the radio button beside the task summary.
You can also delete the task by clicking the delete icon beside

the task.
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Adding Tasks
Using add tasks option you can assign different tasks to different technicians. Say if a change is
reported by the requester the change might involve multiple technicians work. The change owner
(manager) whoever received the change can assign different tasks to the different technician.
To add tasks,
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password.
2. Click the Changes tab in the header pane.
3. Click the Title of the change to which you would like to add tasks.
4. Click the Add New menu -> select Tasks option. This opens the Tasks window.
5. Specify the Title of the task in the given text field. This is a mandatory field.
6. Specify relevant information about the tasks in the Description field.
7. Select the Scheduled Start Time for the task from the calendar button. Also select
the Scheduled End Time for the task from the calendar button.
8. The Actual Start Time and End Time of the task will be entered by the technician
doing the task.
9. Select the Owner of the task from the combo box.
10. Specify the Status of the task.
11. Specify any relevant comment about the task in the Comments field.
12. If you wish to be reminded of the task previously then select the Email me before
option and select the number of days from the combo box.
13. Save the values. You can see the tasks getting displayed in the Implementation tab.
All the tasks created for the change will be listed under the implementation tab under
the Task Details title in descending order. The tasks assigned to other technicians
can be viewed in their Task summary list in the home page.
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Adding Work Logs
You can enter the technicians time spent details for the change using this option. The total time spent
will exclude the time that the change was kept on hold. It takes the time of creation to the change was
closed.
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the changes list page.
3. Click the title of the change for which you like to enter the work log. This opens the change
details page.
4. Click the Add New combo box -> Select Work Log option from the list. This opens the Add
Work Log page
5. Select the Technician Name from the combo box.
6. Specify the Executed Time (date & time) taken to resolve the change from the calender
button.
7. The Technician Cost per hour will be fetched automatically from the technician details,
which is a non-editable field. If you have already entered the per hour cost of the technician
while adding the technician details, then the details will be fetched automatically. If you wish
to change these values, you can do so manually.
8. The Incident Cost will be automatically calculated taking the (total time spent to resolve the
problem * Technician's cost per hour).
9. If there are any extra charges specify in the Other Charges field.
10. Using the above two data the Total Charges (Technician Charges + Other Charges) will be
displayed automatically.
11. Specify any relevant information about the time spent in the description field.
12. Save the details.
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Assigning Technician to a Change
Each change is handled by a technician, who is responsible for closing the change.
To assign a technician,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Change tab in the header pane. This opens the Changes list page.
3. Click the Title of the change for which you have to assign a technician. This opens the
change details page.
4. Click the Actions combo box on the right hand side of the page ->Click Assign Technician
option from the list. This opens Assign Technician pop up page as shown below. Select the
technician from the list and Assign the change to the technician.

5. Alternatively, you can also assign technician using inline edit option. Click the technician
name shown in the change details block. This opens the drop down box as shown below.
icon to select the technician name else
Select the technician from the list and click the
click cancel icon.

You can also assign more than one change at a time to a technician.
To bulk assign changes to technicians
1. In the Changes list page, select the changes to be assigned a technician by enabling the
check box beside left side each of the change title.

2. Click the Select Technician check box. Select the technician from the drop down list.
3. Assign the technician.
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Picking Up Change
ServiceDesk Plus - MSP provides an option to the technicians to pick-up change(s). If there are
unassigned changes, the technicians can pick-up any of the unassigned changes from the list. This in
turn will increase the efficiency of the IT help desk team.
To pick up changes,
1. From the change list view page, select the changes you would like to pick up by enabling the
check box. The unassigned changes will be in bold font.
2. Click Pick up button. The selected change will be assigned to you. (Or)
3. You can also pick up changes after viewing the change details. Click the title of the change to
open View Change page.
4. Click Assign tab. Select Pick Up option to pick up the change.
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Closing Change
To close a change,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab in the header pane.
3. Click the Title of the change in the Changes list page. This opens the change details page.
4. Click the Close Change link under the Tasks block. This closes the change.
Note: If the mandatory fields are not entered then an error message is shown asking you to enter the
value in the fields.

To reopen the change
You can reopen a changes from the closed state to open state. To do this,
1. Click the title of the change. This opens the change details page.
2. Click the Edit button. This opens the form in the editable format.
3. Change the status field from Completed to Requested and save the changes made.
When a changes is opened from the closed state, you should change the Created Time,
Scheduled Start time and End time of the change. When the request is finally closed, the
completed Time will be automatically updated.
(OR)
4. Click the Status of the change in the form you have inline edit option for each of the change
details. This opens the combo box as shown below,

6. Select the status from the list and immediately the status of the change get's updated.

To view the closed changes
1. From the change list page, select Closed Changes from the Filter drop-down menu. This lists
all the closed changes.
2. To view the closed changes which were assigned to you, select My Closed Changes.
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Deleting Change
You have an option to delete an individual change or group of changes together.
To delete individual changes
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab in the header pane.
3. Click the Title of the change to be deleted in the changes list view page. This opens the
Change Details page.
4. Click the Actions combo box on the top right hand side of the page.
5. Click the Delete link from the list. A dialog pops up asking you to confirm on the delete
process.
6. Click OK to proceed. You can see the change deleted from the list.
To delete more than one change at a time
1. In the Change list view page, select the changes to be deleted by enabling the check boxes.
2. Click the Delete button. A dialog pops up asking you to confirm on the delete process.
3. Click OK to proceed. Or click Cancel to abort deletion.

Zoho Corporation Pvt. Ltd.
177

ManageEngine ServiceDesk Plus MSP – Admin Guide

Associating Incidents to a Change
You can associate Incidents with a change. Multiple similar Incidents can be associated to a single
change. This allows completion of multiple requests simultaneously.
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the Change List View page. Click the change title to be
associated with the Incidents. This opens the change details page.
3. Click the Actions combo box on the top right side of the page. Click Associate Incidents
option. This opens Associate Incidents to Change page as shown below,

4. Select the type of requests to be displayed by selecting from the Show combo box on the top
left hand side of the page. Ex: Open Requests or All Requests and so on. On selecting the
request type the corresponding requests get listed.
5. Select the incidents from the list by enabling the check box beside each incident.
6. Click Associate Incidents to associate respective requests to the change. The associated
incidents get listed in the Incidents tab in the change details page as shown below,
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Associating Problems to a Change
Multiple problems can be associated with a change. Doing this allows multiple problems to be workedon simultaneously.
To associate problem(s),
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the Change List View page. Click the change title to be
associated with the problems. This opens the change details page.
3. Click the Actions combo box on the top right side of the page. Click Associate Problems
option. This opens Associate Problems to Change page.
4. Select the type of problems to be displayed by selecting from the Show combo box on the top
left hand side of the page. Ex: Open Problems or All Problems and so on. On selecting the
problem type the corresponding problems get listed.
5. Select the problems from the list by enabling the check box beside each problem.
6. Click Associate Problems to associate respective problems to the change. The associated
problems get listed in the Problems tab in the change details page.
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Publishing Announcements
ServiceDesk Plus - MSP gives you an option to publish announcements while doing the change
without breaking the work flow. Say if you have to make an announcement to the company that the
mail server will be down for next five hours and your are doing the change then in this case you need
not go to the home page and make an announcement. You can directly publish the announcement
from the change module.
To Publish Announcements,
1. In the Change Details page click the Actions combo box and select the Make an
announcement option. This opens the Add New page.
2. Specify the Announcement Title in the given text field. This is a mandatory field.
3. Specify any relevant information about the announcement in the Description field. Also
specify the result under the Resolution title.
4. Specify the date and time to Show this announcement, between these dates from the
calender button. If this field is not entered the announcement will be displayed in the
dashboard for ever.
5. Select the check box to Show this announcement only to technicians .
6. Select the check box to Send this announcement as mail .
7. Save the changes. You can see the announcement page as shown below. To view the next
and previous announcement in the dash board click the Next and Previous buttons on the
right side of the page.

You can also edit and delete the announcement in the same page.
To edit the announcement,
1. Click Edit button. This opens the Edit Announcement form.
2. Change the details of the announcement in form.
3. Save the changes. All the changes made in the announcement will be saved.
To delete an announcement,
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1. To delete the announcement click Delete button. A dialog pops up asking you confirm on the
delete operation.
2. Click OK to delete. Or click Cancel to retain the announcement.
Alternatively you can also publish announcements to all of your customers or to the technicians group
from the Home page. The announcements are displayed just below the my view requests tab in the
home page as shown below,
All recent announcements will be displayed first based on the date. To view all the announcements
(even completed ones), click the Show All button on the right side of the page.

To add a new announcement
1. Login to ServiceDesk Plus - MSP using the administrator / technician user name and
password.
2. In the login home page, if you have permissions to add an announcement, you will notice the
Add New button in the announcements box as shown above. Click the button. The Add New
Announcement dialog pops up.
3. Enter the Announcement Title. This can be a short statement that describes the
announcement.
4. Type the Announcement Content in the text box provided for the same.
5. Select the From date and To date using the calender icon beside the respective fields.
6. If you wish to publish the announcement only to the technicians and do not wish to expose it
to your requesters, then select the check box Show this announcement only to
technicians. The announcement will be displayed in the home page with a lock beside it.
7. If you wish to Send this announcement as mail then select the corresponding option by
enabling the check box.
8. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.
The announcement will be added and the pop-up will display the announcement details as entered by
you. The announcement title will be displayed in the login home in bold text in the announcement box
with a new icon beside it.
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Send Notifications
To send notifications specific to the change to the CAB members, to change managers, technicians or
to any person concerned,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab in the header pane. This opens the change list view page.
3. Click the title of the change to which the notification has to be sent. This opens the change
details page.
4. Click the Actions combo box and select the Send Notification link. This opens the Send
Notification page.
5. Specify the To and CC address in the given text field.
6. Specify the Subject of the notification in the given text field.
7. Specify relevant information about the notification in the Description field.
8. Send the notification.
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Change Planning
The change plan is formulated to get started with the change process. It needs to have complete
details about the reasons for considering the change that how this change can impact the business.
The change planning stage needs to have following information so that change managers and CAB
have all the details to make informed decisions.
•

Impact Analysis - Risk involved in implementing the change.

•

Rollout Plan - How the plan will be implemented.

•

Back Out Plan - Plan to restore things back to the original state if plan fails.

•

Checklist - List of mandatory items required for the plan to succeed.

To specify the change plan,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the Change List view page. Click the title of the change for
which you need to plan to make decisions. This opens the change details page.
3. Click the Planning tab. You can view the change planning stages one below the other.

To add the Impact details,
1. Click the Add button. A text area is displayed for entering the impact details.
2. Specify the risk involved in implementing the change in the given text area.
3. Save the details. The details get displayed.
4. Click Attach File button to attach a file for the impact details. The maximum size of
the attachment is 10MB.

To specify the Roll Out Plan
1. Click the Add button. A text area is displayed for the roll out plan.
2. Specify how the plan will be implemented in the given text area.
3. Save the details. The details get displayed below the title.
4. Click Attach File button to attach a file for the impact details. The maximum size of
the attachment is 10MB.

To specify the Back Out Plan
1. Click the Add button. A text area is displayed for the back out plan.
2. Specify the plan to restore things back to original state if plan fails in the given text
field.
3. Save the details. The details get displayed below the title.
4. Click Attach File button to attach a file for the impact details. The maximum size of
the attachment is 10MB.
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To enter the Checklist
1. Click the Add button. A text area is displayed for the check list.
2. Specify the list of mandatory items required for the plan to succeed in the given text
field.
3. Save the details.
4. Click Attach File button to attach a file for the impact details. The maximum size of
the attachment is 10MB.
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Recommending Change by CAB
The Change Advisory Board (CAB) is a body that exists to recommend changes and to assist Change
Management in the assessment and prioritise of changes. As and when a CAB is convened, its
members should be chosen who are capable of ensuring that all changes are adequately assessed
from both the business and technical viewpoint. A requester from an account can be a CAB member
for that account.
General Work Flow for approving a change
•

The CAB should be convened for a change. The CAB members can differ for each change.
The CAB member should be a requester from the corresponding account. He should be able
to asses from both the business and technical viewpoint.

•

Once the CAB is convened the change should be sent to the CAB members for
recommendation.

•

The technician who receives the change or is assigned a change will be the owner of the
change and he will send the change for recommendation to the CAB.

•

If the change is recommended by the CAB members, the CHANGE MANAGER should
approve the change. Change Manager is a technician who works for the MSP.

•

A technician acts on a change only when it is approved.

To add CAB members and send for recommendation,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Changes tab. This opens the Change List view page.
3. Click the Title of the change which you need to send for recommendations. This opens the
change details page.
4. Click the Approvals tab. You have to add CAB members, and send the change for
recommendation. CABs for the account in which the change is created will be displayed. The
CAB members have the permission to recommend or reject a change.

To Add CAB Members
5. Click the Add CAB Member button.
6. Select the CAB from the combo box.
7. Select the members list for the committee. The selected members will be responsible for
approving the changes.
8. Save the changes. You will get a confirmation message saying members are added to the
CAB successfully.

Send the change for Recommendation
9. Click Send for Recommendation button to send the change for approval to the CAB
members. Only the members of the CAB can recommend a change. This opens the submit
change for approval page.
10. If the e-mail id is already configured for the CAB members then the Id gets automatically
added to the 'To' field. To text field. This is a mandatory field.
11. Specify the Subject in the given text field. This is a mandatory field.
12. Specify the Description about the change in the given text field.
13. Send the mail to the CAB members for approval. Once the mail is sent the CAB members get
a mail with a link to approve the changes as shown below.
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Administrator has requested your recommendations for this Change - Change Cards in the
Server. Click here to view Change details
http://shawnadams/approval/Approve.jsp?ITEMID=2&MODULE=Change&KEY=211873315245
93&USERID=4
14. Click the link in the mail to open the form as shown below,

15. Select Approve Recommend or Reject radio button based on the change details listed
below the form.
16. Specify the Comments in the given text field.
17. Save the changes.

Approving a change for the Change Manager
If you login as a Change Manager, you can go to the detailed view of the change and go to the
'Approval' tab. This tab will list the approval status from each of the CAB members to which it was
sent for recommendation. Once the CAB members approve the change, you can click on the
'Approve' button to approve the change. Only when the change is approved, the technician who is
assigned the change can take further action on it.
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Approving Change by the Change Manager
Only the Change Manager has the authority to approve the change. Any technician with the
SDChangeManager role is a change manager.
Once the change is recommended by the CAB members the Change Manager should Approve or
Reject the change. Except for the Standard Change type all other change type should be approved
the change manager. The standard change type is a pre-approved change type hence it does not
require any approval from the change manager. Only the approved changes will be taken-up by the
technician to whom the change is assigned.

To Approve the Change by the Change Manager,
1. Log in into ServiceDesk Plus - MSP using your user name and password.
2. Click the Changes tab -> click the title of the change to be approved. This opens the change
details page.
3. Click the Approvals tab, you get a link on the top right hand side of the page to approve or
reject the change as shown below,

4. Click the Approve link to approve the change. This opens a dialog box.
5. Specify the comments in the box and Save the details.
6. Text in the link changes as Approved with the change manager name, date and time will also
be displayed as shown below. At any time to reject the change, you can click the reject link
next to the approve link.

In the change details page Approval status of the change would show as Approved in a non
editable format. Also on the top right hand side of the page the Approval status of the change
would change as Approved.
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Project Management
Project management - the discipline of planning, organizing, and controlling resources to achieve
specific goals is now a part of ServiceDesk Plus - MSP. Using project management you can create
projects: a temporary endeavor to achieve certain objective/change (within a specific time period)
beneficial to your organization.
Effective management of resources like time, budget, manpower and the quality of work, is the
primary goal of project management.

Features:
•
•
•
•
•
•
•
•

Milestones: These help you plan the project, decide its various stages, and also serve as
landmarks that identify how close a project is to completion.
Tasks: Entities that decide the Work Breakdown Structure (WBS) of the project. They are a
part of Milestones.
Task Relationship: Decide parent/dependent tasks, connect tasks that are similar, by
establishing Task Relationship.
Flexibility in Swapping Member Roles: Ability to switch/change "member roles" anytime
allows administrators to focus on Milestones/Tasks requiring immediate attention, thus
speeding up the project by focusing on grey areas.
Gantt View: Chart presenting a bird's eye view of the project: a standpoint from where not
only the entire project can be viewed but also can be reconfigured based on the approaching
deadline.
Timesheet: Log for tracking time spent on tasks involved in the project. It helps
administrators take necessary steps based on the project's progress rate.
Comments: Comments that enable members/administrators to share their views on each
other's tasks for the betterment of the project.
Project Overview Map: Map presenting 'a clear picture' of the entire project.

Projects created within the Projects Module can also be:
•

Associated with Change using 'Associate Change' option
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Project Management Workflow

Zoho Corporation Pvt. Ltd.
189

ManageEngine ServiceDesk Plus MSP – Admin Guide

Working with Projects
Learn how to create, edit, delete, and associate change with projects under this section.

•
•
•
•
•
•

Creating Projects
Scheduling Projects
Editing Projects
Deleting Projects
Project Overview Map
Associating Change

Creating Projects
There are two ways in which the new project form can be accessed in the application,
a. Quick Actions drop down
b. Projects Tab

a. Quick Actions drop-down menu
The Quick Actions drop-down menu is a quick navigator to instantly access the New Project form.
Click Quick Actions drop-down menu -> Project under Create New block.

b. Projects Tab
To create a new project from the project tab,
1. Click Projects tab in the header pane.
2. Select an account to which you would like to create a project from the Account drop down.
3. Click the New Project button to open the New Project form. (Use 'Add New Link' while
creating first Project.)
4. Specify the Project Title, Description and Project Code in the fields provided.
5. Select the Project Type, Status and Priority from the drop down list.
6. Specify Project Schedule Start and Schedule End date.

Adding more details to the Project:
To evaluate Project against the projected plan, you are provided with the following additional fields:
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To add more details about the project, click More Fields... button in the New Project form.
1. Select the Actual Start date of the project. This information is used for recording real-time
project completion date.
2. Select the Projected On date on which the project is projected to get completed.
3. Enter the approximate hours required for completing the project in the Estimated Hours field.
4. Enter the Actual Hours required to complete the project.
5. Enter the planned and real-time expenditure towards the project in the Estimated Cost and
Actual Cost fields.
6. Click Save. You will find the Attach button beside the Project Attachments header.
7. To add an attachment, click Attach button. You can use also use New file link to when you
are attaching the file for the first time. This opens an Attach File pop-up.
1. Click Browse button and select the file to be attached from the file chooser window
and click Open button.
2. Enter any Description about the attachment.
3. Click the Attach file button. The selected file is listed below the Project Attachments
heading. Please ensure that the maximum size of the attachment is 10 MB.

Scheduling Projects
Project Scheduling not only helps you schedule the project but also determine whether the project is
'on-schedule', 'delayed' or 'ahead' by comparing it against real-time completion.
To schedule the project do the following:
1. Configure the Scheduled Start and Scheduled End Date
2. Fill in the Actual Start and Actual End Date (upon project completion)
3. Based on Scheduled/Actual Dates, project would be considered:
o
o
o

On Schedule if the Scheduled Date and Actual Date are the same.
Delayed if the Project (Actual Date) has past the Scheduled Date. (no of days by
which project is delayed gets displayed on the project list view page)
Ahead if the Project (Actual Date) is completed before the Scheduled Date. (no of
days by which project is ahead gets displayed on the project list view page)

Editing Project
To edit a project,
1. Click the Title of the project which you want to edit from the Project list page. This opens the
Project Details page.
displayed below the Project title to modify the project details.
2. Click the Edit icon
3. On modifying the details, click Update Project button to save the changes. If you do not want
to save the changes, click Cancel.
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Deleting Projects
Project can be deleted in two ways:
a. Bulk Delete: From Project List view page, select Project(s) to be deleted, and click on
Delete button.
b. Single Delete: Select the project to be deleted by clicking on the project title in the Project
List view page and click on Delete icon

.

Project Overview Map
Project Overview Map provides a bird's eye view of the project. This can be viewed by opening a
--> Project Overview Map.
project to view the Project View page and clicking on the Actions icon
It is a map that walks you through the entire project with its Milestones and Tasks representing clearly
the different layers existing within the project.
This map also indicates whether Milestones/Tasks have been completed by means of a Tick Mark
.
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Associating Change
Projects, apart from serving as entities that help achieve some specific goal, can also be associated
with Change in the form of Change Implementation.
Project can be used as a large scale change implementation which has its own members and tasks.
and select Associate Change option.
To associate project with Change, click on Actions icon
The Associate Project to Change window is displayed. Select the Account from the drop down. The
Change related to the selected Account are displayed. Select the Change to be associated and click
Associate button.
Note: An associated Change can be dissociated by clicking on 'Dissociate Change' option from the
Actions menu.

Milestones
Milestones are critical events which receive special attention within the project management
framework. Besides serving as markers that indicate a project’s progress, milestones allow you to
group Tasks, establish relationship between Tasks, and organize their order. They ensure the project
is moving in the right direction. A completion of a milestone is a major step towards completion of the
project.

Scenario:
To understand Milestones better let us consider an IT Test Environment SetUp Project.
Superficially speaking, an IT Test Environment Set Up can be split into:
•
•
•

Database Configuration
Workstation Configuration
Test Network Configuration

These major tasks - that outline the entire project - which in turn will contain several other
tasks are known as Milestones.

Advantages
•
•
•
•

Uninterrupted workflow with no delays.
Proper classification of Tasks, their relationships and dependencies.
Clear presentation of 'who does what, when, and for how long'.
Ensure projects are on schedule.
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Milestones - Stepping Stones to Project's
Completion

Working with Milestones
Adding Milestones is the first step to creating a project. They help outline the entire project and
present a clear picture of the innumerable Tasks involved by allowing project members to design the
Task Hierarchy and Task Dependency.

In this section you will learn how to: create, edit, and delete Milestones.

•
•
•
•

Creating Milestones
Scheduling Milestones
Editing Milestones
Deleting Milestones

Creating Milestones
To create a milestone,
1. Click on Milestones tab in the Projects View page.
2. Click the Add New button to open the New Milestone form. You can use 'Add New' link while
creating first Milestone.
3. Specify the Title and Description of the Milestone.
4. Select the Status, Owner and Priority from the drop down.
5. Specify Project Schedule Start date.
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Adding more details to Milestone
To add more details about the milestone, click More Fields... button in the New Milestone form.
1. Select the Actual Start date of the milestone. This information is used for recording real-time
milestone completion date.
2. Select the Projected On date on which the milestone is projected to get completed.
3. Enter the approximate hours required for completing the milestone in the Estimated Hours
field.
4. Enter the Actual Hours required to complete the milestone.
5. Enter the real-time expenditure towards the milestone in the Actual Cost fields.
6. Click Save. You will find the Attach button beside the Milestone Attachments header.
7. To add an attachment, click Attach button. You can use also use New file link to when you
are attaching the file for the first time. This opens an Attach File pop-up.
1. Click Browse button and select the file to be attached from the file chooser window
and click Open button.
2. Enter any Description about the attachment.
3. Click the Attach file button. The selected file is listed below the Project Attachments
heading. Please ensure that the maximum size of the attachment is 10 MB.

Scheduling Milestones
Milestone Scheduling not only helps you schedule the milestone but also determine whether the
milestone is 'on-schedule', 'delayed' or 'ahead' by comparing it against real-time completion.
To schedule the milestone do the following:
1. Configure the Scheduled Start and Scheduled End Date
2. Fill in the Actual Start and Actual End Date (upon project completion)
3. Based on Scheduled/Actual Dates, milestone would be considered:
o
o
o

On Schedule if the Scheduled Date and Actual Date are the same.
Delayed if the Project (Actual Date) has past the Scheduled Date. (no of days by
which project is delayed gets displayed on the project list view page)
Ahead if the Project (Actual Date) is completed before the Scheduled Date. (no of
days by which project is ahead gets displayed on the project list view page)

Editing Milestone
To edit a milestone,
1. Click the Title of the milestone which you want to edit from the Milestone list page. This
opens the Milestone Details page.
displayed below the Milestone title to modify the milestone details.
2. Click the Edit icon
3. On modifying the details, click Update Milestone button to save the changes. If you do not
want to save the changes, click Cancel.
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Deleting Milestones
Milestones can be deleted in two ways:
a. Bulk Delete: From Milestone List View, select Milestone(s) to be deleted, and click on
Delete button.
b. Single Delete: Select the project to be deleted by clicking on the project title in the Project
List view page and click on Delete icon

.

Working with Tasks

•
•
•
•
•
•

What are Tasks?
Configuring Tasks
Scheduling Tasks
Adding Worklog
Editing Tasks
Deleting Tasks

What are Tasks?
Task is an activity that is a part of a Project. In other words, Project has multiple phases with Task
being a small incident/part of each and every phase. Tasks can be associated with Milestones or can
be directly linked to the project. In general, Tasks are the most basic elements that ensure various
actions are performed in an orderly manner within the project.

Scenario:
To understand Tasks better let us consider the same IT Test Environment SetUp Project used
for Milestones:
IT Test Environment Set Up can be split into 3 major phases - that is, milestones:
•
•
•

Database Configuration
Workstation Configuration
Network Configuration

These Milestones can further be divided into following steps: determining database
purpose, organizing required information, dividing information into tables and so on for
database configuration. Likewise workstation and test configuration too would have several
steps. These actions that may or may not be a part of Milestone are known as Tasks.
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Configuring Tasks
To create a task for a milestone,
1. Select the Milestone from the Milestone List view and click on the Tasks tab in the header
pane.
2. Click Add New button to open the New Task form. (Use Add New Link while creating first
Task)
3. Specify task Title and Description.
4. You can add a task instantly by using the pre-defined task templates in the application. Select
a template from Use Task Template drop down. The task details such as Title and
Description are automatically populated.
5. The milestone associated will be displayed in the Associated Milestone field.
6. Select Status and Priority from the drop down.
7. Select Owner (technician) of the task from the drop down. (Members of this project with
"Project View" permission will be listed in the owner drop down.)
8. Specify Task Scheduled Start and Scheduled End date.
9. If the task requires on-site visit, then select the Requires on-site visit check box.

Adding more details to Task(s)
To indicate Task's progress and to discuss about ways of bettering it, you are provided with the
following fields:
To add more details about the task, click More Fields... button in the New Task form.
1. Select the Actual Start date of the project.
2. Select the Task type from the drop down.
3. Specify the % of completion that helps denote the extent to which the task has been
completed (any value between 1 - 100).
4. Specify the Additional Cost in the field provided.
5. Specify any relevant comment about the task in the Comments field.

Scheduling Tasks
Task Scheduling not only helps you schedule the task but also determine whether the task is 'onschedule', 'delayed' or 'ahead' by comparing it against real-time completion.
To schedule the task do the following:
1. Configure the Scheduled Start and Scheduled End Date
2. Fill in the Actual Start and Actual End Date (upon project completion)
3. Based on Scheduled/Actual Dates, task would be considered:
o
o

On Schedule if the Scheduled Date and Actual Date are the same.
Delayed if the Task (Actual Date) has past the Scheduled Date. (no of days by
which project is delayed gets displayed on the project list view page)
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o

Ahead if the Task (Actual Date) is completed before the Scheduled Date. (no of
days by which project is ahead gets displayed on the project list view page)

Adding Work Log
Using this option, the time spent by a technician on a task can be recorded. It takes the time of
creation to till the request is closed.
1.
2.
3.
4.
5.

Click the Title of the task to which you like to enter work log.
Click Work Log tab.
Select Owner (technician) from the drop down.
Select the Start Time and End Time of the task from the calendar lookup.
The Time Taken To Resolve the task will be automatically displayed on selecting the Start
Time and End Time.
6. If there are any extra charges specify in the Other Charges field.
7. Specify any relevant information about the time spent in the Description field.
8. Click Save button. The work log is listed in the Work Log tab.

Editing Task
To edit a task,
1. Click the Title of the task which you want to edit from the Task List view page. This opens the
Task Details page.
displayed below the Task title to modify the task details.
2. Click the Edit icon
3. On modifying the details, click Save button to save the changes. If you do not want to save
the changes, click Cancel.

Deleting Tasks
Task can be deleted in two ways:
a. Bulk Delete: From Task List view page, select Task(s) to be deleted, and click on Delete
button.
b. Single Delete: Select the task to be deleted by clicking on the task title in the Task List view
page and click on Delete icon

.
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Tasks - Basic Elements of Projects
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Task Dependency & Task Order
•
•

Configuring Task Dependency
Configuring Task Order

Configuring Task Dependency
Projects contain innumerable tasks which in some way would be connected to each other since they
are working in unison towards the same goal. To clearly define such relationships between tasks and
to distinguish parent tasks from child tasks you are presented with the option of configuring task
dependencies.
To configure task dependency,
1. Select Milestone from the Milestone List view and click on the Tasks tab in the header pane.
2. Click Dependencies button.
3. Dependency Chart displays all available Tasks .

4. To configure Task Dependency, hover over a Task. This opens up the Task Dependency
dialog box.
5. The Task Dependency dialog displays the details of the task and has Select Parent &
Remove buttons.
6. Click on Select Parent button. All Tasks present would be highlighted from which the Parent
Task can be chosen.
7. Click Remove button to remove/reconfigure the established relationship.
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Configuring Task Order
Task dependency helps decide which task depends on what thus giving a structure to the project. But
still it does not give a definite structure in the sense it does not decide the order in which these tasks
would be executed. Task organization/ordering is very essential for a project's success and this can
be brought about by clicking on Organize button.
To organize tasks follow the steps mentioned below:
1.
2.
3.
4.
5.
6.

Select Tasks tab.
Click Organize button. The Organize Tasks dialog opens up.
To reorganize a Task, Ctrl + Click (or) Shift + Click on the Task.
Use 'Move Up' and 'Move Down' buttons to change Task's position.
Click Save.
To de-select a Task, click Ctrl + Click.

Project Members
Efficient staff alone does not ensure a project's success. Meticulous planning of project staff; the
permissions given to a projectrole; the flexibility in changing project roles and more come into play to
ensure the project as a whole turns out to be a success.
To configure the project's staff, that is, to add members to a project, assign roles to project members
and establish the project hierarchy click on Members tab.

•
•
•
•
•

Adding Project Members
Changing Member Roles
Changing Member Status
Deleting Project Members
Member Hierarchy Diagram

Adding Project Member(s)
•
•
•
•

Click on Members tab in the Project Details page. Click Add Members button.
Available Users List already configured in ServiceDesk Plus - MSP will be displayed.
Select Project Member(s) by enabling the check box beside the member name. (OR you can
add Technicians of your choice).
Select Project Role from Project Role drop-down and click on ADD button.
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Changing Project Member Roles
However well-planned your project might be things are bound to go off-course when there are
innumerable Tasks to be executed. To ensure project managers are ready enough to face such
incidents they are allowed to 'change project member role' as and when required.
This feature is predominantly used to ensure grey areas of the project get enough attention. That is,
let's say a project member has completed his part and is free, yet the project is progressing at a rather
slow rate, then this member could be assigned some other role that might help speed up the project.
Speeding up the Project is not the sole objective, you can also use this option just to change the role
of the project member, if such a need arises.
To change the role,
•
•
•

Click on Members tab.
Click on Project Role of the member for whom you want to change the role. A drop down box
appears.
Select a role to be assigned to the member from the drop down.

Changing Project Member Status
While creating a Project a number of unforeseen events that might occur should be taken into
account. For example: a member falling sick, a member deciding to quit, or a member requesting a
role change and so on.
Such project members can be kept in the bench by changing their status to Inactive. Milestones and
Tasks associated with inactive members can be assigned to other project members. Inactive project
members can be reinstated by change their status to active.
•
•
•
•

Click on Members tab.
Click on User Status to be changed. A drop down box appears.
Select Inactive option to keep Project Member in the bench.
Select Active option to reinstate Project Member.

Note: At a given time, only one role can be assigned to a project member.
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Deleting Project Member(s)
Project Members can be deleted in two ways:
a. Bulk Delete: From Member List View, select Project Members to be deleted by enabling the
check box beside the member name, and click on Remove button.
b. Single Delete: Select Project Member to be deleted and click on Delete icon

.

Member Hierarchy Diagram Example

Zoho Corporation Pvt. Ltd.
203

ManageEngine ServiceDesk Plus MSP – Admin Guide

Timesheet
Timesheet Tab is a single stop solution for viewing the total time spent by project members on various
Tasks of a Project. And by summing up the total time spent, the Timesheet tab, also displays the
cumulative time spent by all the project members on various tasks.

Note: Timesheet reflects the technician hours spent information from the worklogs of various
Tasks.
It is also possible to view separately the worklog details of tasks pertaining to a project member. To
view these details, click the respective member's name in the Timsheet List View.

Advantages:
•
•
•
•

Provides bird's eye view of total time spent on the project.
Aids in preventive maintainence while working on similar projects in the future.
Helps evaluate scheduled project against the real-time project.
Supplements on-schedule project completion.

Note: Milestone Timesheet logs time spent on Tasks belonging to Milestones, whereas Project
Timesheet tab logs timespent on overall Tasks belonging to a Project.
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Comments & History
•
•
•
•

What are Comments?
How can comments be added/deleted?
History Tab
Recent History Updates Button

What are Comments?
Comments allows project members to communicate with each other. High level authorities can use
them to dispatch orders to their subordinates. Above all, the most important aspect of this feature is
that it allows members belonging to different ranks share their ideas, discuss about what they are
doing, and work towards the betterment of the project.

Adding/Deleting Comments
1. Adding: Click on Comments Tab. Type your Comment and Save it.
2. Deleting: Click on Delete Button

to delete a Comment.

History Tab
History tab lets you view all the events that occur within a project. It lets you know 'who does what and
at what time'. To access a project's history click on History tab. It is possible to hide/show a project's
history by clicking on the 'show/hide' history button

.

Recent History Updates Button
Recent History Updates Button
present in the projects list view page lists events that occur
across various projects present in the projects module, unlike history tab which presents information
pertaining only to a specific project. Project administrators who might own all the projects present in
the module benefit greatly from this option.
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Gantt Chart

•
•
•
•

What is a Gantt Chart?
Viewing and Configuring Gantt View
Accessing Projects via Gantt Box
Gantt View Tab and Gantt View Across All Projects Button

What is Gantt Chart?
Gantt Chart is a bar chart that illustrates a project schedule. This chart also illustrates project
elements - along with their schedule against the project calendar - and summarizes the entire project
using the chart. It presents a clear picture of the different phases of the project and also of the various
activities that occur in the project's work breakdown structure (WBS).
Advantages:
•
•
•

Provides bird's eye view of a project and also serves as a one stop solution for accessing the
entire project module with all it projects (provided, the technician is assigned with Project
Admin role).
Effective Resource Management as project constraints like time, manpower and amount of
work remaining can be viewed and regulated as per situation demands.
Rescheduling of Milestones/Tasks and project member role change, if such a need arises,
can also done via Gantt Chart.
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Viewing and Configuring Gantt View
1. Click on Gantt View tab
2. Gantt Chart with its default view will get displayed.
3. Configure Gantt Chart as per your requirement using
a. Gantt Row Type Filter: Available options are Members, Milestones and
Tasks.
b. Gantt Column Type Filter: Available options are Tasks (Open, Closed and
All) & Milestones (Open, Closed and All)
c. Project Calendar Filter: Available options are Hours, Day and Month
d. More Settings Filter: Available options are Priority, Task Types and Status
4. Gantt Chart would be modified based on your requirements.

Accessing Projects via Gantt Box
Gantt Box that appears on mouse over a "milestone/task" serves as a window through which the
"milestone/task" can be accessed and edited according to the changes taking place within a project.
An entire project can be accessed through Gantt Box if the project member has the rights to do so.
This quick access enhances the effectiveness of Gantt Chart and is very useful in supervising the
project.
Using Gantt Box the following can be done:
1.
2.
3.
4.

Rescheduling of Milestones (or) Tasks and Changing of Milestone/Task details
Reassigning of Milestones/Tasks to Project Members
Changing of Milestone/Task Status
Adding Worklogs and Comments
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Gantt View Tab and Gantt View Across All Projects Button
Gantt Chart can be accessed in two different ways:
•

•
•
•

By clicking on "Gantt View" Tab (in the project's pane) (or) by clicking on "Gantt View
Across All Projects Button"
As the name suggests, the latter presents the gantt view of all projects present in projects
module
Gantt View Across All Projects Button present in the projects list view page is useful for
project administrators
Using this button gantt chart can not only be filtered based on milestones and tasks but also
based on project names and project status.
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Assets
Assets
ManageEngine ServiceDesk Plus - MSP helps to manage all IT and Non-IT assets of your accounts.
ServiceDesk Plus - MSP offers a single view to track and manage all assets with ServiceDesk Plus MSP , you can track and manage ownership of
•

IT, Non-IT and Asset Components.

•

Software Asset Management

IT & Non-IT Asset Management
ServiceDesk Plus - MSP helps you to manage,
•

IT assets such as, workstations, switches, routers, printers, and access points

•

Non-IT assets such as basic fixtures, furniture, chairs, tables, projectors, and desk phones

•

Asset Components such as keyboards, software, software licenses and even printer inks.

Software Asset Management
Software License Management
ServiceDesk Plus - MSP helps you to manage software licenses installed across all accounts.
You can consolidate and manage all software licenses from a single screen. ServiceDesk Plus
- MSP will scan and automatically pickup license keys for Microsoft Windows and Microsoft
Word. You can key-in all the licenses purchased earlier and track future purchase of software
licenses through the Purchase module.
Software Metering
ServiceDesk Plus - MSP helps you to track the usability of the installed software across the
account. It gives the count of rarely used, frequently used and occasionally used software for
each account.
Software Compliance
ServiceDesk Plus - MSP tracks purchased versus installed licenses helping you to ensure
software license compliance for each account. The scheduled scan alerts you when an
unauthorized software installation is detected, ensuring software compliance on an on-going
basis.
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IT Assets
IT Assets
All IP based assets are discovered under IT assets. The list of possible IT assets are given below,
•

Workstations

•

Laptops

•

Printers

•

Switches

•

Servers

•

Routers

•

Access Points

•

Adding New IT Assets

•

Editing Assets

•

Adding Assets to Groups

•

Assigning Assets to Department

•

Modifying the State of the Assets

•

Change log-in Credentials of IT Assets

•

Bulk Scan of IT Assets

•

Deleting Assets

•

Importing Asset Details from CSV

•

Viewing Asset Details

•

Copying Resources

•

Attaching Assets

•

Attaching Components

•

Attaching Documents

•

Assigning Assets to Users/Departments/Assets

•

Adding New Workstation

•

Bulk Scan of Newly Added Workstations

•

Changing Workstation as Server

•

Viewing Workstation Details

•

Print Preview of Workstations

•

Modify Type

•

Adding Software

•

Deleting Workstations
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Adding IT Asset
IT Assets other than workstations are configured under IT Assets. To add a new asset,
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password. This opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab in the header pane. This opens the Asset home page.
on the top left hand side of the page ->
3. Click Quick Actions link
Click Asset option from the drop down menu. (OR)
Click IT Assets under Resources block on the left side of the page

-> Select any one of the listed IT assets link. e.g.
Access points, printers etc. This opens the particular IT asset page.
4.

Click New button. This opens Add Asset page.

5. Select the Product Name of the asset from the combo box. If required, you can add
a new product name by clicking Add New link beside the product name field. This is
a mandatory field.
6. Select the Vendor Name from the combo box. If required, you can add a new vendor
by clicking the Add New link beside the vendor name text field.
7. Specify the Asset Name in the given text field. This is a mandatory field.
8. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the
corresponding text fields.
9. Specify the Acquisition Date & Expiry Date from the calendar button.
10. Select the Site from the combo box.
11. Specify the Location in the given text field.
12. Specify the Asset State by selecting the current status of the asset from the combo
box.
If the asset is in Use state you need to associate or assign asset to department or
user or asset.
1. Allocate the asset to an Asset or to an User or to the Department by
selecting any of the two radio button. Say Associate to Asset or Assign User/
or Department.
2. If you choose to associate asset to an asset then select the asset name from
the Choose Asset combo box. Or if you have chosen to assign to user or the
department then select User or Department from the combo box.
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3. If the asset is leased select the check box Asset is Leased. If the asset is
leased then specify the From and To date from the calendar button.
13. Click Save button to save the changes. To save and add another asset click Save
and add new button.
Note:
1. The user/department/domain/asset are populated based on the site selected.
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Editing Assets
To edit the resource details,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab -> select the IT Assets link on the left hand side of the page. This
opens the list view page of the IT assets.
3. Click the title of the IT asset to be edited. This opens the Asset details page.
4. Click Edit button on the top right hand side of the page (Or) click the Actions combo box next
to the edit resource button -> select the Edit option. This opens the Edit Asset page.
5. Edit the Asset Details block such as Product Name, Asset Name, Tag, Serial No, Bar
Code, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location.
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In
Repair and so on. Then the Associate the asset to User or Department details or Assign to
User or Department details.
7. Update the changes. You can see the assets details getting updated.
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Adding Assets to Group
You have two types of groups in ServiceDesk Plus - MSP say, Static group and Dynamic. Add to
group option in asset list view page is to group bulk of assets. These assets will be grouped under the
Static group by default.
To Add IT Assets to group,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click any of the IT Assets link under the Resources block on the left hand side of the page.
Select any one of the listed IT assets link. e.g. Access points, printers etc. This opens the
particular IT asset page.
3. Select the assets to be added to the group by enabling the check box. Click Actions button > Add to Group option. This opens the Add Resource(s) to page.
4. By default you can group assets only to the static group. Either to the Existing static group
or New static group can be added.
5. If you would like to group the assets under existing static group then click the corresponding
radio button. Select the group name from the combo box.
6. Else, if you would like to add a new static group and group the assets, click New Group radio
button. Specify the Group Name and relevant information about the group in the Description
field.
7. Click Save button to save the changes.

Zoho Corporation Pvt. Ltd.
214

ManageEngine ServiceDesk Plus MSP – Admin Guide

Assigning Assets to Department/Site
Assigning IT Asset to Department
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the corresponding IT Asset link
say, servers, workstations and so on. This opens the selected Assets list view page.
4. Click on the Asset Name to be assigned to a Department/Site by enabling the check box.
5. Click the Actions menu -> select Assign to Department option from the list. This opens Add
Resource(s) to pop-up window.
6. Select the Department Name from the combo box and Save the details.
Assigning IT Asset to Site
1. From the Asset list view page, click the Actions menu -> select Assign to Site option from
the list. This opens Assign Resource(s) to Site pop-up window.
2. Select the Site name from the combo box.
3. Save the details. Else click Cancel button.
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Modifying State for IT Assets
To modify the state of IT Assets,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This
opens the Assets list view page.
4. Select the assets to be modified of their status by enabling the check box. Click the Actions
menu and select the Modify State option. This opens the Modify State pop up window.
5. Select the State from the combo box. For ex, In Store, In Use and so on.
6. Save the changes.
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Change log-in Credentials for bulk of IT Assets
You can change the log-in credentials for bulk of assets. You have Global credentials and Local
credentials. Global credentials are common login permissions for all the assets. Local credentials are
private login permissions for an asset (generally used to restrict the access permissions to everyone).
To change the login credentials,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click IT Assets under Resources block on the left hand side of the page. Select the
respective IT assets link. e.g. Access points, Printers and so on. This opens the
corresponding IT asset page.
4. Select the IT Assets to change the log-in credentials by enabling the check box. This opens
the assets list view page. Click the Actions combo box --> and select the Change
Credentials option. This opens the corresponding page.
5. Select either Global Credentials or Local Credentials by selecting the radio button.
Global Credentials
1. On selecting the global credentials, select the Network from the combo box.
2. Select the communication Protocol either SSH or Telnet option for linux workstations
by enabling the corresponding radio button.
3. If you would like to Scan Software in Linux Workstations then enable the
corresponding check box.
4. Specify the User Name and Password for the network.
5. Save the details. If you would like to Save and Scan now click the corresponding
option.
Local Credentials
1. On selecting the local credentials, specify the User Name and Password.
2. Select the communication Protocol either SSH or Telnet option for linux workstations
by enabling the corresponding radio button.
3. If you would like to Scan Software in Linux Workstations then enable the
corresponding check box.
4. Save the details. If you would like to Save and Scan Now click the corresponding
option.
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Bulk Scan of IT Assets
Scan now option is to scan group or bulk of assets for assets data. Each time when a new asset is
added, instead of scanning all the assets, you can scan the newly added assets for resource details.
If you have changed the credentials for the assets or if you want to specify the log-in credentials for an
asset then select the Change Credentials option under the actions menu and specify the details.
Then click Save and Scan now button for scanning the assets.
To scan bulk of IT Assets,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This
opens the Assets list view page.
4. Select the assets to be scanned by enabling the check box. Click the Actions tab -> select
Scan Now option. This opens the Scan wizard page with total number of scanned and failed
assets. And you can view the asset details in the Resource details page.
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Deleting Assets
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password. This opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click IT Asset link under the resource block on the left hand
side of the page. This opens the IT Assets list view page.
3. From the assets list view page, select assets to be deleted by enabling the check
box.
4. Click Delete button to delete the selected assets. You can see the selected assets
deleted from the list.
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Importing Asset details From CSV
ServiceDesk Plus - MSP helps you to import your asset details saved in CSV (Comma Separated
values) format. If you have asset details in .XLS files, open it with Microsoft Excel and save it as .CSV
files and then import it.
1. From the Assets view list page, click the Import from CSV link. This opens the
Resource Import Wizard page.
2. Select the Resource Category from the combo box, IT or NON IT. This is a
mandatory field.
3. Select the Resource Type from the combo box.
If you have selected Non-IT as resource category then the resource type would display
components and assets. (OR) If you have selected IT as resource category then the
resource type would display, components and IT Assets. Under IT Assets you have
workstations and other IT-Assets. This is a mandatory field.
4. Select the Account from the combo box. This is a mandatory field.
5. Select the Site from the combo box. This is a mandatory field.
6. Locate the .CSV file using the Browse button.
7. Click on Step2 button to go to the next page. Click Previous button if you need to go
the previous page.
8. If you have selected the resource type as workstations then select the Workstation
details from the combo box. Also specify the Asset Details by selecting from the
combo box. The columns in .CSV file are populated in the select boxes beside each
field label. Advent Net Manage Engine ServiceDesk Plus - MSP asset field’s needs
mapping with the field names from the .CSV file.
9. Map the Workstation Name for workstation details. For asset details map the
Product Type, Product Name, Asset Name from the combo box. These are
mandatory fields.
10. Map the Model, Tag, Manufacturer, Operating System and Domain details for the
workstation details.
11. Map the Asset Tag, Asset Serial No, Bar Code, Vendor Name, Asset Cost, Warranty
Expiry Date, Expiry Date, Location, Assigned to User, Assigned to Department from
the combo box.
12. Map the Acquisition Date field with the relevant field in the .CSV file. Also map the
order of the acquisition date i.e. date/month/year available in the .CSV file.
13. Click Step3 to go the next page. Click Previous button if you need to go the previous
page.
14. Click Import Now button to import the existing data from the .CSV file. Once the data
is imported, you can see the Import Wizard page with result break-up.
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Viewing IT Asset Details
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click IT Asset link on the left hand side of the page. This opens the IT
Assets list view page.
3. Click on the IT Asset name to view the IT Assets details. By default Resource Info tab details
are displayed.

Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.

Viewing Resource Info Details
Resource Info tab displays the Resource Details such as,Resource Name, Tag, Bar Code,
Serial No Region, Cost, Acquisition Date and many other details are displayed.

Viewing Relationships
This relationship tab shows the assets association to other Assets, Business Services, Users
and Components.
On clicking the tab -> click the Add Relationship button on the top right hand side of the page.
Connection Relationship
1. Click the Connection Relationship option from the list. This opens the Connection
Relationship page.
2. To connect the assets to other assets select the Assets radio button.
1. Select the assets to be connected from the Asset List.
2. Move the selected asset to the Connected Assets list using the >> button.
3. Save the details. You can see the connected assets under the Connected to
Assets block.
Usage Relationship
1. Click the Usage Relationship option from the list. This opens the Usage Relationship
page.
2. Select the Assign the asset to User/Department radio button to associate the asset
to the user/department.
1. Select the User from the combo box.
2. Select the Department to be associated from the combo box.
3. If the Asset is Leased then select the corresponding check box.
4. Save the changes. (Or)
3. Select the Associate to Asset radio button to assign the asset to the asset.
1. Choose Asset to be associated from the combo box.
2. Save the details.
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Container Relationship
1. Click the Container Relationship option from the list. This opens the Container
Relationship page.
2. Select the Components radio button to associate the components to the user. Select
the type of components to be displayed in the list by selecting it from the choose
product combo box.
3. Select the components from the Components List and move it to the Attached
components list using >> button.
4. Save the details.
Note:
1. The user/department/domain/asset are populated based on the site selected.

Viewing History of IT Asset
Click on the History tab to view the IT Asset history. This gives the complete IT - Assets
Resource Ownership History on date and State of the components.

Request Details
On clicking the Request Details page you will be able to view all the requests raised for the
asset.
On Clicking the request title you can view the details of the request, requester details, Assets
belonging to the user, Time elapsed to solve the request, resolution for the request and history
of the request
Also you can send reply for the request or forward the request to the technician. You can
Search associated problem and change or add new problem or change to the request.

Viewing Contracts of the IT Asset
Click on Contracts tab to view the contracts attached to the IT Asset. This gives the complete
details about the contract such as, vendor name, support details, contract rules, expiry date,
cost and other rules.

Viewing Costs
1. Click on the Costs tab to view the costs associated to the IT Asset.
2. Click on Add Cost button at the right side of the page to add cost to the IT Asset.
3. Select the Cost Factor from the combo box. For ex. Service Cost. This is a
mandatory field.
4. Specify the description about the cost in the Description field. Say if the cost factor is
service cost you can specify important information about the service cost.
5. Specify the Amount in $ in the Amount field. This is a mandatory field.
6. Select the Date from the calendar button. This is mandatory field.
7. Click on Add Cost button to add the cost. You can see the cost added to the IT Asset
shown in the Other Costs list view page.
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Copying Assets
Using Copy Resource option you can make multiple copies of the resource and its details. On making
multiple copies of the resource, it becomes easier for the technician to add bulk of similar assets. The
technician need not manually enter all the resource details for each resource. The new copies of the
resource will be assigned with new asset name and rest of the details is retailed as is.
Example:
If you have ten printers of the same configurations in your organization, then in this case, enter the
configurations for one printer and save it. Then copy the same printer for ten times and add its
configurations to other printers.
To make multiple copies of the Resources,
1. Click the Assets tab in the header pane. This opens the assets home page.
2. Click IT Assets under Resources block on the left hand side of the page. Select the
respective IT assets link. e.g. Access points, Printers and so on. This opens the
corresponding IT asset page.
3. Click the Title of the assets to be duplicated. This opens the Asset details page.
4. Click the Actions menu on the right hand side of the page. Select Copy Resource option.
This opens the Copy Resource pop up window as shown below,

5. Specify the Number of Copies to be made for the resource in the given text field.
6. Copy the resource. You can see the list of resource copies listed in the list view.
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Attaching Assets
To attach assets to the IT Assets,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets link under the Resource block on the left hand side of the page. Select
the corresponding IT Asset link say, Printers, Access Points and so on. This opens the Asset
list view page.
4. Click the title of the asset to be attached with an asset. This opens the asset details page.
5. Click the Actions combo box -> select the Attach Asset option from the list. This opens the
Attach Asset pop up window.
6. If you would like to display the list of all assets or filter specific asset then select the assets to
be displayed from the List combo box. Ex: Printer, Access Points and so on. Also select the
type of asset such as asset in store, in use and so on from the of type combo box.
7. You have two columns, such as Asset list and Attached Assets list. You have to select the
assets to be attached from the assets list and move it to the attached assets list using the >>
button. To remove the assets from the attached assets list use the << button.
Example:
If you would like to attach a printer to a workstation then select the list of assets to be
attached from the assets list and move it to the attached assets list.
8. Save the changes. If you would like to detach all the attached assets then select the Detach
All option.
Note:
1. The asset(s) are populated based on the account selected.
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Attach Component
To attach components to an asset,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane, this opens the assets home page.
3. Select the IT Assets link under the Resource block on the left hand side of the page. Select
the corresponding IT Asset link say, Printers, Access Points and so on. This opens the IT
asset list view page.
4. Click the Title of the asset to be attached with an component. This opens the asset details
page.
5. Click the Actions combo box -> select the Attach Component option from the list. This
opens the Attach Component pop up window.
6. If you would like to display the list of all components or filter specific components then select
the components to be displayed from the List combo box. Ex: keyboard, mouse and so on.
Also select the type of component such as component in store, in use and so on from the of
type combo box.
7. You have two columns, such as Component list and Attached Components list. You have
to select the components to be attached from the components list and move it to the attached
components list using the >> button. To remove the component from the attached component
list use the << button.
Example:
If you would like to attach a keyboard and a mouse to a workstation then select the list of
components to be attached from the component list and move it to the attached component list.
8. Save the changes. If you would like to detach all the attached components then select the
Detach All option.
Note:
1. The component(s) are populated based on the account selected.
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Attach Documents
To attach documents,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab in the header pane. This opens the Asset home page.
3. Select IT Assets link under the resource block on the left hand side of the page. Select the
corresponding IT Assets say, Printers, Routers and so on. This opens the IT asset list view
page.
4. Click the Asset Name of the asset to which the document needs to be attached. This opens
the Asset details page.
5. Click the Actions combo box on the top right hand side of the page -> select the Attach
Documents option. This opens the Attach File pop up window.
6. Choose the file to be attached by clicking the Browse button. The maximum size of the
attached file can be 10 MB.
7. Click Attach File. The attached document will be listed in Asset details page under Attached
beside file name.
Documents. The attached file can be deleted by clicking the delete icon
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Assigning IT Asset to User/Department/Asset
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This
opens the selected Assets list view page.
4. Click on the Asset Name to be assigned a user/department/asset. This opens the Asset
details page.
5. Click the Actions menu on the right hand side of the page -> click Assign option from the list.
This opens the Assign/Associate page
6. If you would like to assign the asset to user or department then, select Assign User and or
Department radio button. Or if you would like to associate with an asset then select
Associate to Asset radio button.
Assign User and or Department
1. On selecting this radio button, select the User name and Department name from the
combo box.
2. If the asset is leased then enable the Asset is Leased check box and specify the
From and To date of the lease.
Associate to Asset
1. On selecting this radio button, Choose the Asset to be associated from the combo
box.
7. Save the details.
Note:
1. The user/department are populated based on the site selected.
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Add New Workstation
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab in the header pane. This opens the asset home page.
3. Click IT Asset link under the resource block on the left hand side of the page. Select the
corresponding assets say, Printers, Routers and so on. This opens the Asset list view page.
Click New button. (OR)
tab on the top left hand side of the page -> click
Click on Quick Create
Workstation option. This opens the Workstation Configuration page.
Computer Details
4. Specify the Name of the computer in the name text field and select the Model of the
workstation from the combo box. This is a mandatory field. Ex: Latitude D620.
5. Specify the Service Tag & Manufacturer of the workstation in the given text field.
6. Specify the Processor Count, Processor Info, Clock Speed and Manufacturer of the
processor in the given text fields.
7. Specify the RAM and Virtual Memory in (MB) the given text fields.
8. Also specify the Name and Service Pack of the operating system in the corresponding fields.
Resource Info Details
9. Specify the resource info details such as, Resource Tag, Resource Serial No, Bar Code &
Location in the given text fields.
10. Select the Site and Vendor Name of the workstation from the combo box.
11. Select the Acquisition Date, Expiry Date & Warranty Expiry Date from the calender
button.
Note:
1. The user/department/domain are populated based on the site selected.

Asset State Details
12. Select the status of the asset from the Asset State combo box. Ex: In Store, In Use and so
on
Network Adapter Details
13. Specify the network adapter details such as, Network IP Address, MAC Address, NIC,
Network, DNS Server name & Default Gateway in the given text field.
14. Select the Domain name from the combo box.
15. If you would like to enable DHCP then select the check box.
Input/Output Devices Details
16. Also specify the input/output devices details of the workstation. Specify the Monitor Type,
Mouse Type, Keyboard Type & their corresponding manufacturers in the respective fields.
17. Save the details. If you would like to Save and Add New workstation then click the
corresponding button.
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Bulk Scan of Newly Added Workstation
Using this option you can scan a new workstation added to the domain for its hardware and software
details. This is very useful when you have to scan a single or a set of newly added workstations. In
such case you don't have to scan the entire domain for adding the workstations to the network.
To Scan New Workstation,
1. Click on the Assets tab in the header pane -> click the Workstations link under the
Resources tab on the left side of the page. This opens Workstations list view page.
2. Select the Workstations to be scanned by enabling the check box -> Click the New Scan
button next to the Actions menu. This opens the Scan Configuration page.
3. Specify the Site and Name/IP of the workstation. This is a mandatory field.
4. Select the log-in credentials for the workstation by selecting either of the two radio buttons.
Say Global or Local credentials. By default Global Credentials option will be selected.
Global Credentials
1. Select the Scan type from the combo box. Say Domain mode or Network mode.
2. Select the Domain/Network name from the combo box. This is a mandatory field.
3. Specify the Login Name and Password for the selected domain.
Local Credentials
1. Specify the local Login Name and Password.
2. Select the Protocol to connect it to the workstation by enabling either of the two radio
buttons. Say SSH or Telnet.
3. If you would like to scan software in Linux workstation then select the corresponding check
box.
4. Click Scan to scan the workstation. Else click Cancel.
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Changing Workstation As Server
You can change workstation as server,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click IT Assets under Resources block on the left hand side of the page. Click the
Workstations link. This opens the workstations list view page.
4. Select the workstations name to be changed as server by enabling the check box.
5. Click the Actions menu and select the Change as Server option. This opens the Modify
Device Type page as shown below,

6. Select the Type of the server from the combo box.
7. Save the details.
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Viewing Workstation Details
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click Workstation link under IT Assets title on the left hand side of
the page. This opens the workstations list view page.
3. Click on the workstation name to view the workstations details. By default Resource Info tab
details are displayed.

Viewing Resource Info Details
Resource Info tab displays the Resource Details & Workstation Details. Resource details such
as Resource Name, Tag, Bar Code, Serial No etc. Workstation details such as Computer
Name, OS version, Service pack, Processor details, memory information and many other
details are displayed.

Viewing Hardware Details
Click Hardware tab to view the complete Hardware details of the workstation. The hardware
tab is broadly divided in to four major blocks such as Workstation Details block, Network
Details, Discs and Drive Details, Printer Details and Other Details.
Under the workstation block you can view computer system, operating system, processor,
memory and installed memory details. Under network block you can view the network adapters
details. Under disks and drives block you can view the hard disks, logical drives and physical
drives details. The printer details can be viewed under the printer details block. Under other
details block you can view the keyboard, mouse, monitor, multimedia, ports, USB controllers
details.

Viewing Software Details
Click Software tab to view the software details of the workstation. This opens the software
details page with the list of all installed software’s in the workstation. By default the list of All
Software will be displayed.
Select the corresponding filter option from the Filter Viewing combo box. There are different
status levels of the software, such as Excluded, Managed, Prohibited, Freeware,
Shareware and Unidentified. You can select any of these status levels and filter the
software’s listed.
Click on the software title to view the software details such as, number of licensed
installations, number of unlicensed installations and number of Purchased licenses.
If there are any license violations a warning message is displayed saying: License
Violation. Software installations are more than purchased licenses.

Viewing Relationships
This relationship tab shows the assets association to other Assets, Business Services, Users
and Components.
On clicking the tab -> click the Add Relationship button on the top right hand side of the page.
Connection Relationship
1. Click the Connection Relationship option from the list. This opens the Connection
Relationship page.
2. To connect the assets to other assets select the Assets radio button.
1. Select the assets to be connected from the Asset List.
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2. Move the selected asset to the Connected Assets list using the >> button.
3. Save the details. You can see the connected assets under the Connected to
Assets block.
Note:
1. The assets are populated based on the account selected.
Usage Relationship
1. Click the Usage Relationship option from the list. This opens the Usage Relationship
page.
2. Select the Assign the asset to User/Department radio button to associate the asset
to the user/department.
1. Select the User from the combo box.
2. Select the Department to be associated from the combo box.
3. If the Asset is Leased then select the corresponding check box.
4. Save the changes. (Or)
3. Select the Associate to Asset radio button to assign the asset to the asset.
1. Choose Asset to be associated from the combo box.
2. Save the details.
Note:
1. The users and departments are populated based on the site selected.
Container Relationship
1. Click the Container Relationship option from the list. This opens the Container
Relationship page.
2. Select the Components radio button to associate the components to the user. Select
the type of components to be displayed in the list by selecting it from the choose
product combo box.
3. Select the components from the Components List and move it to the Attached
components list using >> button.
4. Save the details.
Note:
1. The components are populated based on the account selected.

Viewing History of workstation
Click on the History tab to view the workstation history. This gives the complete Workstation
Scan History and Resource Ownership History on date.

Request Details
On clicking the Request Details page you will be able to view all the requests raised for the
asset.
On Clicking the request title you can view the details of the request, requester details, Assets
belonging to the user, Time elapsed to solve the request, resolution for the request and history
of the request
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Also you can send reply for the request or forward the request to the technician. You can
Search associated problem and change or add new problem or change to the request.

Viewing Contracts of the workstation
Click on Contracts tab to view the contracts attached to the workstation. This gives the
complete details about the contract such as, vendor name, support details, contract rules,
expiry date, cost and other rules.

Viewing Costs
Click on the Costs tab to view the costs associated to the workstation.
Click on Add Cost button to add cost to the workstation.
Select the Cost Factor from the combo box. For ex. Service Cost. This is a mandatory field.
Specify the description about the cost in the description field. Say if the cost factor is service
cost you can specify important information about the service cost.
Specify the Amount in $ in the Amount field. This is a mandatory field.
Select the Date from the calendar button.
Click on Add Cost button to add the cost. You can see the cost added to the workstation shown
in the Other Costs list view page.
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Print Preview of Workstation Details
You can view the preview of the workstation details in printable format.
To view the Preview of Workstation Details,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click IT Assets under Resources block on the left hand side of the page. Select the
Workstations link. This opens the workstation details page.
4. Click the Workstation Name to view the preview of the workstation details. This opens the
Workstation details page.
5. Click the Actions menu on the right hand side of the page. Select Print Preview option. This
opens the Resource Details pop up window. You can view the complete resource details,
workstation details, network details, disks & drives details, printer details, other details,
software details, installed service packs details, resources attached details, workstations scan
history details, resource ownership history details, contracts details & costs details.
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Modify Type
To Modify Device type,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click IT Assets under Resources block on the left hand side of the page. Select the
Workstations link. This opens the workstation list view page.
4. Click the Workstation Name to be modified of the device type. This opens the Workstation
details page.
5. Click the Actions menu on the right hand side of the page. Select Modify Type option. This
opens the modify device type pop up window.
6. Select the device type from the Modify Type combo box.
7. Save the details.
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Adding Software
Using this option you can add multiple software to the workstation.
To add Software to the workstation,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click IT Assets under Resources block on the left hand side of the page. Select the
Workstations link. This opens the workstation list view page.
4. Click the Workstation Name. This opens the Workstation details page.
5. Click the Actions menu on the right hand side of the page. Select Add Software option. This
opens the Add Software pop up window.
6. Select the software from the list to be added to the workstation. You can select multiple
software to be added to the workstation using ctrl or shift keys.
7. Save the details. Else Close the pop-up window.
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Deleting Workstations
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click IT Asset link on the left hand side of the page. This opens the IT
Assets list view page.
3. From the Workstations view list page, select workstations to be deleted by enabling the check
box.
4. Click Delete button to delete the selected workstations. You can see the selected workstation
deleted from the list.
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Remote Desktop Sharing
With multi site support, ManageEngine ServiceDesk Plus - MSP has emerged as a globally supported
IT helpdesk software, effectively resolving issues raised from various locations. Sometimes, there
may be issues that require technicians to access machines in remote location say, a SAP related
issue in New York requires immediate attention and your support team is located in California.
Likewise, when a request is raised via phone call, it would be great if the technician can access the
requesters machine from his desk to resolve the issue instantly.
That is where Remote Desktop Sharing comes into play ! Instead of launching a whole bunch of
different softwares to access remote machines, ServiceDesk Plus - MSP Remote Desktop Sharing
helps you to access all your scanned workstations and resolve issue in no time !

Browsers compatible for accessing remote desktop
•

InternetExplorer (version 5.5 and above)

•

Firefox
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Accessing Remote Control
1. Click the Asset tab in the header pane.
2. From the Resources block, select Workstations under IT assets. The list of all the
workstations is displayed.
3. Select the workstation you wish to gain remote access.
4. From the workstation details page, click on Remote Control tab.
Note: Please note that the credentials should be configured before selecting the remote
control tab. If the credentials are not configured then the log-in credentials window pops up.
5. Click Save and Remote Control.
The following activities occur on clicking the Remote Control tab from the workstation details page.

File Transfer
The Agent.exe file is installed in the C drive of the remote machine and an ActiveX control is run as a
viewer. The following should be configured in the remote machine for the file transfer.
•

Enable "File and Printer share" on executing the command (given below) in the command
prompt of the remote machine
netsh firewall set service FILEANDPRINT

•

User should have permission to write in C drive of remote machine.

The above two steps are required only on performing remote control to a workstation for the first time.
The ports for pushing the agents are TCP 135, 138, 139 and 445.
Instead of opening these ports and giving permission to all the scanned workstations for transferring
files, you can push the agent.exe from Active Directory to all the machines.
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To push the agent to remote machine from Active Directory,
1. Download the contents in the batch file and copy it to the ActiveDirectory machine. The
contents in the batch file are,
copy file://network/ share\agent.exe c:\ /y
copy file://network/ share\install.iss c:\ /y
copy file://network/ share\uninstall.iss c:\ /y
2. Copy the files from <SDP-Home>\server\default\conf\agent\*.* to the Active directory
machine.
3. In the script, the path from where the files are to be copied is specified as "network share".
Replace this path to where you have copied the files to.
4. From your Domain controller, click Start -> Administrative Tools -> Active Directory Users
and Computers.
5. In the console tree, right click on your domain, and select Properties.

6. Select Group Policy tab, and click Open (New) button. The Group Policy Management
window opens.
7. Right click on the name of domain or the Organizational unit for which you would like to
configure the script. Click Create and Link a GPO Here... option.

Zoho Corporation Pvt. Ltd.
240

ManageEngine ServiceDesk Plus MSP – Admin Guide

8. Type a name for the new GPO (for example; REMOTECONTROL), and click Ok. The GPO is
added to the existing list.
9. Right click on the newly created GPO and click on Edit option.
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10. From the Group Policy Object Editor window, select User Configuration -> Windows
settings -> scripts -> double click logon.

11. In the new Logon Properties window click on Add. The Add a Script window opens. Browse
and select the Script name "CopyAgent.bat" and the script should be accessible by the
remote machines.

12. Click Ok on Logon Properties window.
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Installing the Agent and starting the Service
Using Windows Management Instrumentation (WMI), the agent is installed and the remote
workstation can be accessed. The ports to install and start the agent as service in WMI are TCP 135,
445 and one random port greater than 1024. The service starts with the name ManageEngine
AssetExplorer-RemoteControl.
Note: You can verify the installation of the agent by check the files under the directory
C:\ProgramFiles\AdventNet\ME\AssetExplorer\RemoteControl of the remote machine.

Installing ActiveX Viewer in the browser
On starting the service in the remote machine, the ActiveX viewer is installed in the client machine,
which connects the remote machines as add on to the browser. In Firefox 2 browser, the viewer is
installed each time the remote control button is selected.

Acknowledge
An acknowledge message appears in the client window from which you try to connect the remote
machine. Click Ok to allow technician to access your workstation.

Meeting
The Meeting is established between the remote machine and the client machine (this may or may not
be server machine). The port TCP/ 10443 should be opened in the firewall between the remote
machine and the client machine for this communication.

Disconnect Remote Control
When you close the pop up window of Remote Control, the service running in the target computer will
be stopped using WMI.
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Components
Components
A part of the asset (ie. associated with the asset) which does not stand alone are grouped under
components. The list of all possible components are given below,
•

Keyboards

•

Mouse

•

Software’s

•

Software Licenses

•

Printer ink

•

Adding Components

•

Adding Components to Groups

•

Deleting Components

•

Viewing Components Details

•

Edit Components

•

Associate Assets

•

Copy Resources

•

Attach Documents
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Adding Components
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password. This opens the ManageEngine ServiceDesk plus - MSP home page.
on the top left hand side of the page ->
2. Click Quick Actions link
Click Asset option from the drop down menu. This opens Add Asset page. (OR)
Click Asset Components under Resources on the left side of the page -> Select any
one of the listed IT assets components link. e.g. Keyboards etc. This opens the
particular Asset Component page.
3. Click New button. This opens Add Asset page.
4. Select the Product Name from the combo box. If required, you can add a new
product name by clicking Add New link beside the product name field. This is a
mandatory field.
5. Select the Vendor Name from the combo box. If required, you can add a new vendor
by clicking the Add New link beside the vendor name text field.
6. Specify the Asset Name in the given text field. This is a mandatory field.
7. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the
corresponding text fields.
8. Specify the Acquisition Date & Expiry Date from the calendar button.
9. Select the Site from the combo box. This is a mandatory field.
10. Specify the Location in the given text field.
11. Specify the Asset State by selecting the current status of the asset from the combo
box.
If the asset is in Use state you need to associate or assign asset to department or
user or asset.
1. Allocate the asset to an Asset or to an User or to the Department by
selecting any of the two radio button. Say Associate to Asset or Assign User/
or Department.
2. If you choose to associate asset to an asset then select the asset name from
the Choose Asset combo box. Or if you have chosen to assign to user or the
department then select User or Department from the combo box.
3. If the asset is leased select the check box Asset is Leased. If the asset is
leased then specify the From and To date from the calendar button.
12. Click Save button to save the changes. To save and add another asset click Save
and add new button.
Note:
1. The user/department are populated based on the site selected.
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Adding Components to Group
You have two types of groups in ServiceDesk Plus - MSP say, Static group and Dynamic. Add to
group option in component list view page is to group bulk of components. These components will be
grouped under the Static group by default.
To Add Components to group,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click any of the Components link under the Resources block on the left hand side of the
page. This opens the components list view page.
3. Select the components to be added to the group by enabling the check box. This opens the
Add Resource(s) to page.
4. By default you can group components only to the static group. Either to the Existing static
group or New static group can be added.
5. If you would like to group the components under existing static group then click the
corresponding radio button. Select the group name from the combo box.
6. Else, if you would like to add a new static group and group the components, click New Group
radio button. Specify the Group Name and relevant information about the group in the
Description field.
7. Click Save button to save the changes.
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Deleting Components
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click Asset Components link under resource block on the left hand
side of the page. This opens the components list view page.
3. From the components list view page, select assets to be deleted by enabling the check box.
4. Click Delete button to delete the selected assets. You can see the selected assets deleted
from the list.
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Viewing Components Details
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click Components link under on the left hand side of the page. This
opens the components list view page.
3. Click on the components name to view the components details. By default Resource Info tab
details are displayed.
Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.

Viewing Resource Info Details
Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code,
Serial No Region, Cost, Acquisition Date and many other details are displayed.

Viewing History of Components
Click on the History tab to view the components history. This gives the complete components
Resource Ownership History on date and State of the components.

Request Details
On clicking the Request Details page you will be able to view all the requests raised for the
Component.
On Clicking the request title you can view the details of the request, requester details, Assets
belonging to the user, Time elapsed to solve the request, resolution for the request and history
of the request
Also you can send reply for the request or forward the request to the technician. You can
Search associated problem and change or add new problem or change to the request.

Contracts Details
Click on Contracts tab to view the contracts attached to the components. This gives the
complete details about the contract such as, vendor name, support details, contract rules,
expiry date, cost and other rules.

Costs Details
1. Click on the Costs tab to view the costs associated to the components.
2. Click on Add Cost button to add cost to the components.
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3. Select the Cost Factor from the combo box. For ex. Service Cost. This is a mandatory
field.
4. Specify the description about the cost in the Description field. Say if the cost factor is
service cost you can specify important information about the service cost.
5. Specify the Amount in $ in the Amount field. This is a mandatory field.
6. Select the Date from the calendar button. This is mandatory field.
7. Click on Add Cost button to add the cost. You can see the cost added to the
components shown in the Other Costs list view page.
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Copying Resources
Using Copy Resource option you can make multiple copies of the component and its details. On
making multiple copies of the resource, it becomes easier for the technician to add bulk of similar
components. The technician need not manually enter all the components details for each component.
The new copies of the component will be assigned with new component name and rest of the details
is retailed as is.
Example:
If you have twenty keyboards of the same configurations in your organization, then in this case, enter
the configurations of one keyboard and save it. Then copy the same keyboard for twenty times and
add its configurations to other keyboards.
To make multiple copies of the Resources,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab, this opens the asset home page -> select the Asset Components link
on the left hand side of the page.
3. From the list view page of the Asset Components -> click the title of the asset component to
be duplicated. This opens the asset components details page.
4. Click the Actions combo box -> select the Copy Resource option. This opens the Copy
Resource page as shown below,

5. Specify the Number of Copies to be made for the resource in the given text field.
6. Copy the resource. You can see the list of resource copies listed in the list view.
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Editing Components
To edit the resource details,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab -> select the Asset Components link under the resource block on the
left hand side of the page. This opens the list view page of the asset components.
3. Click the title of the Asset Components to be edited. This opens the Asset details page.
4. Click Edit button on the top right hand side of the page (Or)
Click the Actions combo box next to the edit resource button -> select the Edit option. This
opens the Edit Components page.
5. Edit the Asset Details block such as Asset Name, Tag, Serial No, Bar Code, Vendor Name,
Cost, Acquisition Date, Expiry Date, and Location. The Product Name cannot be edited as
it is linked to the product list created by the technician.
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In
Repair and so on. Then the Associate the asset to User or Department details or Assign to
User or Department details.
7. Update the changes. You can see the components details getting updated.
Note:
1. The user/department are populated based on the site selected.
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Associate Assets to Components
To associate assets to the components,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab in the header pane. This opens the Asset home page.
3. Select the Asset Components link under the resource block on the left hand side of the page.
This opens the asset components list view page.
4. Click the title of the component to be associated with an asset. This opens the component
details page.
5. From the components details page, click Associate tab on the top right hand side of the page.
This opens the Associate to Assets pop up window.
6. Select the Asset to be associated from the Choose Asset combo box.
7. Save the details. Component associated to an asset can be viewed under the relationships
tab of the selected asset details page.
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Attach Documents
To attach documents,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab in the header pane. This opens the Asset home page.
3. Select Asset Component link under the resource block on the left hand side of the page.
Select the corresponding component say, keyboard. This opens the Component list view
page.
4. Click the Asset Name of the asset to which the document needs to be attached. This opens
the Asset details page.
5. Click the Actions combo box on the top right hand side of the page -> select the Attach
Documents option. This opens the Attach File pop up window.
6. Choose the file to be attached by clicking the Browse button. The maximum size of the
attached file can be 10 MB.
7. Click Attach File. The attached document will be listed in Asset details page under Attached
beside file name.
Documents. The attached file can be deleted by clicking the delete icon
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Non-IT Assets
Non IT Assets
All non IP based assets are grouped under Non - IT assets. The list of all possible non-it assets are
given below,
•

Projectors

•

Scanners

•

Tables

•

Chairs

•

Telephones

•

Adding Non-IT Asset

•

Editing Non-It Asset

•

Adding Non-It Asset to Group

•

Assigning bulk Non-It Asset to Department/Site

•

Modify the State of Non-It Assets

•

Delete Non-It Asset

•

Viewing Non-It Asset Details

•

Assigning Non-It Asset to Users and/or Department

•

Copy Resources

•

Attach Asset

•

Attach Component

•

Attach Documents

Zoho Corporation Pvt. Ltd.
254

ManageEngine ServiceDesk Plus MSP – Admin Guide

Adding Non-IT Asset
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password. This opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click Quick Actions
on the top left hand
side of the page -> Click Asset option from the drop down menu. This opens Add
Asset page. (OR)
Click Non-IT Assets under Resources on the left side of the page -> Select any one
of the listed Non-IT assets link. e.g. Projectors, Scanners. This opens the particular
Non-IT asset page.
3. Click New button. This opens Add Asset page.
4. Select the Product Name of the asset from the combo box. If required, you can add
a new product name by clicking Add New link beside the product name field. This is
a mandatory field.
5. Select the Vendor Name from the combo box. If required, you can add a new vendor
by clicking the Add New link beside the vendor name text field.
6. Specify the Asset Name in the given text field. This is a mandatory field.
7. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the
corresponding text fields.
8. Specify the Acquisition Date & Expiry Date from the calendar button.
9. Select the Site from the combo box. This is a mandatory field.
10. Specify the Location in the given text field.
11. Specify the Asset State by selecting the current status of the asset from the combo
box.
If the asset is in Use state you need to associate or assign asset to department or
user or asset.
1. Allocate the asset to an Asset or to an User or to the Department by
selecting any of the two radio button. Say Associate to Asset or Assign User/
or Department.
2. If you choose to associate asset to an asset then select the asset name from
the Choose Asset combo box. Or if you have chosen to assign to user or the
department then select User or Department from the combo box.
3. If the asset is leased select the check box Asset is Leased. If the asset is
leased then specify the From and To date from the calendar button.
12. Click Save button to save the changes. To save and add another asset click Save
and add new button.
Note:
1. The user/department are populated based on the site selected.
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Editing Non-IT Assets
To edit the non-it assets details,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab -> select the Non-IT Assets link on the left hand side of the page. This
opens the list view page of the IT assets.
3. Click the title of the Non-IT asset to be edited. This opens the Asset details page.
4. Click Edit button on the top right hand side of the page (Or) click the Actions combo box next
to the edit resource button -> select the Edit option. This opens the Edit Asset page.
5. Edit the Asset Details block such as Product Name, Asset Name, Tag, Serial No, Bar
Code, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location.
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In
Repair and so on. Then the Associate the asset to User or Department details or Assign to
User or Department details.
7. Update the changes. You can see the assets details getting updated.
Note:
1. The user/department are populated based on the site selected.
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Adding Non-IT Assets to Group
You have two types of groups in ServiceDesk Plus - MSP say, Static group and Dynamic. Add to
group option in Non-IT asset list view page is to group bulk of Non-IT assets. These assets will be
grouped under the Static group by default.
To Add Non-IT Assets to group,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click any of the Non-IT Assets link under the Resources block on the left hand side of the
page. This opens the Non-IT assets list view page.
3. Select the Non-IT assets to be added to the group by enabling the check box. This opens the
Add Resource(s) to page.
4. By default you can group Non-IT assets only to the static group. Either to the Existing static
group or New static group can be added.
5. If you would like to group the Non-IT assets under existing static group then click the
corresponding radio button. Select the group name from the combo box.
6. Else, if you would like to add a new static group and group the Non-IT assets, click New
Group radio button. Specify the Group Name and relevant information about the group in the
Description field.
7. Click Save button to save the changes.
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Assigning Bulk Non-IT Assets to Department/Site
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the Non-IT Assets title under the Resources block. Select the specific Non- IT Asset
link. This opens the Assets list view page.
Assign Bulk of Assets to Department
1. Click on the Non-IT assets to be assigned to a Department by enabling the check boxes.
Click Actions menu -> select Assign to Department option. This opens Assign Resources
to pop-up window.
2. Select the Account and Department Name from the combo box.
3. Save the details.
Assign Bulk of Assets to Site
1. Click on the Non-IT assets to be assigned to a Site by enabling the check boxes. Click
Actions menu -> select Assign to Site option. This opens Assign Resources to pop-up
window.
2. Select the Account and Site Name from the combo box.
3. Save the details.
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Modifying the State of Non-IT Assets
To modify the state of Non-IT Assets,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click Non-IT Asset link on the left hand side of the page. This opens
the IT Assets list view page.
3. From the Assets list view page, select the asset to be modified by enabling the check box
beside the asset title.
4. Click the Actions combo box -> select the Modify State option. (OR) From the Asset details
page, click the Change link beside the Resource State on the right hand side of the page.
This opens the Modify State page.
5. Select the Modify State from the combo box. Ex: In Use, In Store and so on.
6. Save the changes.
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Deleting Non-IT Asset
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab on the header pane. This opens the Asset home page.
3. Click Non-IT Assets link under Resource block on the left hand side of the page. This opens
the Non-IT Assets list view page.
4. Enable the check box beside the assets to be deleted. Click Delete button.
5. A confirmation dialog appears. Click Ok to continue. You can see the selected assets deleted
from the list.
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Viewing Non-IT Assets Details
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. This
opens the ManageEngine ServiceDesk plus - MSP home page.
2. Click on Assets tab -> Click Non-IT Assets link under on the left hand side of the page. This
opens the Non-IT Assets list view page.
3. Click on the Non-IT Asset name to view the Non-IT Assets details. By default Resource Info
tab details are displayed.

Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.

Viewing Resource Info Details
Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code,
Serial No Region, Cost, Acquisition Date and many other details are displayed.

Viewing History of Non-IT Assets
Click on the History tab to view the Non-IT Assets history. This gives the complete Non-IT
Assets Resource Ownership History on date and State of the Non-IT Assets.

Request Details
On clicking the Request Details page you will be able to view all the requests raised for the
Non-IT Asset.
On Clicking the request title you can view the details of the request, requester details, Assets
belonging to the user, Time elapsed to solve the request, resolution for the request and history
of the request
Also you can send reply for the request or forward the request to the technician. You can
Search associated problem and change or add new problem or change to the request.

Contracts Details
Click on Contracts tab to view the contracts attached to the Non-IT Assets. This gives the
complete details about the contract such as, vendor name, support details, contract rules,
expiry date, cost and other rules.

Costs Details
1. Click on the Costs tab to view the costs associated to the Non-IT Assets.
2. Click on Add Cost button to add cost to the Non-IT Assets.
3. Select the Cost Factor from the combo box. For ex. Service Cost, Purchase Cost
etc. This is a mandatory field.
4. Specify the description about the cost in the Description field. Say if the cost factor is
service cost you can specify important information about the service cost.
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5. Specify the Amount in $ in the Amount field. This is a mandatory field.
6. Select the Date from the calendar button. This is mandatory field.
7. Click on Add Cost button to add the cost. You can see the cost added to the Non-IT
Assets shown in the Other Costs list view page.
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Assigning Non-IT Assets to Users and/or Department
To assign assets to asset/users/departments,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab -> select the Non-IT Assets link on the left hand side of the page. This
opens the list view page of the Non-IT assets.
3. Click the title of the Non-IT asset to be assigned to users or departments. This opens the
Asset details page.
4. Click Assign button (Or) the Actions combo box on the top right hand side of the page ->
select the Assign option. This opens the Assign/Associate page.
5. Select the Assign the asset to User/Department radio button to associate it to the
user/department.
1. Select the User from the combo box.
2. Select the Department to be associated from the combo box.
3. If the Asset is Leased then select the corresponding check box.
4. Save the changes.
6.

Else select the Associate to Asset radio button to associate to the asset.
1. Choose Asset to be associated from the combo box.
2. Save the details.
Once you save the details the page is refreshed with a message saying 'Owner assigned
successfully for this resource'.
Note:
1. The user/department are populated based on the site selected.
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Copying Resources
Using Copy Resource option you can make multiple copies of the resource and its details. On making
multiple copies of the resource, it becomes easier for the technician to add bulk of similar assets. The
technician need not manually enter all the resource details for each resource. The new copies of the
resource will be assigned with new asset name and rest of the details is retailed as is.
To make multiple copies of the Resources,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click Non-IT Assets under Resources block on the left hand side of the page. Select the
respective Non-IT assets link. e.g. Projectors, Scanners and so on. This opens the
corresponding Non-IT asset page.
4. Click the Title of the assets to be duplicated. This opens the Asset details page.
5. Click the Actions menu on the right hand side of the page. Select Copy Resource option.
This opens the Copy Resource pop up window.

6. Specify the Number of Copies to be made for the resource in the given numeric field.
7. Click Copy to make the copies of the Non -IT asset. The new copies of the Non-IT asset will
be assigned with new asset name that will uniquely identify them. The rest of the information
is retained as is. If required, you can also edit the resource details.
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Attaching Assets
To attach assets to the IT Assets,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab -> select the Non - IT Assets link on the left hand side of the page. This
opens the list view page of the Non-IT assets.
3. Click the title of the Non-IT asset to be attached to other assets. This opens the Asset
details page.
4. Click the Actions combo box on the top right hand side of the page -> select the Attach
Asset option. This opens the Attach Asset page.
5. You have two columns, such as Asset list and Attached assets list. You have to select the
assets to be attached from the assets list and move it to the attached list using the >> button.
To remove the asset from the attached asset list use the << button.
Example:
If you would like to attach a scanner to a list of workstations then select the list of workstations
from the asset list and move it to the attached asset list.
6. Save the changes. If you would like to detach all the attached assets then select the Detach
All option.
If you would like to display the list of all assets or a specific asset in the Site such as Linux
workstations, Laptops D620 etc, then in this case select the assets to be displayed from the
List combo box. Also select the type of asset such as assets in store, in use and so on from
the of type combo box.
Note:
1. The asset(s) are populated based on the site selected.
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Attach Component
To attach component to an Non -IT asset,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane, this opens the assets home page -> select Non-IT
Assets under Resources block on the left hand side of the page. Click the specific Non - IT
asset link. This opens the Non-IT assets list view page.
3. Click the title of the Non-IT asset to be attached with an component. This opens the Non-IT
asset details page.
4. Click the Actions combo box and --> select the Attach Component option from the list. This
opens the Attach Component pop up window.
5. If you would like to display the list of all components or filter specific components then select
the components to be displayed from the List combo box. Ex: keyboard, mouse and so on.
Also select the type of component such as component in store, in use and so on from the of
type combo box.
6. You have two columns, such as Component list and Attached Components list. Select the
components to be attached from the components list and move it to the attached components
list using the >> button. To remove the component from the attached component list use the
<< button.
Example:
If you would like to attach a keyboard and a mouse to a workstation then select the list of
components to be attached from the component list and move it to the attached component list.
7. Save the changes. If you would like to detach all the attached components then select the
Detach All option.
Note:
1. The components(s) are populated based on the site selected.
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Attach Documents
To attach documents to an Non-IT Asset,
1. Log in to ServiceDesk Plus - MSP using your user name and password.
2. Click the Assets tab -> select the Non-IT Assets link under the resource block on the left
hand side of the page. This opens the IT asset list view page.
3. Click the title of the Non-IT asset to be attached to other assets. This opens the Asset
details page.
4. Click the Actions combo box on the top right hand side of the page -> select the Attach
Documents option. This opens the Attach File pop up window.
5. Choose the file to be attached by clicking the Browse button. The maximum size of the
attached file can be 10 MB.
6. Click Attach File. The attached document will be listed in Asset details page under Attached
beside file name.
Documents. The attached file can be deleted by clicking the delete icon
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Software Asset Management
Software Asset Management
ManageEngine ServiceDesk Plus - MSP discovers all installed software in the network. Asset
managers have tough time managing personal, official and recreational software that is common in
the workplace.
1) ServiceDesk Plus - MSP groups scanned software based on Managed, Open Source types etc with
account segmentation.
2) Help in license management
3) Help in Group based on application
4) Software metering- which tracks the usage of the software in each workstation.
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Scanned Software
Scanned Software
1. Click on Assets tab -> Click Software link under the Resource block on the left hand side of
the page -> Scanned Software option. This brings up the Software list view page. By default,
the list of Software for All the sites of previously selected account will be displayed. You can
change the Account and Site combo box to view software llist of certain site(s)
2. Select the corresponding filter option from the Viewing combo box. You can view the
software with different status levels using filters. They are,
o

Excluded: Software that is omitted from use.

o

Freeware: Software that is provided without charge.

o

Managed: All licensed software comes under this software type.

o

Prohibited: Software that is prevented from use.

o

Shareware: Software that is available free of charge, may be distributed for
evaluation with a fee requested for additional features or a manual etc.

o

Unidentified: Unknown software can be categorized under this software type.
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Adding New Software
To Add new Software,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click Software title under Resources block on the left hand side of the page. Click the
Scanned Software link. This opens the software list view page. By default the list of All
software will be listed.
4. Click the New button on the right hand side of the page. This opens Add Software form.
5. Specify the Software Name in the given text field. e.g. Adobe Photoshop. This is a
mandatory field.
6. Specify the Version of the software. Say 7.1,7.2 etc.
7. Select the Software Type from the combo box. Say Managed.
8. Select the Software Category from the combo box. Say Graphics. This is a mandatory field.
9. Specify relevant information about software in the Description field.
10. Click Add button to add the software.
Note:
1. Software added will not be listed under Assets-> Scanned Software. To associate a
software, go to workstation details page.Choose Actions->Add Software
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Viewing Software Details
Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.
1. From the Software view list page, select Managed software type from the Filter Viewing
combo box, to view the license details of the software. All the licensed software comes under
Managed software type.
2. Click on the software name to view the software details.
3. In the software details page, You have the Product Name, Version, Manufacturer and
Category. You can also change the category by clicking change link adjacent to the category.
4. You can also view the purchased licenses details, Licensed users, Available Licenses and
Unlicensed Installations. On having unlicensed installations you get a warning message for
license violation as shown below,

Licensed Installations
Under Licensed Installations, you can view the workstation details, user details, software usage
details, number of licensed installations and allocated licenses details.

Un Licensed Installations
Under Unlicensed installations, you can view the list of unlicensed installations , users using the
unlicensed software, usage of the software say frequently or occasionally etc can be viewed.

Allocate Licenses to single machines
1. Click on the Select software license icon -> Select software license page opens.
2. Select the license name by enabling the radio button.
3. Click Save button to save the changes. You can see the unlicensed installations
changing to licensed installations and listed under the Licensed Installations column.

Allocate Licenses to multiple machines
1. Select the workstations to allocate licenses by enabling the check box.
2. Click Allocate License button to allocate licenses to bulk of workstations. It takes all
un allocated licenses and assign it to the workstations automatically.
Note:
1. The Software License are populated based on the site selected.
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Purchased Licenses
Under Purchased licenses, you can view the number of purchased licenses, license type, Installation
details, license key details etc.
To delete the purchased licenses,
1. Select the purchased licenses from the list by enabling the check box.
2. Click Delete button to delete the selected licenses. A window pops up to get your
confirmation on the delete operation click Yes to proceed. You can see the software licenses
getting deleted from the list.
Move Licenses
To move licenses to selected site,
1. Select the licenses to be moved to the site by enabling the check box.
2. Select the site from the Move Licenses To check box. Click Move button to move the
licenses. You can change site by selecting the site from the site option at the top left of the
page.

License Agreements
Software license agreement is a contract between the software vendor and the purchaser. It is often
called as the end user license agreement. The license agreement consists of terms and conditions on
how to use the software in the organization.
You can Filter to view the license agreement based on the active and expired agreements. In addition,
you can also add a new license agreement and delete the existing license agreement for this
software.
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Changing Software Type
1. From the Software view list page, click the software name. This opens the software details
page.
2. Click Actions link on the right hand upper corner of the page. Select change software type
option. This opens change software type page.
3. Select any one of the listed software type. Say Excluded.
4. Click change button to change the software type. You can see the software type changing to
excluded in the software details page.
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Changing Software Category
Using this option, you can change the existing category of the software. Ex: From Graphics software
to Multimedia software so on.
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click the Software under Resources block on the left hand side of the page. Click Scanned
Software link. This opens the software list view page.
4. Select the corresponding filter option from the Filter Viewing combo box. By default the list of
All Software will be listed.
5. Select the software from the list to change the category by enabling the check box. Click
Change Category button. This opens Change Software Category to pop-up window.
6. Select the Software Category from the list say Accounting, Development etc.
7. Click Save button to save the changes.
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Deleting Software
1. From the Software view list page, select the corresponding filter option from the Viewing
combo box. By default the list of All Software will be displayed.
2. Select the software to be deleted by enabling the check box.
3. Click Delete button to delete the selected software. A pop up window pops up to get your
confirmation on the delete operation. Click OK to proceed. You can see the selected software
getting deleted from the list.
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Associating Software Minor Versions
ManageEngine ServiceDesk Plus - MSP allows you to group minor versions of the software under
major version.
For e.g. A company buys AdobePhotoshop 7.0 with 4 licenses. The license is applicable for both 7.1
and 7.2 versions and vice versa. In this case 7.0 is the major version and 7.1 and 7.2 are the minor
versions. The licenses purchased are the same for all the three versions.
If Adobephotoshop 7.0 is installed in two different machines and 7.1 & 7.2 is installed in other two
different machines. On scanning for Adobe Photoshop software before grouping, the ServiceDesk
Plus - MSP shows the list as different single entries. The purchased licenses for the software would
be as' 4 ' for the version 7.0 and ' 0 ' purchases for other versions (7.1 & 7.2).
Using associate minor versions option you can group 7.1 & 7.2 minor versions under 7.0 major
version. This shows the software list to be a single entry with the number of purchased licenses and
installations. Thus helps you in avoiding individual entry for each version of the software. And also
helps in easier management of the installed software for the assetmanager.
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click Software title under Resources block. Click Scanned Software link. This opens
software list view page.
4. Click the software name. This opens the software details page.
5. Click on the Actions tab on the right hand side upper corner of the page. Click Associate
Minor Versions option. This opens Associate minor versions page.
6. Select the managed software (licensed) to be grouped of minor versions from the list. Click >>
button to move the selected managed software to the Version Group list. By moving the
selected managed software under Version Group, all the minor versions will be associated
with the major version.
7. Click Save button. You can see all the added minor versions getting displayed in the software
details page under the title Software - All Versions.
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Emailing Users
ManageEngine ServiceDesk Plus - MSP has email options for the technicians to communicate to the
users. Say, technicians communicate to the users for any event occurred or to get any information
from users.
To Email Users,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the Assets home page.
3. Click Software under Resources block. Click Scanned Software link. This opens the
software list view page.
4. Click on the software name. This opens the software details page.
5. Click on the Actions tab on the right side corner of the page-> click Email users option. This
opens Email Users page.
6. Specify the To email address in the given field.
7. Specify the Subject and Description about the email in the respective fields. By default you
have subject and description provided for the email.
8. Click Send E-mail button to send the email to the user.
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Software Summary
ServiceDesk Plus - MSP scans your network and automatically discovers all software available in the
workstations. From the Software Dashboard, Asset Managers can
•

Group the software according to the Manufacturers and the Site in which they are associated.

•

Easily ensure compliance by keeping a check on the list of compliant, under licensed and
over licensed software.

•

Facilitate easy access to view the total number of software that are unused, rarely used,
managed, prohibited and unidentified for the selected Manufacturer and Site.

•

View the number of expired license agreement, agreement to be expired in the next 7 days
and agreement to expire in the next 30 days.

•

Software Metering - tracks the usage of software in each workstation.
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License Agreement
License Agreement
Software License Agreement is a contract between the software vendor and the purchaser. Software
companies often make special contracts, such as contract for support and warranty with large
businesses. Also, the license agreement consists of the acquisition date, expiry date, terms and
conditions on how to implement the software in the organization. These documents are called as the
End User License Agreement (EULA).
ManageEngine ServiceDesk Plus - MSP provides an option to maintain the license agreements in the
database by adding the license agreement in the application. Also you can associate the license
agreement with the software licenses.

Add New License Agreements
1. Click Assets -> License Agreement under Resources block. The available license
agreement is listed.
2. Click Add New button.
3. Select the Manufacturer of the software for which the license agreement is created from the
drop down.
If the manufacturer is unavailable in the list, select the add new icon
Manufacturer and Description in the pop up.

. Enter the

4. Specify the Agreement Number and Authorization Number. The Agreement Number is a
mandatory.
5. Select the Acquisition Date and Expiry Date of the software using the calendar icon.
6. Select the Vendor from whom the software was purchased from the drop down.
If the vendor detail is unavailable in the list, select the Add New icon
Vendor Name, Description and name of the Contact Person.

and enter the
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7. Specify the Description and Terms for the license agreement.
8. If required, you can also attach relevant documents to the agreement. Click Attach File
button. Browse through the file and click Attach file.
9. You can add additional license agreement fields directly from this form by clicking Add More
Fields.

You can choose the type from Single-line, multi-line, pick list, numeric and date/time fields.
Enter the Label and Default Value (for single-line and multi-line) to be displayed in the form.
10. Specify the Purchase and Invoice Details such as, Purchase Order Number, Purchase
Order Name, the date of purchase of the software in the respective fields.
11. Also, enter the Invoice Number, Invoice Date from the calendar icon and the Total Cost of
the software.
12. You can either associate the license with an existing software license (provided there are
unassociated license available for the selected manufacturer) or add a new software license
and associate the agreement.
Associate existing license to agreement
1. Click Associate to Existing License button.
2. From the Associate Existing License pop up window, choose the Site and Software
from the filter drop down.
3. Enable the check box beside the license to be associated with the license agreement.
4. Click Associate to agreement button. The selected licenses is associated and listed
below the Purchase Software License block.
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Add New License and Associate
You can instantly add a software license and associate it to the license agreement.
1. Click Add New License and associate button.
2. From the pop up window, select the Software, License Type, License Options,
Installations Allowed, License Key and the Cost ($) from the drop down. The
License Type, License Options and Installations Allowed are mandatory fields.
3. You can add licenses for other software by clicking the Add icon and repeat the steps
as above.
4. Click Associate to agreement button. The license is associated and listed below the
Purchase Software License block.
13. You can notify users before the license agreement expires by selecting the users to be
notified from the Users List. Click >> button to move the selected user to Notified User List
block.
14. Select the Days before which the selected users should be notified of the license agreement
expiry. If you have selected the users to be notified of the license expiry then this field is
mandatory.
15. Click Save.
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Edit and Delete License Agreement
You can modify and delete the existing license agreement from the application.

Edit License Agreement
1. Select Assets tab -> License Agreement under Resources block. The list of available
license agreement is displayed.
2. Select the Agreement Number to be edited.
3. From the License Agreement details page, click Actions -> Edit Agreement option.
The Edit License Agreement form appears with details populated while creating the license
agreement. The Manufacturer field is non-editable.
4. Modify the details and Save the changes.

Delete License Agreement
1. Select Software -> License Agreement under Resources block. The list of available license
agreement is displayed.
2. Enable the check box beside the Agreement Number to be deleted.
3. Click the Delete button. The agreement is deleted from the list.
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Print the License Agreement
You can preview and print the entire license agreement details using Print Preview option.
To print the license agreement,
1. Click Assets tab -> License Agreement under Resources block. The list of available license
agreement is displayed.
2. Select the Agreement Number link of the license agreement to print.
3. From the License Agreement details page, click Actions -> Print Preview option. The license
agreement details appear in a printable form in a pop up window.
4. Click CTRL + p keys to print the contract details.
5. Set the required options and click OK.

Zoho Corporation Pvt. Ltd.
283

ManageEngine ServiceDesk Plus MSP – Admin Guide

Software License
Software Licenses
ServiceDesk Plus - MSP helps you to manage software licenses installed across the enterprise. You
can consolidate and manage all your software licenses from a single screen. ServiceDesk Plus - MSP
will scan and automatically pickup license keys for Microsoft Windows and Microsoft Word. You can
key-in all the licenses purchased earlier and track future purchase of software licenses through the
Purchase module.
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Add Software License
Using this option, you can create a software license for the existing software. The software license
form can be accessed by two ways in ServiceDesk Plus - MSP application.
a. Quick Actions drop down
b. Assets Tabs
a. Quick Actions drop down
The Quick Actions drop down is a quick navigator to instantly access the Software License form from
the home page. To add a new Software License, go to Step 2 in Software Tab.
b. Assets Tab
1. Click Assets tab in the header pane.
2. Select Software -> Software License under Resources block. The list of available software
license is displayed.
3. Click Add New button.
4. Select the Manufacturer of the software.
5. The list of managed software available for the selected manufacture is listed in Managed
Software drop down. Select the software for which the license is created.
6. Select the Vendor Name from the drop down.
If the vendor is not available in the list, you can add a new vendor on selecting the Add New
link. In the pop up, specify the Vendor Name, Description and Contact Person, and save
the changes.
7. Select the date of purchase of the software from the calendar button in Acquisition Date
field.
8. Select the Expiry Date of the software from the calendar icon.
9. Specify the cost of the software per license in Purchase Cost field.
10. Select the department for which the software was purchased in Purchased for drop down
list.
11. If you have configured Sites, select the site name where the licensed software is installed,
from Allocated to Site drop down.
12. Select the License Type from the drop down. Each manufacturer has their unique license
type apart from the several common license types. Some of which are,
o

Individual: License type for single installation

o

OEM (Original Equipment Manufacturers): License type for software that is already
installed in the hardware.

o

Named User License: License Type for a specific user.

o

Volume: License Type supporting multiple users.

o

Client Access License (CAL): License type that gives a user the rights to access
the services of the server.

o

Trial License: License Type for trial versions of software.

o

Enterprise (Perpetual): License Type that does not require renewal and is for life
long.

o

Concurrent License: License Type for software that can be accessed by a specific
number of users at a time.
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o

Free License: License Type for freeware software.

o

Enterprise Subscription: License Type that requires renewal for every specific
period.

o

Node Locked: License Type for workstations with specific configurations.

Individual License/OEM
1. Select the License Option as either Full Package Product (FPP) or Others from the drop
down.
2. Specify the Number of licenses required for the selected product.
3. Enter the License Key (s) for the software in the given text box. The license keys values
should be in comma separated values format. Say XBVJD, YCCYR, 7DF28, JH2PX, MYT7M.
4. Save the details. The license is listed in the software license list view page.

Volume License/Trial License
1. Mention the Number of licenses required for the selected product.
2. Specify the number of Installations allowed per license.
3. Specify the License Keys in the given text field. Say XBVJD, YCCYR, 7DF28, JH2PX,
MYT7M.
4. Save the details. The license is listed in the software license list view page.

Client Access License (CAL)
The Client Access License consists of the following License Options,
•

Per Seat-Device/ Per Seat-User: License given to each unique user/device to avail the
server software product. The number of CALs is equal to the number of devices/users
accessing the server software.

•

Per Server: License given to each server. The number of devices accessing the server
simultaneously is limited and is primarily recommended for servers that require limited
access.

•

Per Processor: Connect unlimited users/workstations to the server product.

•

Per Mailbox: License for each mailbox using Exchange Server.

Select the License Option from the combo box.
Per Seat-Device
1. Enter the required Number of CALs.
2. Specify the License Keys in the given text field. Say XBVJD, YCCYR, 7DF28, JH2PX,
MYT7M.
3. If there is any additional information required, then the same can be specified under
Additional Information block.
4. You can select the workstations that can access the software from Choose CAL Installation
block.
Select the workstation by either choosing the client software from Filter by or from
Departments drop down. You can also search for the workstation on entering the name in
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Search field and selecting Go button. The list of server/workstations is displayed. Select the
workstations. Click >> button to move to CAL Installation box.
Note: The number of workstations selected should be lesser than or equal to the specified
number of CALs.
5. Save the details. The license is listed in the software license list view page.
Per Seat-User/ Per-Mailbox
1. Specify the details similar as above.
2. Instead of selecting the workstations from Choose CAL Installation block, choose the Users
to access the software from the list displayed.
3. Save the details. The license gets listed in the software license list view page
Per-Server
1. Specify the details similar as in Per-Device.
2. Associate the specified number of CALs to the server selected from Associate to Server
drop down list.
3. Save the details. The license gets listed in the software license list view page
Per-Processor
1. Specify the Number of Processor (s) that supports the ability to connect unlimited
users/workstations in the given field. Since unlimited users/workstations can connect to the
server software product the CAL Installation block is not available.
2. Specify the details as configured above.
3. Save the details. The license is listed in software license list view page.
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View Software License
The details of the software license added by you are displayed under Software License details page.
Apart from viewing the software details, you can also view the workstations allocated with the
software license, any relevant document attached and the contracts associated to the software
license.
To view the software license details,
1. Select Assets tab -> Software License under Resources block. The list of available software
license is displayed.
2. Click the software license name to view the software details. The page opens to display
License Info and the Contracts tab.

License Info
The details added in the New Software License form is displayed under this block. Apart from the
details added, you can also view the license agreement number associated with the Software.
From this page, you can Edit and Attach relevant documents the software license using the options
from the Actions drop down.

Contracts Tab
Contracts associated to software are listed under the Contracts tab. You can add a new contract
under the Contracts tab.
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Edit/Delete Service Packs
To Edit Service Packs,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the Assets home page.
3. Click the Software title under Resources block on the left hand side of the page. Click the
Service Packs link. This opens the Service Packs list view page.
4. Select the Service Pack name to be edited from the list. This opens the service pack details
page.
5. Click the Edit button on the right side corner of the page. This opens the Edit Service Pack
page.
Modify the Service Pack Name, Type and Description of the service pack. Also you can add
software or service packs to the existing service pack list. To add to the list, select from the
available list of software and move to the selected software using >> buttons.
6. Click Save button to save the changes.

To Delete Service Packs,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the Assets home page.
3. Click the Software title under Resources block on the left hand side of the page. Click the
Service Packs link. This opens the Service Packs list view page.
4. Select the Service Packs from the list to be deleted. Click the Delete button. A pop up
window pops up asking your confirmation on the delete operation.
5. Click Ok to proceed. You can see the service packs deleted from the list.
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Attach Documents
To attach document to Software Licenses,
1. Click the Assets tab in the header pane; this opens the assets home page.
2. Click Software title under the Resources block on the left hand side of the page.
3. Click Software Licenses link. The software licenses list view page opens.
4. Select the software license to attach the document.
5. From the details page of the selected software license, click Actions drop-down menu ->
select Attach Documents option from the list. The Attach File dialog pops up.
6. Click Choose File button to select the file. The maximum size of the attached file can be 10
MB.
7. On selecting the file, click Attach File button to attach the document.
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Service Packs
Service Packs
ServiceDesk Plus - MSP keeps track of all the service packs such as hotfix, security update, installer,
on scanning the workstations.
To view the Service Packs details,
1. Click Software title -> Service Packs link under Resources block. The service pack list view
page opens.
2. Click the service pack name to view the service pack details.
The details page displays the complete detail about the service pack with number of installations, and
installation without service packs. It also provides information on the number of software the service
pack applies to.
Say, if the service pack Security Update for Windows XP is applicable for Microsoft Windows XP
Professional and Microsoft Windows 2000 Professional then this software list would be displayed
before the service pack installations list.

Service Pack Installations
Under this block you get the list of all service pack installations with the Workstation name, User
name, Installed On and Installed By details.

Software Installations without Service Packs
Under this block you get the list of all software installations without the service packs along with the
Workstation name, User name, Software and Usage details.
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Edit and Delete Service Packs
ServiceDesk Plus - MSP gives you an option to modify and delete the existing Service Packs.

Edit Service Packs
1. Click Software title -> Service Packs link under Resources block. The service pack list view
page opens.
2. Select the Service Pack name to be edited from the list.
3. From the Service Pack details page, click the Edit button. This opens the Edit Service Pack
page.

Modify the Service Pack Name, Type and Description of the service pack. Also, you can add
software or service packs to the existing service pack list. To add to the list, select from the
available list of software and move to the selected software using >> buttons.
4. Save the changes.

Delete Service Packs
1. Click Software title -> Service Packs link under Resources block. The service pack list view
page opens.
2. Enable the check box beside the Service Packs to be deleted from the list.
3. Click Delete button. A confirmation message appears.
4. Click OK to continue. The Service Pack is deleted from the list.
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Groups
Manage Groups
ManageEngine ServiceDesk Plus - MSP helps you to group assets based on asset properties. You
can group assets of users belonging to the same team and location. Organizing assets based on
groups gives you more fine-grained control and helps you manage assets efficiently. E.g. you can
group assets based on OS, Service packs, Memory size and so on. When you are getting ready for
migration you will be able to pinpoint assets with 256 MB RAM that need upgrade before rolling out
Windows Vista.
•

Creating New Group

•

Removing Assets from a Group

•

Editing and Deleting Group
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Creating New Group
For easier channelization, users can be categorized under Static and Dynamic groups.
Under Static group you define the group by listing its members.
Under Dynamic group resources are grouped automatically based on certain criteria set by the
administrator.
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
menu on the top left side of the page. Select
3. Click Quick Actions link
New Group under Asset - Groups from the list. [OR]
Click Groups under Resources block on the left hand side of the page. Click New Group
link. This opens the Create Group form.
4. Specify the Group Name in the given text field. This is a mandatory field.
5. Specify relevant information about the newly created group in the Description field. Say the
group name is Test DL600 you can specify Test DL600 stands for Dell Lateral 600.
6. Select any of the Group Type by enabling the radio button. Say Static or Dynamic group.
Static Group: You define the group by listing its members.
Dynamic Group: Resources are grouped automatically based on certain criteria.
7. Click Save button to save the group. You can see the newly created group getting listed in the
Create Group page.
8. Once the group is created you have to add resources to the group.
To add resources to the Static group,
1. Select the filter criteria from the Showing combo box. Say for ex. You can select All Assets
in Use.
2. Specify the Search criteria in the given text field.
3. Click Go button to list all resources based on the filter criteria. All the resources gets listed
under Pick resources to add block.
4. Select the resources to be added to the group by enabling the check box.
5. Then click Add button to add resources to the group. You can see the selected resource
added to the group, shown under Resources In group column.
To add resources to the Dynamic Group,
1. You define the filter criteria by selecting the Criteria and Conditions from the combo box.
Select the Criteria from the combo box say for e.g. Resource Criteria or Workstation
Criteria.
2. Select Conditions from the combo box, which will be listed based on the selected criteria.
3. Click Choose button to choose the resource or workstation criteria listed based on the criteria
you have selected. For example: If you have selected resource criteria as Product Type and
conditions as is then on clicking choose button you will get the list of all product types say
scanners, keyboard, printers etc.
4. Select any one of the Match Criteria by selecting either of the radio buttons. Say (And) or
(OR) criteria.
5. Select any of the listed Product Type and click Ok buttons to add to the group. You can see
the group criteria getting listed.
6. Click Save and View group button to view the list of all resources based on the filter criteria.
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Removing Assets from Group
To remove the existing resources from the group,
1. From the Group list view page, select the resource name from the list by enabling the
check box under the Resources in-group column.
2. Click Remove from Group button to remove the resources. You can see the
selected resource deleted from the list.

Zoho Corporation Pvt. Ltd.
295

ManageEngine ServiceDesk Plus MSP – Admin Guide

Editing & Deleting Groups
To Edit Groups,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Assets tab in the header pane. This opens the Assets home page.
3. Click Groups under Resources block on the left hand side of the page. Click Manage
Groups link.
4. From the Manage Group list view page, click Edit link. This opens Edit Group page.
5. In the Edit Group form, the Group Type is in non editable text. Do the required changes and
click Save.

To Delete Groups,
1. From the Manage Group list view page, click the corresponding Delete link to be deleted on
the right hand side of the page.
2. A pop up window pops up to get your confirmation on the delete operation. Click OK to
proceed. You can see the group deleted from the list.

Zoho Corporation Pvt. Ltd.
296

ManageEngine ServiceDesk Plus MSP – Admin Guide

Purchase
Purchase
The Purchase module streamlines the procurement of required components and allows you to add
them as unassigned assets. The Purchase module is tightly integrated with the Inventory. You can
configure the vendor-related information and the products supplied by those vendors and their price
quotes in ServiceDesk Plus - MSP . This information helps in making the choice of vendors while
generating the Purchase Order (PO) by comparing the pricing of each vendor. The purchase process
starts with a purchase request and is completed when the requested component or item has been
purchased and reaches the requester of the purchase request. Below is the workflow that details the
various steps involved in a purchase process.

To reach the purchase module, log in to the ServiceDesk Plus - MSP application using your user
name and password and click the Purchase tab in the header pane.
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View Purchase Order based on Filters
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This brings up the Purchase Orders list view
page. By default the status of the Purchase Order will be 'All POs'.
3. Select the corresponding filter option from the Filter Showing combo box. You can view
purchase orders with different status levels using filters. They are,
•

All POs
All Purchase Orders irrespective of the status will be listed. This is the default status
on opening the purchase order list view.

•

Open POs
The newly added Purchase Order will fall under this category. These POs are not
submitted for approval.

•

POs Pending Approval
The Purchase Orders which are submitted and waiting for approval from the
purchase order approvers will be listed under this category.

•

Approved POs
All the Purchase Orders which are approved but the purchase items are not yet
received will be listed under this category.

•

Rejected POs
All the Purchase Orders rejected by the purchase order approver gets listed under
this category.

•

Ordered POs
Lists all the POs for which the items have been ordered by the vendor.

•

Partially Received POs
Purchase Orders, which are partly received from the vendor, will be listed under this
category.

•

Received POs
Lists the POs for which the items have been completely received.

•

Invoice Received POs
Lists all the POs for which the invoice is received from the vendor.

•

Payment Done POs
Lists all the POs for which the payment is done.

•

Closed POs
The Purchase Order gets listed under this category when the purchased items are
fully received from the vendor.

•

Overdue POs
Purchase orders not delivered and have exceeded the delivery date will be listed
under this category.

•

POs due in next 7 days
Outstanding Purchase Orders, expiring in next 7 days will be listed under this
category.

•

POs due in next 30 days
Outstanding Purchase Orders, expiring in next 30 days will be listed under this
category.

•

Searched POs
While searching for the Purchase Order under Search, the list of Searched POs will
fall under this category.
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Creating a New Purchase Order
To create a new purchase order,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This opens the purchase order list view page.
3. Click the New Purchase Order button available in the Purchase Order block.(OR)
Click Quick Actions

button in the home page --> click Purchase Order

. This
option under Create New
opens the Add Purchase Order form. By default, the status of the Purchase Order while
adding will be New PO, after which the status changes to Open.
4. Specify the Order No in the given field. For ex: 140. This is mandatory field.
5. Enter the PO Name say, Purchase of monitors, and the Required By Date by invoking the
. The PO name in mandatory field.
calender icon
6. Select the Vendor Name from the combo box. This is mandatory field. If the specified vendor
adjacent to the Vendor field and
name is not available in the list, click Add New link
specify the vendor details like Name, Contact Information and Contact Person of the vendor.
Click Save button to save the details.
7. Select the Shipping and Billing Address from the combo box. You can also add the
. Enter relevant details in the
shipping and billing address by clicking the Add New link
pop up window.
8. On selecting the Vendor, the corresponding Product Type and Products gets populated in
the combo box. Select the Product type and the Products, the items gets listed one below the
other along with the price details.
beside the
You can also add new product to the specified vendor by invoking the icon
product combo box. This opens the Products Details pop up window. Specify the Product
Name and the Product Type of the item which are mandatory fields. Specify the Part No and
the Price of the item in the given fields. Click Save, the item gets added to the list.
9. By default, the check box beside the item will be enabled. Specify the price of the item if it is
not mentioned and the quantity of items to be ordered in the text box. The cost calculations of
the item changes accordingly to the number of items purchased.
10. Under the general information block, select the Cost Center and the GL Code from the
combo box. By default, the Requested By will be the name of the technician creating the PO.
The Created Date and the Owner is in non editable text.
11. Enter the description for the PO or any other information that you wish to add in the Remarks
field.
12. If there are any specific terms associated with the PO, enter the same in the Terms field.
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13. If you would like to attach a file then click Attach file button.
14. Select the Approvers of the purchase order from the PO Approver(s) list pop window by
.
clicking the icon
15. Specify the Signing Authority of the company in the respective field.
16. Click Save the Purchase Order button to save the details.
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Viewing a Purchase Order
To view purchase orders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This displays the list of All POs, by default. If you
want to see a PO that is in any other state, then you need to choose corresponding state from
the Filter Showing combo box.
3. From the list of POs, click the PO Name link of the PO that you wish to view.
The View Purchase Order displays the PO details in the same way as in create PO form. The PO
header has the name of your organization, logo, and the mailing address. The Order No, PO Name,
Required By date and the status can be viewed at the right hand side of the header.
Next, consists of the details about the vendor, such as the vendor's name, address, phone number,
fax, and the name of the contact person at the vendor location. Adjacent to this is the billing address
and shipping address to which the invoice needs to sent and the assets needs to be delivered
respectively.
Finally, the items are listed along with the cost calculations. The item table lists the item name, part
no, price ($) per quantity, quantity ordered, and the total cost for the quantity ordered. Below this
table, the cost details for shipping and sales tax are displayed and the final total cost of the PO is also
displayed.
The General Information consists of, the Created Date, Owner of the PO, PO requested by, the cost
center and the GL Code.
If there were any remarks provided for the PO while creating it, they are displayed at the bottom,
along with the terms of the PO, attachments and the PO Approver(s) List. The footer consists of the
signing authority and Place.
In case of closed POs in the view PO details page, you can also view the received items beside the
ordered no of items in the Item List block.
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Editing a Purchase Order
To edit purchase orders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This displays the list of All POs, by default. If you
want to see a PO that is in any other state, then you need to choose corresponding state from
the Filter Showing combo box.
3. From the list of POs, click the PO # of the PO that you wish to edit.
4. Click Actions button --> Edit Purchase Order. The edit PO form is similar to the create new
PO form where you can edit the PO details. Edit the entries and proceed as elaborated in
Creating a New Purchase Order section.
5. Click Save Purchase Order to save the changes and sent the PO for approval to the
concerned approvers.
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PO Approval Process
Once the Purchase Order is created, the PO should be submitted for Approval to the concern
authority. The approval process is initiated by sending a request for approval to the concerned
authority and depending on their decision the PO is approved or rejected.
•

The technician/requester approving the purchase order should be assigned with the Purchase
Order Approver role.

•

While creating a purchase order the approver should be selected from the approver's list to
send for approval.

•

If the approver is not selected or if there are no approver in the list, a warning message
appears while submitting the PO for approval.

•

Once the request is submitted for approval the status of the PO changes to PO Pending
Approval.

Submit PO for Approval
1. Click the Purchase tab in the header pane to open the PO List View page.
2. Select the Open POs to be submitted for approval using the Filter drop down. Click the PO
name link.
3. From the PO details page, click Actions tab -> Submit for Approval option. The Submit for
Approval dialog pops up.
4. Enable Send Mail Notification check box, if you wish to send a mail to the approver regarding
the PO Approval.
5. The To field is pre populated with the email address of the approvers. If required, you can
modify the subject content manually.
6. Type in the message text for mail notification in the Description field.
7. Click Send. The mail notification is sent to the user addressed in the To field of the
notification.

Approve / Reject PO
Once the PO is submitted for approval, a mail is sent to the user addressed in the To field. The email
contains the link to the PO requiring approval. Clicking the link displays the PO awaiting approval. The
user can also approve/reject the PO directly from the application.
Approve/Reject PO from the application
If you have the permission to approve/reject a Purchase Order,
1. Login to the ServiceDesk Plus - MSP application with your login credentials.
2. Click the Purchase tab in the header pane.
3. Select the POs Pending for Approval using the Filter drop down. Click the PO name link.
4. From the PO details page, click Actions tab -> Approve/Reject option. You can send an
email notification to the PO owner regarding your decision.
The approved Purchase Order is grouped under the status Approved POs while all the rejected
Purchase Orders is grouped under Rejected POs status. The Rejected POs can be deleted
completely from the system or can be edited and sent for approval again.
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Order PO from Vendor
Once the Purchase Order is approved by the concern personnel, you need to order the items from the
vendor.
1. Click the Purchase tab in the header pane to open the PO List View page.
2. Select Approved POs from the Filter drop down. Click the PO name link.
3. From the PO details page, click Actions tab -> Order this PO option. The Order this PO
dialog pops up.
4. Enable Send Mail Notification check box, if you wish to send a mail to the vendor regarding
ordering of items.
5. Enter the Email address of the Vendor in the To field. You also have an option to CC this
mail.
6. If required, you can modify the Subject content manually and type in the message text for
mail notification in the Description field.
7. Click Attach file button to attach relevant files to the Order.
8. Click Send. The status of the PO is changed to 'Ordered'.
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Receiving PO Items
Once the PO is approved, it is sent to the vendor to receive the ordered items. The ordered items can
be received either partially or completely from the vendor. In both the cases you can have the receipt
of the received items. On receiving the partial items from the vendor the purchase order can be
marked as Partially Received and moved under Partially Received POs. And on receiving the
complete items from the vendor, the purchase order can be moved under Closed POs.
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This opens the Purchase Order list view page.
To mark partially or completely receive items,
1. From the Purchase Order list view page select the corresponding filter option from the Filter
Showing combo box. By default, the list of All POs will be displayed.
2. Select Approved POs from the Filter Showing combo box. Click the PO # Name for the
received items. This opens View Purchase Order page.
3. Click on the Actions tab and click Receive Items. The Receive Items dialog pops up.
4. Enable the check box beside each of the received items. If only a part of the ordered items
are delivered, then click the quantity of the item which is partially received and enter the
quantities that have been received as shown below,

5. Select the Account from the drop down to recieve the items. The Sites will be automatically
populated on selecting the Account.
6. Click Receive Items button. This updates the PO with the Received Quantity value and
moves the PO under Partially Received POs.
When a future shipment arrives, you can follow the above process to update the quantity of items that
have been delivered. Once all the items have been received, the PO moves to the closed status.
All the received items from the PO will be added as resources automatically. And the resources that
are created from a particular PO will be associated to that particular PO.

Associated Assets
The purchased items received can be viewed and associated to groups.
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1. Click Actions tab -> Associated Assets link option. This will display all the assets that were
created from the PO.
2. Associate the assets to the group by enabling the check box beside the asset. Click Actions
button --> Add to Group. This opens the Add Resource(s) to pop up window.
3. Select the group from the existing list of groups or enable the radio button beside New
Group, to add a new group. The asset gets associated to the corresponding group.
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Reconcile PO Items
Once the resources are received from Purchase Order, the resources are associated to Department
or Groups. But on performing domain scan or network scan, the associated IT assets get duplicated.
Say, "LD400 - PO # 2[10]" is the workstation purchased and has been renamed as "AE-dept". On
performing a scan, both the workstations appear in the List View. To avoid this you can reconcile the
assets from either the PO details page or from the asset list view page.

Note

1. Items with the Product Type as Consumables are not added to the assets and
hence cannot be reconciled.
2. The scanned workstations can be reconciled only once.
3. You cannot reconcile workstations from the same purchase order.

To reconcile assets from the purchase order details page,
1. Click the Purchase tab in the header pane to open the Purchase Order list view page.
2. Click the PO# name link of the purchase order for which the items needs to be reconciled.
You can also use the Filter drop down to sort and select the PO.
3. From the purchase order details page, click Actions -> Reconcile option. The Reconcile
Workstation(s)/Server(s) pop up.
4. In case of workstations and servers, select the check box beside the resource name and
enter the Service Tag of the scanned workstation/server.
5. Click Reconcile button. The data in the purchased workstation is copied to the scanned
workstation copied. On reconciling, the purchased workstation is deleted.
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Add Invoice details and Notification
Once the PO is approved by the concern personnel, the Invoice and Payment options get populated
in the Actions tab. On receiving the Invoice from the Vendor, you can add the Invoice details and also
sent a notification to the concern technicians.

Add Invoice
1. Click the Purchase tab in the header pane to open the purchase list view page.
2. Click the PO Name link of the Purchase Order to add an Invoice.
3. From the PO details page, click Actions drop-down menu -> Add Invoice option. The Add
Invoice dialog pops up.

4. Enter the Invoice ID. This field is mandatory.
5. Select the Receive Date and the Payment Due Date from the calendar.
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6. If required, enter the relevant comments from regarding the Invoice in the Comments field.
7. You can also enable payment notification to the technicians by enabling the check box.
8. Select the technicians from the list for payment notification. Click >> button.
9. Enter the Days before which the notification should be sent to the selected technicians.
10. Click Save.

Receive Invoice
Once the Invoice is received from the Vendor, you can notify the same to the PO approvers.
1. Click Actions drop down -> Receive Invoice option. The Receive Invoice dialog pops up.
2. Enable Send Mail Notification check box.
3. Enter the email address in the To field.
4. If required, you can modify the Subject content manually and type in the message text for
mail notification in the Description field.
5. Click Send. The status of the PO changes to Invoice Received.
The Invoice details such as the Invoice ID, Received Date, Payment Due Date and Created by can be
viewed in the PO details page under Invoice and Payment tab.

Zoho Corporation Pvt. Ltd.
309

ManageEngine ServiceDesk Plus MSP – Admin Guide

Add Payment details and Notification
Once you receive the Invoice from the Vendor, you can proceed with the payment process and notify
the approvers done the payment is done.

Add Payment Details
1. Click the Purchase tab in the header pane to open the purchase list view page.
2. Click the PO Name link of the Purchase Order to add an Invoice.
3. From the PO details page, click Actions drop-down menu -> Add Payment option. The Add
Payment details dialog pops up.

4. Enter the Pay Amount ($). This field is mandatory.
5. Select the Date of Payment from the calendar.
6. If required, enter relevant comments in the Comments field.
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7. You can also enable notification if there are any dues in the payment by enabling the check
box.
8. Select the Payment Due Date from the calendar icon.
9. Select the technicians from the list for payment notification. Click >> button.
10. Enter the Days before which the notification should be sent to the selected technicians.
11. Click Save.

Payment Done
Once the payment is done, you can notify the same to the PO approvers.
1. Click Actions drop-down menu -> Payment Done option. The Payment Done dialog pops
up.
2. Enable Send Mail Notification check box.
3. Enter the email address in the To field.
4. If required, you can modify the Subject content manually and type in the message text for
mail notification in the Description field.
5. Click Send. The status of the PO changes to Payment Done.
The Payment details such as the Payment Date, Amount Paid, Payment Due Date (if any) and
Created by can be viewed in the PO details page under Invoice and Payment tab.
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E-mailing the PO Owner
When some unexpected events happen, the owner of the PO would want to be notified of them. For
example, when the purchased items have not been delivered even beyond the required date, the PO
owner must be notified of it, so that he can take necessary steps. ServiceDesk allows you to notify the
owner of the PO by attaching the PO to the mail.
To e-mail the PO owner,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click Purchase tab in the header pane. This opens the purchase order list view page.
3. In the list of POs displayed, click the Purchase Order ID for which the e-mail notification
needs to be sent. If you want to send an email to the owner of a PO in any other state, then
choose the corresponding option from the Filter Showing combo box.
4. Click Actions button on the right side of the page --> click Email the Owner under the notify

block
5. A Send Notification form is opened in a separate window with the To address filled with the
PO owner's e-mail ID. The Subject reads as Notification for Purchase Order id <number>.
6. If you want to inform anyone else about the PO details, then you can add their e-mail ID in the
CC field.
7. Enter the mail content in the Description field.
8. You can attach any relevant documents by clicking Attach File button.
9. Click Send. A message is displayed saying that the e-mail has been sent.
10. Click Close to close the window.
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E-mailing the Vendor
On approving the Purchase Order by the concern technicians, an e-mail notification is sent to the
vendor on the purchase of the items.
To e-mail the vendor,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane.
3. In the list of outstanding POs displayed, click the Purchase Order ID for which the e-mail
needs to be sent. If you wish to notify a vendor of a purchase order that is in a different state,
then from the Filter Showing combo box, select the corresponding filter option, and click the
purchase order ID that you need.
4. On the right side, under the tasks block, click E-mail the Vendor.
5. A Send Notification form is opened in a separate window with the To address filled with the
vendor's e-mail ID. The Subject reads as Notification for Purchase Order id <number>.
6. If you want to send the same notification to anyone else, then add their e-mail ID in the CC
field.
7. Enter the mail content in the Description field.
8. Click Submit. A message is displayed saying that the e-mail has been sent.
9. Click Close to close the window.
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Printing a Purchase Order
To print a purchase order,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This displays the list of All POs , by default. If you
want to print the POs from a different status, then select the status from the Filter Showing
drop down list.
3. Click the PO # of the purchase order which you wish to print. This opens the View Purchase
order page.
4. Click Actions button on the right of the task block --> Print Preview option. The Purchase
Order details are displayed in a printable format in a pop-up window.
5. Click Ctrl + P keys (OR) click Print from the browser menu to print the purchase order details.
6. Set the required options and click Ok.
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Deleting a Purchase Order
To delete purchase orders,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Purchase tab in the header pane. This displays the list of All POs, by default. If you
want to delete PO that is in any other state, then you need to choose corresponding state
from the Filter Showing combo box.
3. Enable the check box beside the PO # of the purchase order that you wish to delete, in the list
view.
4. Click Delete button. The PO gets deleted from the available list.
You can also delete individual POs by clicking the PO # and entering the PO details view. Click
Actions button --> Delete Purchase Order option.
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Searching in Purchase
You can search for purchase orders (POs) with the search in purchase option of ServiceDesk Plus MSP application.
To search for POs,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. In the left side, in the search block, choose Purchase from the Search in combo box. If you
are in the purchase section, then by default, purchase is selected.
3. In the Enter Keyword field, type in your search string.
4. Click Go or press the Enter key in your keyboard. The search results display all the purchase
orders that match the search string.
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Purchase Default Values
With this option, you can set the default values to be populated in the New Purchase Order form. You
can set default values for fields such as tax rate, the billing and shipping address, the purchase order
terms and conditions and so on. Thereby, making it feasible to add create a Purchase Order instantly.
Also, from this option, you can set the mandatory fields to be filled in before closing a PO. These
fields are the additional fields configured under Purchase Additional Fields.
To access the purchase default value configuration page,
1. Click the Admin tab in the header pane.
2. In the Purchase/ Contracts block, click Purchase - Default Values icon
Purchase Default Values page.

. This opens the

Configuring Purchase Default Values
•

Default Currency: The default currency to be displayed in all the purchase orders (PO)
generated and in places where money is being used. Say, USD, $

•

Default Tax Rate (%): Tax rate used for calculating the sales tax in all the POs generated.
You can provide different tax rate to a specific PO by entering the new rate while creating the
PO.

•

Signing Authority: Signing Authority's name.

•

Tax Shipping: Enable the check box for additional tax in shipping of the items.

•

Shipping Address: Select the default Site to which the PO items needs to be shipped.

•

Billing Address: Select the default Site for invoice and billing the PO items.

•

Cost Center: Default cost center department to be displayed.

•

Approver (s): Approvers for the purchase order. The approvers can be the users or
technicians in your organization.

•

PO Owner as Approver: Enable the check box if you wish to add the PO owner as the
approver.

•

Multi Approval: If there are more than one approvers, on enabling multi approval check box,
the PO is approved only if all the approvers approve the PO. The PO is rejected even if one of
the approvers rejects the PO.

•

Terms and Remarks: Terms and remarks while making the purchase.

•

PO# Start From: Customize the PO number.

Mandatory fields for closing PO
The fields listed in this block are the PO additional fields configured in the application. Enable the
check box beside the field that should be filled in before closing the PO. Click Save to save the
settings.
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Purchase Order Additional Fields
You can configure purchase additional fields that need to appear in the new purchase order form.
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Admin tab in the header pane.
3. In the Purchase/Contracts management block, click the Purchase - Additional Fields icon
. This opens the Purchase - Additional Fields page. You can add four types of fields in the
form: text, numeric, date/time and cost.
4. To add the text fields, enter the label name in the form fields below the Label heading. If
required, enter the description for the field.
5. You can choose the type of text field that you wish to add by selecting the radio buttons.
o

Single-line text field: Allows you to add just a text field in the new purchase order
form.

o

Multi-line text field: Allows you to add a text box where a lengthy description can be
added in the new purchase order form.

o

Pick List: Allows you to add a combo box in the new purchase order form. Contents
of the combo box can be added by specifying it in the text field and adding it to the
list. This gives you an option to select from the list . In all the three cases, you can
add default values for the text field in the space provided for the field.

To add items for the pick list, enter the value in the text filed and click Add Item. To select the
default selected value of the list, click on the value in the list.
6. To add numeric fields, click the Numeric tab and then enter the label name in the form fields
provided for the same.
7. To add date/time fields, click the Date/Time tab and enter the required details.
8. To add the cost field, click the Cost tab. You have two cost type fields, Add cost (for cost
addition) and Subtract cost (for cost subtraction). Click the corresponding radio button to
select the cost fields.
9. Click Save. A message for successful creation of the fields is displayed.
These fields (except for cost) appear under the General Information in the New Purchase Order
form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete
the label names that you wish to remove from the fields of the form and click Save. The respective
fields that you deleted will be removed from the New Problem form.
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General Ledger Code (GL Code)
You can add all the general ledger codes using this option. A general ledger account will have a
specific code for all transactions in the organization. On specifying the GL code you will be able to
track the necessary information for a specific transaction.
Example: If you like to know all your company's IT purchases for the November month 2007, then
you can specify the GL code for IT purchases in november 2007 and get the details.
1. Login in to ServiceDesk Plus - MSP application using your user name and password.
2. Click on the Admin tab in the header pane.
3. In the Purchase/Contracts management block, click GL Code icon
Code List page.

. This opens the GL

To Add GL Code
1. Click the New GL Code link on the right hand side of the page. This opens the GL Code
Details page.
2. Specify the GL Code in the given fields. This is mandatory field.
3. Specify any relevant information about the GL Code in the Description field.
4. Click Add GL Code button to add the code to the GL Code list below.

To Edit GL Code
1. Click the Edit icon

on the left side of the GL code. This opens the edit GL code page.

2. Modify the value and save the details.
3. Click Add GL Code button.

To Delete GL Code
1. Click the Delete icon

on the left side of the GL code.

2. A dialog box pops up asking your confirmation on the delete process. Click Ok to proceed.
You can see the GL Code deleted from the list.
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Cost Centre
Individual department or a group of department makes a Cost center. These cost centers are
budgeted and tracked for the cost, income and allocation. These cost centers will be associated with
the purchase order while making a new purchase in your organization.
To add cost centre,
1. Login in to ServiceDesk Plus - MSP application using your user name and password.
2. Click on the Admin tab in the header pane.
under the Purchase/ Contract Management block. This opens the
3. Click Cost Centre icon
Cost Centre List view page.
4. Click New Cost Centre link on the right hand side of the page. This opens Cost Centre
Details page.
5. Specify the Cost Centre Code in the given text field. This is a mandatory field.
6. Specify the Name of the cost centre in the given text field. This is a mandatory field.
7. Select the Department from the list. This is a mandatory field.
8. Specify the Owner name in the given text field. This is a mandatory field.
9. Specify the Description about the cost centre in the given text field.
10. Click Add Cost Center button to add the cost center.
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Notification Rules
Notification Rules are helpful when an event has to be notified to the technicians.
For ex. When Purchase order is overdue or Audit changes during discovery or Software under
Compliance during discovery or when prohibited software is identified during discovery.
When the above-mentioned situations are managed suitably, it not only helps technicians in efficient
management of the assets but also brings in cost savings to the organization.

Enabling Notification Rules
1. Click on Admin tab -> Click Notification Rules icon
under the Purchase/Contract
Management block. This opens Notification Rules page.
2. To set the notification rules select the relevant notification rules by enabling the check box.
These notification rules are self-explanatory.
3. Except for Purchase order Overdue, You can assign technicians to notify of the fault for all
the other notification rules.
4. To assign technician select Choose button, this brings up the Choose Technician Name
page.
5. Select as many as technicians from the list using ctrl or shift keys.
6. Click OK button to save. You can see the selected technicians displayed in the choose
technicians grayed out field.
7. Click Save button to save the set notification rules. The notification to the administrator or to
the technicians will be generally sent through email.

Customize Message Template
1. You have default message template for Purchase Order and Contracts. To customize email
templates as per your requirement,
2. In the Notification Rules page -> under Customize Message Template, there are two
message templates available one for Purchase Order & other for Contracts.
3. Click Email Template link beside the corresponding module. This opens Message Template
page. In the Message Template edit form; the Notification Type is a non-editable mandatory
field.
4. You can change the Subject provided for the notification type.
5. In the Message block, to add content variables that need to be a part of the notification, select
the fields from the Database fields list and click >> button to move the database fields list to
the Notification fields list. If you want to remove the fields from the Notification Fields list,
then select the same and click << button.
6. To order Notification Fields you can select Forward arrow or backward arrow button.
7. On completing the modifications, click Save button to save the settings.
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Contracts
Contracts
Every organization would maintain an annual maintenance contract with third-party vendors to
maintain its infrastructure and function without any major downtime due to bad maintenance of the
assets owned by it. ManageEngine ServiceDesk Plus - MSP gives you a provision to track such
contract details, its date of commencement, and date of expiry, alert you with a reminder in advance
about the expiry of the contract, the cost incurred for the purchase and renewal of the contract, the
kind of maintenance support provided by the third party vendor, and the third party vendor name with
whom the contract has been signed. Any other related documents to the contract can also be
maintained along with these details as attachments to the contract. To open the contracts module, log
in to the ServiceDesk Plus - MSP application using your user name and password and click the
Contracts tab in the header pane.

•

About Contracts

•

Creating a New Contract

•

Viewing Contract

•

Editing and Deleting Contract

•

Viewing Contract Owner Details

•

Renewing Contract

•

Print Preview of Contract

•

E-mailing the Contract Owner

•

E-mailing the Vendor

•

Search Contracts
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About Contracts
1. Click on Contracts Tab. This brings up the Contracts view list page. By default, the list of
Open Contracts will be displayed.
2. Select the corresponding filter option from the Filter Showing combo box. You can view the
contracts with different status levels using filters. They are,
o

Open Contracts
Contracts which are active and yet to get expired comes under this category.

o

All Expired Contracts
All the expired contracts will be listed under this category.

o

Contracts expired in last 30 days
Contracts which expired in the last 30 days gets listed under this category

o

Contracts expiring in next 7 days
Contracts, which will be expiring in next 7 days, will b listed under this category.

o

Contracts expiring in next 30 days
Contracts, which will be expiring in next 30 days, will be listed under this category.

Note:
The contracts are based on the Account selected.
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Creating a New Contract
To create a new contract for asset,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Contract tab in the header pane. This opens the contracts list view page.
3. Click the New Contract button in the contract index page. (OR)
in the home page -> Click Contracts option
Click Quick Actions link
under Create New. This opens the Add Contract form. This form has three major sections:
Contract Details, Contract Rules, and Notification Rules.
4. Select The Account Name for which the contract is to be created. This is mandatory field.
5. Specify a name for the contract in the Contract Name field. This is mandatory field.
6. Enter relevant Description for the contract in the respective text field.
7. Select the Maintenance Vendor from the combo box listing all the vendor names available.
This is mandatory field. If the vendor is not listed, then click Add New Vendor button beside
the combo box. The Add New Vendor window pops up as shown below,

1. Specify the name of the vendor in the given field. This is mandatory field.
2. Enter a brief description about the vendor in the respective field.
3. Specify the Contact Person in the given field.
4. Click Save. The added vendor is selected and is displayed in the combo box.
If you do not wish to add a new vendor then click Close.
8. In the Support field below it, enter the details regarding the kind of support that will be
provided by the vendor to you.
9. You can add files that are related to the contract and are necessary to be maintained and
referred to along with the contract information. Click Attach File button. The Attach File
window pops up as shown below,
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1. Click the Browse button to open the file selector window.
2. Select the file that you wish to add and click the Attach File button. The
selected file is added and is displayed in the same window just below the file
selection field. The total size of the attachments should not exceed 10 MB.
3. The attached file gets listed along with the File name and the size. The file
beside the file name.
can be deleted on clicking the Delete icon
10. In the Contract Rules section, you need to choose the assets that are to be maintained
under this contract and mention the maintenance period and maintenance cost. Select the
Assets that are covered under the contracts from the Maintained Assets list.
11. To add more resources to the list, click Select Resources for this contract link. This opens
Select Resources page.
1. Specify the Resource Name or Product Type or Product in the search field.
2. Click Search button to get the result. Select the required resources by
enabling the check box.
3. Click Add Items button to add the selected items.
4. Click View Resources>> button to view the selected resources.
5. Click Add Resources to Contract button to add resources to the Maintained
Assets list.
6. Click Remove Selected Resources icon to remove selected resources from
the list.
12. The Active period of the contract is a mandatory field where you need to enter the From and
To date of the contract period. Choose the dates from the calender that can be invoked by
clicking the icon.
13. Enter the maintenance cost in terms of $ in the Maintenance Cost field.
14. Select the check box beside Enable Notification. This displays the notification rules
information. Here you need to select the technician who needs to be notified about the expiry
of the contract and how many days before the expiry, the notification needs to be sent.
15. Click Save.
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Viewing a Contract
To view a contract and its details,

Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is
displayed.
3. Select the Account of the contract you wish to view using the Accounts combo box.
4. Select the status of the contract you wish to view using the Filter Showing combo box.
5. Click the Contract Name link that you wish to view. This opens the View contract page.
The Contract ID is a unique ID given to the contract during the time of its creation. This is system
generated and is used to identify and track the contract uniquely. The contract details are grouped
under three major heads: Contract Details, Contract Rules, and Notification Rules. Based on the
entries made in the contract during the time of its creation, the details will be displayed in the
respective section.
In the Contract Rules block, the assets that are maintained under the current contract are displayed.
These assets are hyperlink to display their respective details. Click any of the asset names to open
the Edit Asset form. Here you can edit the required information and update the same. To know more
on editing assets, refer to the Editing Asset Details section.
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Editing and Deleting Contracts
Editing Contract
To edit a contract,
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password or using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is
displayed.
3. Select the Account of the contract you wish to view using the Filter Showing combo
box.
4. Select the status of the contract you wish to edit using the Filter Showing combo box.
5. Click the Contract Name link that you wish to edit. This opens the View Contract
page.
6. Click the Edit button on the right hand side of the page. (OR)
Click Actions combo box - > Edit Contract option. This opens the Edit Contract
form.
7. The existing details of the contract is displayed. As the contract ID is a system
generated ID, it is not available in the edit contract form. You can edit all the other
details.
8. Once you are done with editing, click Save. If you entered wrong information and
want to know what the initial values were, then instead of Save, click Reset.

Deleting Contract
To delete contract,
1. Log in to the ServiceDesk Plus - MSP application using your user name and
password or using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is
displayed.
3. Select the Account of the contract you wish to view using the Accounts combo box.
4. Select the status of the contract you wish to delete using the Filter Showing combo
box.
5. Click Delete on enabling the check box beside the contract.
6. A pop up window confirming the delete operation appears. Click Ok to proceed. The
contract will be deleted from the list.
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Viewing Contract Owner Details
By default, the owner of a contract is the person who enters the contract details into the application.
To view the owner details,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password or
using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is
displayed.
3. Select the Account of the contract you wish to view using the Accounts combo box.
4. Click the Contract Name link to view the contract owner details. This opens the View
Contract details page.
5. Click Actions combo box - > View Owner Details option. A pop up window containing the
owner details such as, name, employee id, designation, contact information appears.
6. Click Close to close the pop-up.
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Renewing a Contract
To renew a contract,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password or
using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open contracts is
displayed. Select the status of the contract which you wish to renew using the Filter Showing
combo box.
3. Click the Contract Name link that you wish to renew. This opens the View Contract page.
4. Click Actions combo box -> Renew Contract option. The Renew Contract form is displayed
with the contract rules of the original contract. As the contract ID is a system generated ID, it
is not available in the renew contract form. The contract name is appended with the word
renewed. You can edit the name but ensure that the contract name is unique and does not
have the old name.
5. Enter the Description for the contract.
6. Choose the maintenance vendor from the combo box. If the vendor is not listed, then click
Add new link beside the combo box. The Vendor Details page pops up. Specify the name of
the vendor, description, and the contact person name in the pop-up window. Save the
changes.
7. If you have any information on the type of support, enter the same in the Support text area.
8. If there are any documents that you wish to attach to the contract, click the Attach File button.
The Attach File window pops up.
1. Click the Browse button to open the file selector window.
2. Select the file that you wish to add and click the Attach File button. The selected file
is added and gets listed along with the File Name and size. If you wish to delete any
beside the file. The total size of the
of the file then click the delete icon
attachments should not exceed 10 MB.
9. Select the Assets that are covered under the contracts from the Maintained Assets list. To
add more resources to the list,
1. Click Select Resources link. This opens Select Resources page.
2. Specify the Resource Name or Product Type or Product in the Search field.
3. Click Search button to get the result.
4. Select the required resources by enabling the check box.
5. Click Add Items button to add the selected items.
6. Click View Resources>> button to view the selected resources.
7. Click Add Resources to Contract button to add resources to the Maintained Assets
list.
10. The Active period of the contract is a mandatory field where you need to enter the From and
To date of the contract period. Choose the dates from the calender that can be invoked by
clicking the

icon.

Zoho Corporation Pvt. Ltd.
329

ManageEngine ServiceDesk Plus MSP – Admin Guide

11. Enter the maintenance cost in terms of $ in the Maintenance Cost field.
12. Select Enable Notification option by enabling the check box. On enabling you get the User
list & Notified User list. To notify users regarding contract expiry select the user from the
User list and click forward >> button to move the user to the Notified User List. Specify the
days before which the information has to be notified in the Notify before field.
13. Select the check box, Disable all notifications for the old contract, to disable notifications
of the old contract.
14. Click Save.
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Print Preview of Contract
To print a contract,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password or
using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is
displayed.
3. Select the corresponding filter option from the Filter Showing combo box.
4. Click the Contract Name that you wish to print. This opens the view contract page.
5. Click Actions combo box -> click Print Preview option. The contract details are displayed in a
printable format in a pop-up window.
6. Click the Print option to print the contract details.
7. Set the required options and click OK.
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E-mailing the Contract Owner
By default, the owner of a contract is the person who enters the contract details into the application.
To send an e-mail to the owner,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password or
using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is
displayed in the contract list view page.
3. Click the Contract Name link of the contract you wish to e-mail the owner. This opens the
view contract page.
4. Click Actions combo box -> E-mail the Owner option. A Send Notification window opens
with the owner's e-mail ID in the To field. The subject reads as Notification for Contract ID
<number>.
5. If you wish to notify about the contents of the e-mail to anyone else also, then enter their email ID in the CC field.
6. Enter the e-mail content in the Description area.
7. Click Send. A message is displayed saying that the e-mail has been sent successfully.
8. Click Close.
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E-mailing the Vendor
To notify the vendor,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password or
using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open contracts are
displayed in the contract list view page.
3. Click the Contract Name link of the contract you wish to notify the vendor. This opens the
View Contract page.
4. Click Actions combo box - > click E-mail the Vendor option. A Send Notification window
opens with the vendor's e-mail ID in the To field. The subject reads as Notification for
Contract ID <number>.
5. If you want to send the same notification to anyone else, then add their e-mail ID in the CC
field.
6. Enter the e-mail content in the Description area.
7. Click Send. A message is displayed saying that the e-mail has been sent successfully.
8. Click Close.
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Searching Contracts
You can search for contracts with the Search in contracts option of the ServiceDesk Plus - MSP
application.
To search for contracts,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password or
using admin login.
2. In the search block on the left hand side of the page, choose Contract from the Search in
combo box. If you are in contracts section, then by default, contract is selected.
3. In the Enter Keyword field, type in your search string.
4. Click Go or press the Enter key in your keyboard. The search result displays all contracts that
match the search string.
You can search for contracts based on the contract name, asset names added in the contract, and
owner of the contract.
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Import Contracts from XLS file
The easy-to-use XLS import option in ServiceDesk Plus - MSP allows you to import the Contracts
information from the existing database as well as from other applications.
To import Contracts from a XLS file,
1. Click Requests tab in the header pane. The Request List view page is displayed.
2. Click Import from XLS button. The Contract Import Wizard is displayed.
Steps to Import Contracts from XLS file
Step #1: Locate XLS file
1. Click Browse button to select the XLS file.
2. On locating the XLS file from the File Upload window, click Open. The name of the XLS file is
displayed beside the browse button.
3. Click Submit button.
Step #2: Customize Mapping
1. Select the date format to represent all the date fields.
2. Map the Contract field with the field names from the XLS file. If there are any additional
attributes configured, then the same appears in the customized mapping form.
3. Click Import button. The details of the Contracts from XLS are imported.
4. On completion, the data on the total Contracts, the number of Contracts imported and the
number of Contracts failed to import are displayed.

Warning

If there are any failure records while importing the Contracts, do not re-import the
same .xls file. Instead, download the failedContractsList.xls available in the
Imported Result page, correct the errors and then import to avoid duplicate
Contracts.
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Solutions
Solutions
The Solutions module in ServiceDesk Plus - MSP enables you to record solutions to the most
common problems faced by your users. The recorded solutions function as a knowledge based for
your technicians. The technicians can refer the knowledge base articles and resolve the request
instantly. This reduces the turnaround time in attending to the requests generated by the requesters
and closing the same. The solutions are account based i.e., you can maintain separate knowledge
base for each account.
All requesters and technicians who have permissions to view the solutions module can access this
section of the application. The ServiceDesk Plus - MSP administrator can assign access privileges to
the various technicians for the solutions section. This access privilege can vary from just view only
privilege to full control privileges. For setting the access privileges to technicians, refer to the
Configuring Technicians and Configuring Roles sections. Moreover, new technicians joining the
organization can browse through these recorded solutions to have an idea of the frequently resolved
problems.
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About Solutions
1. Click on the Solutions tab. This brings up the Solutions view list page.
2. Select the corresponding filter option from the Filter Showing combo box. You can view the
solutions with different status levels using filters. They are,
o

All Solutions
All the solutions irrespective of the status can be viewed under this category.

o

Approved Solutions
All the approved solutions will be listed under this category.

o

Approval Pending Solutions
The Solutions which are sent for approval gets listed under this category.

o

Unapproved Solutions
The Solutions which are not approved and has to be sent for approval will be listed
under this category.

o

Rejected Solutions
All the rejected solutions will be listed under this category.
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Adding a New Solution
The solutions module is a knowledge base with resolutions for various problems encountered by your
help desk team. It can have solutions grouped under various topics for ease of locating the
corresponding solution. You can add new solutions to the existing knowledge base.
You can create solutions that are applicable for a single account, many accounts or for all the
accounts
To add a new solution,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Solutions tab in the header pane. This opens the solutions list view page. Click
New Solution button.(OR) Click Quick Actions -> Solutions under the Create New block.
This opens the New Solutions page. The title, contents and the topic fields are mandatory.
3. Enter a title for the solution you wish to add in the given text field. This can be a summary of
the complete solution in one line that will exactly tell what the solution is all about.
4. Enter the complete solution in the Contents text field.
5. If this solution requires any additional files to support the article, then you can attach the same
by clicking Attach File button. The Attach File window pops up as shown below,

i. Click Browse and select a file from the file chooser window. Click Open.
ii. Click Attach File button. The attached file gets listed along with its size.
iii. Repeat steps 1 and 2 to attach another file.
6. The Topic field is a combo box that lists all the available topics and sub-topics. Select the
topic in which you wish to add the current solution.
7. The keywords are optional, but the presence of a keyword for the solution will help in
improving the search capability and will provide accurate search results. While entering
multiple keywords, separate them with comma.
8. You can assign this solution to an account by selecting the account from the Available
Accounts column. Click >> button to move the selected accounts to Associated Accounts
column.
Note: Apart from the administrator, the technicians can also create solutions for ‘All Accounts’
provided the technician has the access to ‘All Accounts’.
9. To publish the solution in the self-service portal also, select the check box Publish this
solution in Self-Service Portal also.
If you have configured User Groups for the accounts selected in Step 9, then you can restrict
the solutions to a specific user group by selecting the user group from the available list, use
>> button to move it to the selected user group block. The solution will be available to the
user group on logging into the application.
10. Click Add. If you do not wish to add the solution then click Cancel.
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Viewing Solution Details
You can view the solution along with the solution details such as created by, created on, status and so
on in the solution module.
To view the solution details,
1. Login to ServiceDesk Plus - MSP application using your username and password.
2. Click Solution tab in the header pane. This opens the solution list view page. Choose the
account of your choice. The solutions that are applicable to that account get displayed as
shown below. You can also select 'All accounts' to view all the solutions that you have access
to.

Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.

3. Click the solution which you want to view from the solution list view page. This opens the
View Solutions Details page as shown below,
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4. The Solution Id and the Status gets displayed on the right hand side of the page.
5. The Subject, Type and Category can be viewed along with the complete solution.
6. The Keywords gets listed below the solution. If there are multiple keywords then they are
separated by commas.
7. The Solution Details such as Created By, Created On, Type, Views, Status and so on can
be viewed under this block. The requester details can be viewed by clicking the created by
link.
8. The Accounts to which this solution is available is displayed. Also, the selected User
Groups in the account is displayed.
9. The comments given to the solution on approving/rejecting can be viewed in Comments
History. The status of the solution can also be viewed.
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Editing a Solution
To edit a specific solution,
1. From the solutions list view page, click on the solution which you want to edit using the filter
showing combo box. (OR) you can select the solution which you wish to edit by clicking the
topic from browse by topics. All the solutions, irrespective of the status, available under that
topic gets listed.
2. Click the Edit button available on the right hand side of the view solutions details page.
3. You can edit all solutions to which you have access including those that are applicable to 'All
accounts'. There is only one copy of the solution that gets saved in the database. So, any
changes you make to a solution will be reflected for all the accounts to which the solution is
associated.
4. In the Edit Solutions page, make the necessary modifications. The title, contents, and the
topic under which you wish to place the solution are mandatory fields. You can also add more
attachments or delete existing ones.
5. Click Save. If you want to drop the modifications made, click Reset. If you do not want to
save the changes and get back to the solutions listing, click Cancel.
6. On Saving the solution, the status of the solution shows Unapproved. The solution has to be
submitted for approval to the concerned technician. To know more on refer Submit for
Approval.
Alternatively, to open the solution that you wish to edit, type the solution title in the keyword field of the
search block and click Go or press the Enter key. The solutions matching the search string will be
listed, from which you can choose the solution and edit the same.
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Submit for Approval
The newly added solutions have to be approved by the appropriate technician. Only when a solution
is approved, it can be published in the self-service portal. To provide access permission to approve
solutions refer Configuring Roles.
To submit for approval,
1. From the solutions list view page, select Unapproved Solutions from the filter showing
combo box. The list of all Unapproved solutions gets displayed.
2. Click the subject of the solution which you want to submit for approval. This opens the View
Solutions page. The Status is shown as Unapproved below the Solution Id.
3. Select Submit for Approval under the Approve Actions combo box on the right hand side
of the page. This opens Submit for Approval page.
4. Select the To address by invoking the icon
window as shown below,

. This opens the Add users for Approval pop up

•

Enable the check box adjacent to the user whom you want to submit the solution for
approval.

•

The To text field gets filled with the mail id of the corresponding administrator.

5. The Subject and Description is entered as given in Notification Rules email template. If
needed you can modify the subject and description content manually, else you can change
the same from the Notification Rules email template under Helpdesk.
6. If there is any relevant files to be attached then, click Attach File button.
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7. Click Send to submit the solution for approval.
The mail notification is sent to the person who was addressed in the To field of the notification. The
mail contains the link to the specific solution which needs approval. On clicking the link, it leads you to
the login screen, where on providing the proper credentials, the solution awaiting approval opens. To
approve/reject solutions refer Approve/Reject Solutions.
Note: Apart from the administrator, the technicians who have access to 'All Accounts' can approve the
solutions of ‘All Accounts’.
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Approve/Reject Solution
On submitting the solutions for approval, a mail notification is sent to the appropriate technician
requesting the approval of the solution along with a link for the solution. The solution can be either
approved or rejected. The approve solution access permission is given in Configuring Roles.
Apart from the administrator, the technicians who have access to 'All Accounts' can approve the
solutions of ‘All Accounts’.
To approve/reject solution,
1. Click the link to open the solution.
2. Login to the ServiceDesk Plus - MSP application using your username and password. This
opens the view solution details page of the solution pending for approval. The status of the
solution shows Approval Pending on the right hand side of the page.
3. Click Approve Actions combo box -> Approve Solution. This opens the Approve
Comments pop up window. Specify any related Comments in the field provided. Click
Approve.
4. If you wish to reject the solution then, select Reject Solution under Approve Actions. This
opens Reject Comments pop up window. Specify comments, such as reason to reject the
solution in the Comments field. Click Reject.
To approve/reject bulk solutions,
1. From the solution list view page, select Unapproved Solutions from the filter showing combo
box. Enable the check box adjacent to the solutions which you want to approve/reject.
2. Click Actions button -> Approve Solution. This opens the Approve Comments pop up
window. Specify any related Comments in the field provided. Click Approve.
3. If you wish to reject the solution then, select Reject Solution under Actions button. This
opens Reject Comments pop up window. Specify comments, such as reason to reject the
solution in the Comments field. Click Reject.
The approved solutions can be viewed by the requesters in the self service portal. The rejected
solutions can be edited and sent for approval to the concerned technician. Thus the solution is not
completely deleted from the list.
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Delete Solutions
To delete a specific solution
1. From the solutions list view page, click on the solution which you wish to delete using the filter
showing combo box.
2. Alternatively, click the topic in which the solution you wish to delete is available. All the
solutions available under that topic are listed. Alternatively, you can also search for the
solution using the Search in Solutions feature.
3. Click the Delete button available on the right hand side of the page. A confirmation dialog
opens.
4. To continue deleting, click OK; or else, click Cancel.
To delete multiple solutions,
1. Enable the check box adjacent to the solution in the solutions list view page.
2. Click Delete button. A confirmation dialog opens.
3. Click Ok to continue. The solution gets deleted from the list.
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Search in Solutions
ManageEngine ServiceDesk Plus - MSP allows you to search for solutions using its Search in
Solutions option.
To search for solutions,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. In the search block, choose Solutions from the Search in combo box.
3. In the Enter Keyword field, type in your search string.
4. Click Go or press the Enter key in your keyboard. The search results display all the solutions
that match the search string.
Alternatively, from the solutions list view page, enter the search string in the Search Solutions text
field. Click Search Solutions button. The list of solutions corresponding to the search string gets
displayed.
Another option to search solutions will be using the column-wise search option. To perform a columnwise search
1. Click the search icon at the end of the solution list view headers. This opens the search
field just below every column in the list view as shown below,

Note: The Accounts select box on top of the page allows you to select the account for which
you want to view data .
If 'All Accounts' is selected, the data pertaining to all accounts for which the technician
has access is displayed.
If an account's name is selected, data pertaining to the selected account is displayed.

2. Enter the search key in field under the column of your choice. You can enter keywords in
more than one column to perform a combined column search.
3. Click Go. The search results matching the search string(s) are displayed.
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Browsing Solutions by Topic
To browse for solutions using topics,
1. Log in to ServiceDesk Plus - MSP application using your user name and password.
2. Click the Solutions tab in the header pane. This opens the Solutions list view page.
combo box next to manage topics link. This opens the
3. Hover over
Categories window listing all the topics and their sub topics as shown below,

4. To view all the sub topics, click >>Show All link on the right hand side of the page. This lists
out the topics and sub topics in a logical manner.
5. On clicking the topic, the solutions of the topic and its corresponding sub topics gets listed.
Click the sub topic to view the solutions only in that sub topic.
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Managing Topics
Managing Topics
You can add new topics, rename an existing topic, associate topic groups, and move topics and
subtopics to a different parent topic. This provides you the ability to organize your solutions in a logical
manner. Only the Administrator and Account Admin can Manage topics.
To manage topics
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Solutions tab in the header pane.
3. Click the Manage Topics link available in the Solutions list view page adjacent to the Browse
by Topics combo box. The manage topics page is displayed with the available topics and their
subtopics listed in the hierarchy. From here you can add, rename, move, and delete topics.

Adding a New Topic
To add a new topic
1. In the Manage Topics page, click the Add New Topic button. The add new topic form is
displayed just above the available topics list with the Topic Name and the list of parent topics
as the two fields. If there are no topics available then the Choose a parent topic field will
have the /Topic Root alone.
2. Enter the name of the topic in the Topic Name field and choose the parent topic under which
you want to place the new topic.
For example - if you want to add the new topic as a main level topic, choose /Topic Root as
the parent topic. Or else, choose any other topic as the parent topic.
3. If you add the topic to /Topic Root, you can associate this topic to an existing topic group. If
you choose the parent topic as /Topic Root, the list of available topic groups are displayed.
Note: If you add a topic to a topic group, all the sub-topics under that topic are also added to
the topic group.
4. Click Add. The topic is added as subtopic to the parent that you chose and is displayed in the
available topics list. A message is displayed stating that the new topic is added successfully.

Renaming a Topic
To rename a topic
1. In the Manage Topics page, click the Edit link of the topic that you wish to rename. The Edit
topic form is opened.
2. Type the new name for the topic in the topic name field.
3. Click Save.
The changes made to the topic name are displayed in the available topics list and a message is
displayed above the list.
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Moving a Topic
To move a topic to a different parent
1. In the Manage Topics page, click the Edit link in the row of the topic that you wish to move.
The Change Parent Topic form is displayed. In the Choose the parent topic text box, by
default, the current parent topic of the topic that is to be moved is selected.
2. Select the new parent topic.
3. Click Save. If you do not want to move the topic to a different parent topic, then click Cancel.

Note: You cannot move a topic as a subtopic to its current child topic itself.

Deleting a Topic
To delete a topic
1. In the Manage Topics page, click the Delete link in the row of the topic that you wish to
delete. A confirmation page opens.
2. Click Confirm to delete the topic or click Cancel to retain the topic. If you click Confirm, then
the topic is deleted and a message is displayed stating that the topic is deleted.
When a topic is deleted, by default, the solutions present under the topic are also deleted and if there
are any subtopics, then these are moved to the /Topics Root. You can later choose to move the
topics as child topics to other parent topics. But if you want to override the default actions performed
during the delete operation, move the subtopics of the topic which you plan to delete, under a different
parent topic of your choice. Also, if you do not wish to delete the solutions that are available under the
topic to be deleted, then you can move the solutions to other topics. For this, when you click the
Delete link and are led to the confirmation page,
1. Select the check box below the first point. This opens the topic list box, and enables you to
move the reference of the solutions of the topic to a different parent topic of your choice.
2. Select the parent topic of your choice from the list box.
3. To move the subtopics to a different parent topic, select the check box below the second point
in the confirmation page.
4. In the topic list box, select the parent topic of your choice under which the subtopics of the
current parent topic that is being deleted can be moved.
5. Click Confirm.
This deletes the topic after moving the solutions and subtopics from the deleted topic to the parent
topic you selected.

Note: You cannot move a subtopic of the topic that is going to be deleted, as a subtopic to
another child topic of the same parent topic which is going to be deleted.
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Billing
Bill Generation
Bills are automatically generated and e-mailed to the addresses specified in the Contract Billing page.
Once the bills are generated, it will be available under the Billing tab. If the bill amount is paid by the
customer, then the status of the bill can be marked as paid.
You also have an option to regenerate a bill if any changes are made to the requests during the billing
period. Once a bill is regenerated, you will have the option to send the bill to the customer and mark
the regenerated bill as Main Bill. After a bill is marked as the main bill, the originally generated bill is
replaced by the new bill and displayed in the Bill list page.
You can also generate ad-hoc bills using the Billing tab.

View Bill
1. Login to ServiceDesk Plus - MSP application using the admin username and password.
2. Click the Billing tab in the header pane. This opens the bill list view page.
3. Select the required account using the Account drop down to view the bills generated for that
account. Here you can view, edit (mark as paid), or regenerate bill.

Mark Bill as Paid
Once the bill amount is paid by the customer, the service provider can manually mark the bill status as
paid.
To mark bill as paid,
1. In the bill list view page, click on the Edit icon

beside the bill to edit.

2. The bill opens in editable format with all the bill details.
3. To mark the bill as paid, select the Yes option from the Bill Paid drop down.
4. Select the Date on which the bill is paid from the calender icon

.

5. You can also download the copy of the bill by clicking on the Download link.
6. Click Submit. The Last Updated by field is updated automatically.

Regenerate Bill
If you have made any changes to the request during the billing period, the changes can be updated in
the bill with the option of regenerating the bill. Once a bill is regenerated, you will have the option to
send the bill to the customer and mark the regenerated bill as main bill.
To regenerate a bill,
1. Click the Billing tab in the header pane. This opens the bill list view page.
2. Select the required account using the Account drop down to view the bills generated for that
account.
3. Click the Regenerate link in the bill which you want to regenerate.
4. The bill is regenerated and displayed in the Billing Report page.
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5. From the Billing Report page, click Mark as main bill button to mark the bill as main bill. A
message is displayed stating that the bill is made as main bill successfully.
6. You can send the regenerated bill to the customer by clicking on the Send bill to customer
button. The regenerated bill will be automatically e-mailed to addresses configured in the
contract billing page.

Generate Ad Hoc Bill
If you would wish to view the bill before the billing date, then you have an option to generate ad hoc
bills.
To generate ad hoc bill,
1. Click the Billing tab in the header pane. This opens the bill list view page.
2. Select the account using the Account drop down to generate bill.
3. Click the Generate Bill button. Select the date column name from the Select Column combo
box.
4. Select the period for which you want to generate the bill. If you would like to generate bill
during this week, last week, this month, last month, this quarter, last quarter, today, or
yesterday then select the During radio button and select the time period from the combo box.
(OR) If you wish to provide a custom period, then select the From and To date using the
calendar icon.
5. Click the Generate Bill button. The ad hoc bill is generated and displayed.

Zoho Corporation Pvt. Ltd.
351

ManageEngine ServiceDesk Plus MSP – Admin Guide

Configuration Management Database (CMDB)
Configuration Management Database (CMDB) is a centralized repository that stores relevant
information about all the significant entities in your IT environment. The entities, termed as
Configuration Items (CIs) constitutes of Hardware, the installed Software Applications, Documents,
Business Services and People that are part of your IT system. Unlike the asset database that
comprises of a bunch of CIs, the CMDB is designed to support a vast IT structure where the
interrelation between the CIs are maintained and supported successfully.
Each CI within the CMDB is grouped under specific CI Types, and is represented with Attributes and
Relationships. Attributes are data elements which describe the characteristics of CIs under a CI
Type. For instance, the attributes for CI Type Server would be Model, Service Tag, Processor Name
and so on. Relationships denote the link between two CIs that identifies the dependency or
connection between them.
The CMDB in ServiceDesk Plus - MSP, keeps a track of all the pending requests, problems and
change raised for the CI Type - Assets, Business and IT Services. Any impact cause by the
malfunctioning of these CIs on other CIs can be identified using the Relationship Map, and specific
measures can be adapted to minimize the effect. The CMDB, thus, functions as an effective decision
making tool by playing a critical role in Impact Analysis and Root Cause Determination.
Before you begin populating the CIs into the CMDB, you need to configure the CMDB configurations
(Configuration Item Types and Relationship Types) in the Admin tab.

CMDB - Admin Configurations
The Configuration Management Database (CMDB) module can be accessed by the administrator,
and technicians with CMDB Role. If you are the administrator or technician having access permission
to the CMDB module, then before you go ahead configuring the CIs and their relationships, you need
to configure the following Admin configurations,

•

Configuration Item Types (CI Types) - Categorize your CIs under specific CI Types.

•

Relationship Types - Configure the nature of relationships set between different CIs.
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Configuration Item Types (CI Types)
Configuration Item Types (CI Types) denote the broad classification of different entities, under
which, the Configuration Items (CIs) are categorized. Any organization specific entity can be
considered as a CI Type, such as Business Services, Workstations, Servers, Documents and even
the People working for your organization.
Each CI Type can be defined with specific Attributes and Relationships that are unique for the CIs
classified under them.
In case your CI Type structure is granulated and possess various types, then you can further drill it
down to Sub Types. For instance, the CI Type-Server may possess various sub types such as File
Server, Application Server, Database Servers and so on.

To access the Configuration Item Types List view,
1. Click Admin tab in the header pane.
2. In Asset Management, click Configuration Item Types. The Configuration Item Types List
view is displayed.
From this page, you can add CI Types, create new CIs for a CI Type, view CIs under a CI Type, and
also view the relationship map with the default relationship attributes.
Topics discussed under this section:
•
•
•

•

Representation of Icons in the CI Type List view
Adding CI Type
Attributes
•
• Setting Attributes for CI Type
• Using Drag and Drop Field
• Editing & Deleting Attributes
Setting default Relationships
•
• Adding Relationships
• Adding Relationship Attributes
• Viewing Relationship Map
• Editing & Deleting Relationship

Representation of Icons in the CI Type List View
•
•
•

- To create a new CI under a CI Type. Clicking this icon takes you to the Add New CI form.
- To view CIs under a CI Type.
- To view the relationship map for a CI Type. The relationship map holds the default
relationships configured for the CI Type.
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Adding CI Type
To add CI Type from the Configuration Item Types list view page,
1. Click Add New CI Type link. The Add New CI Type form pops-up.
2. Enter a Name for the CI Type. For example, Workstations, Business Services, Department.
This field is mandatory.
3. If the structure of the CI Type is granulated, then you can further drill it into Sub Types. For
instance, the CI Type-Workstation can be further drilled down into Sub Types like IBM
Workstation, Unix Workstation and Windows Workstations. If the entered CI Type name is a
sub type, then select the Parent Type from the drop down.

4. Enter brief Description about the CI Type in the field provided.
5. Click Save button.
The page navigates to the Edit Configuration Item Type with the CI Type name, Parent Type
and Description pre-populated with the specified values.
6. Choose an Icon to depict this CI Type in the list view. By default, an icon is uploaded for the
CI Type. To upload a different icon, click Change link. Click Browse to select the image and
click Import Image button.
NOTE: The support formats to import images are jpg, gif and png.
7. Most of the CIs populated in the CMDB may be assets or components, such as Workstations,
Servers, Access Points, Keyboards and so on. These CIs can be tracked as assets in the
asset database.
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To track CIs under a CI Type as an IT or Non-IT assets/components in the Asset module,
enable Track as asset check box. Select the Category and asset Type from the drop down.
NOTE: The Track as asset option is available only for the parent CI Type.

Attributes
Attributes are data elements that describe the characteristics of the CI Type. For instance, the
attributes for the CI Type-Workstation could include Model, Service Tag, IP Address, Processor
Speed and so on. By default, the form displays the Attributes tab.

Setting Attributes for CI Type
You can set two types of attributes for a CI Type namely, Default Attributes and Attributes Specific
to CI Type. Default Attributes are common to all the CI Types, such as Name, Site, Department and
so on. To add a default attribute, click Edit button. [Refer Using Drag and Drop Fields topic to know
more on configuring default attributes].
CI Type Specific Attributes provide more information on a particular CI Type. The attributes for the
CI Type-Workstation can be considered as the attributes specific to the CI Type. The attributes,
default attributes and CI Type specific attributes, are configured using the Drag and Drop fields.

Using the Drag and Drop Fields
The Drag and Drop Field section consists of different customizable fields such as, Single line, Multi
line, Pick List, Numeric and Date fields. Apart from these customized fields, System Attributes
(entities configured in the Admin tab or data fetched during scan) can also be set as attributes for the
CI Type.

Adding System Attributes
1. Drag the System Attribute field in the form. The System Attributes form opens.
2. Choose the System Attributes from the drop down. You can enter a different name for the
system attribute in Label Name field.
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2. Click
icon to add another system attribute.
3. Click Add button to add the system attribute(s) in the form.
4. Click Save.

Adding Customizing Fields
To add the other customized fields,
1. Drag and drop the field (Single Line, Multi Line, Pick List, Numeric or Date field) in the CI
Type attribute form.
2. The Add Attribute form pops up where you need to enter the Attribute Name and
Description. In the case of Pick List fields, enter the options to add to the list.
3. Click Save. The customizable field is added in the form.
You can re-arrange fields in the form by dragging the fields and placing it over the highlighted
area.
NOTE:
1. Newly added Product Type with Type field as Assets or Components will be
considered as CI Type and populated automatically in the CI Type List view.
2. You cannot create a sub type for the CI Type - People. Instead you can create sub
types for Requesters and Technicians.
3. The sub types inherit the Attributes and Relationships from the parent CI Type. Apart
from this, attributes and relationships can also be configured for sub type.
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Editing CI Attributes
To edit a customized attribute,
1. Click the Edit icon
beside the field to modify. The Edit Attribute form pops up with the
values pre-filled while adding the attribute.
2. Modify the Attribute Name and Description field.
3. Click Save. The form is populated with the newly added changes.

Deleting CI Attributes
You can remove unwanted attributes from the CI Type form. To delete a customized
attribute,
1. Click the Delete icon

beside the field. A dialog box confirming the delete operation appears.

2. Click OK to proceed. The field is removed from the form and is added to system attributes list.
WARNING: Deleting a CI Type attribute will remove the attribute from the form. You may lose
the data configured for the attribute in the CI form.

Setting Default Relationships
You can establish default relationships between the newly added CI Type and other CI Types from
the Relationships tab. For instance, the relationship set for the CI Type Workstation can be,

Workstation
(Newly added CI Type)

Runs

Software

(Relationship Type)

(CI Type)

the inverse of this relationship type will be automatically added for CI Type - Software as,

Software
(CI Type)

Runs on
(Relationship Type)

Workstation
(CI Type)

Setting default relationships provides feasibility while adding relationship between the CIs categorized
under the CI Type. For a sub type, the parent CI Type relationships are adapted, apart from which
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new relationships can also be created. Using the Relationship Map, the relationship configured with
other CI Types can be viewed, and the map can be exported or printed.

Adding Relationships
To establish a relationship between two CI Types,
1. Click Relationships tab in Edit Configuration Item Type form.
2. Click Add button. The Add Relationship form pops up.
3. Select the nature of the relationship between the CI Type and another CI Types from
Relationship Type drop down.
4. Select the CI Type to which the relationship is established. Both the Relationship Type and CI
Type are mandatory fields.
5. Click Save. The attributes associated to the relationship can be set.

Adding Relationship Attributes
Relationship Attributes provides more information on the relationship between the CI Types. For
instance, the relationship attributes between the CI Type Workstation and Software can be, the
Version of the software installed, the Installation path, Installed on, service pack details and so on.
To add relationship attributes,
1. Click Add Relationship Attribute button.
2. Enter the Attribute Name. Say, Version Installed.
3. Select the Field Type from the drop-down. The field type can be either Single Line, Multi
Line, Pick List, Numeric or date field.
4. Enter brief Description about the relationship attribute in the field provided.
5. Click Save. The attribute is added to the relationship attribute list.
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To delete a relationship attribute,
1. Enable the check box beside the Attribute Name in the Add Relationship form.
2. Click Delete button. A dialog box confirming the delete operation appears.
3. Click OK to proceed. The relationship attribute is deleted from the list.

Relationship Map
The default relationships configured with other CI Types are viewed in the Relationship Map. Click
Relationship Map icon to view the map.

Editing Default Relationships
To edit a CI Type relationship,
1. Click the edit icon
beside the CI Type relationship to edit. The Edit Relationship Type
form pops up pre-filled with values configured while adding the relationship.
2. Modify the Relationship Type and CI Type. Both the fields are mandatory.
3. Even while editing, you can add new relationship attributes or edit the existing relationship
attributes by clicking on the Attribute Name link.
4. Click Save.
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Deleting Default Relationships
To delete a CI Type relationship,
1. Click the delete icon
beside the CI Type relationship. A dialog box confirming the delete
operation appears.
2. Click OK to proceed. The relationship is deleted from the CI Type relationship list.
WARNING: Deleting a CI Type relationship will remove the relationship from the relationship
map.

Relationship Types
Relationship Types denotes the nature of relationship between a CI and another CI. It shows how
the CIs are interconnected and interdependent with other CIs. The Relationship Type is expressed
twice, one as Relationship Type and the other as Inverse Relationship Type. Some of the
examples of relationship types are Runs::Runs On, Sends data to::Receives data from, Located
In::Houses and so on.
Let's take a look at an example with the Relationship Type as Runs::Runs On. The relationship
between a server and application is expressed as Server1 Runs Application1, while the relationship
between the application and server is automatically expressed with the inverse relationship type,
Application1 Runs On Server1.
Using relationship types, CI Type relationships can be set from Admin -> CI Type and from the CI
form. For establishing relationship using the Relationship Types, refer Relationships under CI Types.
To access the Relationship Type configuration wizard,
1. Click the Admin tab in the header pane.
2. Click Asset Management in the left pane and select Relationship Types option. The
Relationship Types List view is opens,displaying the default relationship types. From this
page, you can add a new relationship type, edit relationship type and perform bulk delete of
relationship types.

Adding New Relationship Type
1. Click Add New Relationship Type link.
2. In the Add New Relationship Type form, enter the Relationship Type and the Inverse
Relationship Type. For example, Runs::Runs On. Both fields are mandatory.
3. Enter brief Description about the nature of the relationship type in the field provided.
4. Click Save. The relationship type is saved and displayed in the list view. To cancel the
operation and return to the list view, click Cancel.

Editing Relationship Type
1. In the Relationship Types List view, select the relationship type to edit. The Edit Relationship
type form opens with the fields pre-filled with values entered while adding the relationship
type.
2. Modify the field values for Relationship Types, Inverse Relationship Type and Description.
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3. Click Save. The changes are saved and displayed in the list view. If you do not want to edit
the relationship type, then click Cancel.
NOTE: The following default relationship types cannot be edited, Depends On::Used By,
Uses::Used By, Runs::Runs On, Connected to::Connected to and Includes:: Member of.

Deleting Relationship Type
To delete the newly added relationship types from the list view,
1. Enable the check box beside the Relationship type to delete.
2. Click the Delete button. A dialog box confirming the delete operation appears.
3. Click OK to proceed. The relationship type(s) is deleted from the list view.
NOTE: Please note that the pre-configured relationship types cannot be deleted.

Populate CIs in CMDB
The CMDB, when catered to the IT environment, functions as a decision making tool, impact and root
cause analyzer. But, by populating a large amount of data, your CMDB may turn complex, causing a
loss in structure and information, thereby making its analysis less effective.
So how can you build an efficient CMDB without turning it complex? ServiceDesk Plus - MSP gives
you a step-by-step process to identify the essential CIs and populate them in your CMDB.

Steps to populate CIs in CMDB
To set up a less complicated CMDB design, strategize on your CI List and their supported attributes
and relationships. Given below are 3 easy steps through which you can effectively populate CIs in
your CMDB.

Step #1: Narrow down the CI List
The first step is to identify the business critical CIs as per your organizations environment.
Next, group them in appropriate CI Types. Each CI Type holds its own attributes and
relationships that are defined with key stakeholders from the Service Catalog Management,
Change Management and the likes.
Some of the entities that can contribute to your CI list are,
o
o
o
o
o
o

Business Service
Hardware ( IT and Non IT assets, components)
Software (which are installed in the server/workstation like applications, operating
systems, database)
Department
Documents (license agreement, contract, lease agreement)
Users and Support Groups
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NOTE: Please note that not all software are considered as CIs. The software which are
installed in the server/workstation, and group under a CI Type are alone considered as
Configuration Items (CIs).

Step #2: Populate the Configuration Items
After the CI List is strategized and confirmed, you need to populate the Configuration Items
(CIs). ManageEngine ServiceDesk Plus - MSP gives you various ways through which you
can effectively populate CIs into your CMDB.
Populate Workstation/Devices



Windows Domain Scan
Network Scan

Populate Users/Technicians



Importing from Active Directory (for Windows machine)
Importing from LDAP

Populate other CIs such as IT services, Business Services, Department



Importing CIs from CSV file
Manual Addition of CIs

NOTE: Make sure that the CI information in your CMDB is updated from time-to-time.

Step #3: Create the Information Model
The overall information model is complete only when the relationships between the CIs are
defined. While populating Configuration Items using any of the methods in Step 2, the interdependencies between the CIs are identified and established. The relationships can be
viewed from the Relationship Map which helps in impact and root cause analysis.

Import CIs from CSV file
If the CIs are recorded in a .csv file, then you can import the same using Import CIs from CSV file
option. The easy-to-use CSV import option in ServiceDesk Plus - MSP allows you to import the CI
information from the existing database as well as from other applications.
To import CIs from a CSV file,
1. Click CMDB tab in the header pane. By default, the CIs under Business Service are
displayed.
2. Click Import CIs from CSV file link. The CI Import Wizard is displayed.
Steps to Import CIs from CSV file
Step #1: Locate CSV file
1. Select the CI Type for which the CIs should be imported.
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2. Click Browse button to select the CSV file.
3. On locating the CSV file from the file chooser window, click Open. The path to the file
appears automatically in Locate CSV file field.
4. Click Submit button.

The above image shows CI Import Wizard page and the CIs to be imported is of the
CI Type 'Workstation'.
Warning : If there are any failure records while importing the CIs, do not re-import the
same .csv file. Instead, download the FailedCIsList.csv available in the Imported
Result page, correct the errors and then import to avoid duplicate CIs.
Step #2: Customize Mapping
1. Select the date format to represent all the date fields.
2. Map the CI field with the field names from the CSV file. If there are any additional attributes
configured, then the same appears in the customized mapping form.
3. Click Import button. The details of the CIs from CSV are imported.
4. On completion, the data on the total CIs, the number of CIs imported and the number of CIs
failed to import are displayed.
Notes
1. If the CI Type chosen in Step #1 is a parent and if a CI row in the .csv file corresponds to sub
CI Type, then the same can be mapped in the customize mapping form.
2. The Sub Type specified in .csv file should already be configured in the application.
3. If existing CIs are imported again under a different CI Type, then the CIs are grouped under
the new CI Type.

CMDB List View
The Configuration Items (CIs) under each CI Type can be viewed in the CMDB List view. If you
have not populated your CIs into the CMDB, then you can follow the steps given in the document
Populating CIs in CMDB.
NOTE: If you are not the administrator, then you would require Enable CMDB role to access the
CMDB module.
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Click CMDB tab in the header pane. The page navigates to view the Configuration Items (CIs) under
the CI Type - Business Services, by default. To view all the CIs in the CMDB irrespective of the CI
Type, click All CIs link. The CIs are listed with the Name, the CI Type and the Site to which they
belong.
From the CMDB List view, you can perform various actions such as,
•
•
•
•
•

View CIs under each CI Type
Add CIs under a CI Type
Modify CI Type for the CIs
View Relationship Map
Bulk delete of CIs

View CIs under a CI Type
You can view CIs under a specific CI Type by selecting the CI Type from the Configuration Items
icon.
block. Click icon to view Sub CI Type. To view the Sub CI Types of all the CI Types, click

While viewing the CIs under a CI Type, the list view columns display the CI attributes that were
configured while adding the CI Type. For instance, the CI Type - Workstation would have attributes
like Model, Service Tag, Service Pack, IP Address and so on. While viewing the CIs under CI Type Workstation, the configured attributes would be listed in the list view column.
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If you are viewing the list view column of a child CI Type, say Windows Workstation or Unix
Workstation, then the list view column would display the CI attributes configured for the parent CI
Type as well as the attributes configured for the child CI Type.
Note:
1. While viewing CIs under a parent CI Type, the CIs under its Sub CI Type are also listed.
2. The attributes in the column list view for Sub CI Type comprises of the parent CI Type attributes
and the sub CI Type attribute.

Add a CI under a CI Type
To add a CI under a CI Type,
1. Select the CI Type from the Configuration Items block.
2. Click New button and enter the CI details in the Add New form.
The Add New form consists of the attributes configured while adding the CI Type. In case of
Sub CI Types, the attributes configured while adding the Sub CI Type and the parent CI Type
is displayed.

Edit the CI Type for a CI
You can modify the CI Type for a CI. An Actions drop-down button is available in the List view for CIs
that are also tracked in the asset module, such as Keyboard, Access Points, Servers and so on. If you
wish to track CIs under a specific CI Type in the asset module also, then enable Track as asset
option while configuring the CI Type.
From the Actions drop-down, you can modify a CI Type for a CI. To do so,
1.
2.
3.
4.

Enable the check box beside the CI name.
Click Actions drop-down, select Modify CI Type option. The Modify CI Type dialog pops-up.
Select the CI Type from the drop-down.
Click Save.

View Relationship Map
Relationship Map gives a consolidated view of the relationship between the CIs. To view the
relationship map of a CI, click View Relationship Map icon beside the CI. The Relationship Map
opens in a new window.

Delete CIs
To delete CIs from the CMDB List View
1. Select the CI Type under which the CIs should be deleted (OR) Click View All CIs to view all
the CIs irrespective of the CI Type.
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2. Enable the check box beside the CI to delete.
3. Click Delete button. A confirmation dialog appears.
4. Click OK to proceed. The selected CIs are deleted from the list.
NOTE: In delete operation, the related financial and history details of the CI is deleted.

Defining CI Relationships
CI Relationships form a major part of your CMDB, as it is the relationships between the CIs that
differentiate the CMDB from the Asset database. A CMDB without relationships constitutes a bunch of
CIs in a single database; fetched through scan or import process, or by manual addition. But with
relationships, the users accessing CMDB can understand the inter-dependencies between the CIs,
and in the case of a failure, the impact caused on another CI can be identified.
NOTE: To make your CMDB structure less complex, consider the relationships you will require in your
CMDB and ensure to use the right relationship type to define the nature of relationship.

Topics discussed under this section:
•
•
•
•
•

Defining Relationships
Access Relationships Tab
View Relationships from the Relationship Tab
Add Relationship from the Relationship Tab
Delete Relationship

Defining Relationships
In order to define the CI relationships in your CMDB, three piece of information is required.
1. The CI for which the relationship is created
2. The Type of Relationship denoting the inter-dependencies between the CIs, and
3. The dependent CI.
For example, consider a sentence like "ServiceDeskServer Depends on CentOS2Server". Here,
ServiceDeskServer is the CI for which the relationship is created, Depends on denotes the nature of
relationship, and CentOS2Server forms the dependent CI.

Access Relationships Tab
Each CI in ManageEngine ServiceDesk Plus - MSP is represented with Attributes and
Relationships. The Attributes are data elements that describe the characteristics of the CIs. The
Relationships, on the other hand, help in understanding the inter-dependencies between the CIs. The
relationships between the CIs can be defined from the relationships tab.
To access the Relationships tab of a CI,
1. Click CMBD tab in the header pane.
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2. Select the CI Type from the Configuration Items block. Say, Workstation. Else, select All
CIs link to view all the CIs irrespective of the CI Type.
3. Select the CI Name link to view the CI details.
4. From the CI details page, click Relationships sub-tab.

View Relationships from the Relationships tab
The relationship between the CIs is viewed in the Relationship tab. From the Relationship tab, you
can
•
•
•
•

View the Relationships in Map View and List View
Access the full screen of the Relationship Map
Zoom in and Zoom out the relationships linked in the map
Add Relationships

By default, the relationship editor is shown in Map View. To access the full screen view of the
and Zoom out
icon to view
relationships, click view relationship map icon. Use the Zoom in
to reset the relationship map to
particular magnifying levels of the CI relationship. Click Reset icon
the default view instantly.
The List View groups the CIs according to the Relationship Type. You can delete relationships from
the List View.
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Add Relationship from the Relationship tab
To add relationships from the relationship tabs,
1. Click Add relationship button. The Add relationship window pops up.
2. The default relationships configured for the CI Type "Server" is listed in the Choose
Relationship drop-down. Select the relationship from the drop-down, say, "Runs - Software".
The CIs under the CI Type "Software" are listed along with the configured relationship
attributes.

3. If you would like to create relationships with other CIs, enable Search other CIs to Create
Relationships radio button.
4. By default, the CIs available in the CMDB are listed in the Available CI(s) column. If the CI list
is excessive in length, then you can conduct a search for the CI by entering the search string.
Click Search button. The search result is displayed in the Available CI(s) column.
5. You can also view CIs under a specific CI Type. Select the CI Type from the drop-down, say,
Department. The CIs available for the CI Type Department are listed under Available CI(s)
column. You can also conduct a search operation if the CI list under a CI Type is excessive in
length. Say, for the CI Type Department, the entered search string is "Finance". On clicking
Search button, "Finance" appears in the Available CI(s) column.
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6. Select the CI(s) from the Available CI(s) column. Click Move Right >> button to move the
selected CI(s) to the Selected CI(s) column.
7. Select the nature of relationship between the CIs from Choose Relationship Type drop
down.
8. Click Add. The relationship is added in the relationship map.

Delete Relationship
To delete a relationship from the relationship map,
1. Click List View link. The relationships between the CIs are listed according to the relationship
type.
2. Enable the check box beside the CI to delete. If you wish to delete all the CIs under a specific
relationship type, click Select All button.
3. Click Delete button. The selected CIs are deleted from the relationship map.
NOTE: Please note that you cannot delete a relationship from the Relationship Map.

Relationship Map
The Relationship Map is uniquely designed to provide the ability to understand the dependencies
between the CIs. The relationships between the CIs are discovered automatically while populating the
CIs into the CMDB. You can also manually add the relationship between the CIs from the Relationship
Map.
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The Relationship Map shows the number of pending requests, problems and changes raised for the
Assets, Business and IT Services. You can view the pending requests, problems and changes directly
from the relationship map.
Using the Relationship Map, you can analyze the impact caused by the CI on a business service and
identify the root cause of the impact, thus establishing appropriate measures to gradually eliminate
the perpetual issues faced by your organization.
This section has the following contents,
•
•

Access the Relationship Map
• From CI List View
• From CI Details Page
Using the Relationship Map
• Quick Create - Relationship
• Viewi CI Details
• View Pending Requests, Problems and Changes
• View Relationship Attributes
• Add Relationships

Access the Relationship Map
In ManageEngine ServiceDesk Plus, all the CIs are represented with a Relationship Map icon to
have a quick view of the relationships between the CIs. You can find this relationship map icon in the
CI List View and in the CI details page.
From CI List View
1. Click CMDB tab in the header pane.
2. Select the CI Type from the Configuration Items block to view the list of CIs. Else, select All
CIs link to view all the CIs irrespective of the CI Type.
3. To launch the relationship map in a new window, click the Relationship Map icon beside the
CI in the CI List View.

From CI Details page
1. Click CMDB tab in the header pane.
2. Select the CI Type from the Configuration Items block. Else, select All CIs link to view all the
CIs irrespective of the CI Type.
3. Click the CI Name link to view the CI details.
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4. In the CI details page, click the Relationship Map icon to launch the Relationship Map in a
new window.

Using the Relationship Map
From the Relationship Map, you can perform the following operations;
•
•
•
•
•

Create relationships instantly using the Quick Create-Relationship option
View CI details of the CIs
View the pending requests, problems and changes raised for Assets, Business and IT
Services
Add Relationships between the CIs
View Relationship Attributes configured for the CIs.

Quick Create - Relationship
The Quick Create - Relationship is an instant means to create relationships between the CIs. You can
create relationships for the existing CIs in the relationship map or create dependencies between other
CIs using this option.
In order to create a relationship using the Quick Create - Relationship option, three piece of
information is required.
1. The CI for which the relationship is created.
2. The Relationship Type, denoting the inter-dependencies between the CIs.
3. The dependent CI.
For example, enter a sentence like "ServiceDeskServer Depends on CentOS2Server". Here,
ServiceDeskServer forms the first piece of information, Depends on is the relationship type and
CentOS2Server forms the dependent CI.
If the CI name has a space in between, specify the name in double quotes like, "ManageEngine
ServiceDeskServer" Depends on CentOS2Server.
NOTE: To denote installed software, use the relationship "Runs::Runs on".
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To create relationships using the Quick Create - Relationship option,
1. Select the Quick Create - Relationship button in the Relationship Map. The Quick Create Relationship dialog pops-up.
2. Enter a sentence with the CIs and the relationship type. Example, ServiceDeskServer
Depends on CentOS2Server.
3. Click Add. The CI dependencies are added in the Relationship Map.

For dependencies added between two CIs that are not present in the Relationship Map, select Click
here to view map link to view the relationship map between those CIs.

In case of conflict between CIs with similar CI names, such as "Administration" and "Administrator",
the Quick Create - Relationship option provides the list of CIs, from where, you can choose the
appropriate CI. To ease your selection process, choose the CI Type from the drop-down.
You can also create relationships between CIs that are not available in your CMDB. Say, for instance,
if Admin is unavailable in your CMDB, then you can add Admin as a new CI by selecting the CI Type
from the drop-down. Click OK to view the CI in the relationship map.
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View CI Details
While viewing the Relationship Map, you can also view the details of a CI. To view the CI details,
1. Move the mouse pointer over the CI.
2. Click View CI details button. The CI details pops-up.

View Pending Requests, Problems and Changes
The CMDB in ServiceDesk Plus keeps a track of all the pending requests, problems and change
raised for the CI Type - Assets, Business and IT Services. To identify if a request, problem or change
. Move your mouse pointer over the CI to
is raised for the CI, the CI is denoted with a warning icon
view the number of pending requests, problem and changes raised for the CI. You can also view the
details of the request, problem and change from the Relationship Map.
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View Relationship Attributes
Relationship Attributes provide additional information on the relationship between the CIs. Say, for
instance, if a server runs a software application, then details such as the Installation Path, Version,
Installed On and so on can be configured as relationship attributes.
The Relationship Attributes are configured while setting the default Relationships for a CI Type. To
view these relationship attributes on the relationship map, move the mouse pointer over the CI.
NOTE: The Relationship Attributes can be viewed only if the attributes are configured for the
relationship.

Add Relationship
To add relationships from the relationship map, click Add Relationship button. The Add relationship
window pops up. Adding relationships from the relationship map is similar to the method discussed in
Adding Relationships from the Relationship tab.
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Configurations
Configurations
In ManageEngine ServiceDesk Plus - MSP, all types of application configurations are grouped under
Admin. To access the various configuration options, log in to the application using the user name and
password of an admin user and click the Admin tab in the header pane. If this is your first login after
installing the ServiceDesk Plus application, then by default, configuration wizard is opened, and the
screen displayed would be as below,

To proceed with the configurations, follow the instructions provided in the configuration wizard. There
are some default values given for various configurations. If you do not require these values, you can
delete them and add your own values to suit your needs either in the wizard itself or at a later time by
visiting the corresponding configuration group.
You can exit the configuration wizard at any time. Clicking the Exit button closes the configuration
wizard and takes you straightaway to the Admin Home page, where you can perform all the
configurations.
The various configurations are grouped under the following major heads:
•

Helpdesk Configurations

•

Account Configurations

•

Problem/Change Management

•

Discovery

•

Asset Management

•

Software Management

•

User Survey

•

General Settings

Each of these configurations is explained in details in the following sections.
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MSP Configuration
MSP Configuration
The MSP Organization related configurations need to be performed by the admin user. The following
MSP configuration needs to be made to get started with ServiceDesk Plus - MSP product:
1. MSP Organization details
2. Mail Server Settings
3. Roles
4. Technicians
5. Groups
6. Leave Type
7. Remote Assistance Setup
8. Technician Auto Assign
9. Service Plan
10. MSP Sites
11. Operational Hours
12. Holidays
13. Departments
14. Business Rules
15. Service Level Agreements
16. Preventive Maintenance
17. Requesters
To access the MSP configurations:
1. Login to the ServiceDesk Plus - MSP application with the Username and Password of a
ServiceDesk Plus - MSP Administrator.
2. Click the Admin tab in the header pane.
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Configuring Organization Details
You can configure your MSP organization's details in the ServiceDesk Plus - MSP application. This
information will be used in various cases. To configure your MSP organization's details
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the MSP Details block, click the Organization icon
displayed.

. The Organization Details form is

4. Enter the Name of the MSP organization. You cannot leave the name field empty. The other
fields can be empty. But if you have the required information, then enter them as explained in
the following steps.
5. The description field can contain information about what MSP organization specializes.
6. The next block collects the address of MSP organization. Enter the address details in the
relevant fields, such as address, city, postal code, state, and country.
7. If you have a common contact e-mail ID, then enter the same in the E-mail ID field.
8. Enter the phone and fax number, and the URL of MSP company's web site.
9. You can import the company logo and use that in places where the MSP organization details
are being used.
1. Click Import Image button beside the Company Logo field.
2. Click the Browse button and choose the image file from the file chooser window and
click Open.
3. Click Import.
10. By default, the Use this image check box is enabled. If you do not wish to use this image,
then disable the check box.
11. Click Save.
At a later time, if you wish to edit the information that you entered now, you can do so by following the
same procedure explained above.
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Configuring Mail Server Settings
ServiceDesk Plus - MSP allows you to configure the incoming e-mail settings and the outgoing e-mail
settings such that it fetches the mails that are sent to the IT help desk team and sends
notifications/feedback to the technicians, requesters, and vendors.

Incoming Mail Settings
To configure the incoming e-mail settings,
1. Log-in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The Mail Server Settings
3. In the MSP Details block, click the Mail Server Settings icon
page displayed will be as shown in the figure, with the incoming e-mail settings tab selected
by default:

4. All the fields marked * are mandatory fields. Enter the server name, user name, password, email address, email type, port, and the time interval in which the mail needs to be fetched
periodically. The time period is in minutes. The e-mail type is a combo box from which you
need to select the value. If you have selected IMAPS then you have an option to enable
Transport Layer Security (TLS).
5. Click Save. On successful connection to the server, the success message is displayed.
To start fetching the mails, click the Start Fetching button. Once the mail fetching is started, the Save
button in the incoming mail server settings is disabled. If you wish to change any of the settings, then
you need to stop mail fetching, make the changes, save them and then restart the mail fetching.
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Outgoing Mail Settings
To configure the outgoing mail settings,

1. In the Email Settings page, click the Outgoing tab. The outgoing mail settings form is
displayed as above.
2. Enter the outgoing mail server name / IP address, reply-to e-mail address, and port. These
three are the mandatory fields.
3. If there is an alternate server, then enter its name in the Alternate Server Name / IP
Address field.
4. Enter the name of the sender in the Sender's Name field.
5. Choose the e-mail type, which is usually SMTP and SMTPS. By default, the port associatged
to SMTP is 25 and the port associated to SMTPS is 465.
6. If required, you can enable Transport Layer Security (TLS) from the drop down.
7. If your SMTP server for outgoing mails require authentication, then select the check box
Requires Authentication.
8. Enter the User Name and Password in the respective fields.
9. Click Save.

Spam Filter
You can mark all you junk mails into spam by defining filter criteria for the mails. Once you set a
criteria say, "Subject contains Out of Office or Spam", then mails matching this criteria will be dropped
and no new request will be created out of them. To configure Spam Filter,
1. Click Spam Filter tab.
2. Define a rule on selecting a Criteria from the drop down list and also mention the Condition.
3. Specify the filter content in the given text field by clicking choose button.
4. Say, if criteria is Sender and condition is is then the content can be "mailer-deamon".
5. Click Add to Rules button to add the criteria to the rules and match it with the incoming mails.
Specify Match all of the following (And) or Match any of the following (OR) option to
match with the rule by selecting any of the radio buttons.
6. Click Save.
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E-Mail Command
Currently, when e-mails are received, various fields are set according to business rules. E-mail
Command allows the technician to delimit fields in the e-mail, according to which the e-mail can be
parsed and corresponding fields can be set.
Consider a scenario where business rules needs to be created for the following criteria:
•

To assign Category based on subject:
1. When Subject contains “Printer”, set Category as “Printers”
2. When Subject contains “Network”, set Category as “Network”
3. When Subject contains “Routers”, set Category as “Hardware”
4. When Subject contains “Switches”, set Category as “Hardware”

•

To assign Priority based on subject:
1. When Subject contains “High Priority”, set Priority as “High”
2. When Subject contains “Low Priority”, set Priority as “Low”

•

To assign Urgency based on subject:
1. When Subject contains “Urgent”, set urgency as “Urgent”
2. When Subject contains “High Urgency”, set urgency as “High”

For example, when the subject contains “Printer” and “High Priority” or when the subject contains
“Printer” and “Low Priority”, separate business rules have to be written for each criteria. This becomes
complicated further when more fields need to be set based on the incoming e-mail. We need to have
hundreds of business rules to achieve combinations of several fields and that will complicate the
entire business rule section.
Also, consider another scenario where business rules for incoming e-mails are set as follows:
•

When Category is “Printer”, Subject contains “Crash” and Priority is “Low”, place in Group
“Hardware problems”

Suppose an incoming e-mail has a subject line “Printer Crash” with high priority, then the request field
will be set as ‘Category = Printer’ with ‘Priority = Low’ based on the existing business rule.
E-mail command overcomes this complication. Request fields can be defined through an e-mail itself.
An incoming e-mail is parsed, and various request fields are set from the e-mail content based on the
parsing delimiters.
To configure E-mail Command,
1. In the E-mail Settings page, click on E-mail Command tab. The E-mail Command
configuration screen is displayed.
2. Click on the check box Enable E-mail Command to activate the e-mail parsing feature. If this
option is not selected, then the incoming e-mail will be handled as a normal mail based on
established business rules even if the incoming e-mails contain the parsing string in the
subject.
3. In the E-mail Subject contains text box, enter valid subject that determines the e-mails
which have to be parsed. E-mails containing this text will be parsed for various fields. Assume
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the E-mail Subject identifier is given as @@SDP@@, then all e-mails with subject as
@@SDP@@ alone will be considered for parsing.
4. Provide any special character (@@, ##, $$, %%, &&, so on) as the Command Delimiter.
The field values assigned between these special characters are assigned to the
corresponding fields while the requests are created. Assume if the Command Delimiter is
@@and category field needs to be set to Printer, then the email description should contain
@@Category=Printer@@.

Notes:
•

A request can be created/edited/closed/picked up by a technician through e-mails.
Operational string “Operation = AddRequest”, “Operation = EditRequest”, “Operation =
CloseRequest” and “Operation = PickupRequest” is used for this purpose.

•

To edit, pick up or close a request through e-mail, the corresponding operational string
(EditRequest/PickupRequest/CloseRequest) and the RequestId must be present. If not, the email will be processed normally and treated as a new request.

•

When a request is edited through an e-mail, the conversation will not be added in the request.
Hence attachments and inline images in the e-mail will not be updated in the request.
However, the update information will be added in the history.

•

If the field name given in the e-mail is not available in ServiceDesk Plus - MSP, then parsing
will be excluded for that field.

•

If there is more than one value present for a particular field in an e-mail, then the last value
alone will be taken and others will be discarded.

•

Request threads with subject containing the “RequestId” and no operational string
(UpdateRequest) will be updated as a normal conversation and a new request will not be
created.

Zoho Corporation Pvt. Ltd.
381

ManageEngine ServiceDesk Plus MSP – Admin Guide
•

The e-mail sender should have a log in for ServiceDesk Plus - MSP for the E-mail Command
to happen. This is because, various operations that can be handled by a user to parse an email are defined by the user’s Role. Request authorization (close a request, pick up a request,
update a request, accept closure of a request and so on) are set using Roles in ServiceDesk
Plus - MSP.

•

The e-mail sender will be considered as the requester if the requester name is not specified in
the e-mail.

•

Permissions and Parameters supported:

•



If the e-mail sender is a requester with requester permissions, then the fields that be
parsed are limited. A requester can parse only those fields that he can view in the
request form while creating a request.



If the e-mail sender is a technician with technician permissions, then the fields that
can be parsed are same as those fields that he can view in the request form while
creating a request.



Fields that can be parsed are LEVEL, MODE, PRIORITY, URGENCY, IMPACT,
CATEGORY, SUBCATEGORY, ITEM, GROUP, TECHNICIAN, TECHE-MAIL,
REQUESTER, REQUESTERE-MAIL, REQUESTID, REQUESTTEMPLATE,
REQUESTTYPE, STATUS, ACCOUNT, SITE, ASSET and additional field label (the
field label given in the e-mail must match the field label set in the product)



To change the fields that a requester or a technician can parse, go to Admin -->
Request Templates (under Helpdesk domain), select Default Template and add or
remove the fields.

The RequestId present in the description of the e-mail it will be given higher precedence over
the RequestId present in the subject of the e-mail.

Consider an example:
1. To create an e-mail that has to be parsed, the subject of the e-mail should be same as defined in
the configurations (E-mail Subject contains), for example, "@@SDP@@” and the content is as
follows:
@@ACCOUNT = Sample Account@@
@@SITE = Sample Site@@
@@CATEGORY = Printers@@
@@PRIORITY = High@@
@@URGENCY = Normal@@
@@LEVEL = Tier 4@@
@@MODE = E-mail@@
@@IMPACT = Affects User@@
@@GROUP = Network@@
When the request is created, say with a Request ID 6735352, the fields for the request are set based
on the above content from the parsed e-mail.
2. To edit this request, say to assign a Technician or a Sub-Category, operational string
“OPERATION = EditRequest” along with the RequestId (or WorkOrderId) and the delimiting fields
have to be specified in the e-mail as follows:
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@@OPERATION = EditRequest@@
@@REQUESTID = 6735352@@
@@TECHNICIAN = Administrator@@
This updates the request 6735352 and assigns ‘Administrator’ to the ‘Technician’ field.
3. To pick up the request through an e-mail, the technician who has ‘AssigningTechnician’
permission should specify the operational string “PickupRequest” along with the RequestId should be
mentioned in the e-mail. The technician can pick up the request only if the request falls under his site.
@@OPERATION = PickupRequest@@
@@REQUESTID = 6735352@@
4. To close the above request (6735352) through an e-mail, the operational string (CloseRequest)
and the Request ID has to be present in the content of the e-mail.
@@OPERATION = CloseRequest@@
@@REQUESTID = 6735352@@
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Configuring Roles
Each technician accessing the help desk tool will have a set of permissions to execute specific tasks
in the application. These access permissions are termed as Roles in ServiceDesk Plus. Roles are
defined based on the various modules in the application.
The Administrator has the privilege to create multiple roles and assign it to technicians based on the
requirement. You can also view the list of technicians assigned to a particular role from the Role List
View page.
Note: Please note that Roles can be assigned to technicians alone. The Roles for requesters are
pre-defined and hence cannot be configured.
To open the role configuration page:
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
3. On the Users block, click the Role icon
You can add, edit, or delete roles.

. The next page displays the available list of roles.

Add Role
To add a role,
1. Click the Add New Role link to open the Add Role form.
2. Enter the Role Name in the given text field. The Role Name has to be unique and is a
mandatory field.
3. Enter a brief description of the role in the Description field.
4. Set the Access Permissions for the role by selecting the check boxes beside the access
levels defined for each module of the application.
Example: If you wish to provide full control permissions to the requests, inventory, contract
and solutions module, then enable the check box below Full Control. This will automatically
enable all the operations of the corresponding modules. You can provide add permission to
the remaining modules by selecting the Add check box. Enabling the Add check box
automatically enables the view permission.
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5. The access permissions for request and purchase modules are further categorized and
defined under Advanced Permission. Set the advanced permission for add, edit and delete
operations by enabling the check box.
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adding/Editing Request Task: Permission to Add/Edit the request tasks.
Adding Requesters: Enabling this option will allow you to add new requesters on the
fly while creating a new requests/problem/change. Adding requesters without this
permissions pops up an error message stating "Requester Does not Exist".
Resolving Request: Permission to change a request status to Resolved.
Disabling Stop Timer: Permission to allow a requester to change the status of a
request to OnHold.
Merging Requests: Enable this option to provide permission to merge two or more
requests.
Closing Request: Permission to change a request status to Closed.
Modifying Due Time: Permission to change the Due By Time and also the First
Response Time of a request.
Modify Resolution: Enable this option to provide permission to edit a resolution. On
disabling this option, the technician can only add the resolutions for a request without
a resolution entry.
Re-opening Request: Permission to change the status of the request to Open from
the previous state.
Assigning Technicians: Permission to allow a technician to assign or reassign a
request to a technician.
Editing Requester: Permission to edit the requesters name while viewing the
request.
Deleting Others Notes: Permission to edit/delete notes added by other
users/technicians. If the option is disabled, then the technician can delete the notes
added by him.
Deleting Others Time Entry: Permission to delete the Work order details entered by
other users. If the option is disabled, then the Technician can only edit/delete his
Work Order Entry.
Deleting Request Task: Permission to delete the request tasks of a request.

6. You can also choose to restrict the technician from viewing all the requests received by the
application. To do this, select the corresponding radio button which will suit your need from
the following,
• All: The technician with this role can view all the requests and assets in ServiceDesk
Plus - MSP.
• All in associated Site: The Technician can view the requests and the assets of all
his associated sites. To associate the site to the technician refer Technician.
• All in Group & assigned to him: The technician will be restricted to view all the
requests of the Group to which he/she belongs and also those requests that are
assigned to him/her.
• Assigned to him: The technician will be restricted to view the requests that are
assigned to him/her.
Example: A site has two groups, say Group1 and Group2. Adam is a technician
associated to group1 with the privilege All in group & assigned to him enabled in
the role assigned to him. With this restricted view enabled, Adam can view all the
requests in Group1and the requests assigned to him. He has the privilege to reassign the requests to other technicians in his associated sites but once this is
executed, the request will not be visible to Adam.
7. You can also provide permission to approve solutions in the role by enabling the check box
beside Technician allowed to Approve solution. Thus the technician assigned with this role
will be able to approve solutions.
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8. Click Save. If you want to add more just one role, click Save and add new button.
At any point, if you decide not to add the new role, then click Cancel to get back to the role list.
Clicking the View List link on the top right corner of the add role form will also take you to the role list
view.

Edit Role
To edit an existing role,
1. In the Role List page, click the edit icon beside the role name that you wish to edit. This
opens the Edit Role form.
2. You can modify the name of the role, description, and the permissions associated with the
role.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a role, if you wish to add a new role, then click the Save and add new button. The
Add Role form opens after displaying a message that the changes are saved.

Viewing Technicians Assigned to a Role
To view technicians assigned to a role,
1. In the Role List page, click View Technicians configured with this Role icon .
2. The Role to Technicians pop up appears listing the number of technicians configured with this
role. The names of the technicians are also displayed.

Delete Role
1. In the Role List page, click the delete icon beside the role name that you wish to delete. A
confirmation dialog is opened.
2. Click OK to proceed with the deletion. If you do not want to delete the role, then click Cancel.
3. If technicians are assigned with the role, then the Technician List is displayed in a popup
window.
4. You can notify the technician by selecting the technician and clicking Send Notification
check box. The e-mail address of the technician appears in the To filed. You can add CC
recipients for this notification, if required. Enter the Subject and Description. Click OK. The
notification is sent to the technician.
Note: You cannot edit or delete the SDAdmin and SDGuest roles that are already defined in
the application. They are the default administrator and requester roles defined.
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Configuring Technicians
The IT help desk team comprises the help desk team manager, help desk agent, and technicians who
will be handling the requests posted / raised by various requesters from different accounts. You can
add, edit, or remove the technicians in the application and also provide them with various access
privileges that suit their role and need. You can also view the list of technicians in a particular account
and/or site by selecting the account from the Accounts combo box and site from Technicians for
combo box.
To open the technician configuration page,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
3. In the MSP Details block, click the Technicians icon
page. Here you can add, edit, or delete technicians.

. This opens the technicians list view

Note: The Account Admin and Site Admin can add and view the technicians of the site
to which he/she is associated by selecting the site from the Technicians for combo
box. The Technicians for combo box will appear if the sites are configured. The sites
can be configured in Admin- Sites.

Add Technician
To add a technician and associate a role with him/her,
1. Click the Add New Technician link available in the top right corner of the Technician List
page. This opens the Add Technician form.
2. Enter the Full Name and Employee ID of the technician in the Personal Details block. The
name is a mandatory field.
3. In the contact information block, enter a valid e-mail ID and SMS Mail ID of the technicain. If
the technician has a phone and a mobile number, you can enter the same in the space
provided for entering these values.
4. Enter the cost details of the technician in the Cost per hour field.
5. You can associate multiple accounts and sites to a technician. Select the accounts to which
you want to associate the technician from the list of Available Accounts and move it to
Associated Accounts by clicking >> button. Once accounts are associated, the sites
corresponding to selected accounts get populated in the Available Sites list. Select the sites
you want to associate this technician to and move them to Associated sites in the same way
as described above for accounts. Similarly you can also dissociate the Accounts and sites.
You can also associate/dissociate sites from the technicians in the Technicians list page.
Note: For technicians who are not SDAdmin or SDAccountAdmin, sites have to be
associated. If only accounts are associated, the technician will not be given access to the
account. If you want to give access to all sites of an account, select an account and move it to
associated accounts and select all sites under that account and move them to associated
sites.
6. You can also assign Groups to the technician. Select the groups from the list of Available
Groups and move it Associated Group by clicking >> button.
7. If you have defined any additional fields, then they will be listed as Additional Technician
Details. Enter the relevant information for the same.
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8. To provide login access to the technician with specific access privileges or enable
administrative privileges for the technician, enable the check box beside Enable Login for
this technician. This displays the Login Details block.
9. Enter the Login Name and Password. Enter the password again in the Re-type Password
field. All these fields are mandatory if login is enabled. Also note that the login name needs to
be unique.
10. Now you need to assign a role to the technician, which will define his access privileges to
various modules in the application.
o If you want the technician to have complete administrator access then select the radio
button, Enable Administrator Privileges. This option will not be available when a
Site Admin logs in to the application using his login credentials.
o If you want the technician to have complete administrator access to all accounts
selected, then select the radio button, Enable Administrator Privileges for the
accounts selected above.
o If you want the technician to have complete administrator access for the above
selected sites then select the radio button, Enable Administrator Privileges for the
sites selected above.
o Else, Enable Custom Privileges radio button and choose the roles from the list of
Available Roles and move it to Assigned Roles by clicking >> button. If you want to
remove any of the roles assigned, then select the role from the Assigned Role list
and click << button. The selected roles will be removed.
11. Click Save. If you want to add more than one technician then, click Save and add new
button.
If you decide to give the login access for the technician at a later time, you can save the technician
details without the login details. For this, you need to stop with the step 5 and click Save. Later you
can add the login details by editing the technician details.
At any point, if you decide not to add the new technician, then click Cancel to get back to the
technician list. Clicking the View List link on the top right corner of the add technician form will also
take you to the technician list view.

Import Technician from CSV
To import technicians from a CSV (Comma separated value) file,
1. Click on the Import from CSV available in the top right corner of the Technician List page.
This will open a pop-up screen for importing technicians through CSV.
2. Locate the CSV file on your system using the 'Browse' button and click the 'Next' button.
3. Select and map fields from the CSV file to the fields for the technician (like Name, Job Title,
EMail, Mobile, Phone, SMS Id and Cost per hour). Name is a mandatory field and it must be
unique.
4. Click Next and then the 'Import Now' button to import technicians. The final screen on the
pop-up shows the summary of records imported.
Note: Technicians who are imported will not be associated with accounts or sites. This has to
be done manually. To view the technicians imported through CSV, select 'All Accounts' in the
Accounts combo box and 'All Sites' in the 'Technicians association for' combo box.

Edit Technician
If you have added a technician without giving the login details, then you can enable the same by
editing the technician's details. To edit a technician information,
1. Select the site of the technician which you wish to delete from the Technicians for combo
box. By default, the list of all the technicians is displayed. Click the edit icon beside the
technician's full name that you wish to edit. If you have not enabled the login permissions, the
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edit technician form opens with a view similar to the add technician form. Enable the login
permissions as mentioned in the add technician form (starting from step 6 onwards).
2. If the login permissions have been added while adding the technician itself, then the edit
technician form will look as shown
below,

3. In the above form, you can modify all the fields displayed and also change the roles assigned,
by adding or removing roles. (To add new roles, refer to the Configuring Roles section.)
4. Click Save to save the changes performed. At any point, if you wish to cancel the operation
that you are performing, click Cancel.
Even while editing a technician, if you wish to add a new technician, then click Save and add new
button after making the changes. The Add Technician form opens after displaying a message that
the changes have been updated successfully.
You can also change the password of the technician from the Edit Technician form.
1. Click the Reset Password link available beside the Password field in the Edit Technician
form.
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2. In the Reset Password pop-up, enter the New Password in the field provided below the
login name.

3. To send the reset password information to the user, select the check box below the New
Password field.
4. Click Reset Password. If you do not wish to change the password, click Close instead of
Reset Password.
5. In the Edit Technician form, click Save.
While editing the technician details, you can also choose to remove his/her login permissions.
1. In the Edit Technician form, below the password field, click the Yes link beside the Remove
Login field. A confirmation window appears.
2. Click Ok to proceed. A message is displayed informing the removal of the login permissions
and the technician edit form is displayed without the login details. If you do not wish to remove
the login permission, click Cancel.
3. Click Save.

Associate Technicians to Sites
You can associate bulk technicians to sites using this option. If you have added the technician without
associating the sites then the same can be done from the technicians list view page.
1. From the technicians list view page, enable the check box adjacent to the technician for
whom you want to associate site.
2. Click Actions button --> Associate to Site option. The Associate Technician(s) to site pop
up window appears.
3. Select the Account and Site to which you want to associate the technician from the combo
box.
4. Click Associate button. The technician gets associated to the site.

Dissociate Technicians from Sites
You can dissociate bulk technicians from sites using this option. The added sites can also be
dissociated from the technician from the technicians list view page.
1. From the technicians list view page, enable the check box adjacent to the technician for
whom you want to associate/dissociate site.
2. Click Actions button --> Dissociate from Site option. The Dissociate Techncian(s) from
site pop up window appears.
3. Select the Account and Site from which you want to dissociate the technician from the
combo box.
4. Click Dissociate button. A pop up window confirming the operation appears. Click Ok to
proceed. The technician gets dissociated from the site.
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Note: Dissociating the technicians from a site will remove all their traces from SLA,
Business Rules and Groups associated to that site.

Changing Technicians as Requesters
To change technician as requester,
1. In the Technician List view, select the check box beside the technicians to change as
requesters.
2. Click Actions drop down button.
3. Select Change as Requester option. A dialog box confirming the operation appears.
4. Click OK to proceed. The selected technicians are changed as requesters and listed in the
Requester List view.

Delete Technicians
1. Enable the check box beside the technician which you wish to delete from the Technician
List page. Click the delete button. A confirmation dialog is opened.
2. Click OK to proceed with the deletion. If you do not want to delete the technician, then click
Cancel.
Note: Delete icon will not be available beside the name of the technician who has currently
logged in to the application. To delete that technician, you need to log out and log in as a
different technician and then delete the details. Also, the administrator technician details can
be deleted only by another technician with administrative privileges.
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Configuring Groups
Request Groups denote the location where the various incoming requests can be categorized and
grouped. Each Group can have a group of technicians incharge of handling the requests pertaining to
that Group You can configure these Groups in such a way that notifications can be sent to technician
group who belong to the Group regarding a new request creation. These Groups will be listed in the
drop-down menu in the New Request form.
To open the Group configuration page
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the MSP Details block, click the Groups icon

. You can add, edit, or delete Groups.

Add Group
To add a request Group,
1. Select the Site and Click the Add New Group link available at the right top corner of the
Group list page.
2. In the Add Group form, enter the group name in the Name field. This is mandatory field.
3. Select the technicians that you wish to group under this Group from the Available
Technicians list box and click >> button to move them to Technicians interested in this
Group. NOTE: Only the technicians associated to the selected site would be available.
4. You can choose the technicians of the Group to whom you wish to notify for a new request
creation in the Group. To do this select the check box Send notification to Group
technician(s) when a new request is added to this Group. This drops down the technician
selection field.
5. Click Choose button to open the List of Group Technician pop-up window.
6. Select the technicians whom to wish to notify and click OK.
7. To choose the technicians to send notification for unpicked requests in the Group, select the
check box Send notification to technician(s) when a request in this Group is left
unpicked. This drops down the technician selection field and time period configuration after
which the notification will be sent.
8. Click Choose button to open the complete list of technicians available in your help desk.
9. Select the technicians from the list box and click OK. The technicians get listed in the field
provided.
10. Enter the time period, from the creation of the request in Group, after which the notification of
unpicked requests will be sent to the selected technicians.
11. If you wish to describe the Group in detail enter the same in the Description text box.
12. Enter the Group E-mail id in the given text field. Multiple e-mail id for a group should be
separated by commas or semi colon and needs to be unique.
13. Specify the Sender's Name and the Sender's E-mail in the given text field. The senders
name will be specified while sending e-mails.
14. Click Save. The new Group is added.
If you want to add more than one Group, then instead of clicking Save, click Save and add new
button. This adds the new Group and reopens the Add Group form.
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At any point, if you decide not to add the new Group, then click Cancel to get back to the Group list.
Clicking the View List link on the top right corner of the add Group form will also take you to the
Group list view.

Note: Enabling the check boxes while adding Group does not ensure that the notification will
be sent. This setting is just to choose the technicians to whom the notification needs to be sent
and the time frame after which the unpicked request notification is to be sent. To actually send
the notification, you need to enable the corresponding setting under the Notification Rules
under the Admin tasks, which are:
1. Notify Group technician by mail when request is added to Group.
2. Notify technician by mail when request is unpicked in Group.

Edit Group
To edit an existing Group
1. In the Group List page, click the edit icon

beside the Group name that you wish to edit.

2. In the Edit Group form, you can modify the name of the Group, the technicians belonging to
the Groups, the notification settings, and description.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a Group, if you wish to add a new Group, then click Save and add new button
instead of clicking Save button after making the changes.

Delete Group
1. In the Group List page, click the delete icon
delete. A confirmation dialog appears.

beside the Group name that you wish to

2. Click OK to proceed with the deletion. If you do not want to delete the Group, then click
Cancel.
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Configuring Leave Types
Leave types is the type of leave taken by the technician such as sick leave, casual leave and so on.
This is essential while marking leave for the technicians in Scheduler. You can configure the type of
leave using Leave Types option. To open the leave type configuring page,
1. Login to ServiceDesk Plus - MSP application using your username and password.
2. Click the Admin tab in the header pane.
3. In the Users block, click Leave Types icon

. This opens the Leave Types page

Add Leave Type
1. Click New Leave Type link on the right hand side of the leave type list view page. This opens
the Add-Leave Type form.
2. Enter the Name of the leave type in the given text field. For ex. Sick Leave, On Duty. The
specified name has to be unique. This is mandatory field.
3. Specify brief description about the leave type in the Description text field.
4. Click Save. The leave type gets listed in the list view page. Click Save and Add New to save
and add another leave type.

Edit Leave Type
1. From the Leave Types list view page, click the edit icon beside the leave type which you
wish to edit. This opens the Update page.
2. Modify the Name and the description field.
3. Click Save. You can also save and add another leave type from Update page by clicking
Save and Add New.

Delete Leave Type
1. From the Leave Type List view page, enable the check box adjacent to the leave type which
you wish to delete.
2. Click Delete button. A confirmation dialog appears.
3. Click Ok to continue. The leave type gets deleted from the list.
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Remote Assistance Setup
Certain scenarios may require the Technician to access machines in remote locations say, a
requester from New York requires immediate assistance and the MSP's Technician is located in San
Francisco. Similarly, when a request is raised via phone call, it would be great if the Technician could
send an invite for remote assistance and access the requester's machine from his desk, thus
increasing productivity and reducing the time taken to resolve the issue. With the Remote Assistance
the Technician can access the requesters machine and resolves the request instantly with ease.
Note
1. Please note that one session is free and can be used any number of times. Additional
sessions need to be purchased.
2. A Zoho Account is required to avail Remote Assistance feature.
3. Remote control can be invoked from Request Details page .
4. Remote control can also be invoked from Workstation/Server in asset Tab.
To configure Remote Assistance
1. Login to ServiceDesk Plus using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. Click the Remote Assistance Setup Icon.
4. Enter Zoho Account Details.
5. Save the changes.
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Technician Auto Assign
Apart from assigning technicians to requests using Business Rule, selection of category or from the
UI, technicians can be automatically assigned to requests on configuring the Technician Auto Assign
option. The Technician Auto assign follows the Round Robin or Load Balancing methods, and based
on the availability of the technicians, the requests are assigned. So if a technician is unavailable on a
specific day, and the due by time of certain requests falls on that day, the technician on leave will not
be assigned to those requests.

Note

For site specific requests, the technicians associated to the sites are auto assigned to
the requests. Similar for requests associated to groups, the technicians associated to
the groups are assigned to the requests.

To access Technician Auto Assign Configuration,
1. Click the Admin tab in the header pane to open the configurations wizard page.
2. Click Technician Auto Assign icon
page opens.

under Users block. The Technician Auto Assign

Enabling Technician Auto Assign
1. Select Enable Technician Auto Assign check box.
2. Requests are assigned to the technicians either through Round Robin or Load Balancing
model.
Load Balancing: The number of requests that are In progress and assigned to a technician is
taken as the load of the technician. So on selecting this model, technicians with the least load
are assigned to requests.
Round Robin: In this model, technicians are assigned to the request irrespective of the load.
3. The tech auto assign is executed for newly created requests, edited requests or, to both
created and edited requests. Select your option by enabling the radio button.
4. On creating a new request, the technician auto assign can be applied to either the
Unassigned Requests or to the assigned/unassigned Requests.
Unassigned Requests: On selecting this option, the technician auto assign is applied to
requests that are unassigned even after passing through all the Business Rules and Category
selections.
All Requests: When this option is selected, the technicians assigned to the requests through
business rules or category selection will be overridden.
Note

While editing a request, technician auto assign is applied to requests that remain
unassigned even after the application of Business Rules and Category selection. The
auto assign is not applied to requests that are assigned to technicians.
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Excluding Technicians from auto assign
You can exclude certain technicians from being auto assigned say, the administrator, site admin,
change manager.
1. Click Exclude the following Technician check box.
2. Click Add Technicians to exclude link. The list of technicians available in the application
appears.
3. Select the technicians to be excluded by clicking on their Name link. These technicians get
listed under Selected Technicians. Click OK button.
You can delete individual technicians from the Selected Technicians list using the delete icon.
Click Delete All link to delete all the technicians from the Selected Technician list.

Excluding Requests from auto assign
You can also exclude certain requests from being auto assigned to technicians. Say for example,
requests with the priority as "High" should not be auto assigned to technicians.
1. Select Enable Exceptions check box.
2. Choose the Column from the drop down and its corresponding Value using the icon

.

3. Choose to match all the exceptions (AND) or any of the exceptions (OR) from the drop down.
4. Save the details.
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Configuring Service Plan
A Service Plan is used to setup the service usage information. It allows you to configure the plan type,
bill cycle, allowance and usage charges. With these details you can capture and charge accounts for
the services you provide.
To open the Service Plan configurations page,
1. Login to the ServiceDesk Plus - MSP application with admin username and password.
2. Click the Admin tab in the header pane.
under the MSP Details block. The resulting page will
3. Click the Service Plan icon
display the available list of service plans. You can add, edit, or delete service plans as you
wish.
Note
Operations such as Add, Edit and Delete can be performed from the Service Plan list
view.

Add Service Plan
To add a Service Plan,
1. Click Add New Service Plan link.
2. In the Service Plan form, specify a unique Service Plan Name. This field is mandatory.
3. Select the type of service charge offered for the service plan, say, charge the customer based
on the hours spent to resolve the request or charge based on the number of requests created
during the bill cycle.
4. Select the time period as Monthly, Quarterly, Half-yearly or Yearly from the Bill Cycle drop
down. For the selected time period enter the Fixed Base Charge and specify the number of
hours allowed for the selected bill cycle in the Allowance field. For example, 24 hours per
month.
NOTE: The fixed base charge will get added to the bill irrespective of the usage.
5. Once the allowance is consumed, you can choose either to mark further requests as blocked
or charge requests separately by selecting Mark requests as blocked once the allowance
is consumed or Allow requests over and above the allowance at extra charge option
under the Additional Usage block.
6. If you would like to charge requests separately, then the additional charges can be configured
under Additional Usage Charges block. You can either charge with the Fixed Cost Per
Hour or Differential Cost Per Hour. If you choose your service plan as 'Differential Cost Per
Hour', then you can configure different charges for different time periods such as Operational
Hours, Non-Operational Hours, Weekend Hours and Holiday Hours.
7. If you would like to carry forward the unused units to the next bill cycle, select Carry forward
unused allowance check box.
8. You can allow technicians to enter additional charges in the worklogs by selecting the Allow
technician to enter additional charges check box.
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NOTE: If this check box is selected, the option to add additional charges will be available
while adding worklogs in the Add Work Log page.
9. You can also allow technicians to overwrite the automatically calculated time spent for
resolving a request while adding worklogs by selecting Allow technician to overwrite the
time taken to resolve check box.
10. Click Save. The service plan details are saved followed by a success message along with the
link to configure Account Contract. Clicking on the link will redirect to the Contract Billing page
for configuring contract billing for account.
Note

Whenever the allowance for an account is consumed and if the service plan additional
usage option is set to "Block requests once the allowance is consumed", then all the
requests for that account are shown in a 'strikeout' style in the Request List view page.
The 'strikeout' style is also used to show requests when the contract has expired.

Edit Service Plan
1. Click on Edit icon

beside the service plan name to be edited.

2. From the edit service plan form, Modify the required details.
NOTE: You will be able to modify only the Service Plan name, Fixed Base Charge and Other
options.
3. Save the changes. At any point, if you wish to cancel the operation that you are performing,
click Cancel.

Delete Service Plan
1. Enable the check box beside the service plan which you wish to delete from the Service Plan
List page.
2. Click Actions drop down and select Delete service plan[s] option. A confirmation dialog is
opened.
3. Click OK to proceed with the deletion. If you do not wan to delete the service plan, then click
Cancel.
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Configuring MSP Sites
MSP Organizations, big or small, may have several branches across the globe to handle various
specialized activities. These branches can be located in the same or different regions, and the data
from each of these branches need to be maintained in the same place. You can configure various
sites (branches) to a region in the ServiceDesk Plus - MSP application.

Note: The administrator has the privilege to Add/Edit/Delete a site.

Add Site
To add new site,
1. Login to ServiceDesk Plus - MSP application using the username and password of the admin
user.
2. Click Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Sites' from the menu on the left side to open the MSP Sites page
5. Click on Add New Site link on the right side near the top. The Add New Site form opens.
6. Enter the Site Name in the text field provided. It is mandatory field.
7. Enter brief information in the Description field about what your organization does in the
above mentioned site.
8. Select the Region and the Time Zone of the site from the combo box. The specified time
zone is essential to calculate the operational hours for the site. Hence, any request raised in
the site can be resolved within its operational hours.
9. Specify the Address of the organization along with City, Postal Code, State and Country.
10. Enter the Contact Information such as E-mail Id, Phone no, Fax no and the Web URL of
your organization.
11. Enable any of the following related settings,
1. Refer Default Settings: On enabling refer default settings, the default settings are
not copied to site and hence there is not separate site based configurations (except
for departments). Instead the configurations made under the default settings are
referred to the site. Any modifications made under the default settings such as,
adding a new holiday or group to the existing list will get applied to the sites with refer
default settings enabled.
Say, for an organization with various sites having similar site specific configurations,
enable refer default settings instead of copying the default configurations to every
site. Any additional holiday or group added under default settings will automatically
get applied to all the sites with this option enabled.
2. Copy Default Settings: Copy default settings help you to maintain separate site
specific configurations for every site, and if there is any slight modifications made
under default settings then, the same gets pushed to the sites provided the previous
states of default setting and site configuration is the same. Any minor changes made
in the site based configurations of a site is exclusively for the particular site.
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Say, the escalation rules set in a SLA for one site is different from another site. In this
case, enable copy default settings radio button and modify the changes in the
escalation rules.
3. Custom Settings: Custom default settings help you to organize, configure and
maintain separate site specific configurations of a site. The default settings do not
have any influence over the default settings.
Consider an organization with branches across the globe having different operational
hours and holidays, and thus with different SLAs. In this case, site specific
configurations needs to be configured separately for every site by enabling the radio
button corresponding to the options in Custom Settings for the site.
12. Click Save button to save the site details and return to the list view. Click Save and add new
button to save and add another site. If you wish to cancel the operation then click Cancel.

Edit Site
To edit a site,
1. From the site list page, click the edit icon
Site page opens with the existing details.

beside the site which you wish to edit. The Edit

2. You can modify all the fields in this page. Click Save to save the modified changes. Click
Save and Add New to save and add another site.

Delete Site
To delete site,
1. In the Site List page, click the delete icon
confirmation dialog appears

beside the site which you wish to delete. A

2. Click Ok to proceed. The site gets deleted from the list of available sites.
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Configuring Operational Hours for MSP Sites
You can configure operational hours for your various sites. The operational hours for a site depends
on the time zone configured for that site. The operational hours that you configure is used while
calculating the request due by date and time. To set a site's operational hours,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click the Organization Details icon

.

4. Click on 'MSP Operational Hours' from the menu on the left side to open the MSP Operational
hours page

4. Select the site from the Operational hours for combo box.
Note:The Site Admin can set the operational hours for the sites to which he is
associated. The sites can be selected from the Operational Hours for combo box. The
Operational hours for combo box will appear if the site is configured in Admin- Sites.
5. If your organization works round the clock, then select Round the clock (24 hours) radio
button. If you do not work round the clock then, select the radio button beside Select
Operational Hours. Specify the working hours of your organization by selecting the Start
Time and the End Time from the drop down boxes.
6. Now, select the days that your organization works by selecting the check boxes provided
beside the days of the week.
7. Click Save.
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You can also view the operational hours of a site by selecting the site from Operational Hours for
combo box.
If you have already set the operational hours and wish to modify the same, you still need to follow the
same procedure as specified above. But in this case, when you click Operational Hours from the
Admin Home page, it will open the Operational Hours form with the details that have been set
earlier. You can make the necessary modifications and then click on Save.
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Configuring Holidays for MSP sites
You can set the holidays for different sites in your organization using the Holidays option available in
the Admin page. This page has the list of holidays during which the site will remain closed. It is
exclusive of the weekly holidays. You can also set holidays to repeat on the same date each year
such as, New Years Day, Christmas and so on. By doing this, you need not manually add the holiday
every year in the list of Holidays.
The holiday list along with the operational hours will be used for calculating the expected completion
time of a request, depending on the priority or SLA applicable to that request. To open the holiday
configuration page,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Holidays' from the menu on the left side to open the MSP Holidays page
Note: The Site Admin can add and view the holidays to the site which he is associated.
To view the holidays in a particular site, select the site from the Holidays for combo
box.

Add Holidays
To add holidays in a site,
1. Select the site for which you want to add the holiday from the Holidays for combo box. If the
sites is not selected then the holidays gets added under Default Settings.
2. Click Add New Holiday link available at the top right corner of the holiday list page. This
opens the Add New holiday form.
3. Select the Date on which you want to add the holiday by invoking the calender icon
is mandatory field.

. This

4. Enter a brief description of the significance of the holiday in the Description text field.
th

5. If the holiday occurs every year such as, 25 December (Christmas), then enable Check if
this is recurring holiday check box. This will automatically add the holiday every year for the
site.
6. Click Save. If you do not wish to add the holiday and would like to get back to the holiday list,
click Cancel.
7. Clicking the View List link on the top right corner of the add holiday form will also take you to
the holiday list view.

Edit Holidays
1. Select the site for which you want to edit the holiday from the Holidays for combo box. This
lists out the holidays for the corresponding site.
2. Click the edit icon

beside the holiday Date that you wish to edit.

3. Modify the date and the description of the holiday, and enable/disable the 'check if this is
recurring holiday' check box in the Edit Holiday form.
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
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Delete Holidays
1. Select the site for which you want to delete the holiday from the Holidays for combo box.
This lists outs the holidays in that site.
2. Enable the check box beside the holiday Date which you want to delete from the holiday list
page. Click the Delete button on the left hand side of the page. A confirmation dialog
appears.
3. Click OK to proceed with the deletion. If you do not want to delete the holiday, then click
Cancel.
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Configuring Departments for MSP sites
There can be various departments in an organization which can be situated in different sites and,
each of these departments have a group of employees in them. In ServiceDesk Plus - MSP you can
add, edit, or delete the various departments of your organization. These departments are essential
while adding requesters and technicians since each requester or technician will be associated to a
particular department of the organization. To open the department configurations,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Departments' from the menu on the left side to open the MSP Departments
page
Note:The Site Admin can configure the department for the sites to which he/she is
associated. The list of departments associated to the site can be viewed by selecting the
site from the Departments for combo box.

Add Department
To add a department in a site,
1. Select the site for which you want to add the department from the Departments for combo
box.
2. Click Add New Department link available at the top right corner of the Department list page.
This opens the Add Department form.
3. Enter the Department Name in the text field. This is mandatory field.
4. Provide a brief Description about the department in the text field provided.
5. Click Save. At any point, if you do not wish to add the department and would like to get back
to the department list from the add department form, click Cancel.

Edit Department
To edit an existing department,
1. Select the site for which you want to edit the department from the Departments for combo
box. This lists out the available departments corresponding to the site.
2. Click the edit icon
Department form.

beside the Department Name that you wish to edit. This opens the Edit

3. Modify the department name and its description.
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.

Delete Departments
1. Select the site for which you want to edit the department from the Departments for combo
box.
2. Enable the check box beside the department name which you wish to delete from the
department list page. Click Delete button. A confirmation dialog appears.
3. Click OK to proceed with the deletion. If you do not want to delete the department, then click
Cancel.
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Configuring Business Rules for an MSP's site
You can define Business Rules for various sites of your organization. Business Rules enable you to
organize incoming requests (via web form and e-mail) and perform actions such as delivering them to
groups, assigning status and other request parameters. Business Rule can be applied to a request
when it is created (or received), edited or both. Notification can also be sent to the technicians once
the Business Rule is executed.
To open the Business Rule configurations page,
1. Login to the ServiceDesk Plus - MSP application with admin username and password.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Business Rule' from the menu on the left side to open the MSP Business Rules
page
Note: The Site Admin can add and view the business rules to the site which he is
associated. To view the business rules of a site, select the site from the Business Rules
for combo box.

Add New Business Rule
To add a Business Rule,
1. Select the site to which you want to add the business rule from the Business Rules for dropdown list.
2. Click Add New Business Rule link available at the top right corner of the Business Rules List
page.
3. The Add Business Rule form consists of three blocks to be configured namely, Business
Rule Details, Criteria and Actions and Notification.

Business Rule Details
The details of the Business Rule are exclusively for the newly added business rule.

1. Specify a unique Rule Name in the given text field. It is a mandatory field.
2. The Site selected in Business Rules for drop down box is displayed as non-editable
text.
3. Provide the content to describe the business rule in the Description text field.
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4. Business Rule can be executed on a request when it is created via web form (or
received via email), edited or both on choosing the options from Execute when a
request is drop-down list. By default, the 'Created' option is selected.
5. You can disable a Business Rule by selecting Disable Business Rule check box. On
disabling a Business Rule, the rule will not get executed on any new or edited
request. The disabled business rule will be marked in grey in the list view.
6. By default, the execution of the business rule will stop once a rule is applied on a
request. To continue execution of successive business rules even after a business
rule is applied on a request, select Turn on Cascade Execution check box.
7. By default, when a business rule is applied, the request values will be changed with
the values in the business rule only if the request value is empty. If the request value
is not empty, the business rule value will not be applied. To override the request
values with the values in the business rule enable Override request values with
Business Rule values.
Example: If the Priority in a request is set to 'High' and the Actions Set in the
business rule is 'Set Priority to Low', then the priority is automatically set to 'Low'
when the business rule is applied.
Note: Bulk actions such as delete, disable/enable business rules, turn on/off
cascade execution can be performed on a business rule by selecting the check
box beside the business rule and click Actions drop down button.
To turn on/off cascade execution to a business rule from the list view, click the
beside the business rule. A confirmation message appears. Click OK to
icon
continue. The icon will be grayed if the cascade execution is discontinued.

Criteria and Actions
Under this block, define the rules and criteria that need to be satisfied by the incoming
request.

1. Select the Criteria and Condition from the respective drop-down list, and then the
individual values that needs to be matched by clicking the Choose button. The values
from the database for that particular parent criteria that you chose from the drop down
list opens. Choose the values you want and click Ok.
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Example: If you want to match the requester name John, then select Requester
Name in the Select Criteria drop down box. Now select the condition is or is not from
the drop down list. The list varies for each criteria. Click Choose button to open the
list of requesters in a pop-up window. Select the requester name from the list and
click Ok. For multiple selection, press Shift or Ctrl key while selecting the names.
The selected names appears in the text box just beside the choose button.
2. Click Add to Rules to add the defined rule to the rules table.
3. By default, the radio button Match ALL of the following is selected. If you do not
want all of them to be checked but if it is enough if any one of the rules are matched,
then select the radio button Match ANY of the following.
4. After defining the rules, you need to define the actions that need to be performed on
the request matching the criteria. Choose the action from the Choose Action drop
down list.
5. Click Choose button to select the values for the chosen action.
Example: If the action you had chosen was to Place in Group, then click the Choose
button to display the list of groups available in the corresponding site. Select the
group to which the request has to be placed and click Ok.
6. Click Add to add the action in the actions table.

Notification
You can send Email and SMS notification to technicians once a business rule is applied.
Caution: Configure Mail Server Settings before enabling Notification.
To enable Email notification,
•

Select the check box beside Email. Click Add to select the list of technicians from
Select Assign to Technicians pop up window. Click Ok to add the technicians.

To enable SMS notification,
•

Select the check box beside SMS. Click Add to select the list of technicians from
Select Assign to Technicians pop up window. Click Ok to add the technicians.

To edit the Email Template,
•

Click Edit Email Template link to open the email template form. Make the required
changes in the Subject and Message text field. Click Ok.

Click Save. If you want to add more than one business rule, then click Save and Add New. At any
point, if you do not wish to add the business rule and would like to get back to the business rules list
from the add business rule form, click Cancel.
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Edit Business Rule
To edit an existing business rule,
1. In the Business Rules List page, click the edit icon
you wish to edit.

beside the Business Rule Name that

2. In the Edit Business Rule form, you can modify all the fields mentioned in the add business
rule form.
3. To edit the Match the below criteria set, click the edit icon beside the individual criteria.
The respective selection window is opened in a separate pop-up. You can choose more
values or remove a few values by de-selecting them.
4. You can also delete a criteria completely. To delete a criteria, click the delete icon
the individual criteria.

beside

5. In the actions to be performed, you can add new actions, edit or delete the existing actions.
6. Click Save to save the changes performed. At any point you wish to cancel the operation that
you are performing, click Cancel. Even while editing a business rule, if you wish to add
another new business rule, then click Save and Add New button.

Delete Business Rule
1. From the Business Rule List page, enable the check box beside the Rule Name you wish to
delete.
2. Click Actions drop down button, and select the Delete option. A confirmation dialog opens.
3. Click Ok to proceed with the deletion. If you do not wish to delete the business rule, then click
Cancel.

Organize Business Rules
Organizing the business rules decide the order in which the rule is applied on the incoming request.
You can organize the business rule to appear in a particular order in the list view,
1. Select the site for which you wish to rearrange the order of the business rule from the
Business Rules for combo box.
2. Click Organize Business Rules link at the top tight hand corner of the Business Rules List
view page. A pop-up window opens displaying the list of available business rules in the order
that is appearing in the list view.
3. Select a business rule, and click Move up or Move Down button beside the list.
4. Click Save.
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Configuring Service Level Agreements for MSP Sites
You can have Service Level Agreements (SLAs) defined for intra-organization service provided by the
IT help desk team. These SLAs help evaluating the efficiency, effectiveness,and responsiveness of
your help desk team. The SLAs can be defined for each individual, or departments, or workstations in
a site. The priority for an incoming service request is automatically set if the request is governed by an
SLA rule. Also, if the request is not attended to and resolved within the time specifications of the SLA,
then you can set the escalation rules.

To open the SLA configurations page,
1. Login to the ServiceDesk Plus - MSP application with admin username and password.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Service Level Agreements' from the menu on the left side to open the MSP
SLAs page
5. By default, all SLA based mail escalations will be enabled. If you wish to disable the
escalation click Disable Escalation button.
Note: The Site Admin can configure the SLA for the sites to which he is associated by
selecting the site from the Service Level Agreement for combo box. The list of all
SLAs corresponding to the selected site gets displayed.

Add New Service Level Agreement
To add an SLA,
1. Select the site to which you want to add the SLA from the Service Level Agreement for
combo box.
2. Click Add New SLA link at the top right corner of the SLA list page.
3. In the Add New SLA form, specify the SLA Name in the text field provided. It is a mandatory
field.
4. The Site selected in Service Level Agreement for drop down box is displayed in non editable
text.
5. If required, you can provide a corresponding Description for the SLA.
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6. In the SLA rules block, set the rules and criteria for the SLA. By default, the radio button
Match ALL of the following is selected. If you do not want all of them to be checked but if it
is enough if any one of the rules are matched, then select the radio button Match ANY of the
following.
7. Select the Criteria and Condition from the respective text box, and then choose the
individual values that need to be matched by clicking on the choose button. The values from
the database for that particular parent criteria that you chose from the drop down list opens.
Choose the values you want and click OK.
Example: If you want to match the requester name John, then select Requester Name in the
combo box. Now click Choose button, to open the list of requesters in a pop-up window.
Select the requester name from the list and click Select. For multiple selection, press Shift or
Ctrl key while selecting the names. The selected names will appear in the text field just
before the choose button.
8. Click Add to Rules to add the defined rule to the Rules Set.
9. Set the Response Time and the Resolution Time in terms of days, hours and minutes. The
specified response time should be less that the resolution time.
10. If you want this duration to override the operational hours, then select the check box beside
Should be resolved irrespective of operational hours. By selecting this, you will be
overriding the operational hours of your organization and the due by time will be calculated
from the creation time without taking into consideration the holidays and operational hours.
11. The request can be escalated to other technicians when the request is not responded or
resolved within the specified time. There are two blocks of escalations, one for the Response
Time and the other for the Resolution Time.
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Response Time:
There is only one level of escalation if the response time elapses.
i.

To enable escalation, select the check box beside Enable Level 1 notification.

ii.

Click Choose button to choose the technicians to whom the SLA violation should be
escalated.

iii.

You can choose to escalate before the violation or after the violation. If you wish to
escalate the request before the SLA violation then click Escalate Before option.
Specify the number of days before the SLA violation is about to happen in the text
box. This is to escalate to the technician about the onset of the violation. You can
also specify the time of escalation.

iv.

Similarly, click Escalate After option to escalate after the violation. Specify the
number of days after the SLA violation has occurred in the text box. You can also
specify the time of escalation.

Resolution Time:
There are 4 levels of escalation if the specified resolution time elapses.
i.

To enable escalation, select the check box beside Enable Level 1 notification.

ii.

Click Choose button to choose the technicians to whom the SLA violation should be
escalated.

iii.

You can choose to escalate before the violation or after the violation. If you wish to
escalate the request before the SLA violation, then click Escalate Before option.
Specify the number of days before the SLA violation is about to happen in the text
box. This is to escalate to the technician about the onset of the violation. You can
also specify the time of escalation.

iv.

Similarly, click Escalate After option to escalate after the violation. Specify the
number of days after the SLA violation has occurred in the text box. You can also
specify the time of escalation.

12. Click the Save button to save the SLA and return to the list view. If you want to add more than
one SLA, then click Save and Add New.
At any point, if you do not wish to add the SLA and would like to get back to the SLA list from the add
SLA form, click Cancel. Clicking the View List link on the top right corner of the add SLA form will
also take you to the SLA list view.
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Edit Service Level Agreement
To edit an existing SLA,
1. Select the site of the SLA you wish to edit from the Service Level Agreement for combo
box. The lists of all the SLA corresponding to that site is displayed.
2. Click the edit icon

beside the SLA Name.

3. In the Edit SLA form, you can modify all the fields mentioned in the add SLA form.
4. Click Save to save the changes. At any point you wish to cancel the operation that you are
performing, click Cancel. Even while editing an SLA, if you wish to add another new SLA,
then click Save and Add New button.

Delete Service Level Agreement
1. Select the site of the SLA you wish to delete from the Service Level Agreement for combo
box. The list of SLA corresponding to the site gets displayed.
2. Enable the check box beside the SLA. Click the Delete button. A confirmation dialog appears.
3. Click Ok to proceed with the deletion. If you do not want to delete the SLA, then click Cancel.

Organize Service Level Agreements
Organizing the SLAs decide the order in which the SLA is applied on the incoming request. You can
organize the SLA to appear in a particular order in the list view,
1. Select the site for which you wish to rearrange the order of the SLA from the Service Level
Agreement for combo box.
2. Click Organize SLA link available above the list of SLAs in the SLA List view. A pop-up
window is opened with the list of available SLAs in the order that is appearing the list view.
3. Select an SLA, and click Move up or Move Down button beside the list.
4. Click Save.
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Configuring Preventive Maintenance tasks for MSPs
You can create a Preventive Maintenance Task for regular maintenance such as changing the printer
toner every month or perform a regular service shutdown.
To schedule a preventive maintenance task,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Preventive Maintenance Task' from the menu on the left side to open the MSP
Preventive Maintenance Task page
5. Click Add New PM Task link. This opens Add Preventive Maintenance Task page. You can
create a preventive maintenance task in two steps.

Creating a Task Template
Task template has four blocks, Request details, Owner details, Requester details, Category details.
1. Specify the Status of the request from the comb box. Ex. Open.
2. Specify the Level of the request from the combo box. The level should be selected based on
the priority. Ex. If the priority of the request is high then select Tier 1.
3. Select the Mode from the combo box. This will be the mode of communication, to inform the
technician.
4. Select the Priority from the combo box. For ex. High, Medium, Low etc.
5. Select the Group from the combo box. This option is given to group the task template. Ex.
Network, Hardware etc.
6. Select the Technician from the combo box to assign the task and click the requester list icon
to select the requester Name. This is a mandatory field. The other details such as Contact
Number, Workstation ID and Department get filled automatically based on the requester
details specified in the requester form.
7. Select the Category, Sub Category and Item from the combo box.
8. Specify the Subject line for the task in the given text field. Specify relevant information about
the task in the given Description field.
9. To attach a file to the task template click Attach a File button to attach files.
10. You can add Resolution in the resolution text field.
11. Click Next>> button for Task Scheduling.

Task Scheduling
To schedule a task, select the time frame from the listed options:
Daily Schedule: To run a daily maintenance task, click Daily Schedule radio button.
1. Select the Time at which the maintenance task should be scheduled from the combo box.
2. Select the Date on when the maintenance task should be scheduled from the Calendar
button.
3. Save the details.
Weekly Schedule: To run a weekly maintenance task, click Weekly Schedule radio button.
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1. Select the day of the week by enabling the corresponding check box beside the day of the
week.
2. Else if you wish to schedule on all days of the week, then click Everyday check box.
3. Select the Time frame to schedule the task from the combo box.
4. Save the details.
Monthly Schedule: To run a monthly maintenance task, click Monthly Schedule radio button.
1. Select the month to run the task by enabling the check box beside Every Month.
2. Select the Date on when the task should be scheduled from the combo box.
3. Select the Time at which the task should be scheduled from the combo box.
4. Save the details
Periodic Schedule: To run a periodic maintenance task, click Periodic schedule radio button.
1. Specify the day (s) in the given text field to schedule the maintenance task. i.e after every
specified nth day the maintenance task will be executed.
2. Save the details.
One Time Schedule: To run a one time maintenance task, click One Time Scheduling radio button.
1. Select the Date & Time on when the maintenance task should be executed.
2. Save the details.
For Example:
If you wish to schedule a monthly task to change the printer cartridges,
1. Select Monthly Schedule radio button.
2. Select the check box every month.
3. Choose the date from the combo box. Ex: 3rd of every month.
4. Select the time from the combo box. Ex: 1500 hrs.
5. Save this schedule. A task to change cartridge will be sent to you every month on 3rd at 1500
hrs helping you to complete the regular maintenance task in advance without any request
sent from the users.
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Configuring MSP Requesters
You can add, edit, or remove requesters from ServiceDesk Plus - MSP application and also provide
them with login permissions to access the self-service portal.
To open the requester configuration page:
1. Log in to the ServiceDesk Plus - MSP application with the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
3. On the MSP Details block, click Organization Details

icon.

4. Click on 'MSP Requesters' from the menu on the left side to open the MSP Requesters page

Add Requester
To add a requester and provide login access to him/her,
1. Click Add New Requester link available at the top right corner of the Requester List page.
This opens the Add Requester form
2. In the Personal Details block, enter the Full Name and Employee ID of the technician. The
name is a mandatory field. Specify any relevant information about the requester in the
Description text field.
3. In the contact information block, enter a valid e-mail ID. If the requester has a phone and a
mobile number, you can enter the same in the space provided for entering these values.
4. Specify the department details such as, Site and the corresponding Department Name to
which the requester belongs from the combo box. The requester has an option to view, only
his requests, all his department requests, all the requests in the site to which he is associated
or all requests from the account to which he is associated, select the corresponding option
from the Requester allowed to view combo box. Specify the Job Title of the requester in the
field provided.
5. If you have added any organization-specific fields for the new requester form, those will be
available under the Additional Requester Details block. Enter the relevant information.
6. In the Self-Service Access Details block, enter the Login Name and Password, if you wish
to provide self-service access to the requester. Enter the password again in the Re-type
Password field.
7. If the requester is associated to a domain then select the Domain from the drop down list.
8. Certain requesters can also approve purchase order in an organization. Upon enabling the
check box adjacent to Purchase Order Approvers, a link is sent to the requester to accept
or reject the PO.
9. Click Save. If you want to add more than one requester then, click Save and add new button.
At any point if, you decide not to add the new requester, then click Cancel to get back to the
requester list. Clicking the View List link on the top right corner of the add requester form will also
take you to the requester list view.

Import Requesters from Active Directory
You can also import requesters from an active directory. To import requesters from active directory
1. Click Import from Active Directory link in the Requester List page. The Import From
Active Directory window pops up.
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2. From the list of domains that are listed in the Domain Name combo box, select the domain
name in which the active directory from which you wish to import is installed. If the other
details such as domain controller name, user name, and password have already been
entered in the Domain scan page, then that will be populated automatically. Else enter the
name of the domain controller in the Domain Controller Name field, login name and
password in the corresponding fields.
3. Select the Fields for Import from the active directory by enabling the check box.
4. Click Import Now !. The import wizard displays the various Organizational Units (OUs)
available in that domain. Choose the specific OU from which you wish to import users by
selecting the check box beside it.
5. Click Start Importing. Once the import is complete, the data on how many records were
added, how many overwritten, and how many failed to import will be displayed.

Import Requester from CSV (Comma Separated Value) Files
You can also add requesters by importing from CSV files. To import requesters from CSV file

Step 1: Locate the CSV file
1. Click Import from CSV link in the Requester List page. The Import Wizard opens in
a pop-up window.
2. Click the Browse button in the wizard.
3. Select the CSV file in the file chooser window and click Open.
4. Click Next.

Step 2: Customize Mapping
1. The CSV column names are populated in the select boxes beside each label. Map
the ServiceDesk Plus - MSP requester fields with the field names from the CSV file.
2. Click Next.

Step 3: Import
1. Click Import Now button. The values from the CSV file will be imported to the
requester details. Once the import is complete, the data on how many records were
added, how many overwritten, and how many failed to import.
If at any point you wish to stop importing from the CSV file, click the Exit button.

Note 1: Login name column will be the identifier for requesters. No two requesters can have
the same login name. Hence the existence of a requester will be checked based on the login
name value.
So, if by mistake there was any mismatch of fields during mapping, and a new import of CSV
is performed, the records will be updated based on the login name value. If there were any
records that did not have any login name at all or there was mismatch in the login name
itself, then duplicate entries will be created. In these cases, delete such entries from the
requester list and import again or manually edit the information available.
Note 2: While Importing users using CSV, the existing user information is overwritten based
on two criteria - Username and Domain, and the Email id. If the Domain is not specified for a
user and on performing a new import of CSV, the user information will be overwritten but the
Domain will remain null even if the field is specified.
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Edit Requester
To edit the requester details,
1. In the Requester List page, click the edit icon beside the requester's full name that you
wish to edit. The Edit Requester form is displayed with the existing details of the requester.

2. In this form, you can modify all the fields displayed. You can also change the login name of
the requester.
3. Click Save. If you do not wish to modify any of the details, click Cancel.

Change Requester Password
You can change the requester's password while editing the requester details.
1. To change the password of the requester, click the Reset Password link. The reset
password window is opened.

2. Below the Login Name display, enter the New Password in the text field.
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3. Click Reset Password. If you do not wish to change the password, click Close
instead of Reset Password.

Change Requester to Technician
You can change a requester to technician without having to delete the requester information
and recreate the same as a technician. To change requester to technician,
1. Click the Change as Technician option available at the top left corner of the edit
requester form. The page refreshes to display the edit technician form.
2. Change the roles assigned to the requester from SDGuest to any other role that you
wish to provide the technician.
3. Enter any other details that you wish to enter including the Cost per hour and so on.
4. Click Save. If you do not wish to change the requester to technician, click Cancel
instead of Save.
If you want to continue adding technician after converting a requester to technician, then
instead of clicking Save, click Save and add new button. This saves the technician details
and reopens the add technician form after displaying a success message for changing the
requester to technician.

Associate Workstation to Requester
You can also associate a workstation with the requester. To associate a workstation with the
requester
1. Click the Associate Workstation link available at the top right corner of the edit
requester form. The associate workstation window is opened.

2. In the Associate Workstation pop-up, select the workstations that you wish to
associate with the requester from the Workstation List and move them to the
Associated Workstations list by clicking the >> button. To dissociate workstations,
select the respective workstations in the Associated Workstations list and click the
<< button. If you wish to dissociate all the workstations, then click Dissociate All.
3. After associating the required workstations, click Save Changes.
4. A message is displayed. Click the Close button.

Delete Requesters
1. In the Requester List page, click the delete icon
wish to delete. A confirmation dialog is opened.

beside the requester's full name that you
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2. Click OK to proceed with the deletion. If you do not want to delete the requester, then click
Cancel.

Search Requesters
To search requesters
1. In requestr list view, click on the alphabet with which the name of the requester starts. This
lists the requesters whose name starts with that alphabet.

2. If you are unsure of the starting letter, then you can type the name (first name or the last
name, which ever you know) or email ID or any other parameter that will identify the requester
in the field beside the Search Requester List. This lists the requesters whose details
matches the search string that you entered.
You can also search requesters from the Search available on the left menu in the other pages of the
application. From the Search in combo box, select Requesters and type your search string in the
Enter Keyword text field. Click Go or press Enter. The requester names that match the search string
are listed in a separate pop-up window.
Another option to search requesters will be using the column-wise search option. To perform a
column-wise search
1. Click the search icon at the end of the requester list view headers. This opens the search
field just below every column that is visible in the list view.
2. Enter the search key in field under the column of your choice.
3. Click Go. The search results matching the search string(s) are displayed.

Requester List View Customization
To customize the requester list view
1. Click the column edit icon available at the corner of the requester list headers. This opens
the available columns that can be displayed in the list view. All those that are visible currently,
will have the check box beside them selected.
2. To remove a column, disable the check box beside the column name.
3. To add a column to the list view, enable the check box beside the column name.
4. To change the column order, click the up and down arrow after selecting the column that you
wish to move.
5. Click Save.
This will add only those columns which you have chosen in the list view. You can also sort the list
view based on columns. To sort requester list by column, click the column header. Clicking it once will
sort it in ascending order. Clicking twice will sort the column in descending order.
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Helpdesk Configurations
Helpdesk Configurations
Various helpdesk related configurations need to be performed by the admin user, before the
ServiceDesk Plus - MSP request module can be opened for real time functioning of fetching the IT
help desk mails and tracking the same. The following helpdesk configurations need to be made for the
new request form to capture meaningful information that can help the technicians solve the reported
issue faster:
1. Request category
2. Request Status
3. Request level
4. Request mode
5. Impact
6. Urgency
7. Request priority
8. Request Type
9. Configuring Additional Fields that need to appear in the new request form, so as to collect
very specific information
10. Request Closing Rules
11. Notification Rules
12. Request Template
13. Resolution Template
14. Reply Template
15. Task Template
16. Configuring Requester - Additional Fields
17. Configuring Technician - Additional Fields
To access the helpdesk configurations:
1. Login to the ServiceDesk Plus - MSP application with the Username and Password of a
ServiceDesk Plus - MSP Administrator.
2. Click the Admin tab in the header pane.
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Request Form Customizer
Request Form Customizer
The new request form can be configured to suit the needs of the organization. It is highly
customizable. You can add your own values to be set for the category of the request, priority of the
request, level of request, and mode of the request. These will already have some default values in
them. If you do not wish to have these then you can delete them and add new values or edit them to
suit your needs. You can also add custom fields which will be available in the form. These custom
fields can be of three types: text field, numeric field, and date field. You can use these to collect the
organization specific information for getting a better and clearer idea about the reported issue. Finally
you can set the default values for the request form fields so that creating and submitting a new
request if made easier. The subsequent sections of the document explain in detail the various
customizations and configurations that can be done in the request form.
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Configuring Category
The requests can be grouped under proper Categories, Sub-categories and Items.
For example: A request to install Adobe Photoshop can be put under the request Category as
Software, Sub-Category as Adobe Photoshop and Item to be Versions 5.0,6.0 and so on.
Similarly, if there is a problem in the functioning of the mouse, then it can categorized under the
Category as Hardware, Sub-Category to be mouse and Item to be scroll button not working.
Depending on the need, you can create various such categories, sub-categories and item for multiple
Accounts using this option. You also have an option to import categories, sub categories and items
from a CSV file. These categories,sub-categories and items will be listed in the drop-down menu in
the New Request form.
To configure category,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. This opens the HelpDesk3. In the Helpdesk block, click the HelpDesk Customizer icon
Category page where you can categorize the request in to category, sub-category and item
for multiple Accounts. You have the list of request form attributes that can be customized
such as status,level,mode and so on is listed on the left side of the page.

Create New Category
4. Click New Category button. This displays the category form.
5. Specify the Category Name in the given text field. For ex. Software. This is mandatory field.
6. Specify relevant information about the newly created category in the Description field.
7. You can associate multiple accounts to the category. Select the accounts to which you want
to associate the category from the list of Available Accounts and move it to the Associated
Accounts by clicking >> button.Similarly you can also disassociate the Accounts.This is also
a mandatory field.
8. Select the technician to be assigned for the newly created category from the Assign To
Technician combo box. All the issues related to this category will be assigned to the selected
technician.
9. Click Save button to save the details. You can see the category getting listed in the category
list view below the form.
10. Click Save And Sub Category button to save the details and add sub category to the
category.

Create New Sub-Category
11. Click New Sub Category button in the category list page to add sub-category to the category.
Or click add sub-category icon
the sub-category form.

beside the category title in the list view . This displays

12. Specify the Sub Category name in the given text field. For ex. AdobePhotoshop. This is a
mandatory field.
13. Specify relevant information about the newly created sub category in the Description field.
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14. Select the Category from the combo box. For ex. Software. This is a mandatory field.
15. Click Save button to save the values. You can see the sub-category getting listed under the
selected category.

Create New Item
16. Click New Item button in the category list page to add item to the sub-category. Or click add
new item icon
beside the sub-category title in the list view. This opens the New Item
form in which the you have category, sub-category and other details on top of the page.
17. Specify the Item name in the given text field. For ex. versions. This is a mandatory field.
18. Specify relevant information about the newly created item in the Description field.
19. Select the Sub Category for the item from the combo box. For ex. software. This is a
mandatory field.
20. Click Save button to save the details.

Import from CSV file
If the categories, sub categories and items are recorded in a CSV file, then you can import the same
using Import from CSV option. Follow the steps given below to import the CSV file.
Step #1: Locate the CSV file
1. Click Import from CSV button. The Import Wizard window pops up.
2. Click the Browse button to select the CSV file.
3. On locating the CSV file from the file chooser window, click Open. The path to the file
appears automatically in the Locate CSV file field.
4. Click Submit button.
Step #2: Customize Mapping
1. Map the Category, Sub Category and Item with the field names in the CSV file.
2. Click Import button. The details of the CIs from CSV are imported.
3. On completion, the Import Results are displayed. The number of categories, sub categories
and items that are imported and the number of categories, sub categories and items that have
failed to import are displayed.
NOTE:
1. The new field(s) will be added and the existing field(s) will not be overwritten.
2. Importing the field which is already marked as "not for further usage" will not be changed to
active again.
3. If a field is empty, it will be ignored and the remaining field(s) by the hierarchy (Category ->
Sub-Category -> Item) in that record/row will also be ignored.
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Editing & Deleting Category
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon
Configuration Wizard page.

. This opens the

4. Click the HelpDesk Customizer block at the left side of the page under the HelpDesk block.
This opens the HelpDesk- Category page.

Editing Category
1. Click the edit icon
edit category form.

beside the category name in the Category List page. This opens the

2. edit the details and save the changes.

Editing Sub-Category
1. Click the title of the category in the category list page. This opens the sub-category details
page.
2. Click the edit icon

. This opens the edit sub-category form.

3. Edit the details and save the changes.

Editing Item
1. Click the title of the sub-category to open the item details page.
2. Click the edit icon

. This opens the edit item form.

3. Edit the details and save the changes.

Delete Category
1. From the Category List page, select the categories to be deleted by enabling the check box.
2. Click delete icon beside the category name in the category list page. A pop window pops
up to get your confirmation on the delete operation.
3. Click OK to proceed. You can see the category deleted from the list.

Delete Sub-Category
1. Click the corresponding sub-category from the list. You can view the list of sub-categories for
the category.
2. Select the sub-category from the list by enabling the check box.
3. Click Delete button to delete the selected sub-category. A pop window pops up to get your
confirmation on the delete operation.
4. Click OK to proceed. You can see the sub-category deleted from the list.

Delete Item
1. Click the corresponding item from the list. You can view the list of items for the category.
2. Select the item from the list by enabling the check box.
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3. Click Delete button to delete the selected item. A pop window pops up to get your
confirmation on the delete operation.
4. Click OK to proceed. You can see the item deleted from the list.
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Configuring Status
The requests that are received in ServiceDesk Plus - MSP will be taken up by the technicians and will
be in various stages of completions. For ease of managing the requests and to know the status in
which each of the received requests are in, ServiceDesk Plus - MSP allows you to create various
request status under which you can group requests. These status can either be In Progress or
Closed. While creating a status, you can also choose to stop the request timer for the status that is
being created. Depending on the need of your organization, you can create various such status, which
will be listed in the status drop-down menu in the New Request form.
To open the status configuration page
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page displays
3. In the Helpdesk block, click the HelpDesk Customizer icon
the list of request form attributes that can be customized on the left menu and the category list
page.
4. Click Status from the left menu, or click the Next button on the top of the category list page.
The Status List page is displayed. You can add, edit, or delete the request status.

Add Status
To add a request status
1. Click the Add New Status link available at the right top corner of the Status list page.
2. In the Add Status form, enter the name of the status in the Name field.
3. Select the Type to which the status belongs. The status type allows you to identify the
whether the status that you are adding is still in progress and hence should be a part of the
open requests or should be moved to the closed requests. If the added status requires the
timer of the request to be stopped, then you need to set the check box Stop timer.
4. If you wish, you can enter the status Description. Please note that you cannot create two
status with the same Status Name.
5. Click Save. The new status is added.
If you want to add more than one status, then instead of clicking Save, click Save and add new
button. This adds the new status and reopens the add status form.
At any point, if you decide not to add the new status, then click Cancel to get back to the status list.
Clicking the View List link on the top right corner of the add status form will also take you to the status
list view.

Edit Status
To edit an existing status
1. In the Status List page, click the edit icon

beside the status name that you wish to edit.

2. In the Edit Status form, you can modify the name of the status.
3. If the status belongs to the In Progress type, then you can choose to stop or start timer. If the
request status belongs to the completed type then you cannot edit the type of the request
status.
4. If you wish you can edit the Description of the status.
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5. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a status, if you wish to add a new status, then click Save and add new button
instead of clicking Save button after making the changes.

Delete Status
1. In the Status List page, click the delete icon
delete. A confirmation dialog appears.

beside the status name that you wish to

2. Click OK to proceed with the deletion. If you do not want to delete the status, then click
Cancel.
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Configuring Level
Request level is a measure to indicate the complexity of a request. For example, if the received
request just has some information and does not require any action to be taken, then it can be
classified as Level 1. If there is a minor level action, such as providing the requester some tips to
resolve the issue, then it can be classified as Level 2, and so on. To open the request level
configuration page
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page displays
3. In the Helpdesk block, click the HelpDesk Customizer icon
the list of request form attributes that can be customized on the left menu and the category list
page.
4. Click Level from the left menu. The Level List page is displayed. You can add, edit, or delete
the request levels.

Add Level
To add a request level
1. In the Level List page, click Add New Level link at the top right corner.
2. In the Add Level form, enter the level Name. If you want, you can enter the level Description
also. Please note that you cannot add two levels with the same name. Each level needs to be
unique.
3. Click Save. The new level gets added to the already existing list.
If you want to add more than one level, then instead of clicking Save, click Save and add new button.
This adds the new level and reopens the add level form.
At any point, if you decide not to add the new level, then click Cancel to get back to the level list.
Clicking the View List link on the top right corner of the add level form will also take you to the level
list view.

Edit Level
To edit an existing level
1. In the Level List page, click the edit icon

beside the level name that you wish to edit.

2. In the Edit Level form, you can modify the name and description of the level.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a level, if you wish to add new level, then click Save and add new button instead
of clicking Save button after making the changes.

Delete Level
1. In the Level List page, click the delete icon
A confirmation dialog appears.

beside the level name that you wish to delete.

2. Click OK to proceed with the deletion. If you do not want to delete the level, then click
Cancel.
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Configuring Mode
There are different modes of submitting a request to the IT help desk team. ServiceDesk Plus - MSP
provides you the option of submitting the request through an online form. Instead, a requester can call
up the IT help desk agent and inform him/her regarding an issue faced, where the help desk agent will
ensure to log the details discussed over the phone call through the web-based form. The other mode
by which you can submit a request is by sending a mail to the IT help desk team. The IT help desk will
then log the details of the mail through the web-based form in the ServiceDesk Plus - MSP
application. If there are other methods of reporting a request to the IT help desk team in your
organization, you can add the corresponding mode. To open the mode configuration page
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page displays
3. In the Helpdesk block, click the HelpDesk Customizer icon
the list of request form attributes that can be customized on the left menu and the category list
page.
4. Click Mode from the left menu. The Mode List page is displayed. You can add, edit, or delete
the request mode.

Add Mode
To add a request mode
1. In the Mode List page, click Add New Mode link at the top right corner.
2. In the Add Mode form, enter the Mode Name. If you want, you can enter the mode
Description also. Please note that each Mode Name needs to be unique.
3. Click Save. The new mode gets added to the already existing list.
If you want to add more than one mode, then instead of clicking Save, click Save and add new
button. This adds the new mode and reopens the add mode form.
At any point, if you decide not to add the new mode, then click Cancel to get back to the mode list.
Clicking the View List link on the top right corner of the add mode form will also take you to the mode
list view.

Edit Mode
To edit an existing mode
1. In the Mode List page, click the edit icon

beside the mode name that you wish to edit.

2. In the Edit Mode form, you can modify the name and description of the mode.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a mode, if you wish to add new mode, then click Save and add new button instead
of clicking Save button after making the changes.

Delete Mode
1. In the Mode List page, click the delete icon
A confirmation dialog appears.

beside the mode name that you wish to delete.

2. Click OK to proceed with the deletion. If you do not want to delete the mode, then click
Cancel.
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Adding New Impact
Impact is a measure of the business criticality of an Incident or a Problem. Impact is often measured
by the number of people or systems affected. By default you have four Impact details listed in the list
view.
To add new Impact,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon
Configuration Wizard page.

. This opens the

4. Click the Impact link at the left side of the page under the HelpDesk block. This opens the
Impact page.
5. Click New Impact link on the top right hand side of the page. This opens the Add impact
details page.
6. Specify the Name of the impact in the given text field.
7. Specify the details about the impact in the given Description field.
8. Save the changes.
9. Click the Save and add new button to save the Impact and add another Impact.
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Adding New Urgency
Urgency is about the necessary speed of solving an incident of a certain impact. By default you have
four Urgency details listed in this page.
To add new urgency,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon
Configuration Wizard page.

. This opens the

4. Click the Urgency link at the left side of the page under the HelpDesk block. This opens the
Urgency page.
5. Click on the New Urgency link on the right hand side of the page. This opens the Add
urgency details page.
6. Specify the Name of the Urgency in the given text field. This is a mandatory field.
7. Specify the urgency details in the Description field.
8. Save the changes.
9. Click the Save and add new button to save the urgency and add another urgency.
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Configuring Priority
Priority of a request defines the intensity or importance of the request. To open the request priority
configuration page
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page displays the
3. In the Helpdesk block, click the Helpdesk Customizer icon
list of request form attributes that can be customized on the left menu and the category list
page.
4. Click Priority from the left menu. The next page displays the available list of priorities. You
can add, edit, or delete the request priorities.

Add Priority
To add a request priority,
1. In the Priority List page, click the Add New Priority link at the top right corner. This opens
the Add Priority form.
2. Enter the priority name in the Name text field. The provided name has to be unique and
cannot be duplicated. This is a mandatory field.
3. If required, select the Color code to identify the priority by invoking the icon
color has to be unique for every priority specified.

. The selected

4. You can enter a short description about the priority in the Description field. This can help in
understanding the kind of priority associated with the name mentioned in the Name field.
5. Click Save. The new priority is added to the already existing list. At any point you wish to
cancel the operation that you are performing, click Cancel.
Priority order is a number that is associated with the priority name. This defines the order in which the
request received by the IT help desk team is to be handled. The requests that have a higher priority
order are taken first before the other requests with lower priority are attended to.
If you want to add more than one priority then, click Save and add new button. This adds the new
priority and reopens the add priority form.

Note: The priority name along with its color code can be view in the request list view page
provided the priority check box is enabled in the column chooser.

Edit Priority
To edit an existing priority
1. In the Priority List page, click the edit icon

beside the priority name that you wish to edit.

2. In the Edit Priority form, edit the fields you want to change.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a priority, if you wish to add a new priority, then click Save and add new button
instead of clicking Save button after making the changes.
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Delete Priority
1. From the Priority List page, enable the check box beside the priority name that you wish to
delete.
2. Click Delete button. A confirmation dialog appears.
3. Click OK to proceed with the deletion. The priority gets deleted from the available list. If you
do not wish to delete the priority, then click Cancel.
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Priority Matrix
The priority matrix helps you to determine the Priority automatically based on Impact and Urgency of a
request. Impact is listed in the y-axis, and Urgency list in the x-axis of the matrix. Priority Matrix
requires a one-time configuration by the Administrator.
Once you set the Priority for specific Impact and Urgency in the priority matrix, when a requester
selects a similar impact and urgency combination in the new request form, then the priority of the
request will be determined based on the matrix.
To set up Priority Martix,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page displays the
3. In the Helpdesk block, click the Helpdesk Customizer icon
list of request form attributes that can be customized on the left menu and the category list
page.
4. Click Priority Matrix from the left menu. The next page displays priority matrix with impact list
in the y-axis and the urgency list in the x-axis.
5. From the Priority Matrix page, click the priority link against specific urgency and impact, this
opens the drop down box.

6. Select the corresponding priority from the list. The priority will be set for the particular Impact
and Urgency combination.
In priority matrix : If Impact is Affects Business and Urgency is High then Priority
should be High.
Example

Result in request form : If requester/technician selects Affects Business for impact
and high for urgency in the request then, the priority field gets filled automatically and
displays as high.
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Configuring Request Type
Request Type is the type of request sent by the requester such as service request or request for any
information. ServiceDesk Plus - MSP gives you the provision of configuring your request type other
than the default options. This is essential while creating a new request under the request module.
1. Login to ServiceDesk Plus - MSP application using the username and password of the admin
user.
2. Click the Admin tab in the header pane.
. This displays the list of
3. In the Helpdesk block, click the HelpDesk Customizer icon
request form attributes that can be customized on the left menu.

Add Request Type
To add a new request type,
1. Click the Add Request Type link on the right hand side corner of the Request Type list page.
This opens the Add Request Type form.
2. Specify the name of the request type such as, Incident, Request for Information in the Name
text field. This is mandatory field.
3. Enter a brief description about the type of requests which fall under the category in the
Description text field.
4. Click Save, to save and return to the list view page. Click Save and Add New to save and
create another request type.

Edit Request Type
1. From the Request Type list page, click the edit icon
want to edit. This opens the Update- Incident page.

beside the request type which you

2. Modify the changes in Name and Description text field.
3. Click Save to save the changes. You can also Save and add a new request type by clicking
Save and Add New.

Delete Request Type
1. From the Request Type list page enable the check box adjacent to the request type which
you want to delete.
2. Click Delete button. A confirmation message for the delete operation pops up. Click Ok to
proceed. The request type gets deleted from the list.
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Configuring Additional Fields
Sometimes you may want to capture some additional details about an organization, for which, you
need additional fields apart from the default fields in the New Request form. You can add your own
fields using the Additional Fields configuration.
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page displays
3. In the Helpdesk block, click the HelpDesk Customizer icon
the list of request form attributes that can be customized on the left menu and the category list
page.
4. Click Request - Additional Fields from the left menu. The next page is a form that allows
you to add the field labels and description of the field. You can add three types of fields in the
form: text, numeric, and date/time. These three fields are available in three tabs as shown
below:

The default tab selected is Text.
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5. To add the text fields, enter the label name in the form fields below the Label heading. If
required, enter the description for the field.
6. You can choose the type of text field that you wish to add by selecting the radio buttons. A
Single-line text field allows you to add just a text field. The Multi-line text field allows you to
add a text box where a lengthy description can be added. A Pick List allows you to add a list
menu from which you can select. In all the three cases, you can add default values for the text
field in the space provided for the same.
7. To add items for the pick list, enter the value in the text filed and click Add Item. The value
will get added to the list below. To select the default selected value of the list, click on the
value in the list.
8. To add numeric fields, click the Numeric tab and then enter the label name in the form fields
provided.
9. To add Date/Time fields, click the Date/Time tab and enter the required details.
10. Click Save. A message is displayed saying that the additional field is successfully created.
The new custom fields that you have added will appear in the New Request form under the
Additional Request Details block.
To delete the user-defined fields, follow the above steps till the 4th step. Then, delete the label names
you wish to remove and the default entries made for them, and click Save. The respective fields that
you deleted will be removed from the New Request form.
On adding the field, the newly added fields has to be configured in the Request Template by Drag and
Drop method. You can also preview your new request form by clicking the Request Template link in
the left menu.
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Request Closure Code
Request Closure Code denotes the reason behind closing a request, whether the request was closed
successfully, unsuccessfully, cancelled and so on. Using the request closure code, the administrator
is able to comprehend the purpose of closing the request by the technician. In addition, comments
can be provided to give a detailed explanation for closing the requests. The configured request
closure code list appears while closing the request, and the data entered is viewed in the request
details page.
To access the Request Closure Code list page,
1. Click Admin tab in the header pane to open the Configuration Wizard page.
2. In the Helpdesk block, click Helpdesk Customizer icon

.

3. Select Request Closure Code from the left menu. The available request closure code is
displayed. From this page you can add, edit and delete a closure code.

Add New Closure Code
1. Click Add New Closure Code link.
2. Specify a unique Name for the request closure code. The name is a mandatory field.
3. Provide a brief Description about the request closure code.
4. Click Save to save the request closure code and return to the list view.
To add more than one request closure code, click Save and Add New button. This adds the new
closure code and reopens the Add Request Closure Code form.
Click Cancel to exit the add request closure code form and return to the list view. Clicking the View
List link on the top right corner of the add request closure code form also take you to the Closure
Code list view.

Edit a Request Closure Code
1. In the Request Closure Code list view page, click the edit icon
name to edit. The Update form is displayed.

beside the closure code

2. Modify the Name and Description.
3. Click Save, to save the request closure code and return to the list view.
Even while editing a closure code, if you wish to add a new request closure code, click Save and Add
New button. This updates the request closure code and reopens the Add Request Closure Code form.
Click Cancel to exit the add request closure code form and return to the list view. Clicking the View
List link on the top right corner of the add request closure code form also take you to the Closure
Code list view.

Delete Request Closure Code
1. From the Request Closure Code list view, enable the check box beside the closure code to
delete.
2. Click Delete button. A dialog box confirming the delete operation appears.
3. Click OK to continue. The request closure code is deleted from the list.
If the request closure code is used in a request, the closure code is not deleted, instead it is grayed
(made inactive) and will not be available for further usage.
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To bring the request closure code back to the active state,
1. Click the edit icon

beside the inactive request closure code. The update form is displayed.

2. De-select the Request Closure Code not for further usage check box.
3. Click Save. The request closure code is save and will be available for further usage.
Click Save and Add New, to save and add another request closure code. Click Cancel to exit the add
request closure code form and return to the list view.
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Request Closing Rules
Request closing rules can be used to select the mandatory fields to be filled in by the technicians
while closing the requests. You can also use it to confirm user acknowledgement to the technician
and close requests either manually or automatically.

To preset the request closing rules,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon
Configuration Wizard page.

. This opens the

4. Click the Request Closing Rules link at the left side of the page under the HelpDesk block.
This opens Request Closing Rules page.
5. Select the mandatory fields for closing the request from the list by enabling the check box.

Confirm User Acknowledgement
On closing the request, the resolution is acknowledged by the requester through mail (if the option is
enabled in Notification Rules). If you want to prompt a confirmation message to the technician asking
if user has acknowledged the resolution then enable Yes, prompt a message radio button, else
enable No, don't prompt a message radio button.

Request Closing Process
Manual Closing
1. If you would like to close the request manually select the Manual radio button.
2. Save the changes. On resolving the request each time you have to close the request
manually.
Automatic Close
1. Select the Automated Close radio button to close the request automatically.
In the automatic mode,
•

An email is sent to the requester when the Request is put in Resolved state



The Requester can Close the Request with the close link given or Re-open
the Request by replying to the mail.



If the Requester takes no action the Request will be closed after the number
of days specified in the combo box.

2. Select the close resolved request after n number of days from the combo box.
After the selected number of days the resolved requests will be closed automatically if
the requester does not take any action.
3. Save the details.
Example: If you have selected Resolution as a mandatory field, then the technician fixing the
problem, should enter the reason and solution for the problem in the resolution text field before
closing the request, else an error message pops up asking you to enter the details in the resolution
field. If Yes, prompt a message radio button is enabled then, a confirmation message is prompted to
the concerned technician if user has acknowledged the resolution.
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Configuring Notification Rules
ManageEngine ServiceDesk Plus-MSP allows you to send notifications to requesters and technicians
through notification rules. The notifications can be of two types: email and SMS. These notification
modes can be set across various modules of the application, such as requests, problem, change and
solution. Any default actions that you might want to perform when the state of any item changes can
also be defined.
To set the notification rules and the message template,
1. Login to the ServiceDesk Plus-MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Notification Rules icon

under Helpdesk block.

4. By default, all notifications are sent in Rich text format. Clicking on Plain text formatting
button will switch all the notifications in Plain text format.
5. Click on the appropriate tabs to configure for request, problem, change and solution modules.

6. To enable or disable any of the notification rules, select or de-select the check box beside
each of the rules.
7. For certain notifications you need to select the technicians who need to be notified when a
new request is created.
o

Click Choose button.

o

Select the technicians from the list of technicians is displayed in a pop-up window.

o

For multiple selections, press Shift or Ctrl key and then select the technicians.

o

Click OK.

o

The selected technicians get listed in the text box beside the Choose technician(s)
button.

8. Click Save.
9. Requester Notification rules can be configured for each account . You can do this by
selecting an account from the account combo box, select the relevant check boxes and click
Save. Alternatively, you can also use the Assign To Account link to assign a notification to
one or more accounts.
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Note
While saving the notifications settings, if "All Accounts" is selected in the account combo box
the selected Requester Notifications settings will be applied for all the accounts.

Customizing Message Template
You can customize the message template for each of the notifications.
1. Click Customize Template link beside the notification for which you wish to modify the
content that is being sent.

2. You can change the subject and the message content by typing the text of your choice and
also adding other variables that you wish to display as a part of the subject or message
content. To add more variables, just click the corresponding variable from the list box beside
the respective field.

Junk Mail Notification
Junk Notification Filters prevents unwanted acknowledgements or notifications being sent to
requesters / technicians when an information mail reaches the help desk. These mails are not
requests and do not require any action to be taken.
Say, acknowledgement email like Out of Office replies, notifications that bounce back when the mail
destination is not reachable (because of a wrong mail address) can be stopped from being
acknowledged or notified.
To define a Junk Mail Notification,
1. Click on Edit Criteria link.
2. Define a rule by select the criteria and condition from the drop down combo list.
3. Click Choose.
4. Enter the value in the field provided. Click Save.
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5. Click Add to Rule.
6. You can either match all of the following (AND) or match any of the following (OR) criteria.
Select an appropriate radio button.
7. Click Save.
You can also edit or delete the criteria on clicking the appropriate icon.
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Incident Template
In real world, there is a need to support different types of incident request which might require
different fields in the form layout. Incident Template supports to configure different set of fields for
different type of requests. In case, when requesters report about a particular incident like, printer
problem or mail fetching problem,its time to create a template for that incident. As an MSP you serve
a wide variety of customers, who have varied business practices. The type of data that has to be
captured differs from one account to the other. ServiceDeskPlus MSP lets you to configure Incident
Templates for each individual account.
To open the incident template form,
1. Login to ServiceDesk Plus - MSP application using the admin username and password.
2. Click the Admin tab in the header pane.
. The Configurations wizard
3. In the Helpdesk block, click HelpDesk Customizer icon
page opens.
4. Click Incident Template on left side of the page under the helpdesk block. The Incident
Template list view page opens.
5. Click Add New Template link on the right hand side of the page to open the request form.
The incident template form viewed by the technician is shown below,
The incident template form consists of three blocks namely, Header, Field list and the Canvas.
• Header: The header consists of the Template Name and Comments field. Here, you
have the option to make this template available to the accounts. You can either make
this template available to all the accounts configured in ServiceDesk Plus - MSP by
selecting the check box This Template is applicable for all accounts, or you can
select the account to which you want to show this template from the Available
Accounts column.
• Field List: The field list consists of the list of fields and the add new field option.
• Canvas: The canvas decides the form look and has drag and drop area.
•

Show to Requester: The incident template can be made available to requesters by
enabling "Show to Requester" check box. If you have configured User Groups for the
selected accounts, then the template can be restricted to the requesters of a specific
user group by selecting the user groups from the list.

The following are the actions that can be performed in the form,
• Form Customization
- Add New fields
- Drag and Drop fields
- Setting Field Property
• Request Preview
- Technician View
- Requester View
- Add Tasks
• Edit Incident Template
• Delete Incident Template
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Form Customization
The layout of the form can be customized by, add/remove fields, set field properties and re-arrange
the fields in the Canvas for a request template.

Add New Field
1. You can add new fields by dragging the Add New Field option under the Drag and
Drop field on to the canvas.

2. The Add New Field pops up as shown below,

3. Select the type of field such as, text, numeric, by enabling the radio button beside it.
4. In the text field settings block, specify the Label Name in the field provided. This is
mandatory field. If required, enter the significance of the field in the Description text
field.
5. Select the type of the text field such as single-line, pick list.
6. Click Ok, the field gets added in the dragged place in the canvas with the above
specifications.
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The newly added fields are common for all the templates. The field name will also be same for
all the templates. The newly added field can be edited or deleted only in Request - Additional
Fields.

Drag and Drop
1. Drag the field from the Field List and drop it onto the canvas. The drop areas will be
highlighted. The dragged field can be dropped only in the highlighted area.
2. The fields in the form can also be re-arranged by dragging the field and placing it over
an empty cell. The field can be placed only in the highlighted area. The request
details can be moved as a whole block.
3. If you wish to Undo/Redo the changes then select the corresponding buttons.

Setting Field Properties
You can customize the fields such as, status, priority, mode by either changing the field
properties, that is, making the fields mandatory or closing the fields. Thus you can customize
the entire form by keeping the relevant fields in the canvas for a template. To customize the
form,
1. Hover over the field, an Edit Field property and Field Close button will appears.
2. Click the Edit Field Property button

o

. A drop down appears containing the options,

Mandatory Field: The field can be made mandatory by enabling the check box
adjacent to this option.
Note: If the Item field is marked as mandatory then the category and sub category
fields will automatically be marked as mandatory. Similarly, if the Impact details is
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marked as mandatory then the Impact field will automatically be marked as
mandatory.
o

Requester can Set: On enabling this option, the requester can edit the fields. The
'requester can view' option automatically gets enabled.

o

Requester can View: The requesters can only view the field and cannot set nor edit
values on enabling this option.
Note: The fields such as request details, subject and description do not have field
properties and hence can be only re-arranged in the canvas.

3. Click Field Close button to remove the field from the canvas and add it to the field
list. The fields such as status, priority, description, subject and requester details does
not have the Field Close option.
On customizing the form layout, the fields are pre filled with values. Click Save. The template gets
added to the available list in the Incident Template list view page. To save and add tasks for the
template, click Save and Add Task instead of Save.
At any point, if you do not wish to add the incident template and would like to get back to the list view
page, click Cancel. Clicking the View List link on the top right corner of the incident template form will
also take you to the incident template list view page.
The incident template will get populated under the New Request link . The created template is based
on the Default Template. Click on the New Incident link. The Default Incident Template form opens.
The Default Incident Template form cannot be deleted nor renamed. A request created through mail
will also be based on this template.
Note: You can set the Site for a incident template. Consider the scenario where all the SAP
related issues is handled in New York, and a requester from a different location is raising a
SAP issue through incident template. Instead of setting the default site of the requester raising
the request, the site field is not over written and the request is routed to New York.

Request Preview
On customizing the request form for both the requesters as well as technicians, you can see the
preview for both the logins using this option.
To see the request preview,
1. From the Incident Template list view page, click the Template name which you wish to
preview. By default, the request template form for a technicians is opened. You can drag and
drop fields in the canvas, re-arrange, add/remove and set properties for the field.
2. You can view the incident template form for a requester if the Show to requester option is
enabled. To view the incident template form for a requester, click the Requester tab on the
top left hand side of the page. The header section is grayed and hence is non editable. In the
requester preview page, certain fields are hid from the requester while the rest of the fields
can only be re-arranged.
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3. You can view and add tasks related to the request template on clicking the Tasks tab. This
displays the list of tasks for the template. You can add tasks by clicking Add Task button. To
add task refer Add Task.

Edit Incident Template
You can edit the incident template and also have a preview of the incident templates for a technician
and a requester.
1. Click on the incident template name from the incident template list view page. By default,
theincident template form for a technicians is opened.
2. You can drag and drop fields in the canvas, re-arrange, add/remove and set properties for the
field.
3. You could edit account associations of the template using This Template is applicable for
all accounts option. You could also associate accounts to one or more templates at one go,
you could do this through the option Assign to account to the right of Add new
Template in the incident template list view page.
4. You can view the incident template form for a requester if the Show to requester option is
enabled. To view the incident template form for a requester, click the Requester tab on the
top left hand side of the page.
5. In the requester preview page, the fields can only be re-arranged. The header section will be
grayed and hence will be non editable.
6. You can also view and add tasks related to the request by clicking on the Task tab. This
displays the list of tasks for the template. You can also add tasks by clicking Add Task
button.
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Delete Incident Template
1. From the incident template list view page, enable the check box adjacent to the template
which you want to delete.
2. Click delete button, a pop up window appears confirming the delete operation.
3. Click Ok to continue. The template gets deleted from the list. If the template is been used by a
request then the template will be marked in grey indicating no further usage of the template in
the incident template list view page.
To bring the form back to usage, disable' Template not for further usage' check box under
the Header block of Edit Request Template form.

.
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Configuring Request Settings
You can set the default values for each of the configuration parameters available in ServiceDesk Plus
- MSP application for the ServiceDesk Plus - MSP request form. These default configurations, once
set, will be reflected in the new request form as default values. The requester can change the values
while submitting the request. These settings can be changed/modified any time. To configure the
request settings
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
. The next page
3. In the Helpdesk block, click the Request Form Customizer icon
displays the list of request form attributes that can be customized on the left menu and the
category list page.
4. Click Request Default Values from the left menu. The Request Default Values page is
displayed. You can set the default values for the request category, level, mode, priority and
Group.
5. From the Default Category combo box select the default category value which you wish to
set for every new request. Similarly, choose the values of your choice from each of the combo
boxes for the default request level, mode, priority and group.
6. You can also restrict the list of workstations displayed in the workstation combo box in the
new request form of the self-service portal. This list can be set such that only workstations
associated with the particular requester posting the request are displayed. To do this, select
the check box beside the label, Show workstations associated to requester in SelfService Portal.
7. Click Save. This saves the request default settings.
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Reply Template
While replying to requests, technicians tend to type the same response repeatedly to many requests.
With Reply Template, technicians can create templates for the repetitive response to requests, thus
saving time and easing their work.
To open the configuration page for reply template,
1. Login to ServiceDesk Plus - MSP application with the username and password of an admin
user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click Reply Template to open the Reply Template list page.

Add New Template
1. Click New Template button to open the Add Reply Template form.
2. Specify a unique name for the template in the Template Name text field.
3. Enter the content of the template in the Description text field. Both the Name and Description
are mandatory fields
4. You can mark this template as inactive by enabling the check box beside Mark this template
INACTIVE. The inactive template is marked in grey and does not get listed in the reply
template drop-down while replying to requests.
5. Click Save. To save and add another resolution template, click Save and Add New.

Editing a Template
1. In the Reply Template list page, click on the Edit icon
edit.

beside the template you wish to

2. In the Edit Reply Template form, modify the required changes mentioned while adding the
Reply.
3. Click Update. Even while editing, if you wish to add a new Reply template, then click Update
and add new button. At any point you wish to cancel the operation that you are performing,
click Cancel.

Deleting a Template
1. In the Reply Template list page, select the check box beside the template you wish to delete.
2. Click the Delete button. A confirmation message appears. Click Ok to continue. The reply
template gets deleted from the list.
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Task Template
Certain tasks need to be repeated by the technicians for different users and scenarios. With Task
Template, repeated tasks can be pre defined thus saving time on creating and assigning tasks to the
technicians. Task Template can be applied while adding tasks to a request, problem or change.
To open the configuration page for task template,
1. Login to ServiceDesk Plus - MSP application using your username and password.
2. Click the Admin tab in the header pane.
3. In the helpdesk block, click Helpdesk Customize icon
opens.

. The configuration wizard page

4. Click Task Template on the left hand side of the page in the helpdesk block. The list of
available task templates is displayed.

Add Task Template
1. Click New Template button to open the Add-Task Template form.
2. Specify a unique name for the task in Template Name text field. It is a mandatory field.
3. Specify the Title of the task in the field. It is a mandatory field.
4. Enter a brief Description of the task in the provided field.
5. Select the Owner of the task from the drop down list.
6. Select the Status of the task, say Open or Closed, from the drop down list.
7. Specify relevant comments for handling the tasks in the Comments text field.
8. You can mark the template as inactive on selecting the check box beside Mark Template as
Inactive. The inactive template is marked in grey and do not get listed in the Add task form
while adding tasks to requests, problem or change.
9. Click Save. To save and add another task, click Save and Add New.

Editing a Template
1. In the task template list view page, click on the Edit icon
edit.

beside the template you wish to

2. In the Edit-Task Template form, modify the changes mentioned while adding the task
template.
3. Click Update. While editing, if you wish to add a new Task Template click Update and Add
New button. At any point, if you wish to cancel the operation you are performing, click
Cancel.

Deleting a Template
1. In the task template list view page, select the check box beside the template you wish to
delete.
2. Click the Delete button. A confirmation message appears. Click Ok to continue. The task
template is deleted from the list.
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Service Catalog
Service Catalog
Enterprises today seek for an approach to enhance and streamline the communication between IT
and the end-users. While the IT department has services and the users have needs, the manner in
which the services must be exposed to the users is a crucial task. This is where Service Catalog in
ManageEngine ServiceDesk Plus - MSP plays a vital role in your organization.
Service Catalog is where you can portray the wide range of services offered by your IT department to
the end-users. Some of the most common day-to-day IT services required by the users are,
installation, relocation, internet access, email access, virus protection, provision of hardware and
software, mail server, account management and so on. With the simplicity and clarity through which
the services are exposed in ServiceDesk Plus - MSP allows users to easily browse through the
services, raise requests instantly and monitor their status thereon.
To access the service catalog configuration wizard page,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under Helpdesk block. The Service Catalog page opens
2. Click Service Catalog icon
listing the service categories available in the application. Since most of the services differ for
each account, you can create a separate catalog view for all your accounts.

From this page, you can add a new service category, manage the service items and also
add services under each category. The number of services available is specified under each
service category.
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Getting Started
To start configuring your personalized Service Catalog, you need to first define Service Categories.
Service Categories holds a classified group of service items and can be configured from the Manage
drop down. Apart from this, an instant means to the add service category is by clicking the Add
Service Category button. The configured Service Categories are displayed in the list view with an
icon to depict its uniqueness, and can be viewed by all the accounts.
From the Manage drop down, you can also configure the Additional Fields and Service Level
Agreement for the service requests. If the default parameters in the template do not contain key
information that is relevant to your organization, then the same can be configured from the Additional
Fields. Using Service Level Agreements, your help desk team effectiveness and efficiency can be
determined.
NOTE: The Service Categories and Additional Fields would be displayed to all the accounts
configured in ServiceDesk Plus - MSP. Deleting a service category or an additional field will remove
the service category or additional field for all the accounts.

Service Requests for a service category is configured using the Add Service button beside the
category. The list of services under a service category can be viewed using the drop down icon
beside them, and on hovering over the services, the delete, edit and disable icons appear. Using
these icons, the preferred operations can be performed.
Representation of icons in Service Catalog list view screen,
- icon to delete a service item.
- icon to edit a service item.
- icon to disable a service item.
- icon to enable a service item.
The configured service items are listed under the Service Catalog drop-down menu. With Service
Catalog, services are easily accessed, facilitating users to browse for services, submit requests for IT
services and monitor their status. Click Service Catalog drop-down menu to view the Template
Categories and the Template List.

Zoho Corporation Pvt. Ltd.
456

ManageEngine ServiceDesk Plus MSP – Admin Guide

Service Catalog - Service Categories
Service Category is a comprehensive list of IT services provided by the IT department to the endusers. Each service category has a classified group of service items which are exposed to user
groups who are approved to access it.
NOTE: The Service Category will be displayed to all the accounts configured in ServiceDesk Plus MSP. Deleting a service category will remove the service category for all the accounts.
To access the Service Category configuration page,
1. Click Admin module in the header pane. The configuration wizard page opens.
2. Click Service Catalog icon

under Helpdesk block.

3. From the Service Catalog configuration wizard page, click Manage drop down and select
Service Categories option. The Service Categories list view page opens where you can add
edit and delete a service category.

Apart from this, an instant means to get to the add service category form is by clicking the Add
Service Category drop-down menu in the Service Catalog configuration wizard page

Adding Service Category
1. Click Add Service Category drop-down menu. The Service Category page opens.
2. Specify a Name for the Service Category. This field is mandatory.
3. Enter a brief Description about the IT service details in the field provided.
4. Set an Icon for the service category. You can choose the icon from the icon set or upload an
icon. The Icon set consists of the icons available in the application, by default. To upload an
icon, click Upload an icon link and browse through the icons.
5. Click Save to save the details and return to the list view. Click Cancel to return to the list
view.

Editing a Service Category
1. From the Service Category list view page, click on the edit icon
category to edit. The Service Category page opens.

beside the service

2. All the fields in the form are editable. Modify the necessary fields.
3. Click Save to save the details and return to the list view. Even while editing a service category
you can add a new service category by selecting Save and Add New button. Click Cancel to
return to the list view.
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Deleting a Service Category
1. From the Service Category list view page, enable the check box beside the service categories
to delete.
2. Click Delete button. A dialog box confirming the delete operation appears.
3. Click OK to continue. The service category is deleted from the list.
NOTE: If the service category is being used by a module, then the service category would be greyed.
A greyed out service category will not be listed in the Service Catalog. To bring a service category
beside the greyed out service category and deselect Service
back to usage, click the edit icon
not for further usage check box.
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Service Catalog - Additional Fields
If you require any further additional information apart from the defined pre-set fields in the service
request form, you can configure the same under Service Management - Additional Fields. The
additional fields can be made available in all the service request forms or in specific service request
forms pertaining to a service category. You can add text fields, numeric fields and date type fields in
the form.
To add additional fields,
1. Click Admin tab in the header pane. The configuration wizard page opens.
2. Click Service Catalog icon

under Helpdesk block.

3. From the Service Catalog configuration wizard page, click Manage drop down and select
Additional Fields option.
4. Select the Service Category for which the additional field should appear. If the additional
field should appear in all the service request forms, then select "common fields".
Text Additional fields
If the additional fields are for alphabets and alphanumeric characters, then use the Text Additional
Fields. You can add up to 24 Text fields in the New Incident form.
1. By default, the Text tab is selected. Specify the Label for the Additional field.
2. Specify any relevant information about the additional field in the Description text field.
3. You have 3 types of text field namely, Single-line, Multi-line and Pick List (drop-down
menu).
o

Single-line: A Single-line text field is for text which can be accommodated in a single
line.

o

Multi-line: The Multi-line text field is for text which requires a lengthy description.

o

Pick List (drop-down menu): The Pick List or drop-down menu allows you to add a
list of items from which you can select. To add the items, enter the value in the
highlighted text field. Click Add Item. The value is added to the list. To delete an
item, select the item and click the Delete button.

4. You can also specify the Default Value to appear in the new incident form.
5. Click Save button to save the settings.
Numeric Additional fields
If the additional fields are for only numeric characters, then use the Numeric Additional Fields. You
can add up to 8 Numeric fields in the New Incident form.
1. Click the Numeric tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text field.
4. Save the settings.
Date / Time Additional fields
If the additional fields are for data and time, then use the Date / Time Additional Fields. You can add
up to 8 Date / Time fields in the New Incident form.
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1. Click the Date/Time tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text fields.
4. Click Save to save the settings.
These additional fields will appear in the Service Fields section of the new service form. To delete
the user-defined fields, instead of adding the label names, delete the existing label names you wish to
remove from the fields of the form and click Save.

Zoho Corporation Pvt. Ltd.
460

ManageEngine ServiceDesk Plus MSP – Admin Guide

Service Catalog - Service Level Agreement
Service Level Agreement evaluates the efficiency, effectiveness and responsiveness of the help desk
team. The services created in the application can be exclusively assigned with specific SLAs thereby
setting a due by date for the service requests. Escalation rules can also be set if the request is not
attended and resolved within the specified time.
The Service Level Agreements are account based, and the account should be selected before adding
the SLA. You also have an option to copy the SLA to other accounts.
To access the SLA configuration wizard page,
1. Click Admin tab in the header pane. The configuration wizard page opens.
2. Click Service Catalog icon

under Helpdesk block.

3. From the Service Catalog configuration wizard page, click Manage drop down and select
Service Level Agreements option. In the SLA List view page, you can add, edit and delete
an SLA, and also copy an SLA to other accounts.

Adding SLA
1. Select an Account for which you want to add the SLA.
2. Click Add New SLA link. The SLA form has three blocks of information, namely SLA Details,
SLA Rules, and Escalations.
3. The SLA details consist of the SLA name and description.
1. SLA Name uniquely identifies the SLA. It is a mandatory field.
2. You can provide a brief explanation of the SLA in the Description field.
4. SLA Rules are where you need to set the Agreed Upon Time (due by time) for the service
request. Enter the agreed upon time in terms of days, hours and minutes. If the service
request should be fulfilled irrespective of the working hours and holidays, then enable Should
be fulfilled irrespective of the operational hours check box.
5. Escalate the service requests to other technicians if the request is not resolved within the
specified resolution time. Select the check box beside Enable Level 1 Escalation. Click
Choose button to select the technicians to whom the SLA violation should be escalated.
6. You can choose to escalate before or after the SLA violation. If you wish to escalate the
request before the SLA violation, click Escalate Before option. This informs the technician
about the impending of the violation. Specify the number of days before the SLA violation in
the text box. You can also specify the time of escalation.
7. Click Escalate After option to escalate after the violation. Specify the number of days after
the SLA violation has occurred in the text box. You can also specify the time of escalation.
8. Similarly, there are four levels of escalation when the resolution time violates.
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9. Click the Save button to save the SLA and return to the list view.
Click the Save and Add New button to save the SLA and add another SLA. Click View List to
view the SLA list view page. To return to the Service Catalog configuration wizard page, click
Go Back.

Editing SLA
1. From the Service Category list view page, click edit icon
The edit SLA page opens.

beside the SLA name to edit.

2. The fields, SLA details, SLA rules and escalations are editable. Modify the necessary details.
3. Click Save button to save the SLA and return to the list view. Even while editing, you can add
a another SLA on clicking Save and Add New instead of the Save button. Clicking on Cancel
takes you to the list view.

Copying to Account(s)
1. From the Service Catalog list view page, select the check box beside the SLA to copy to
another account.
2. Click Actions drop-down menu and select Copy to Account(s).
3. Select the Accounts and click the Copy button. The selected SLAs are copy to the selected
accounts.

Deleting SLA
1. Enable the check box beside the SLA to delete.
2. Click the Delete button. A dialog box confirming the delete operation appears.
3. Click OK to proceed with the deletion. If you do not want to delete the SLA, then click Cancel.
NOTE: If the SLA is greyed instead of getting deleted, then the SLA is being used by a service
request. A greyed out service category will not be listed in the Service Catalog. To bring the SLA back
beside the greyed out SLA and deselect SLA not for further usage
to usage, click the edit icon
check box.
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Service Catalog - Service Items
The day-to-day IT services such as installation, relocation, internet access, email access, virus
protection, provision of hardware and software, mail server and so on are configured under this
section. The service items are classified and grouped under Service Categories, which are displayed
in the Home page.
The Service Request form consists of a drag and drop template that should be configured in order to
meet the end-user requirement. If the service involves the need of some resources, then the same
can be configured under the Resource Info block. Furthermore, approvers, service level agreement
and tasks can be assigned to the service request.
To configure Service Items,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under Helpdesk block. The Service Catalog page opens
2. Click Service Catalog icon
listing the service categories available in the application.
3. Click Add Service button beside a service category to add service under it. The Add Service
Item form opens to display three tabs namely, Form Designer, Workflow and Requester View.
By default, the form Designer is displayed.

This following is explained under this section.
•

•

Configuring Form Designer
o

Configuring Resource Information

o

Show to Requester option

Configuring Workflow
•

Approver Details

•

SLA

•

Adding Tasks to service requests

•

Template Action

•

Requester View

•

Enabling/Disabling Service Item

•

Editing Service Item

•

Deleting Service Item

Configuring Form Designer
To add services under a service category,
1. Click Add Service button beside the service category. The service request for Technician
View consists of the Header, Service Fields and Service Preview.
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o

Header: The header consists of the Service Name and Description. Here, you need
to select the accounts to which you want to show this service. Select the Accounts
from the Available Column list and click >> button. You also have an option to select
all the accounts available in the column. If you want this service to be available to all
your accounts in the Available Column, then select the Select all the accounts
check box.

o

Service Field: The service fields consist of the list of available parameters and an
option to add new fields for the service item.

o

Service Preview: The service preview decides the form look and consists of drag
and drop template area, the Undo and Redo options, Resource Info block and
Show to Requester check box. With the template, individual forms can be
customized for each service by dragging the available service fields to the service
preview form, remove fields from the form, set the field property and also rearrange
fields in the form.

2. To add a new field in the form, drag Add New Field option in the service preview form. Place
the field only in the yellow highlighted area of the form.

i.

An Add New Field pop up appears where you can select the type of field to be added
to the canvas. The field can be text, numeric or Date/Time field.

ii.

Specify a unique Label in the field provided. This field is mandatory. Also, enter the
significance of the field in the Description text field.

iii.

For Text field, select the field type from Single-line, Multi-line or Pick-list. Enable any
one of the radio buttons.
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iv.

Click Ok to add the field in the canvas with the above specifications.

4. The newly added fields are common for all the service items under a service category.
Alternatively, you can also add new fields in Additional Field. From this section, you can also
edit and delete the additional fields.
3. Similarly, you can drag the Service fields onto the service preview form. If required, the fields
in the service preview form can be rearranged by dragging the field and placing it over the
yellow highlighted area.
4. While rearranging the fields, if you want to Undo/Redo a change, click the corresponding
button.
5. You can also add or select the default values to appear in the form.
6. To customize and remove undesirable fields in the form, hover over the field, the Edit Field
Properties icon
i.

ii.

and the Remove Field icon

Click Edit Field Properties icon
appears,

appears.

. A drop down containing the following options

•

Mandatory Fields: Enabling this option sets the field as mandatory.

•

Requester can set: Enabling this option allows the users to edit the field,
i.e., they can enter or select values for the field while raising a new service
request. Enabling this option automatically enables 'requester can view'
check box.

•

Requester can view: Enabling this option alone allows users to view the
field in the service request form but they cannot enter values in the field while
raising a service request.

to remove the fields from the service preview form. The
Click Remove Field icon
fields detached from the form are listed in the Service Fields block.

NOTE

1. If the Item field is marked as mandatory then the corresponding Category
and Sub category will be automatically marked as mandatory.
Similarly, if the Impact details are marked as mandatory then the Impact field
will also be marked as mandatory.
2. The fields such as Requester Details, Subject and Site do not have Edit
Field Properties icon and hence these fields can only be re-arranged.
3. Fields such as Status, Description, Requester Details, Site and Subject do
not have Remove Field icon.

7. Save the service before proceeding to the Resources block.
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Configuring Resource Information
If the service involves any resources then you can mention them under the Resource Info block. The
process of adding resources involves a series of questions, and the resources can be displayed in
either of the following formats - check box, drop down, plain text or with simple yes/no.
Take the case of a new employee joining your organization. The resources provided to the new
employee would be, providing a desktop/laptop, installing the necessary software, provision of any
additional hardware resource, communication device, entry into application logins like Active
Directory, VPN, Email, Payroll, CRM and so on. These resources are entered under Resource Info
block of the service request.
To add resources,
1. Click Add Resource button on the Resource Info block.
2. In the Add Resource pop up, specify the Resource Title and a brief Description for the
purpose for adding this resource. The Resource Title is a mandatory field.
3. Next, you can either choose to select the question from the existing question list or create a
new question.
Selecting from an existing question list:
To select a question from the existing question list, use the Select your question drop down.

Select a question from the list, say "Choose the additional hardware required". The question is
displayed along with an edit and delete icon. If you wish to add another additional hardware to
. Enter your option and add it to the existing list as shown
the list, click on the edit icon
below. Click Ok to save the question.
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Adding New Question:
If your desired question is not in the existing question list, then you can add a new question by
clicking New Question button. Enter your Question and select the question format from the
options provided. The question can be displayed either in a simple yes or no format, drop
down, check box or as a plain text.
If you have selected the Question Type as a check box or drop down, then the Add Options
appears, listing all the product types configured in the application. Selecting a product type lists
all the products (configured in the application) under that product type.
For instance, if the selected product type is "Software", then all the managed software available
in the application is listed. If the selected product type is "Workstation", then the workstations
configured and scanned in the application are listed.
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Select the assets/software to be displayed in the question by clicking >> (move right) button as
shown in the image. Click OK to save the question.
Manual addition of Resources:
Apart from resources in the application, you can manually add resources that are not
configured in the application. To add resources manually in the application, select Add
manually from Add options drop-down. Enter the resource in the text field as shown in the
image.

In this case the resource is "HP Pavilion" and click Add >> to make the resource available in
the question. Click OK to save the question. To add another question, click New Question and
follow the process as above.
4. Click Save to save the resource information. The questions are displayed in the Resource
Info block of the service preview form from where you can also edit or delete the added
resources.
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Show to Requester
To make the service request accessible in the requester's login, select Show to Requesters check
box. If User Groups are configured in the application, then the user groups for all the selected
accounts are listed in the Available User Group column. You can select the user groups to which you
want to show the service. Selecting the user groups makes a clear indication of the end users who
can subscribe to the services.
Say for instance, if a service request should be shown to the requesters in the Sales department,
then, configure the user group by selecting the "Department" as "Sales" under Admin -> User
Management -> User Groups. Once the user group is configured, enable "Show to Requester"
check box in the service item form and select the user group as "Sales User Group". To know more
about configuring user groups, refer User Groups.

Click Save to save the details. Click Save and Configure Workflow button, to configure the service
request workflow.

Work Flow
The Work Flow tab consists of options to select the approvers and map Service Level Agreement for
the service. Since the workflow process for one account may not be similar to another, you can
configure the workflow speparately for each of the selected accounts.
Approver Details
Certain service request raised in the application requires approvals from the concerned users to go
ahead with the request. The approvers can be technicians or requesters with the permission to
Approve Service Requests, and should possess an email address in the application.
. The approver can also be the
Select the Approvers for the service request using the icon
department head to which the requester belongs provided the approver has the permission to approve
service requests.
On selecting the approver, the appropriate notifications have to be selected.
•

Send approval notification automatically when a service request is raised - Enable this
check box to send an approval notification to the concerned authority each time a service
request is raised.

•

All configured approvers have to approve the Service Request - Enabling this check box
makes it mandatory for all the configured approvers to approve the service request. If anyone
of the approver rejects the service request, then the request does not proceed further.

•

Do not assign technician before Service Request is approved - This option is enabled
only on selecting "Send approval notification automatically when a service request is raised"
check box. On selecting this option, a technician is assigned to a service request only when
the service request is approved by the concern authority.
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SLA
Each service request created in the application is assigned with a specific SLA to set the due by date.
Select the SLA for the service request from the drop down. You can also add new SLAs using Add
New SLA link.

Adding Tasks to Service Requests
You can add tasks to a service request if the request involves multiple technician work.
To add Tasks to service requests,
1. Click the Tasks tab -> click Add Task button from the task list view page.
2. In the Add Task form, specify the Title of the task. The Title is a mandatory field.
3. Specify relevant information about the tasks in the Description field.
4. Select the Group to which task has to be assigned. Select the Technician of the task from
the combo box. Tasks can be assigned either:
•

to a Group alone,

•

to a Group and a specific Technician in the group,

•

to a Technician alone without selecting the group,

•

to no Group and no Technician.

5. If there are multiple tasks for a service request, the implementation of one task may be
dependent on the completion of another. In this case, the dependencies on tasks can be
captured by clicking on the relevant tasks under Task Dependency block.
6. Select the Status of the task from the drop down.
7. Specify any relevant comment about the task in the Comments field.
8. Click Save to save the details. Click Save and Add New, to save the details and open
another Add Task form. Click Cancel to go back to the tasks list view.
You can also organize tasks from the list view to suit your desired priority. Click Organize Tasks
button and change the order of the tasks using the up and down buttons.
The tasks for a service request are automatically created and assigned to the configured technician
each time the service request is raised.
Template Action
If the service request involves installing/uninstalling software or executing scripts, then the same can
be performed from the centralized server through Desktop Central Integration. The Desktop Central
activities are performed with the aid of a Desktop Central Agent that should be installed on the
Windows workstation.
To avail this functionality, configure the Server Name and Port number of the Desktop Central server
in SDP - MSP application. Since all service requests do not require Desktop Central operations, this
activity is limited by providing a Template Action check box in each service item form. This
functionality is attainable only when Desktop Central 7.0 and above is integrated with SDP - MSP.
Refer Desktop Central Integration to know more.
Click Save to save the details. Click Save and Configure Requester button, to configure service
request form for requesters.
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Requester View
The "Requester View" tab is available in the service form only if the requesters have permission to
view the service request. Click the Requester View tab to view the requester preview of the service
request.
The service form is similar to the technician preview except,
• The header section is grayed indicating that its non-editable,
• The service fields have limited parameters and the option to add new field is unavailable
• Parameters such as Mode, Request Type, Level, Impact, Impact Details and Urgency are
unavailable for the requester preview.
• The Edit Field Properties option is absent for the fields.
You can drag the available service fields onto the service preview form. Place the field only in the
yellow highlighted area of the form. You can also rearrange the existing fields in a similar manner. In
addition, you can also set default values for the fields to appear while raising the service request.
Click Save to save the configured details. Click Cancel to exit the form.

Disabling/Enabling Services
By default, a newly added service is enabled in the list view. To disable a service,
1. Click the

icon beside the service category to list the services under them.

2. Hover over the service to disable. Click disable service icon . The service is grayed and
will not be listed along with the existing services in the home page.
To enable a service.
1. Click the

icon beside the service category to list the services under them.

2. Hover over the service to enable. Click enable service icon
listed along with the existing services in the home page.

. The service is enabled and is

Editing Services
To edit a service under a service category,
1. Click the

icon beside the service category to list the services under them.

. The service form for a technician
2. Hover over the service item to edit. Click the edit icon
opens where you can add new fields, rearrange the existing fields and edit the default values.
3. Click Save to save the configurations. Similarly, you can edit all the remaining tabs from the
service catalog page.
Click Save and Configure Requester button, to configure service request form for requesters.
To add tasks, click Save and Add Tasks.

Deleting Services
To delete services under a service category,
1. Click the

icon beside the service category to list the services under them.

2. Hover over the service item to delete. Click the delete icon

. A confirmation dialog appears.

3. Click OK to proceed. The service item is deleted from the list.
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Configuring Requester - Additional Fields
By default, the New Requester form has the required fields, where you can enter important details
about an organization. Sometimes, you may need some additional fields in the New Requester form.
You can add your own fields using the Requester User Defined Fields configuration.
To add your own custom fields in the new requester form:
1. Login to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
. The next page is a
3. In the Helpdesk block, click the Requester - Additional Fields icon
form, where you can enter the field label and description of the field. You can add three types
of fields in the form: text, numeric, and date/time. These three are available in three tabs as
shown below:
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4. To add the text fields, enter the label name in the form fields below the Label heading. If
required, enter the description for the field.
5. You can choose the type of text field that you wish to add by selecting the radio buttons. A
Single-line text field allows you to add just a text field. The Multi-line text field allows you to
add a text box where a lengthy description can be added. A Pick List allows you to add a list
menu from which you can select. In all the three cases, you can add default values for the text
field in the space provided for the same.
6. To add items for the pick list, enter the value in the text filed and click Add Item. The value
will get added to the list below. To select the default selected value of the list, click on the
value in the list.
7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields
provided for the same.
8. To add date/time fields, click the Date/Time tab and enter the required details.
9. Click Save. A message for successful creation of the fields is displayed.
These fields appear under the grouping Additional Requester Details in the New Requester form.
To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the
label names that you wish to remove from the fields of the form and click Save. The respective fields
that you deleted will be removed from the New Requester form.
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Configuring Technician - Additional Fields
By default, the New Technician form has the required fields, where you can enter important details
about an organization. Sometimes, you may need some additional fields in the New Technician form.
You can add your own fields using the Technician User Defined Fields configuration.
To add your own custom fields in the new technician form:
1. Log in to the ServiceDesk Plus - MSP application with the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
. The next page is
3. In the Helpdesk block, click the Technician - Additional Fields icon
a form, where you can enter the field label and description of the field. You can add three
types of fields in the form: text, numeric, and date/time. These three are available in three
tabs as shown below:

4. To add the text fields, enter the label name in the form fields below the Label heading. If
required, enter the description for the field.
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5. You can choose the type of text field that you wish to add by selecting the radio buttons. A
Single-line text field allows you to add just a text field. The Multi-line text field allows you to
add a text box where a lengthy description can be added. A Pick List allows you to add a list
menu from which you can select. In all the three cases, you can add default values for the text
field in the space provided for the same.
6. To add items for the pick list, enter the value in the text filed and click Add Item. The value
will get added to the list below. To select the default selected value of the list, click on the
value in the list.
7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields
provided for the same.
8. To add date/time fields, click the Date/Time tab and enter the required details.
9. Click Save. A message for successful creation of the fields is displayed.
These fields appear under the grouping Additional Technician Details in the New Technician form.
To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the
label names that you wish to remove from the fields of the form and click Save. The respective fields
that you deleted will be removed from the New Technician form.
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Account Configuration
Account Configuration
A MSP would have many Accounts to whom service would be provided. An Account represents a
customer account. The account configuration section would be used by the administrator to configure
the account specific details
1. Account
2. Region
3. Site
4. Operational Hours
5. Holiday
6. Department
7. Business Rule
8. Service Level Agreement
9. Preventive Maintenance
10. Active Directory
11. LDAP
12. Requester
13. User Groups
To access the Account configurations:
1. Login to the ServiceDesk Plus - MSP application with the Username and Password of a
ServiceDesk Plus - MSP Administrator.
2. Click the Admin tab in the header pane.
With ServiceDesk Plus MSP 7.6 you could configure the account related settings for your own
helpdesk as well. The configurations are available under Admin--> MSPDetails
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Configuring Accounts
A Managed Service Provider (MSP) would provide service to many Accounts, big or small, across the
globe to handle various specialized activities. These accounts would contain site(s) located in the
same or different region, and the data from each of these site(s) need to be maintained in the same
place. You can configure various sites to a region in the ServiceDesk Plus - MSP application The
segmentation is :
Account --> Region --> Site --> Department

Note: The administrator has the privilege to Add/Edit/Delete an account. The Account Admin
can only View/Edit the accounts to which he is associated from the Account list page.

Add Account
To add new account,
1. Login to ServiceDesk Plus - MSP application using the username and password of the admin
user..
2. Click Admin tab in the header pane.
3. On the Account Details block, click Account

icon.

4. In the Account List view page, click Add New Account link on the right hand side corner. The
Add New Account form opens.
5. Enter the Account Name in the text field provided. It is a mandatory field.
6. Enter brief information in the Description field about the account.
7. Enter the Login URL in the text field provided. It is a mandatory field. Login URL allows
requester from an account to view their account-specific images when they login through the
URL. Example: If Login URL for an account is given as zohocorp, requesters for that account
should login through http://sdpmsp.com/zohocorp.
8. Enter the Default Site Name in the text field provided. It is a mandatory field. Click on the
icon beside the Default Site Name field for more information about default site.
9. Specify the Address of the account along with City, Postal Code, State and Country.
10. Enter the Contact Information such as E-mail Id, Phone no, Fax no and the Web URL of the
account.
11. Enter the Support E-Mail Address in the text field provided to which requests will be sent by
a requester of this account. This e-mail address will also be used for sending 'Notifications' to
the requester and used for replies to requests send from the product. NOTE: The e-mail Id
specified here should be aliased with the Mail Account specified in Incoming Mail Server
Settings.
12. Specify the Email Domains from which emails will be sent to this account. When a requester
sends an e-mail from an e-mail address that is not already registered with the product, the
request will be created under this account.
NOTE: Support E-Mail Address gets precedence over Email Domain.
13. Use the Attach file button to attach any document related to the Account.
14. Use the Import image buttons to import the Login and Header image for the Account.
15. Click Save button to save the account details and return to the list view. Click Save and Add
new button to save and add another account. If you wish to cancel the operation then click
Cancel.
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Edit Account
To edit an account,
beside the account which you wish to edit.
1. From the account list page, click the edit icon
The Edit Account page opens with the existing details.
2. You can modify all the fields in this page. Click Save to save the modified changes. Click
Save and Add New to save and add another account.

Delete Account
To delete account,
1. In the Account List page, select the check box beside the account which you wish to delete.
And click Actions->Delete Account(s) link. A confirmation dialog appears
2. Click Ok to proceed. The account gets deleted from the list of available accounts.
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Configuring Regions
Account Organizations can have various branches to handle various specialized activities. Such
branches can be located at different regions and data from each of these branches need to be
maintained in the same place. You can configure the various locations of the Account branches in the
ServiceDesk Plus - MSP application. To open the organization regions configuration page,
1. Login to the ServiceDesk Plus - MSP application using user name and password of an admin
user.
2. Click the Admin tab in the header pane.
. The next page displays the
3. In the Account Details block, click the Regions icon
available list of regions. You can add, edit, or delete regions.

Add Region
To add a new region,
1. Click Add New Region link available at the top right corner of the Region list page.
2. In the Add Region form, enter the Region Name. This is mandatory field.
3. Specify brief description about the core activities taking place in the branch in the
Description text field.
4. Click Save to save and return to the list view. Click Save and Add New a to save and add a
new region. At any point, if you do not wish to add the region and would like to get back to the
location list, click Cancel.

Edit Region
To edit an already existing region,
1. In the Region List page, click the edit icon

beside the Region Name that you wish to edit.

2. In the Edit Location form, modify the location name and its description.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
Even while editing a region, if you wish to add another new region, then click Save and add new
button instead of clicking Save button after making the changes.

Delete Region
1. In the Region List page, click the delete icon
delete. A confirmation dialog appears.

beside the Region Name that you wish to

2. Click OK to proceed with the deletion. If you do not want to delete the region, then click
Cancel.
On deleting the region, the sites corresponding to the region along with the attributes such as groups,
SLA, business rules, holidays and so on gets deleted.
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Configuring Sites
An Account Organization, big or small, may have several branches across the globe to handle various
specialized activities. These branches can be located in the same or different region, and the data
from each of these branches need to be maintained in the same place. You can configure various
sites (branches) to a region in the ServiceDesk Plus - MSP application.

Note: The administrator has the privilege to Add/Edit/Delete a site across Accounts. The
Account Admin can Add/Edit/Delete a site which belongs to his Account(s). The Site Admin
can only View/Edit/Delete the sites to which he is associated from the Site List page.

Add Site
To add new site,
1. Login to ServiceDesk Plus - MSP application using the username and password of the admin
user..
2. Click Admin tab in the header pane.
3. On the Account Details block, click Sites

icon.

4. In the Site List view page, click Add New Site link on the right hand side corner. The Add
New Site form opens.
5. Enter the Site Name in the text field provided. It is mandatory field.
6. Enter brief information in the Description field about what your organization does in the
above mentioned site.
7. Select the Region and the Time Zone of the site from the combo box. The specified time
zone is essential to calculate the operational hours for the site. Hence, any request raised in
the site can be resolved within its operational hours.
8. Specify the Address of the organization along with City, Postal Code, State and Country.
9. Enter the Contact Information such as E-mail Id, Phone no, Fax no and the Web URL of
your organization.
10. Enable any of the following related settings,
•

Refer Default Settings: On enabling refer default settings, the default settings are
not copied to site and hence there is not separate site based configurations
(excluding departments). Instead the configurations made under the default settings
are referred to the site. Any modifications made under the default settings such as,
adding a new holiday or group to the existing list will get applied to the sites with refer
default settings enabled.
Say, for an organization with various sites having similar site specific configurations,
enable refer default settings instead of copying the default configurations to every
site. Any additional holiday or group added under default settings will automatically
get applied to all the sites with this option enabled.

•

Copy Default Settings: Copy default settings help you to maintain separate site
specific configurations for every site, and if there is any slight modifications made
under default settings then, the same gets pushed to the sites provided the previous
states of default setting and site configuration is the same. Any minor changes made
in the site based configurations of a site is exclusively for the particular site.
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Say, the escalation rules set in a SLA for one site is different from another site. In this
case, enable copy default settings radio button and modify the changes in the
escalation rules.
•

Custom Settings: Custom default settings help you to organize, configure and
maintain separate site specific configurations of a site. The default settings do not
have any influence over the default settings.

Consider an organization with branches across the globe having different operational
hours and holidays, and thus with different SLAs. In this case, site specific
configurations needs to be configured separately for every site by enabling the radio
button corresponding to the options in Custom Settings for the site.
11. Click Save button to save the site details and return to the list view. Click Save and add new
button to save and add another site. If you wish to cancel the operation then click Cancel.

Edit Site
To edit a site,
1. From the site list page, click the edit icon
Site page opens with the existing details.

beside the site which you wish to edit. The Edit

2. You can modify all the fields in this page. Click Save to save the modified changes. Click
Save and Add New to save and add another site.

Delete Site
To delete site,
1. In the Site List page, click the delete icon
confirmation dialog appears

beside the site which you wish to delete. A

2. Click Ok to proceed. The site gets deleted from the list of available sites.

Change Default Site
To change default site,
1. Select an account from the account combo.
2. Click on Change Default Site link.
3. A popup will be opened which will allow you to change the default site.
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Configuring Operational Hours
You can set the operational hours of the Account situated in various sites. The operational hours for a
site depends on the time zone configured for that site. The operational hours that you configure is
used while calculating the request due by date and time. To set the operational hours,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Operational Hours icon
form is displayed as shown below,

. The Operational Hours

4. Select the site from the Operational hours for comb box. By default, the Operational hours
for combo box will display Default Settings.
Note:The Site Admin can set the operational hours for the sites to which he is
associated. The sites can be selected from the Operational Hours for combo box. The
Operational hours for combo box will appear if the site is configured in Admin- Sites.
5. If the site works round the clock, then select Round the clock (24 hours) radio button. If you
do not work round the clock then, select the radio button beside Select Operational Hours.
Specify the working hours of the site by selecting the Start Time and the End Time from the
drop down boxes.
6. Now, select the days that the site works by selecting the check boxes provided beside the
days of the week.
7. Click Save.
You can also view the operational hours of a site by selecting the site from Operational Hours for
combo box.
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If you have already set the operational hours and wish to modify the same, you still need to follow the
same procedure as specified above. But in this case, when you click Operational Hours from the
Admin Home page, it will open the Operational Hours form with the details that have been set
earlier. You can make the necessary modifications and then click on Save.
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Configuring Holidays
You can set the holidays of the Account that is situated in various sites using the Holidays option
available in the Admin page. This has the list of holidays during which the firm would remain closed
and is exclusive of the weekly holiday when the firm does not function. You can also set repeated
holidays such as, New Years Day, to a site. Thus by doing so you need not manually add the holiday
every year in the Holidays option.
The holiday list along with the operational hours will be used for calculating the expected completion
time of a service request, depending on the priority or SLA applicable to that request. To open the
holiday configuration page,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin/account admin user.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Holidays icon . This displays the Default Settings
of the available list of holidays. You can add, view, edit, or delete holidays for a particular site.
Note: The Account Admin and Site Admin can add and view the holidays to the site
which he is associated. To view the holidays in a particular site, select the site from the
Holidays for combo box.
If the sites are not configured then the Holidays for combo box will not appear. To
configure the sites refer Sites under Account Details block.

Add Holidays
To add holidays in a site,
1. Select the site for which you want to add the holiday from the Holidays for combo box. If the
sites is not selected then the holidays gets added under Default Settings.
2. Click Add New Holiday link available at the top right corner of the holiday list page. This
opens the Add New holiday form.
3. Select the Date on which you want to add the holiday by invoking the calender icon
is mandatory field.

. This

4. Enter a brief description of the significance of the holiday in the Description text field.
th

5. If the holiday occurs every year such as, 25 December (Christmas), then enable Check if
this is recurring holiday check box. This will automatically add the holiday every year for the
site.
6. Click Save. If you do not wish to add the holiday and would like to get back to the holiday list,
click Cancel.
7. Clicking the View List link on the top right corner of the add holiday form will also take you to
the holiday list view.

Edit Holidays
1. Select the site for which you want to edit the holiday from the Holidays for combo box. This
lists out the holidays for the corresponding site.
2. Click the edit icon

beside the holiday Date that you wish to edit.

3. Modify the date and the description of the holiday, and enable/disable the 'check if this is
recurring holiday' check box in the Edit Holiday form.
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
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Delete Holidays
1. Select the site for which you want to delete the holiday from the Holidays for combo box.
This lists outs the holidays in that site.
2. Enable the check box beside the holiday Date which you want to delete from the holiday list
page. Click the Delete button on the left hand side of the page. A confirmation dialog
appears.
3. Click OK to proceed with the deletion. If you do not want to delete the holiday, then click
Cancel.
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Configuring Department
There can be various departments in an account which can be situated in different sites and, each of
these departments have a group of employees in them. In ServiceDesk Plus - MSP you can add, edit,
or delete the various departments of the Account. These departments are essential while adding
requesters since each requester will be associated to a particular department of the account. To open
the department configurations,
1. Login to the ServiceDesk Plus - MSP application using the user name and password of an
admin or account admin user.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Departments icon
of departments. You can add, edit, or delete departments.

. This displays the available list

Note:The Account Admin and Site Admin can configure the department in the sites
which he/she is associated. The list of departments associated to the site can be viewed
by selecting the sites from the Departments for combo box. The Department for combo
box will appear if the site is configured in Admin- Sites.

Add Department
To add a department for an organization in a site,
1. Select the site for which you want to add the department from the Departments for combo
box. By default, the department gets added under Default Settings.
2. Click Add New Department link available at the top right corner of the Department list page.
This opens the Add Department form.
3. Enter the Department Name in the text field. This is mandatory field.
4. Provide a brief Description about the department in the text field provided.
5. Click Save. At any point, if you do not wish to add the department and would like to get back
to the department list from the add department form, click Cancel.

Edit Department
To edit an existing department,
1. Select the site for which you want to edit the department from the Departments for combo
box. This lists out the available departments corresponding to the site.
2. Click the edit icon
Department form.

beside the Department Name that you wish to edit. This opens the Edit

3. Modify the department name and its description.
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.

Delete Departments
1. Select the site for which you want to edit the department from the Departments for combo
box.
2. Enable the check box beside the department name which you wish to delete from the
department list page. Click Delete button. A confirmation dialog appears.
3. Click OK to proceed with the deletion. If you do not want to delete the department, then click
Cancel.
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Configuring Business Rules
You can define Business rules to various sites of an account. This will enable you to organize the
incoming requests (form and e-mail) and perform any action ranging from delivering them to group, to
assigning status and other parameters of the requests.
To open the Business Rule configurations page,
1. Login to the ServiceDesk Plus - MSP application with admin/account admin username and
password.
2. Click the Admin tab in the header pane.
. The resulting page will
3. In the Account Details block, click the Business Rule icon
display the available list of business rules under the Default Settings. You can add, edit, or
delete business rules of a particular site.
Note: The Account Admin and Site Admin can add and view the business rules to the
site which he is associated. To view the business rules of a site, select the site from the
Business Rules for combo box. If the sites are not configured then the Business Rules
for combo box will not appear. To configure the sites refer Sites under Account Details
block.

Add New Business Rule
To add a Business Rule,
1. Select the site to which you want to add the business rule from the Business Rule for combo
box. Click Add New Business Rule link available at the top right corner of the Business
Rules List page. This opens the Add Business Rule page as shown below,
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2. The Add Business Rule form consists of two blocks namely, Business Rule Details and
Business rule.
Business Rule Details
o

Specify the Rule Name in the given text field. This name has to be unique and is a
mandatory field.

o

Provide relevant information about the rule in the Description text field.

o

Business Rule can be executed on a request when it is created via web form (or
received via email), edited or both on choosing the options from Execute when a
request is drop-down list. By default, the 'Created' option is selected.

o

You can disable a Business Rule by selecting Disable Business Rule check box. On
disabling a Business Rule, the rule will not get executed on any new or edited
request. The disabled business rule will be marked in grey in the list view.

o

By default, the execution of the business rule will stop once a rule is applied on a
request. To continue execution of successive business rules even after a business
rule is applied on a request, select Turn on Cascade Execution check box.

o

By default, when a business rule is applied, the request values will be changed with
the values in the business rule only if the request value is empty. If the request value
is not empty, the business rule value will not be applied. To override the request
values with the values in the business rule enable Override request values with
Business Rule values.
Example: If the Priority in a request is set to 'High' and the Actions Set in the
business rule is 'Set Priority to Low', then the priority is automatically set to 'Low'
when the business rule is applied.
Note: Bulk actions such as delete, disable/enable business rules, turn on/off
cascade execution can be performed on a business rule by selecting the check
box beside the business rule and click Actions drop down button.
To turn on/off cascade execution to a business rule from the list view, click the
icon beside the business rule. A confirmation message appears. Click Ok to
continue. The icon will be grayed if the cascade execution is discontinued.

Business Rule
o

Under this block, define the rules and criteria that need to be satisfied by the
incoming request. Set the criteria by selecting from the Select Criteria combo box,
and then choose conditions, and then the individual values that need to be matched
by clicking the Choose button. This will open the values from the database for that
particular parent criteria that you chose from the combo box. Choose the values you
want and click Save.
For example: If you want to match the requester name John, then select Requester
Name in the Define rule combo box. Now select the condition is or is not from the
drop down list. This list varies for each criteria. Then, click Choose button, to open
the list of requesters in a pop-up window. Select the requester name from the list and
click Ok. For multiple selection, press Shift or Ctrl key while selecting the names.
The selected names will appear in the text box just before the choose button.

o

Click Add to Rules to add the defined rule to the rules table.

o

By default, the radio button Match ALL of the following is selected. If you do not
want all of them to be checked but if it is enough if any one of the rules are matched,
then select the radio button Match ANY of the following. After defining the rules,
you need to define the actions that need to be performed on the request matching the
criteria.

o

Choose the action that needs to be performed on the request from the Choose
Action drop down list.
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o

Click Choose button to the select the values for the chosen action.
For example: If the action you had chosen was to Place in Group, then clicking the
choose button will display the available groups in which the request can be placed.
You need to select the group in which the request has to be placed and click OK.

o

Click Add.

3. Click Save. If you want to add more than one business rule, then click Save & Go Next >>.
This adds the business rule and reopens the add business rule form.
At any point, if you do not wish to add the business rule and would like to get back to the business
rules list from the add business rule form, click Cancel. Clicking the View List link on the top right
corner of the add business rule form will also take you to the business rules list view.

Edit Business Rule
To edit an existing business rule
1. In the Business Rules List page, click the edit icon
you wish to edit.

beside the Business Rule Name that

2. In the Edit Business Rule form, you can modify all the fields mentioned in the add business
rule form.
3. To edit the Match the below criteria set, click the edit icon beside the individual criteria.
The respective selection window is opened in a separate pop-up. You can choose more
values or remove a few values by de-selecting them.
4. You can also delete a criteria completely. To delete a criteria, click the delete icon
the individual criteria.

beside

5. In the actions to be performed, you can add or delete actions that need to be performed on
the request that matches the criteria defined.
6. Click Save to save the changes performed. At any point you wish to cancel the operation that
you are performing, click Cancel.
Even while editing a business rule, if you wish to add another new business rule, then click Save &
Go Next >> button.

Delete Business Rule
1. From the Business Rule List page, enable the check box adjacent to the Business Rule
Name that you wish to delete.
2. Click Delete button. A confirmation dialog is opened.
3. Click OK to proceed with the deletion. If you do not want to delete the business rule, then
click Cancel.

Organize Business Rules
You can organize the business rule to appear in a particular order in the list view by following the
steps below:
1. Select the site form which you want to re arrange the order of the business rule from the
Business Rules for combo box. Click Organize Business Rules link available above the list
of business rules in the Business Rules List view. A pop-up window is opened with the list of
available business rules in the order that is appearing the list view.
2. Select a business rule, and click Move up or Move Down button beside the list.
3. Click Save.
Organizing the business rules decide the order in which the rule is applied on the incoming request.
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Configuring Service Level Agreements
You can have service level agreements (SLAs) defined for different sites to which service provided by
the IT help desk team. These SLAs help evaluating the efficiency, effectiveness, and responsiveness
of your help desk team. The SLAs can be defined for each individual, or departments, or workstations
in a site. The priority for an incoming service request is automatically set if the request is governed by
an SLA rule. Also, if the request is not attended and resolved within the time specifications of the SLA,
then you can set the escalation rules.
To open the SLA configurations page,
1. Login to the ServiceDesk Plus - MSP application with admin/account admin username and
password.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Service Level Agreement icon
SLA list page. You can add, edit, or delete SLAs.

. This opens the

4. By default, all SLA based mail escalations will be enabled. If you wish to disable the
escalation click Disable Escalation button.
5. By default, there are four SLAs set namely, High, Medium, Normal,Low SLAs. You can also
add more SLAs to the list.
Note: The Account Admin and Site Admin can configure the SLA for the sites to which
he is associated by selecting the site from the Service Level Agreement for combo
box. This lists out all the SLAs corresponding to that site. If the sites are not configured
then the Service Level Agreement combo box will not appear. To configure the sites
refer Admin- Sites.

Add New Service Level Agreement
To add an SLA
1. Select the site to which you want to add the SLA from the Service Level Agreement for
combo box. By default, the 'Default Settings' option is selected.
2. Click Add New SLA link at the top right corner of the SLA list page.
3. In the Add New SLA form, specify the SLA Name in the text field provided. It is a mandatory
field.
4. The Site selected in Service Level Agreement for drop down box is displayed in non editable
text.
5. If required, you can provide a corresponding Description for the SLA.
6. In the SLA rules block, set the rules and criteria for the SLA. By default, the radio button
Match ALL of the following is selected. If you do not want all of them to be checked but if it
is enough if any one of the rules are matched, then select the radio button Match ANY of the
following.
7. Select the Criteria and Condition from the respective text box, and then choose the
individual values that need to be matched by clicking on the choose button. The values from
the database for that particular parent criteria that you chose from the drop down list opens.
Choose the values you want and click Ok.
Example: If you want to match the requester name John, then select Requester Name in the
combo box. Now click Choose button, to open the list of requesters in a pop-up window.
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Select the requester name from the list and click Select. For multiple selection, press Shift or
Ctrl key while selecting the names. The selected names will appear in the text field just
before the choose button.

8. Click Add to Rules to add the defined rule to the Rules Set.
9. Set the Response Time and the Resolution Time in terms of days, hours and minutes.
Note: The Response Time is the initial response sent out by the technician to the requester
for a request. Automatic replies from Service Desk Plus will not be counted as a response.
The specified response time should be less that the resolution time.
10. If you want this duration to override the operational hours, the select the check box beside
Should be resolved/responded irrespective of operational hours. By selecting this, you
will be overriding the operational hours of your organization and the due by time will be
calculated from the creation time without taking into consideration the holidays and
operational hours.
11. If you want to the due date to override the holidays and weekends then select the check box
Should be resolved/responded irrespective of the Holidays and Should be
resolved/responded irrespective of the Weekends respectively.
12. The request can be escalated to other technicians when the request is not responded or
resolved within the specified time. There are two blocks of escalations, one for the Response
Time and the other for the Resolution Time.

Response Time:
There is only one level of escalation if the response time elapses.
i.

To enable escalation, select the check box beside Enable Level 1 notification.
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ii.

Click Choose button to choose the technicians to whom the SLA violation should be
escalated.

iii.

You can choose to escalate before the violation or after the violation. If you wish to
escalate the request before the SLA violation then click Escalate Before option.
Specify the number of days before the SLA violation is about to happen in the text
box. This is to escalate to the technician about the onset of the violation. You can
also specify the time of escalation.

iv.

Similarly, click Escalate After option to escalate after the violation. Specify the
number of days after the SLA violation has occurred in the text box. You can also
specify the time of escalation.

Resolution Time:
There are 4 levels of escalation if the specified resolution time elapses.
i.

To enable escalation, select the check box beside Enable Level 1 notification.

ii.

Click Choose button to choose the technicians to whom the SLA violation should be
escalated.

iii.

You can choose to escalate before the violation or after the violation. If you wish to
escalate the request before the SLA violation then click Escalate Before option.
Specify the number of days before the SLA violation is about to happen in the text
box. This is to escalate to the technician about the onset of the violation. You can
also specify the time of escalation.

iv.

Similarly, click Escalate After option to escalate after the violation. Specify the
number of days after the SLA violation has occurred in the text box. You can also
specify the time of escalation.

13. Click the Save button to save the SLA and return to the list view. If you want to add more than
one SLA, then click Save and Add New.
At any point, if you do not wish to add the SLA and would like to get back to the SLA list from the add
SLA form, click Cancel. Clicking the View List link on the top right corner of the add SLA form will
also take you to the SLA list view.

Edit Service Level Agreement
To edit an existing SLA,
1. Select the site of the SLA you wish to edit from the Service Level Agreement for combo
box. The lists of all the SLA corresponding to that site is displayed.
2. Click the edit icon

beside the SLA Name.

3. In the Edit SLA form, you can modify all the fields mentioned in the add SLA form.
4. Click Save to save the changes. At any point you wish to cancel the operation that you are
performing, click Cancel. Even while editing an SLA, if you wish to add another new SLA,
then click Save and Add New button.

Delete Service Level Agreement
1. Select the site of the SLA you wish to delete from the Service Level Agreement for combo
box. The list of SLA corresponding to the site gets displayed.
2. Enable the check box beside the SLA. Click the Delete button. A confirmation dialog appears.
3. Click Ok to proceed with the deletion. If you do not want to delete the SLA, then click Cancel.

Organize Service Level Agreements
Organizing the SLAs decide the order in which the SLA is applied on the incoming request. You can
organize the SLA to appear in a particular order in the list view,
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1. Select the site for which you wish to rearrange the order of the SLA from the Service Level
Agreement for combo box.
2. Click Organize SLA link available above the list of SLAs in the SLA List view. A pop-up
window is opened with the list of available SLAs in the order that is appearing the list view.
3. Select an SLA, and click Move up or Move Down button beside the list.
4. Click Save.
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Preventive Maintenance
You can create a Preventive Maintenance Task for regular maintenance such as changing the printer
toner every month or perform a regular service shutdown for an account's site.
To schedule a preventive maintenance task,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Preventive Maintenance Tasks icon
opens the Configuration Wizard page.

. This

4. Click the Preventive Maintenance Tasks link at the left side of the page under the HelpDesk
block. This opens Request Maintenance Tasks page.
5. Click Add New PM Task link. This opens Add Preventive Maintenance Task page. You can
create a preventive maintenance task in two steps.

Creating a Task Template
Task template has four blocks, Request details, Owner details, Requester details, Category details.
1. Specify the Status of the request from the comb box. Ex. Open.
2. Specify the Level of the request from the combo box. The level should be selected based on
the priority. Ex. If the priority of the request is high then select Tier 1.
3. Select the Mode from the combo box. This will be the mode of communication, to inform the
technician.
4. Select the Priority from the combo box. For ex. High, Medium, Low etc
5. Select the Site from the combo box. This is a mandatory field.
6. Select the Group from the combo box. This option is given to group the task template. Ex.
Network, Hardware etc.
7. Select the Technician from the combo box to assign the task and click the requester list icon
to select the requester Name. This is a mandatory field. The other details such as Contact
Number, Workstation ID and Department get filled automatically based on the requester
details specified in the requester form.
8. Select the Category, Sub Category and Item from the combo box.
9. Specify the Subject line for the task in the given text field. Specify relevant information about
the task in the given Description field.
10. To attach a file to the task template click Attach a File button to attach files.
11. You can add Resolution in the resolution text field.
12. Click Next>> button for Task Scheduling.

Task Scheduling
To schedule a task, select the time frame from the listed options:
Daily Schedule: To run a daily maintenance task, click Daily Schedule radio button.
1. Select the Time at which the maintenance task should be scheduled from the combo box.
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2. Select the Date on when the maintenance task should be scheduled from the Calendar
button.
3. Save the details.
Weekly Schedule: To run a weekly maintenance task, click Weekly Schedule radio button.
1. Select the day of the week by enabling the corresponding check box beside the day of the
week.
2. Else if you wish to schedule on all days of the week, then click Everyday check box.
3. Select the Time frame to schedule the task from the combo box.
4. Save the details.
Monthly Schedule: To run a monthly maintenance task, click Monthly Schedule radio button.
1. Select the month to run the task by enabling the check box beside Every Month.
2. Select the Date on when the task should be scheduled from the combo box.
3. Select the Time at which the task should be scheduled from the combo box.
4. Save the details
Periodic Schedule: To run a periodic maintenance task, click Periodic schedule radio button.
1. Specify the day (s) in the given text field to schedule the maintenance task. i.e after every
specified nth day the maintenance task will be executed.
2. Save the details.
One Time Schedule: To run a one time maintenance task, click One Time Scheduling radio button.
1. Select the Date & Time on when the maintenance task should be executed.
2. Save the details.
For Example:
If you wish to schedule a monthly task to change the printer cartridges,
1. Select Monthly Schedule radio button.
2. Select the check box every month.
3. Choose the date from the combo box. Ex: 3rd of every month.
4. Select the time from the combo box. Ex: 1500 hrs.
5. Save this schedule. A task to change cartridge will be sent to you every month on 3rd at 1500
hrs helping you to complete the regular maintenance task in advance without any request
sent from the users.
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IT Services
You can list of all the available IT services in your organization using this option. All the affected IT
Services on change will be selected from the list. The affected IT services list will be submitted to the
CAB to infer the impact of the change also it can be recorded and used for future reference.
To Add New IT Service,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the IT Services icon
page.

. This opens the Configuration Wizard

4. Click on the New Service link on the right hand side of the page. This opens the Add IT
Services details page.
5. Specify the Name of the IT Service in the given text field. This is a mandatory field.
6. Specify the IT Service details in the Description field.
7. Save the changes.

8. Click the Save and add new button to save the IT service and add another IT service.
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Configuring Active Directory Authentication
You can configure to authenticate the requester login with the active directory (AD). This provides you
an advantage of not having to remember too many passwords. In you have configured AD
authentication, then any password change that is made in the AD will also reflect in ServiceDesk Plus
- MSP. So the requesters can login using the login name and password of the system.

Note: Please ensure that before you start configuring the AD Authentication, you have
already imported the requesters. Only if a user account is available in ServiceDesk Plus MSP application, it will authenticate the password for that user account from the active
directory. Hence, when none of the users have been imported from the active directory, the
authentication cannot be done for the user account.
To configure the Active Directory Authentication
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
. Here you
3. In the Account Details block, click the Active Directory Authentication icon
can enable or disable active directory authentication. By default the AD authentication will be
disabled.
4. If you have already imported requesters from the any of the domains from the Account's
network, then click Enable button.
Even after enabling Active Directory (AD) Authentication, if you would like to bypass the AD
Authentication, then in the application login screen, you need to select Local Authentication from the
Domain list box after entering the login name and password, and then click Login button to enter
ServiceDesk Plus - MSP.
To configure the Pass - through Authentication,
On enabling single sign-on, ServiceDesk plus - MSP directly authenticates the windows system user
name and password . Hence you need not login over again to enter into ServiceDesk plus - MSP .
1. Enabling Active Directory, activates the Pass-through authentication (Single Sign-on) option.
2. If you like to activate single sign - on, select the Enable Pass-through Authentication
(Single Sign-On) option.
3. Save the authentication. You will get a confirmation message on the authentication.
Note
1.
o

To enable single sign-on, enabled domain should be two way trusted.

o

Single sign-on works only on Windows Internet Explorer.

If you have not yet imported requesters from any of the domains, you can import them by clicking
Import Requesters from Active Directory link. The Import From Active Directory window pops
up.
1. Select the Account name and from the list of domains that are listed in the Domain Name
combo box, select the domain name in which the active directory from which you wish to
import is installed. If the other details such as domain controller name, user name, and
password have already been entered in the Domain scan page, then that will be populated
automatically. Else enter the name of the domain controller in the Domain Controller Name
field, login name and password in the corresponding fields.
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2. You also have an option to select the fields to import from the active directory. The unselected
fields will not be imported. This is to avoid over ridding of the new values by the old values
from the directory.
3. Apart from the default fields, you can also Import Requester Additional Field details from
the active directory. If you have not configured any requester additional fields, then select
Click here to configure link. This takes you to Requester - Additional Field page, from where
you need to configure the additional fields to be imported from Active Directory. The
configured requester additional fields - Text, Numeric and Date/Time fields, appear in Import
from Active Directory window indicated in the colors Blue, Green and Red respectively.
Enable the check box beside the requester additional fields to import, and specify the field
name configured in active directory beside the selected field. The unselected fields are not
imported.
4. Click Import Now !. The import wizard displays the various Organizational Units (OUs)
available in that domain. Choose the specific OU from which you wish to import users by
selecting the check box beside it.
5. Click Start Importing. Once the import is complete, the data on how many records were
added, how many overwritten, and how many failed to import will be displayed.

Schedule AD import
1. You have an option to schedule Active Directory import in specified number of days.
2. Select the Schedule AD import check box. Specify the number of days in the text box. The
requester details gets imported automatically once in specified number of days.
3. Click saveADSync button to be in sync with the active directory.
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Configuring LDAP authentication
You can also import users from the LDAP server through the domain controller. On enabling the
LDAP authentication, the users can login using their LDAP credentials. By default, the LDAP
authentication will be disabled.
Note: Ensure that before you start configuring LDAP authentication the users are already
imported from the domain. The LDAP authentication supports both linux and windows users.
On enabling LDAP authentication for windows users, the AD authentication gets disabled
automatically.
To import users from a New Domain,
1. Login to ServiceDesk Plus - MSP application using your username and password.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the LDAP Authentication icon
. By default, the LDAP
authentication will be disabled.
4. Select the Account and click Add New Domain button under Domain Controllers block. This
opens the Add New Domain Controller form as shown below,

5. Specify the Domain Controller from where the users have to be imported in the Domain
Controller text field. For ex: ldap://<server name>:<port number>. The default port is 389.
6. Enter the User Name along with the Organizational unit (OU) in the given field. For ex,
CN:john, CN=Users, DC=domain name, DC=com.
7. Specify the Password in the respective field.
8. Specify the Base DN which represents the distinguished base name such as, CN = Users,
DC = domain name, DC = com.
9. Specify the criteria which you want to apply on that particular domain controller in the search
filter text field. For ex: mail=* will import users from the parameter mail in the specified domain
controller.
10. Select the LDAP Server Type from the combo box. For ex. OpenLDAP.
Note: If you have chosen the Server type as default LDAP such as, Microsoft Active
Directory, Novell eDirectory and OpenLDAP then the Login Attributes Label, Mail
Attribute Label and Distinguished Name Attributed Label will appear in a non editable
text.

Zoho Corporation Pvt. Ltd.
499

ManageEngine ServiceDesk Plus MSP – Admin Guide

11. If the LDAP Server Type is Others then, specify the Login Attribute Label and Mail
Attribute Label in the respective fields.
12. The Distinguished Name Attributed Label is similar to the Base DN.
13. Click Save to save the domain controller. If you want to save and import the users, click Save
and Import.
You can also import users from the existing domain by clicking Import Now of the corresponding
Domain Controllers. The existing data will be over written on importing the users from the same
domain. Once the users are imported, Enable LDAP Authentication by selecting the check box.
Click Save. The user can login to the application using his LDAP credentials.

Edit Domain Controller
1. Click domain controller name which you wish to edit. This opens the Add new domain
controller form.
2. Modify the changes and click Save. To save and import the users from the domain controller,
click Save and Import.

Delete Domain Controller
1. From the domain controller list view page, enable the check box adjacent to the domain
controller which you wish to delete.
2. Click Delete button. A pop up window confirming the delete operation appears. Click Ok to
continue. The domain controller gets deleted from the list.
On deleting a domain controller, the users imported from that domain controller will not be able to
login to the application using LDAP credentials.
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Configuring Requesters
ServiceDesk Plus - MSP allows an administrator or a 'Site Admin' or 'Account Admin' to create new
requesters. You can add, edit, or remove the requesters in the ServiceDesk Plus - MSP application
and also provide them with login permissions to access the self-service portal.
To open the requester configuration page:
1. Log in to the ServiceDesk Plus - MSP application with the user name and password of a
ServiceDesk Plus - MSP administrator/Account Admin/Site Admin.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Requesters icon . The next page displays the
available list of requesters for the logged in technician associated Sites. You can add, edit, or
delete requesters accordingly.

Add Requester
To add a requester and provide login access to him/her,
1. Click Add New Requester link available at the top right corner of the Requester List page.
This opens the Add Requester form
2. Select the Account from the Top Header combo and from the Personal Details block, enter
the Full Name and Employee ID of the technician. The name is a mandatory field. Specify
any relevant information about the requester in the Description text field.
3. In the contact information block, enter a valid e-mail ID. If the requester has a phone and a
mobile number, you can enter the same in the space provided for entering these values.
4. Specify the account details such as, Site and the corresponding Department Name to which
the requester belongs from the combo box. These are mandatory fields. The requester has an
option to view, only his requests, all his department requests or all the requests in the site to
which he is associated. Select the options from the Requester allowed to view combo box.
Specify the Job Title of the requester in the field provided.
5. If you have added any organization-specific fields for the new requester form, those will be
available under the Additional Requester Details block. Enter the relevant information.
6. In the Self-Service Access Details block, enter the Login Name and Password, if you wish
to provide self-service access to the requester. Enter the password again in the Re-type
Password field.
7. Certain requesters can also approve purchase order in an Account organization. Upon
enabling the check box adjacent to Purchase Order Approvers, a link is sent to the
requester to accept or reject the PO.
8. Click Save. If you want to add more than one requester then, click Save and add new button.
At any point if, you decide not to add the new requester, then click Cancel to get back to the
requester list. Clicking the View List link on the top right corner of the add requester form will also
take you to the requester list view.

Import Requesters from Active Directory
You can also import requesters from an active directory. To import requesters from active directory
1. Click Import from Active Directory link in the Requester List page. The Import From
Active Directory window pops up.
2. Select the Account name. From the list of domains that are listed in the Domain Name
combo box, select the domain name in which the active directory from which you wish to
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import is installed. If the other details such as domain controller name, user name, and
password have already been entered in the Domain scan page, then that will be populated
automatically. Else enter the name of the domain controller in the Domain Controller Name
field, login name and password in the corresponding fields.
3. Select the Fields for Import from the active directory by enabling the check box.
4. Click Import Now !. The import wizard displays the various Organizational Units (OUs)
available in that domain. Choose the specific OU from which you wish to import users by
selecting the check box beside it.
5. Click Start Importing. Once the import is complete, the data on how many records were
added, how many overwritten, and how many failed to import will be displayed.
NOTE: The requesters imported are associated to default 'Common site' of the selected
Account if no site information was imported from AD.

Import Requester from CSV (Comma Separated Value) Files
You can also add requesters by importing from CSV files. To import requesters from CSV file

Step 1: Locate the CSV file
1. Click Import from CSV link in the Requester List page. The Import Wizard opens in
a pop-up window.
2. Select the Account name and Site from the combo box. These are mandatory fields.
3. Click the Browse button in the wizard.
4. Select the CSV file in the file chooser window and click Open.
5. Click Next.

Step 2: Customize Mapping
1. The CSV column names are populated in the select boxes beside each label. Map
the ServiceDesk Plus - MSP requester fields with the field names from the CSV file.
2. Click Next.

Step 3: Import
1. Click Import Now button. The values from the CSV file will be imported to the
requester details. Once the import is complete, the data on how many records were
added, how many overwritten, and how many failed to import.
If at any point you wish to stop importing from the CSV file, click the Exit button.

Note: Login name and domain name column will be the identifier for requesters. No two
requesters can have the same login name and domain name. Hence the existence of a
requester will be checked based on the login name and domain name value.

Edit Requester
To edit the requester details,
1. In the Requester List page, click the edit icon beside the requester's full name that you
wish to edit. The Edit Requester form is displayed with the existing details of the requester.
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2. In the above form, you can modify all the fields displayed. You can also change the login
name of the requester.
3. Click Save. If you do not wish to modify any of the details, click Cancel.

Change Requester Password
You can change the requester's password while editing the requester details.
1. To change the password of the requester, click the Reset Password link. The reset
password window is opened.

2. Below the Login Name display, enter the New Password in the text field.
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3. Click Reset Password. If you do not wish to change the password, click Close
instead of Reset Password.

Associate Workstation to Requester
You can also associate a workstation with the requester. To associate a workstation with the
requester
1. Click the Associate Workstation link available at the top right corner of the edit
requester form. The associate workstation window is opened.

2. In the Associate Workstation pop-up, select the workstations that you wish to
associate with the requester from the Workstation List and move them to the
Associated Workstations list by clicking the >> button. To dissociate workstations,
select the respective workstations in the Associated Workstations list and click the
<< button. If you wish to dissociate all the workstations, then click Dissociate All.
3. After associating the required workstations, click Save Changes.
4. A message is displayed. Click the Close button.

Delete Requesters
1. In the Requester List page, click the delete icon
wish to delete. A confirmation dialog is opened.

beside the requester's full name that you

2. Click OK to proceed with the deletion. If you do not want to delete the requester, then click
Cancel.

Search Requesters
To search requesters
1. In request list view, click on the alphabet with which the name of the requester starts. This
lists the requesters whose name starts with that alphabet.
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2. If you are unsure of the starting letter, then you can type the name (first name or the last
name, which ever you know) or email ID or any other parameter that will identify the requester
in the field beside the Search Requester List. This lists the requesters whose details
matches the search string that you entered.
You can also search requesters from the Search available on the left menu in the other pages of the
application. From the Search in combo box, select Requesters and type your search string in the
Enter Keyword text field. Click Go or press Enter. The requester names that match the search string
are listed in a separate pop-up window.
Another option to search requesters will be using the column-wise search option. To perform a
column-wise search
1. Click the search icon at the end of the requester list view headers. This opens the search
field just below every column that is visible in the list view.
2. Enter the search key in field under the column of your choice.
3. Click Go. The search results matching the search string(s) are displayed.

Requester List View Customization
To customize the requester list view
1. Click the column edit icon available at the corner of the requester list headers. This opens
the available columns that can be displayed in the list view. All those that are visible currently,
will have the check box beside them selected.
2. To remove a column, disable the check box beside the column name.
3. To add a column to the list view, enable the check box beside the column name.
4. To change the column order, click the up and down arrow after selecting the column that you
wish to move.
5. Click Save.
This will add only those columns which you have chosen in the list view. You can also sort the list
view based on columns. To sort requester list by column, click the column header. Clicking it once will
sort it in ascending order. Clicking twice will sort the column in descending order.
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User Groups
You can classify all the ServiceDesk Plus - MSP end-users (requesters) within your organization into
various User Groups. In Site based implementation, categorizing users into groups is especially
necessary to prevent users from accessing certain items. The users can be restricted to view certain
service items, solutions, announcements and request template.
NOTE: The User Groups are account based, and the account should be selected before adding the
User Group.
For instance, the announcement - Nortel network is down for a day due to maintenance in the site
New York. This announcement is vital for users in site New York alone. A user group is created such
that the announcement is available only to the users associated to site New York. The user group can
also be filtered based on Department, Email ID, Job Title and Name.
To access the user group configuration page,
1. Click Admin tab in the header pane to open the configuration page.
under Users block. The User Group list view page is displayed
2. Click User Groups icon
where you can add, edit and delete a user group.

Adding New User Group
1. Select the Account to which you want to add the User Group.
2. Click Add User Group link from the User Group list view page.
3. Specify a unique Name for the user group. Say, Sales Team in New York. This field is
mandatory.
4. Enter a short Description about this user group.
5. Set the Filter by selecting the Criteria and Condition from the drop down. Enter the value in
the text field.
You can also perform a search operation for the values using the search icon
listing the values for the selected criteria appears. Select a value click ok.

. A pop up
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6. To view the requesters under the specified criteria, click Preview button. The requesters list
appears in a pop up window.
and repeat the similar process. Choose to
7. To add another criteria, click the addition button
match All the conditions (And) or Any one of the condition (Or) from the drop down.
8. Click Save to save the user group and return to the list view. Click Save and Add New, to
save the user group and add another.
The configured User Groups appear while creating a new Service Item, solution,
announcement and request template.

Editing User Groups
1. From the User Groups list view page, click the edit icon
edit. The Edit User Group form appears.

beside the user group name to

2. Modify the Name and Description field.
3. You can also alter the existing filters set or add new filters using the criteria and condition
drop down.
4. Click Save, to save the user group and return to the list view. Even while editing, you can add
another user group by clicking Save and Add New button.

Deleting User Groups
1. From the User Groups list view page, enable the check box beside the user group to delete.
2. Click Delete button. A confirmation dialog appears.
3. Click OK to proceed. The User group is deleted from the list.
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Configuring Contract Billing
Contract Billing is used to set up the service contract that exists between the Service Provider and a
customer account. Once you setup a service plan, the contract billing page allows you to associate
the service plan to an account. Contract Billing also helps you capture details of the service contract
that you enter into with an account.
To open the Contract Billing configurations page,
1. Login to the ServiceDesk Plus - MSP application with admin username and password.
2. Click the Admin tab in the header pane.
3. In the Account Details block, click the Contract Billing icon
Billing page.

. This opens the Contract

Configuring Contract Billing for an Account
1. Select the account for which you want to configure contract from the drop down list.
2. Select the Service Plan from the drop down. This field is mandatory.
3. Select the Start Date and Expiry Date of the contract using the calender icon
fields are mandatory.

. These

4. You can notify the stakeholders through e-mail before the contract expires. Specify the
number of days before and after which the user has to be notified of the contract expiry in the
Notify before and Notify after fields respectively.
5. Specify the email address to which the notification has to be sent in the text box provided. To
customize the e-mail template, click E-mail Template link. This opens up the Message
Template form. Make the required changes in the Subject and Message text field. Click OK.
6. A notification can also be sent whenever the allowance threshold limit is reached by
specifying the limit in the Send notification after (%) field.
7. To attach any relevant file to the contract,
1. Click Attach File button in the Contract Attachments Details block. The Attach File
dialog pops up.
2. Click the Browse button and select the file to be attached from the file chooser
window and click the Open button.
3. Click Attach File. The selected file is listed below the Attachments heading along
with its size.
4. If you have more files to choose, follow steps 1 to 3 repeatedly till you have attached
all the relevant files. Please ensure that the maximum size of the attachment is 10
MB.
8. Select the Bill Date on which the bill needs to be generated from the drop down. This field is
mandatory.
9. Specify the Billing Email address to which the bill needs to be sent. This field is mandatory.
10. Specify the Currency (For example, USD or $) in the given text field. This will be displayed in
the bill during the bill generation. This field is mandatory.
11. Specify the Discount (%) in the given text field.
12. You can add and associate tax details that apply for the contract. Select the tax type from the
list of Available Tax Types and move it to the Associated Tax Types by clicking >> button.
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If you want to remove the tax type associated to the contract, then select the tax type from the
Associated Tax Type list and click << button. The selected tax type will be removed. You
can also add a new tax type by clicking the Add Tax Type button. The Add New Tax Type
dialog pops up. Enter the Tax Name and Tax Rate (%). Click Save.
13. Click Save to save the Account Contract details.
NOTE: The contract once created for an account cannot be deleted.

Viewing other Contracts
You can view the list of other contracts available for an account.
To view other contracts
1. Select an account for which you want to view other contract details from the drop down list.
2. Click View other contracts link available on the top right corner of the Contract Billing page.
This opens the Other contracts list view page.
3. In the Other contracts list view, you can click the Service Plan Name link to view the details of
the other contract.

Renewing Contract
You can renew a contract for an account once the active period has expired. The period (start and
expiry date) needs to be specified in order to renew the contract.
To renew a contract for an account,
1. From the Contract Billing page, select an account for which you want to renew contract from
the drop down list.
NOTE: If the selected account already has an active contract and if you try to modify this
contract, then the contract that is currently active will be terminated one day before the Start
Date mentioned in this contract.
2. Click Renew this contract link available on the top right corner of the Contract Billing page.
3. You can renew the contract with same service plan or you can select other Service Plan from
the drop down. This field is mandatory.
4. Select the Start Date and Expiry Date of the contract using the calender icon
fields are mandatory.

. These

5. You can notify the stakeholders through e-mail before the contract expires. Specify the
number of days before and after which the user has to be notified of the contract expiry in the
Notify before and Notify after fields respectively.
6. Specify the email address to which the notification has to be sent in the text box provided. To
customize the e-mail template, click E-mail Template link. This opens up the Message
Template form. Make the required changes in the Subject and Message text field. Click OK.
7. A notification can also be sent whenever the allowance threshold limit is reached by
specifying the limit in percentage in the Send notification after field.
8. To attach any relevant file to the contract,
1. Click Attach File button in the Contract Attachments Details block. The Attach File
dialog pops up.
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2. Click the Browse button and select the file to be attached from the file chooser
window and click the Open button.
3. Click Attach File. The selected file is listed below the Attachments heading along
with its size.
4. If you have more files to choose, follow steps 1 to 3 repeatedly till you have attached
all the relevant files. Please ensure that the maximum size of the attachment is 10
MB.
9. Select the Bill Date on which the bill needs to be generated from the drop down. This field is
mandatory.
10. Specify the Billing Email address to which the bill needs to be sent. This field is mandatory.
11. Specify the Currency (For example, USD or $) in the given text field. This will be displayed in
the bill during the bill generation. This field is mandatory.
12. Specify the Discount (%) in the given text field.
13. You can add and associate tax details that apply for the contract. Select the tax type from the
list of Available Tax Types and move it to the Associated Tax Types by clicking >> button.
If you want to remove the tax type associated to the contract, then select the tax type from the
Associated Tax Type list and click << button. The selected tax type will be removed. You
can also add a new tax type by clicking the Add Tax Type button. The Add New Tax Type
dialog pops up. Enter the Tax Name and Tax Rate (%). Click Save.
14. Click Save to save the Account Contract details.
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Problem/Change Management
Problem/Change Management
The goal of Problem Management is to find the root cause of incidents and reduce the impact on
business. The goal of Change Management is to control and manage approved changes with
accepted risk. ServiceDesk Plus - MSP allows you to implement a comprehensive problem
management and change management system. Problem/Change related configurations are:
1. Problem Additional Fields
2. Problem Closure Rules
3. Change Type
4. Change Status
5. Change Advisory Board
6. Change Additional Fields
7. Change Closure Rules
To access Problem/Change related configurations:
1. Log in to the ServiceDesk Plus - MSP application using the user name and password.

2. Click the Admin tab in the header pane. The problem/change management block is below the
Help Desk block.
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Problem Additional Fields
You have pre-defined fields by default in the New Problem form to enter the details about the
problem. If you need any additional fields in the New Problem form then, you can add your own
additional fields using this option. You can add text, numeric and date/time fields in the form.
To add your own custom fields in the New Problem form:
1. Login to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Problem - Additional Fields
. This opens the Problem - Additional Fields page. You can add three types of fields
icon
in the form: text, numeric and date/time.
4. To add the text fields, enter the label name in the form fields below the Label heading. If
required, enter the description for the field.
5. You can choose the type of text field that you wish to add by selecting the radio buttons.
o

A Single-line text field allows you to add just a text field.

o

The Multi-line text field allows you to add a text box where a lengthy description can
be added.

o

A Pick List allows you to add a list menu from which you can select. In all the three
cases, you can add default values for the text field in the space provided for the
same.

6. To add items for the pick list, enter the value in the text filed and click Add Item. To select the
default selected value of the list, click on the value in the list.
7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields
provided for the same.
8. To add date/time fields, click the Date/Time tab and enter the required details.
9. Click Save. A message for successful creation of the fields is displayed.
These fields appear under the grouping Additional Problem Details in the New Problem form. To
delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label
names that you wish to remove from the fields of the form and click Save. The respective fields that
you deleted will be removed from the New Problem form.
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Problem Closure Rules
Problem closing rules can be used to select the mandatory fields to be filled in by the technicians
while closing the problems and also includes optional rules that can be enabled by the technician on
closing the problem.
Example: If you have selected 'Associated Tasks should be closed' as a mandatory field in this
page, then the technician whoever resolving the problem, should close all the related tasks to a
problem and enter the details in the corresponding field before closing it. Else an error message pops
up, asking you to fill the details in the field. If you have selected the optional rules as, E-mail all
requesters affected by this problem and Close all associated incidents, on closing the problem a
pop up window listing the selected optional rules appears. Based on the incident the technician can
enable the check box corresponding to the optional rules.
To configure the problem closing rules,
1. Login to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Problem Closure Rules icon
This opens the Problem Closure Rules page.

.

4. Select the Mandatory Fields from the list to be filled in before closing the problem by
enabling the check box.
5. Select the Optional Rules by enabling the check box. The selected rules will get listed to the
technician on closing the problem. Based on the incident the technician can,
o

E-mail technician working on incidents associated with this problem : An e-mail
notification is sent to the concerned technicians working on the incident associated
with the problem.

o

E-mail all requesters affected by this problem : An e-mail notification is sent to all
requesters who have raised requests concerning the problem.

o

Copy problem solution and workaround to all associated incidents : The
solution to the problem and workaround is copied to all associated incidents.

o

Close all associated incidents : All the associated incidents is closed on resolving
the problem.

6. Save the details.
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Change Type
The change types shows the significant changes in the organization which involves cost and time. By
default you have four change types and Standard is a pre-defined change type hence cannot be
edited. And the Standard Change type is a pre-approved change type which will not require approval
from the change manager.
To add a new Change Type,
1. Login to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Types icon
the Change Type list page.

. This opens

4. Click on the New Change Type link. This opens the Add New page.
5. Specify the Name for the change Type in the given text field, say Significant. This is a
mandatory field.
6. Select the Colour by clicking the colour icon to indicate the severity of the change. This is a
mandatory field.
7. Specify the Description about the change type in the description field.
8. Save the changes. You can see the change type getting listed in the change type list view.
9. Click the Save and add new button to save the Change Type and add another Change Type.
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Change Status
Change Status shows the current state of the change in the organization. You have a list of default
change status. Rejected is a pre-defined change status hence cannot be deleted.
To Add New Status,
1. Login to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Status icon
the Status List page.

. This opens

4. Click on the New Status link on the right hand side of the page. This opens the Add Status
page.
5. Specify the Name of the status in the given text field.
6. Specify the Description about the status in the given text field.
7. Save the changes. You can see the new status getting listed in the status list page.
8. Click the Save and add new button to save the Change Status and add another Change
Status.
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Change Advisory Board
The Change Advisory Board (CAB) is a body that exists to approve changes and to assist Change
Management in the assessment and prioritisation of changes. The members of the CAB are selected
based on their expertise and capability to assess change adequately from business and technical
point of view.

Note:
1. The CABS are populated based on the logged in technicians associated
sites/accounts.

To add new a CAB,
1. Login to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Advisory Board icon
This opens the Change Advisory Board (CAB) page.

.

4. Select an Account and click New CAB button. This opens the Add CAB page.
5. Specify the Name of the CAB in the given text field.
6. Select the members of the CAB from the technicians list and move it to the members list
using >> button.
7. Specify the Description of the CAB in the description field and save the changes.

8. Click the Save and add new button to save the CAB and add another CAB.
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Change Additional Fields
You have pre-defined fields by default in the New Change form to enter the change details in the
form. If you need any additional fields in the New Change form then, you can add your own additional
fields using this option. You can add text, numeric and date/time fields in the form.
To add change additional fields,
1. Login to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane.
.

3. In the Problem/Change Management block, click the Change Additional Fields icon
This opens the Change Additional Fields page. You can add three types of fields in the
form: text, numeric and date/time.
4. To add the text fields, enter the label name in the form fields below the Label heading. If
required, enter the description for the field.
5. You can choose the type of text field to add by selecting the radio buttons.
o

A Single-line text field allows you to add just a text field.

o

The Multi-line text field allows you to add a text box where a lengthy description can
be added.

o

A Pick List allows you to add a list menu from which you can select. In all the three
cases, you can add default values for the text field in the space provided for the
same.

6. To add items for the pick list, enter the value in the text filed and click Add Item. To select the
default selected value of the list, click on the value in the list.
7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields
provided for the same.
8. To add date/time fields, click the Date/Time tab and enter the required details.
9. Click Save. A message for successful creation of the fields is displayed.
These fields appear under the grouping Additional Change Details in the New Change form. To
delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label
names that you wish to remove from the fields of the form and click Save. The respective fields that
you deleted will be removed from the New Change form.
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Change Closure Rules
Change closing rules can be used to select the mandatory fields to be filled in by the technicians
before closing the changes.
Example: If you have selected Impact as a mandatory field, then the technician whoever doing the
change, should enter all the impact details of the change before closing it. Else an error message
pops up, asking you to enter the details of the impact in the corresponding field.
To select the mandatory fields,
1. Login to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Closure Rules icon
This opens the Change Closure Rules page.

.

4. Select the mandatory fields for closing the change from the list by enabling the check box.
5. Save the details.
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Project Management
To access Project related configurations:
1. Log in to the ServiceDesk Plus - MSP application using the user name and password.
2. Click the Admin tab in the header pane. Project Configurations would be available in Project
Management block.
In this section, you learn about:
1. Setting Up a Project - Learn about projects, its members and their roles, with an example
project and sample member hierarchy diagram.
2. Configuring Project Types - Learn how to create new project types, assign a specific color,
change them to inactive status via this page.
3. Configuring Project Roles - Learn how to create new project roles, configure access
permissions and assign them to members via this page.
4. Configuring Project Status - Learn how to configure new project status, assign a specific
color, change them to inactive status via this page.

Setting Up a Project
Contents

•
•
•

What are Projects?
Project Members
Project Types and Project Status

Projects
Systematic approach to completing a Task can be termed as a Project. Creating a Work Breakdown
Structure (WBS), providing a crystal clear view of the "work in progress", through various stages
namely Milestones and Tasks, is the Project's ultimate objective. Setting up realistic goals, working
against a reasonable time schedule, with a multitude of members assigned to various roles
concentrating on different aspects of the "work in progress", are some of the features of project(s).
Anything from a simple "office shifting" to an IT project like "setting up a datacenter" can be
considered a project. The basic WBS of a Project is as follows: Milestones, Tasks and related Tasks.
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Let us take the example of "Setting up an IT Test Environment" and see how it is implemented with
projects. As stated earlier, a project can be divided into: Milestones, Tasks and related Tasks.
Superficially speaking, the basic WBS of the Test Environment would be like: Database
Configuration, Workstation Configuration and Network Configuration. These three major tasks
outlining the entire Project can be considered as Milestones.
Milestones, or major Tasks (mentioned above), would in turn require no. of actions to be carried out
for the Milestone to be completed. For example, the Milestone "Workstation Configuration" would
involve: deciding the "hardware/software required", "allocating hardware/software efficiently" (to
respective workstations), and so on. These actions under a Milestone are known as Tasks.

Sample IT Test Environment, along with its Milestones and Tasks, represented through a
project.

Project

Test Environment
SetUp

Milestone
Database
Configuration
Workstation
Configuration
Network
Configuration

Task 1
Organizing Data
Required
Choosing
Hardware/Software
Mail Server
Configuration

Task 2
Designing Data
Tables
Allocating
Hardware/Software
Establishing
Connection between
Workstations and Test
Machines
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The flow diagram for 'Test Environment Setup' project would be as follows:

Project Members
Project member is one to whom a part of the project is assigned. It could be a milestone, task or the
entire project itself. Based on the assigned role, the member would be provided with a set of access
permissions. For example, let's say, you have a deluge of tasks in your project and therefore need a
member to supervise the tasks alone, then you can define a role like Task Supervisor. In similar
manner, you could have members specific to Milestones as well.

Member roles available by default are:
•
•
•
•

Project Admin: Role that allows members to access/control entire project module (that
is,control over all available projects)
Project Manager: Role that allows members to access/control an entire project (add, edit
and delete Projects)
Team Leader: Role that allows members to access/control Milestones (add, edit and delete
Milestones)
Team Member: Role that allows members to access/control Tasks (add, edit and delete
Tasks)
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Sample Member Hierarchy Diagram

Project Types and Project Status
Specify project types and indicate the project status using Project Types and Project Status
respectively. For example: let's say yours is a business project, then such a project can be classified
as of the type 'business'. Similarly, Project Status is useful in indicating the project's progress rate
which plays a crucial part in letting project administrator/ manager decide what steps should be taken
further within to improve it.

Default Project
Types
Business
Infrastructure
Maintenance
Research

Default Project
Status
Open
Onhold
Closed
Canceled
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Configuring Project Types
Project Types classify projects based on the goals they are trying to meet.

To open the configuration page,
1. Click the Admin tab in the header pane.
2. Click on Project Types icon
under Project Management block. The Project Type List
page displays the available types. From this page, you can add, edit and delete project types.

Add Project Types
1.
2.
3.
4.

Click the Add New Project Type link.
Enter the Name of the project type. The name should be unique and is a mandatory field.
To render a project type inactive click Inactive check box.
Select the Color code to identify the project type by invoking the color palette. The selected
color should be unique for every type configured.
5. You can enter a short description about the type in the Description field.
6. Click Save. The type is displayed in the list view page. If you want to add another type, click
Save and Add New button.

Edit Product Type
1. Click the Edit icon
beside the type Name you wish to edit.
2. In the Edit Project Type form, you can edit the project type name and the description.
3. Click Save. At any point, if you wish to cancel the operation that you are performing, click
Cancel.

Delete Product Type
1. Click the Delete icon
beside the type Name you wish to delete. A confirmation dialog is
opened.
2. Click Ok to proceed with the delete operation. The Project Type is deleted from the list. If you
do not want to delete the project type, then click Cancel.
3. If you would like to bulk delete Project Types, select the types to be deleted from the list by
enabling the check box.
4. Click Delete button. A dialog box confirming the delete operation appears.
5. Click OK to proceed with the deletion.
If the project type is used in a project, the project type is not deleted, instead it is grayed (made
inactive) and will not be available for further usage.
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Configuring Project Roles
You can configure various Project roles with a unique set of access permissions which can be
assigned to Project Members.

To access Project Roles configuration page,
1. Click on the Admin tab in the header pane to open the configuration wizard page.
under Project Management block. The Project Role List
2. Click on Project Roles icon
page displays the available roles.
3. By default there are four project roles available, of which two are editable. The Project
Admin and Task Manager are non-editable roles.
o Project Admin would have full control over Project Module
o Team Manager would have permission to work on Tasks assigned to him.
4. You can add, edit and delete project roles from Project Role List page.

Adding a Project Role
1. Click the Add New Project Role link.
2. Enter a unique name for the role in Role Name field. The Role Name is to identify the role
and is a mandatory field.
3. If you would like to inactivate the project role, select Inactive check box. You can uncheck
this to activate the role again.
4. Enter the Description for the role you are adding.
5. Set the access permissions for the role. To set the access permission, just select the check
boxes beside the access levels defined.
NOTE: You can not uncheck Task View option as it is mandatory for a project role.
6. You can also use Project Member allowed to view radio button to set access permissions
for the project role. Based on the permissions configured the project member will be
associated with any one of the following: All Projects/Associated Projects/Associated
Milestones/ Associated Tasks (pointed out by Project Member allowed to view radio
button).
7. Click Save. The role is displayed in the list view page. If you want to add another role, click
Save and Add New button.
At any point, if you decide not to add the new role, then click Cancel to get back to the role list.

NOTE
Users/Requesters (when they are imported in ServiceDesk Plus - MSP) can be
assigned a default project role. These default project roles do not override
project specific roles; they serve as default options when no project role is
configured for the user/requester.
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Edit a Project Role
To edit an existing role,
1. In the Project Role List page, click the edit icon
beside the role name that you want to
edit.
2. In the Edit Project Role form, you can modify the name of the role, description, and the
permissions associated with the role.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are
performing, click Cancel.
While editing a role, if you wish to add a new role, then click Save and add new button.

Deleting Project Role
To delete a role,
1. In the Project Role List page, click the delete icon
beside the role name that you want to
delete. A dialog box confirming the delete operation appears.
2. Click OK to proceed with the deletion. If you do not want to delete the role, then click Cancel.
3. If you would like to bulk delete Project Roles, select the roles to be deleted from the list by
enabling the check box.
4. Click Delete button. A dialog box confirming the delete operation appears.
5. Click OK to proceed with the deletion.
If the project role is used in a project, the project role is not deleted, instead it is grayed (made
inactive) and will not be available for further usage.

Configuring Project Status
Project status denotes the level of progress of a project, based on which appropriate actions can be
taken. You can configure the status under the configuration page.

To open the configuration page,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under the Project Management block. The Status List
2. Click the Project Status icon
page is displayed. You can add, edit, or delete the request status.
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Add Status
1. Click Add New Project Status link.
2. Enter the name of the status in the Status name field.
3. Select the type to which the status belongs. The status type allows you to identify whether the
status that you are adding is still pending or completed.
4. To render a project status inactive click Inactive checkbox.
5. Select the Color code to identify the status by invoking the color palette. The selected color
should be unique for every status configured.
6. You can enter a short description about the status in the Status description field.
7. Click Save.

Edit Status
1. Click the Edit icon
beside the priority name you wish to edit.
2. In the Edit Project Status form, modify the required fields.
3. Click Save. At any point, if you wish to cancel the operation that you are performing, click
Cancel.

Delete Status
1. Click the Delete icon
beside the project status name you wish to delete. A confirmation
dialog appears.
2. Click Ok to proceed with the deletion. If you do not want to delete the status, then click
Cancel.
3. If you would like to bulk delete Project Status, select the statuses to be deleted from the list by
enabling the check box.
4. Click Delete button. A dialog box confirming the delete operation appears.
5. Click OK to proceed with the deletion.
If the project status is used in a project, the project status is not deleted, instead it is grayed (made
inactive) and will not be available for further usage.
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Discovery
Discovery - Scan Workstations and Other Network Devices
With ServiceDesk Plus - MSP you can scan all your windows domain, networks part of your
enterprise, Linux, MAC, Solaris, AIX machines and IP based IT assets. Also, you can set up audits for
scheduling periodic scanning and regular cleanup, scan assets in remote locations and perform
individual scan for newly added workstations.

Note

1. Please note that, only technicians with administrator privilege can perform and
configure a Scan.
2. ServiceDesk Plus currently supports scanning for the following OS - Linux, Solaris,
MAC, IBM-AIX and IP devices - Printers, Routers, Switches and Access Points.

Scanning Mechanisms
•

Windows Domain Scan
Scans all the Windows Workstations and Servers that are,
a. part of Windows domain
b. scanned using Active Directory, and
c.

part of Windows workgroup

You can also scan workstations using an Agent or Agentless mode (scans machines using
WMI).
•

Network Scan
Scan workstations and devices that are part of your network range. Network Scan supports,
a. OS workstations like, Linux, MAC, Solaris, IBM-AIX machines
b. Windows workgroup (workstations that are not part of any domain controller).
c.

•

IP devices like Printer, Router, Switches and Access Points.

Schedule Scan
Schedule scan at periodic intervals to scan domains and networks that are part of your
enterprise. Also, you can set re-scanning intervals to discover newly added workstations.

•

Distributed Asset Scan
For all your remotely located workstations that cannot be accessed by the Central SDP - MSP
server, a Remote SDP - MSP server is installed in each location which scans the workstation
information, and pushes the data to the Central server either manually or automatically.
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Agent Settings
Agent Mode
For a wide spread organization with a complex network infrastructure, the Agent based scanning is
most effective and provides easy deployment, more security and low bandwidth.
The application provides an agent, which can be deployed in the network workstations through
various methods. [Refer Methods of Agent Deployment]. Once the agent is deployed in the network
workstations, it scans all the workstations and provides easy access for remote assistance.

The following topics are discussed in this section:•

Agent Settings

•

Agent Configuration in ServiceDesk Plus application

•

Delta Scan

•

Pros and Cons of Agent mode

Agent Settings
Choose to scan all your Windows workstations in both, Agent and Agentless mode by selecting the
corresponding option from Agent Settings under the Admin tab. If you have enabled Agentless mode,
the Windows workstation and servers are scanned using WMI. If you have enabled both the modes,
the agent based scanning is performed and if that fails, the agentless scanning is performed.
Note
1. Windows is the only Supported Platform for Agent.
2. The Ports used in Agent based Scanning are TCP 9000.
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Agent Configurations
For a successful scan, the agent should communicate with the ServiceDesk Plus - MSP server. The
server details are configured under Agent Configurations. By default, the server in which the
application is installed is populated as the server details.

You can modify these configurations to create your own Agent Configurations.
•

Server Name: The server name or IP address of the computer where ServiceDesk Plus MSP is installed. The agent residing in the client computers communicates with the
ServiceDesk Plus - MSP server using this Server Name/IP address.

•

Server Port: The port configured for the application.

•

Protocol: The protocol used to communicate with the server.

•

Agent Port: The port number of the agent.

•

Scan at System Startup: On enabling this option, the agent scans the workstation on every
startup.

Click Create New Agent button. Clicking on Cancel takes you to the agent settings page.

Zoho Corporation Pvt. Ltd.
529

ManageEngine ServiceDesk Plus MSP – Admin Guide

NOTE:
a. You can also modify the configurations to create your own Agent Configurations.
b. If the agent is installed in all the Windows machines and if any of the below
circumstances occurs, the agent details can be updated using a script.
a.
ServiceDesk Plus - MSP application is moved from one server to another or if the AE
port or protocol (http or https) has been changed.
b.
If agent port needs to be changed in all the machines or enable/disable scanning on
system startup.
This script can be run as a logon script in the Active Directory or manually in each
machine to update the configurations in the agent. While executing the script, the
parameters should be in the format "-servername <AE server name> -port <AE port> protocol <http or https >".
Please contact our support team for the script.

Delta Scan
While performing a scan (Domain scan or Scheduling a scan) through Agent or Agentless mode,
some amount of data is obtained in the ServiceDesk Plus - MSP Server. The data obtained in the AE
Server through an Agent scan is comparatively minimal to that of Agentless. The agent transfers only
the changes ("delta") that occur between two subsequent scans to the server, and automatically strips
out any unchanged data, thus reducing the data transfer to 1 - 2kb instead of the usual 20 - 30kb.

Pros and Cons of Agent Mode
Agent based scan Pros:
1. Only one port is required during scan, which can be configured under Admin -> Agent settings
-> Agent Configuration -> Agent Port.
2. Performs scan on system boot up and pushes the data to AE application.
3. The data transfer in agent scan is very minimal compared to agentless scan and even more
less when compared to delta scan (difference in data between two subsequent scans is
fetched).
4. Quick access to the remote machine on performing Remote Control.
5. Easy to deploy agent through active directory.
6. Dependencies over DCOM and RPC settings are eliminated.
7. Once the agent is installed in all the machines, you can scan those machines from Linux
server.
Agent based scan Cons:
1. Agent should be upgraded if the version is changed. This can be performed from the Active
Directory.
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Methods of Agent Deployment
If you have enabled Agent Mode, you can deploy the agent in the Windows machine through any of
the methods given below,

Agent Deployment Methods
ServiceDesk Plus - MSP installed on Windows server:
1. Import from Active Directory logon script
2. ServiceDesk Plus - MSP Application
o

Bulk Deployment of Agent

o

Upgrading the Agent

o

Installing Agent in individual machine

3. Manual Installation of Agent
4. Installing Agent through PsExec utility
ServiceDesk Plus - MSP installed on Non-Windows server:
1. Import from Active Directory logon script
2. Manual Installation of Agent
3. Installing Agent through PsExec utility
4. Configuring Agent details using Orca editor

ServiceDesk Plus - MSP installed on Windows server
If ServiceDesk Plus - MSP is installed on a Windows server, then you can deploy the agent using the
following methods,
1. Import from Active Directory logon script
2. Deploying Agent from ServiceDesk Plus - MSP Application
3. Manual Installation of Agent
4. Installing Agent through PsExec utility

Method #1: Import from Active Directory logon script
An instant method to push the agent in all the Windows machine within a domain is through Active
Directory logon script. Instead of providing permission to all the scanned workstations for file transfer,
the agent is installed once the user logs into the machine. In addition, the agent can be deployed to all
the newly added workstations automatically on scheduling an AD Import.
To install the agent from Active Directory,
1. Create a network share like, \\MyServer\MyShare
2. Click Download Agent and run the agent.msi file.
3. Save the agent and the script in the network share.
4. In your Domain controller, click Start -> Administrative Tools -> Active Directory Users
and Computers.
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5. In the console tree, right click on your domain, and select Properties.

6. Select Group Policy tab, and click Open (New) button. The Group Policy Management
window pops up.
7. Right click on the name of domain or the Organizational unit for which you would like to
configure the script. Click Create and Link a GPO Here... option.
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8. Type a name for the new GPO say, AGENT DOWNLOAD and click Ok. The GPO is added to
the existing list.
9. Right click on the newly created GPO and click on Edit option.

10. In the new window go to the User Configuration -> Windows settings -> scripts -> double
click Logon.
11. In the new Logon Properties window click on Add. Now Browse and select the script
"\\MyServer\MyShare\InstallAgent.vbs". The script should be accessible by the target
workstations.
12. Specify the Script parameters as msi file name with path (eg.
\\MyServer\MyShare\ManageEngineAssetExplorerAgent.msi) and click Ok.
13. Close the Group Policy Window and click Ok.
14. Quit the Active Directory Users and Computer Window.
15. When the client computer starts the agent is automatically installed.
Note

1. The agent can be deployed to all the Windows Workstations and Servers within the
domain.
2. The agent is deployed when the user logs into the machine.

Method #2: Deploying the Agent from ServiceDesk Plus - MSP Application
Apart from Active Directory which involves deployment of agent in workstations of a particular domain,
you can deploy agents in workstations that are part of a network group or workgroup from the
ServiceDesk Plus - MSP application. You can choose to deploy the agent as a bulk or in individual
machines.
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Configurations essential to deploy the agent from the AE application
1. Scan the workstations using the Scanning Prerequisites.
2. After a successful scan, enable "File and Printer share" on executing the command
(given below) in the command prompt of the workstation to install the agent.
netsh firewall set service FILEANDPRINT

a. Bulk Deployment of Agent
1. From the Workstation Configuration page, click on Agent Details link. The
workstations for which the agent is not installed is listed.

2. Select the check box beside the workstations for which the agent should be installed.
3. Click Install Now. The agent is installed in the selected workstations.

b. Upgrading the Agent
In certain cases, the agent installed in the workstation may be of an older version. You can
upgrade to the latest agent version from the AE application,
1. Select Agent with older version from the Filter drop down.
2. Select the check box beside the workstations for which the agent should be
upgraded.
3. Click Upgrade.

c. Installing Agent in Individual machine
In credentials for Agent Installation page,
•

Name/IP: Enter the workstation name or the IP address of the workstation for which
the agent should be installed.

•

Login Credentials: Select the login credentials as either Global or Local. Global
credentials are common login permissions for all the assets. Local credentials are
private login permissions for an asset.

•

If you have enabled Local Credentials, specify the login credentials to your machine.

If you have enabled Global Credentials
•

Scan Type: Specify the scan type as Domain mode/Network mode under which the
workstation is configured.

•

Domain Name: Select the Domain name/network under which the workstation is
configured.

•

Login Name & Password: Specify the domain credentials.
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Method #3: Manual Installation of Agent
To download and install the agent as a service.
1. Click the Download Agent button.
2. Select the Account/Site for which you want to download the agent.
3. Run the ManageEngineServiceDesk PlusAgent.msi file. The ManageEngine Asset Explorer
Agent Setup Wizard appears.
4. Click Next >.
5. Choose the Installation folder name under which the Agent needs to be installed. By default,
the folder name is specified as C:\ManageEngine\ServiceDeskPlus-MSP directory.

If you want to change the installation directory, then, click the Browse button beside the
directory path. From the file chooser window, choose the directory of your choice and click Ok.
6. Click Next >.
7. The next step is Agent Configurations, if you have not yet configured the agent, you can
specify the server details and agent settings. Click Next >.
8. You also have an option to enable scan whenever the system starts up. Click Next to install
the agent.

Method #4: Installing Agent through PsExec Utility
You can install agents through PsExec utility in Windows Workgroup.
1. Download the PsTools.
2. Install the software in one of the Windows machine.
3. From the command prompt, go to the directory where the PsTools is installed.
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4. Execute the command as given below, to install the agent on each computer listed in the file.
psexec.exe @<file name> -u <domain name\user name> -p <password> msiexec /i <msi file
name>
For example:
psexec.exe @ComputersList.txt -u WORKGROUP\administrator -p password msiexec /i "\\aetest1\msi\ManageEngineAssetExplorerAgent.msi"

ServiceDesk Plus - MSP installed in Non - Windows Server
If ServiceDesk Plus - MSP is installed in a Non - Windows server say, Linux, you can still use the
Agent Mode to scan Windows machines. But, you can neither configure the Agent details from Agent
Settings page nor install and upgrade the agent from the Linux server.
Some of the methods through which you can configure and deploy the agents are,
1. Importing from Active Directory logon script

2. Installing Agent through PsExec utility

Method #1: Import from Active Directory logon script
To deploy the agent through Active Directory, use the logon script and provide additional parameters
as given below,
<agent with directory name> <server protocol> <server ip> <server name> <server port> <agent port>
For example:
\\server\share\ManageEngineAssetExplorerAgent.msi http 192.168.112.153 servicedesk 8080
9000
On entering the additional parameters, follow the steps as in Active Directory logon script.

Method #2: Installing Agent through PsExec Utility
You can install agents through PsExec utility in Windows Workgroup.
1. Download the PsTools.
2. Install the software in one of the Windows machine.
3. From the command prompt, go to the directory where the PsTools is installed.
4. Execute the command as given below, to install the agent on each computer listed in the file.
psexec.exe @ComputersList.txt -u administrator -p Zoho123SDP msiexec /i <msi file name>
SERVERIP=<server ip address> SERVERNAME=<servername> PROTOCOL=<http or
https> PORT=<port no> AGENTPORT=<agent port> SCANATBOOT=<0 or 1>
For example:
psexec.exe @ComputersList.txt -u WORKGROUP\administrator -p password msiexec /i
"\\Linux_Agent.msi" SERVERIP=199.1.1.1 SERVERNAME=servicedesk PROTOCOL=http
PORT=8080 AGENTPORT=9000 SCANATBOOT=1
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Configuring Agent details using Orca editor
To configure the agent details, you need to modify the .msi file using Orca editor and then proceed
with the installation. Once the parameters are configured, you can install the agent using Active
Directory logon script or through PsExec utility.
1. Download the Orca editor.
2. Install the editor in one of the Windows machine.
3. Download the agent from ServiceDesk Plus - MSP server and copy it to the Windows
machine having the Orca editor.
4. Right-click the .msi file and select Edit with Orca option. The Orca editor window pops-up,
listing all the tables on the left hand side.
5. Click Property table.
6. In the right panel, right-click and select Add Row option.
7. Enter the property as SERVERNAME and value as the name of the ServiceDesk Plus - MSP
server. Also, provide the following details,
PROPERTY
SERVERIP
PORT

VALUE
IP Address of the ServiceDesk Plus - MSP Server
Port No. of the ServiceDesk Plus - MSP Server

PROTOCOL

Protocol used by the server, whether it is http or https.

AGENTPORT

Port No. of the Agent. This port should be open in the
Windows machine to install the agent.

8. Save the provided details.
9. Close the editor and proceed with the installation.
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Windows Domain Scan
You can configure and scan all the available Windows Workstations and Servers in your domain
network using ManageEngine ServiceDesk Plus - MSP. When you set up the ServiceDesk Plus MSP application and start it for the first time, the application automatically discovers all the available
Windows domain in your network.

To discover workstations in a domain,
•

Select a Domain and enter the domain controller and login credentials for the domain
controller.

•

Select the Organizational Units (OUs) from the list.

•

The workstations in the OUs are retrieved, enumerated and scanned (ten workstations
are scanned simultaneously)

•

The machines in the specified domain then is Pinged.

•

If the machine responds to the ping, scan the inventories (hardware/software
information) in the machine using Agent or Agentless mode.

The Windows Domain Scan page can be access in two ways,
a. Quick Actions drop down
b. Admin Tab
Quick Actions drop down
The Quick Actions drop down is a quick navigator to instantly access the Domain List page.
Admin Tab
1. Click Admin tab in the header pane to open the configuration wizard page.
under Discovery. The Domain list view page opens
2. Click Windows Domain Scan icon
where you can add, edit, delete and scan a domain.

Add a New Domain
If you find that there are some domains that are missing in the list, then you can add those domains
manually.
1. Click Add New Domain link.
2. Enter the Domain Name. The name should be unique to identify the domain and is a
mandatory field. Say, Acme.
3. If you want the domains to be displayed in the login screen when Active directory
Authentication is enabled, select the check box beside Public Domain. Else un-check the
Public Domain check box to list the domain as Private Domain.
4. Enter the Domain Controller name for the Active Directory Server. The organizational units
are listed only if the domain controller name is provided.
5. Specify the Login Credentials for the domain controller in Username and Password fields.
6. If you wish to add any description for the domain, enter it in the Description text box.
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7. Click Save. The domain is listed in the domain list view page.
Click Save and Scan now button to save and scan the domain immediately. Clicking on Cancel
button takes you back to the list view.

For the workstation scan to execute successfully the following things need to be true:
Note

a. WMI should be enabled in the workstation where the Asset Explorer server is
running.
b. COM/DCOM service should be switched on in all the workstations belonging to the
windows domain.

Scanning a Domain
1. Click Scan Domain icon

of the domain to be scanned from the Domain list view page.

2. Choose the Organizational Units for which you want to import the workstations by enabling
the check box.
3. Select the Site to associate the scanned workstations from the Choose Site option. This
option is available only if the sites is specified
4. Click Start Scanning button to start the scanning process.
You will get the complete report of the scan listing the total number of scanned workstations,
successful scanned workstations and the number of failed workstation list.

Editing a Domain
1. Click Edit icon

beside the Domain Name you wish to edit.

2. In the Edit Domain form, you can modify the name of the domain, login name, password, and
description of the domain.
3. Click Save to save the changes performed. Click Save and Scan now button to save and
scan the domain immediately. At any point, if you wish to cancel the operation that you are
performing, click Cancel.

Deleting a Domain
1. Click Delete icon
beside the Domain Name you wish to delete. A dialog box confirming
the delete operation appears.
2. Click OK to proceed with the deletion. The domain gets deleted from the list. If you do not
wish to delete the domain, then click Cancel.
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Network Scan
With Network Scan you can discover all the Linux, Solaris, MAC, IBM-AIX machines and devices
such as Printers, Routers, Switches and Access Points that are part of your network. In addition,
you can also scan Windows machines and Workgroup (Windows machines that are not part of a
domain), and VMWare Host machines.
To discover workstations in a network,
•

Enter the Network Range to scan.

•

The workstations and devices in the network are retrieved, enumerated and scanned
(ten workstations are scanned simultaneously)

•

The machines in the specified range is Pinged.

•

If the machine responds to the ping, scan the inventories (hardware/software
information) in the machine. Use SSH or Telnet for Linux, Solaris, MAC, IBM-AIX
machines, SNMP for Printers, Routers, Switches and Access Points, WMI for windows
machines.

The Network Scan page can be accessed by two ways in ServiceDesk Plus - MSP application,
a. Quick Actions drop down menu
b. Admin Tab
Quick Actions drop down menu
The Quick Actions drop down menu is a quick navigator to instantly access the Network Scan page.
From the Quick Actions drop down select Network Scan option.
Admin Tab
1. Click the Admin tab in the header pane to open the configuration wizard page.
2. Click Network Scan icon
under Discovery block. The Network list view page opens
where you can add, edit, delete and scan a network.
Ports and Credentials to scan machines using Network Scan
•

Linux, MAC, Solaris, IBM-AIX
Communication Protocol: Telnet or SSH
Login Credentials: Telnet Credentials
Port for Telnet: 23
Port for SSH: 22

•

Printers, Routers, Switches, Access Points
Communication Protocol: SNMP + SSH ( devices are identified and fetched using
SNMP. If SSH credentials is provided, additional information on routers and switches can
be fetched)
Port for SNMP: 161
Port for SSH: 22

•

Windows Machines
Communication Protocol: WMI or Agent
Login Credentials: Credentials of the domain controller
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Add New Network
Linux, MAC, Solaris, IBM-AIX
1. Click Add New Network link.
2. Enter the Network Address. You can either scan the Entire Network say, all workstations
under 192.168.27.0 or particular Range of Network say 192.168.27.0 to 192.168.27.30 by
clicking the corresponding options.
3. Select the Protocol say, SSH or Telnet.
4. If license software are installed in Linux and Solaris machines, enable Scan Software in
Linux and Solaris workstations check box.
5. If you have enabled SSH, enter the SSH login credentials. If you have enabled Telnet, enter
Telnet Credentials in the Login Name and Password fields.
6. Provide any relevant information pertaining to the network details in the Description field.
7. Click Save. Click Save and Scan now, to save and scan the workstations in the specified
range.
Printers, Routers, Switches and Access Points
1. Click Add New Network link.
2. Enter the Network Address. You can either scan the Entire Network say, all workstations
under 192.168.27.0 or particular Range of Network say 192.168.27.0 to 192.168.27.30 by
clicking the corresponding options.
3. If the Protocol is SSH, enable the corresponding radio button.
4. If SSH is enabled, enter the SSH Login Credentials which provides additional information on
routers and switches.
5. For SNMP discovery of network devices enter the Community String.
SNMP is used for identification of printers, routers, switches and access points. In case of
printers the complete inventory is being fetched using SNMP. In case of routers and switches
basic inventory is being fetched using SNMP and a more detailed inventory is done using
SSH or telnet (if credentials are provided).
6. Provide any relevant information pertaining to the network details in the Description field.
7. Click Save. Click Save and Scan now, to save and scan the devices in the specified range.
Windows Machine
1. Click Add New Network link.
2. Enter the Network Address. You can either scan the Entire Network say, all workstations
under 192.168.27.0 or particular Range of Network say 192.168.27.0 to 192.168.27.30 by
clicking the corresponding options.
3. Enter the Login Credentials of the domain controller in the Login Name and Password
fields. The login Name should be provided as <DOMAIN_NAME>/<USER_NAME>. For
instance, ACME/administrator
4. Provide any relevant information pertaining to the network details in the Description field.
5. Click Save. Click Save and Scan now, to save and scan the workstations in the specified
range.
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Scan Domain
1. From the Network List View page, click Scan Network icon

.

2. If your organization is distributed across various sites, select the Site to which the
workstations/devices are associated.
3. Click Start Scanning. Once scanned, you will get the complete report on the success and
failed workstations of the scan.

Edit Network
1. From the Network List View page, click the Edit icon

of the network to be edited.

2. Edit the network details and Save the changes. Click Save and Scan now, to save and scan
the workstations in the specified range

Delete Network
1. From the Network List View page, click the Delete icon
dialog box confirming the delete operation appears.

beside the network to delete.A

2. Click OK to continue. The network is deleted from the list.
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Audit Settings
Audit settings help you to schedule periodic scanning of your network and enable regular cleanup of
scanned information and set re-scanning interval for scanning workstation.

Enable Scheduled Scan
1. Click on Admin Tab -> Click Audit Settings icon
This opens Audit Settings form.

in the configuration wizard page.

2. Select Enable Scheduled Scan check box to configure regular scanning of the
workstations.
3. Set the Date and Time (hours & minutes) for scanning of workstations.
Select any of the 5 radio buttons below the Enable Scheduled Scan sub-heading
explained below:
Scan Once
Select the date on which you want to scan your network using the calendar icon. And
set the time to scan on the chosen date.
Daily Scan
Select the time (hours and minutes) from the combo box to scan workstations on a daily
basis. Then select the date from the calendar button to schedule scans.
Weekly Scan
In the weekly scan option, you can also choose to schedule a daily scan. Select
Everyday checkbox to enable scan on all the days of the week. Or select the check box
beside a particular day of the week. Then set the time (hours and minutes) of the scan
to start the scanning process on the selected day of the week.
Monthly Scan
In the monthly scan option select the check box Every Month to scan every month
throughout the year. Or you can also choose the months you want to scan by selecting
the check box beside the name of the months.
In the monthly scan option you can also choose to schedule a weekly scan by selecting
the radio button Day, and specifying the scanning day of the week from the combo box.
Or select the Date radio button and specify the date from the combo box.
Finally select the time (hours and minutes) of the scan.
Periodic Scan
You can enter a random period of time to repeat the scan. Enter the number in the field
provided. The scan will be performed on every specified nth day. Where n is the number
you enter in the field. The default value is 7th day.
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History Clean up
You can enable regular cleanup of scanned information, by selecting the Enable Scan
History Clean up check box and enter the number of days in the field provided for
deleting the scanned information.

Newly Added workstations
You can also check for newly added workstations by performing a re-scan of your network.
For this you need to select Check for newly added workstations check box and enter the
number of days when the periodic re-scanning of your network will be performed.
Once the details are specified save the changes. Click Reset button to reorganize the
settings.
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Distributed Asset Scan
If you account has offices across the globe, then the ServiceDesk Plus - MSP server may not be able
to access all the assets in sites. Hence, a Remote AE server is installed in each site which scans and
maintains all the workstations, and user information of the respective sites. The data from the Remote
AE Server is pushed to the ServiceDesk Plus - MSP Server either manually or by scheduling the data
periodically.
Since there is a constant need to update the users and workstation information in the ServiceDesk
Plus - MSP Server, you can automate the process by specifying the central server details in the
remote server thereby synchronizing the two servers.

Methods to perform Distributed Asset Scan
Manual
1. Extract the data in a zip format from the Remote AE server and export it to the SDP MSP server.
2. Import this zip file into the SDP - MSP Server.
Auto Synchronization
1. Configure the SDP - MSP Server details in Central Server Settings.
2. Select Export and Push data to Central Server now button. The data is automatically
pushed to the SDP - MSP server provided the server is reachable.
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Asset Scan in Remote AE Server
The scanned information in the Remote AE Server can be updated periodically either manually or
automatically to the SDP - MSP Server.
Installing the Remote AE Server
You can install AssetExplorer as a Remote Server by choosing the server type as Remote AE Server
on starting the application for the first time. The application gets started as the Remote AE Server.

Accessing the Configuration
1. Click the Admin tab in the header pane.
2. Click Distributed Asset Scan

icon under Discovery block.

Methods to export the data
The data can be exported manually or pushed automatically in the SDP - MSP Server.
Manual
1. Click Export Data to export the asset data into a zip file.
2. A confirmation message appears. Click OK to proceed.
3. If the data has been generated successfully, an Export Data box pops up.
4. Click on the link to download the zip.
5. Send the zip file to the central server location through E-mail or through some storage device.
Auto Synchronization
If the central server is reachable, configure the details of the SDP - MSP Server by clicking on Central
Server Settings.
•

Server Name: Enter the Server Name or IP Address of the SDP - MSP Server.

•

Server Port: The port where the SDP - MSP Server is installed.
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•

Server Protocol: The protocol to connect the SDP - MSP server and the remote server. Say,
Http, Https

•

Site: Site where the Remote AE Server is installed. The site specified must be configured in
the SDP - MSP server so that the assets and users is associated to the appropriate site.

•

Username & Password: Credentials of the SDP - MSP Server.

•

Domain Name: Specify Domain Name if Active Directory authentication is enabled in SDP MSP Server.

The Central Server may be connected through a proxy server. In this case,
•

Enable Is connected through Proxy Server check box.

•

Proxy Server Name: The Server Name or IP Address of the Proxy server.

•

Proxy Server Port: The port of the proxy server.

•

Proxy Username & Password: Credentials of the Proxy Server.

On configuring the Central Server Settings, you can export and push the data to central server
automatically by clicking on Export and Push Data to Central Server Now button. The executed
date, status of the operation and related comments is displayed in the List View.
Schedule Pushing of data to SDP - MSP Server
You can schedule to push the data from the remote AE server to the SDP - MSP Server at periodic
intervals.
1. Click Schedule to synchronize data with Central Server link.
2. Select Enable radio button.
3. Select the number of days after which the data should be pushed to the central server.
4. Select the date from the calendar icon to start the process. Also select the Time in hours and
minutes from the drop down.
5. If there is a failure in pushing the data to the central server, you can send a Notify to the
technician. Specify the email address in the text provided.

Importing data into SDP - MSP Server
Accessing the Configuration
1. Click the Admin tab in the header pane.
2. Click Distributed Asset Scan icon

under Discovery block.

3. Click Browse and locate the zip file of the scanned assets.
4. Select the Site of the remote server from the drop down.
5. Click Import button to import the data. On importing the data successfully you get a success
message.
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General Settings
In General Settings, you can configure Invalid Service Tags, provide option for MAC address
identification during scan, and for OIDs with unknown type; option to specify the product type and
product name.

Configure Invalid Service Tags
While performing a scan, the Workstations and Servers are uniquely identified based on its Service
Tags, Name and MAC address. So when the service tags are not incorrectly configured by the OEM,
many machines would result in similar service tags. In such cases, if a scan is performed, one
workstation details would be overwritten by the other. To avoid this, you can add the service tag under
Invalid Service Tag list such that, the workstations with the service tag is ignored during a scan.

Enable/Disable MAC address identification during scan
Machines connected through VPN or VMware have similar MAC address. So while performing a scan
in similar network environment, one machine is overwritten by the other. Hence you can uniquely
identify the MAC address by enabling/disabling the radio button.

OIDs with Unknown Type
While performing a scan, the routers, switches, printers and access point in the network generate an
OID which uniquely denotes the assets. If the OID of the asset is not available in the database, a new
entry is populated from where you can choose the product type and specify the product name.
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Asset Management
Asset Management
The inventory module of the ServiceDesk Plus - MSP application enables you to keep track of the
various assets available for the Account and their corresponding usage and availability. It also helps
you monitor the assets online in any of the networks. This helps you in proactively planning the
resource allocation and purchases. Before you start using the inventory module, you have to
configure the inventory-related information. The inventory-related configurations are:
1. Product Types details
2. Products
3. Vendors information
4. Workstation - Additional Field
5. Asset Additional Field for new asset form
6. Resource State
To access the inventory-related configurations:
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane. The Asset Management block is just below the
Account Details block.
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Configuring Product Types
Each product purchased by an Account can be categorized into a specific product type. This is the
high-level categorization for the assets that are bought. For example, Adobe Photoshop or
Macromedia Flash can be categorized under the product type Software, while HP Inkjet Printer can be
categorized under the product type Printer. In general, product type is a parent category under which
you can group each of the specific assets owned by the Account. Proper categorization helps in
estimating how much has been spent for purchasing each of the product type assets (Printer,
Scanners, etc.), how much assets in each of the product types are available in the Account
organization and so on.

To open the product type configuration page:
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Asset Management block, click the Product Types icon . The next page displays
the available list of product types. You can add, edit, or delete product types.

Add Product Types
To add product types:
1. In the Product Types List page, click Add New Product Type link available at the top right
corner.
2. In the Add Product Type form, enter the Product Type Name. This name needs to be
unique and this field cannot be blank.
3. If required, add relevant Description for the product type.
4. Click Save.
If you want to add more than one product type, then instead of clicking Save, click Save and add new
button. This adds the new product type and reopens the add product type form after displaying a
message that the a new product type is added.
At any point, if you decide not to add the new product type, then click Cancel to get back to the
product type list. Clicking the View List link on the top right corner of the add product type form will
also take you to the product type list view.

Edit Product Type
To edit an existing product type:
1. In the Product Types List page, click the edit icon
you wish to edit.

beside the Product Type Name that

2. In the Edit Product Type form, you can edit the product type name and the description.
3. Click Save. At any point, if you wish to cancel the operation that you are performing, click
Cancel.
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Even while editing a product type, if you wish to add new product type, then click Save and add new
button instead of clicking Save button after making the changes.

Delete Product Types
To delete a product type:
1. In the Product Types List page, click the delete icon
you wish to delete. A confirmation dialog is opened.

beside the Product Type Name that

2. Click OK to proceed with the deletion. If you do not want to delete the product type, then click
Cancel.
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Configuring Products
The specific asset types are termed as products. For example, Dell Lattitude D600 is a product
representing Dell Laptops. These products need to be added in the application so that they can be
used while referencing from the various modules of the application, such as Inventory and Purchase.
As and when you purchase any specific product belonging to a new asset type, you need to add the
new product. Also, if a product needs to be discarded you can also remove it from the list by deleting
the details of the same.
To open the product configuration page:
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Asset Management block, click the Products icon . The next page displays the
available list of products. You can add, edit, or delete product.

Add Product
To add products:
1. In the Product List page, click Add New Product link available at the top right corner.
2. In the Add Product form, enter the Product Name. This field cannot be blank.
3. If you know the manufacturer of the product, enter the same in the Manufacturer field.
4. From the Product Type combo box choose the product type under which you wish to classify
the product that you are adding.
5. Enter the Part No. of the product.
6. If required, add relevant Comments for the product.
7. Click Save. A message is displayed and the product is added. Simultaneously, a Vendors tab
is also added. This tab is to give a vendor association to the product.
8. Click the Vendor tab.
9. Click the Associate Vendor button to associate vendor with the product. This opens the
Associate Vendor page.
10. In the Associate Vendor form, choose the vendor name from the combo box provided and
enter the price of the product. These are the two fields that are mandatory.
11. If you know the warranty period of the product, enter it in the Warranty Period by choosing
the number of years and months from the combo box.
12. Choose the maintenance vendor.
13. If you wish to add any comments, add it in the Comments text box.
14. Click Save to save the details. The page is refreshed to display the vendor association
information. Repeat the steps 9 - 14, till you have added all the vendors who supply this
product.
If you do not wish to associate the vendor now, then click Cancel. It goes back to the Product Details
tab.
If you wish to add more than one product, then in step 7, instead of clicking Save, click Save and add
new button. This would add the product and open the add product form for you to add more
products. In this case, the product vendor association needs to be done later. To get back to the
product list page without adding the product or after completing the vendor product association, click
View List link at the top right corner of the Add Product form.
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Edit Product
If you have added the product without associating the vendor with the product, then you will have to
associate the vendor by editing the product information.
To edit the product information:
1. Click the edit icon

beside Product Name in the Product List page.

2. In the Edit Product form, you can edit all the form fields mentioned in the add product
procedure.
3. Click the Vendor tab and click the Associate Vendor button.
4. Edit the required fields and click the Add button.
Even while editing the product information, if you wish to see the product list page, click the View List
link at the top right corner of the Edit Product form. Also if you want to add a new product, then in the
product details tab, click Save and add new button.

Delete Product
To delete a product, it is necessary that the product vendor association is first removed and then the
product is deleted. Also ensure that the particular product is not used elsewhere. Follow the steps
below to delete a product:
1. In the Product List page, click the edit icon

beside Product Name.

2. Click the Vendors tab.
3. Click the delete icon

beside the Vendors. A confirmation dialog is opened.

4. Click OK to proceed with the deletion. Delete all the vendor associations of the product.
5. Click view list link on the top right corner of the center pane.
6. Now, click the delete icon beside the Product Name for which you removed the vendor
association. A confirmation dialog is opened.
7. Click OK to proceed with the deletion. If you do not wish to delete the product, click Cancel.

Zoho Corporation Pvt. Ltd.
553

ManageEngine ServiceDesk Plus MSP – Admin Guide

Configuring Vendors
An Account organization can have business contacts with more than one vendor for buying the
various resources of the Account. It is very essential for the firm to keep track of its vendors and the
products supplied by these vendors. To configure these details, you can use the configuring vendors
option available in the admin page.
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of an
admin user.
2. Click the Admin tab in the header pane.
3. In the Asset Management block, click the Vendors icon
vendors.

. You can add, edit, or delete

Add Vendors
To add vendors:
1. In the Vendor List page, click Add New Vendor link available at the top right corner.
2. In the Add Vendor form, enter the Vendor Name. This name needs to be unique and this
field cannot be blank. All the other fields are optional.
3. Enter relevant Description for the vendor.
4. Enter the Contact Name at the vendor location.
5. Enter the address details of the vendor in the respective fields.
6. Enter the vendor e-mail ID, phone, fax, and web URL.
7. Click Save. A message is displayed and the vendor is added. Simultaneously, a Products
tab is also added. This tab is for adding the list of products that are supplied by the vendor.
8. Click the Products tab.
9. Click Associate Product button.
10. In the associate product form, choose the product name from the combo box and enter the
price of the product. These are the two fields that are mandatory.
11. If you know the warranty period of the product, enter it in the Warranty Period by choosing
the number of years and months from the combo box.
12. Choose the maintenance vendor from the combo box.
13. If you wish to add any comments, add it in the Comments text box.
14. Click Add. The page is refreshed to display the product association information. Repeat the
steps 9 - 14, till you have added all the products supplied by this vendor.
If you do not wish to add the product list after opening the associate product form, then click Cancel.
It goes back to the Vendor Details tab.
If you wish to add more than one vendor, then in step 7, instead of clicking Save, click Save and add
new button. This would add the vendor and open the add vendor form for you to add more vendors.
In this case, the product list needs to be added later. To get back to the vendor list page without
adding the vendor or after adding the list of product supplied by the vendor, click View List link at the
top right corner of the Add Vendor form.
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Edit Vendor
If you have added the vendor without adding the product list, then you have to add the list of product
supplied by the vendor only by editing the vendor information.
To edit the vendor information:
1. Click the edit icon

beside Vendor Name in the Vendor List page.

2. In the Edit Vendor form, you can edit all the form fields mentioned in the add vendor
procedure.
3. Click the Products tab to add the list of products supplied by the vendor and follow the steps
9 through 14 in add vendors.
Even while editing the vendor information, if you wish to see the vendor list page, click the View List
link at the top right corner of the Edit Vendor form. Also if you want to add a new vendor, then in the
vendor details tab, click the Save and add new button.

Delete Vendors
To delete a vendor, it is necessary that the product vendor association is first removed and then the
vendor is deleted. Also ensure that the particular vendor is not used elsewhere. Follow the steps
below to delete a vendor:
1. In the Vendor List page, click the edit icon

beside Vendor Name.

2. Click the Products tab.
3. Click the delete icon

beside the Products. A confirmation dialog is opened.

4. Click OK to proceed with the deletion. Delete all the products listed.
5. Click view list link on the top right corner of the center pane.
6. Now, click the delete icon beside the Vendor Name for which you removed the product list.
A confirmation dialog is opened.
7. Click OK to proceed with the deletion. If you do not wish to delete the vendor, click Cancel.
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Workstation Additional Fields
You can define your own specific fields that need to appear in the new workstation form apart from the
default fields. You can add text fields, numeric fields, and date/time type fields in the form.

Adding Workstation Additional Fields
Configuring Additional Text fields
in
1. Click on Admin tab -> Click Workstation Additional Fields icon
the Configuration Wizard page. This opens Workstation – Additional
Fields page. You can configure 12 additional text fields for a
workstation.
2. By default the list of all additional text fields are displayed. Specify
the Label for the Workstation Additional Fields.
3. Specify any relevant information about the additional fields in the
Description text field.
4. Specify the Type of the text field by enabling the radio button. It can
be either Single- Line, Multi – Line or drop down menu list.
5. Specify the Default Values in the given text field.
6. Click Save to save the settings.
Configuring Additional Numeric fields
1. Click on the Numeric tab. You can configure 4 additional numeric
fields for a workstation.
2. Specify the Label for the additional field. This is a mandatory field.
3. Specify any relevant information about the additional fields in the
Description text field.
4. Click Save to save the settings.
Configuring Additional Date/Time fields
1. Click on the Date/Time tab. You can configure 4 additional fields for a
workstation.
2. Specify the Label for the additional field. This is a mandatory field.
3. Specify any relevant information about the additional fields in the
Description text fields.
4. Click Save to save the settings.
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Asset Additional Fields
You can define your own organization specific fields that need to appear in the new asset form apart
from the default fields. You can add text fields, numeric fields, and date/time type fields in the form.

Adding Asset Additional Fields
Configuring Additional Text fields
1. Click on Admin tab -> Click Assets Additional Fields icon
in the Configuration Wizard
page. This opens Assets – Additional Fields page. You can configure 12 additional text fields
for an asset.
2. By default the list of all additional text fields are displayed. Specify the Label for the asset
additional fields.
3. Specify any relevant information about the additional fields in the Description field.
4. Specify the Type of the text field by enabling the radio button. It can be either Single- Line,
Multi – Line or drop down menu list.
5. Specify the Default Values in the given text field.
6. Click Save to save the settings.
Configuring Additional Numeric fields
1. Click on the Numeric tab. You can configure 4 additional numeric fields for an asset.
2. Specify the Label for the additional field. This is a mandatory field.
3. Specify any relevant information for the additional fields in the Description field.
4. Click Save to save the settings.
Configuring Additional Date/Time fields
1. Click on Date/Time tab. You can configure 4 additional fields for an asset.
2. Specify the Label for the additional field. This is mandatory field.
3. Specify any relevant information for the additional fields in the Description field.
4. Click Save to save the settings.
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Adding Resource State
Resource can be categorized based on its current status in the organization. Ex: Resource In Use, In
Store, Expired and so on.
To Add New Resource State,
1. Click the Admin tab in the header pane. This opens the Configuration Wizard page.
2. Under the Asset Management block click the Resource State icon
Resource State list page.

. This opens the

3. Click the New Resource State link on the right hand side of the page. This opens the
Resource Sate Details page. By default you have five resource state available in
ServiceDesk Plus - MSP. You cannot edit or delete the resource state.
4. Specify the Resource Sate name in the given text field. This is a mandatory field.
5. Specify any relevant information about the resource state in the Description field.
6. Click Add Resource State button to add the resource to the application.

Zoho Corporation Pvt. Ltd.
558

ManageEngine ServiceDesk Plus MSP – Admin Guide

Software Management
Software
Software helps you to configure all the software related tasks such as Software Type, Software
Category, Software License Types and Additional fields for software license and license agreement.

•

Software Type

•

Software Category

•

License Additional Fields

•

Software License Types

•

Agreement Additional Fields

•

Import License (s) from CSV
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Configuring Software Type
All different forms of software such as, licensed, prohibited, freeware, shareware, excluded and unidentified software comes under this category.
To access the Software Type configuration page,
1. Click the Admin tab in the header pane. This opens the Configuration Wizard page.
under the Software block. This opens the Software Type
2. Click the Software Type icon
list view page. By default there are six software types that cannot be edited nor deleted.
o

Shareware: Software that is available free of charge, may be distributed for
evaluation with a fee requested for additional features or a manual etc.

o

Freeware: Software that is provided without charge.

o

Prohibited: Software that is prevented from use.

o

Excluded: Software that is omitted from use.

o

Managed: All licensed software comes under this software type.

o

Un-Identified: Unknown software can be categorized under this software type.

Adding New Software Type
1. Click the New Software Type link. This opens the Software Type Details page.
2. Specify the Software Type name in the given text field. This is a mandatory field which will
uniquely identify individual software type.
3. Specify any relevant information about the Software Type in the description field.
4. Click Add Software Type button. This adds the software type to ServiceDesk Plus and gets
displayed below the add software form.

Editing Software Type
1. From the Software Type list view page, click the Edit icon

beside the software type to edit.

2. Modify the necessary changes.
3. Click Update Software Type button.

Deleting Software Type
1. From the Software Type list view page, click the Delete icon
delete. A dialog box confirming the delete operation appears.

beside the software type to

2. Click OK to proceed. The software type is deleted from the list.
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Software Category
The software available in the application are organized by grouping them into specific Software
Categories. Some of the default software categories available in the application are Accounting,
Internet, Graphics, Multimedia, Operating System, Game and much more.
To access the software category configuration wizard,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under Software block. The Software Category list view
2. Click Software Category icon
page opens. From this page, you can add, edit and delete a software category.
By default, there are nine software categories listed in the application. These software categories can
neither be edited nor deleted.

Adding Software Category
1. Click New Software Category link.
2. Specify a unique name for the Software Category in the provided field. The Software
Category is a mandatory field.
3. Specify any relevant information about the category in the Description field.
4. Click Add Software Category button to add the software category to the list. Click Cancel to
go back to the list view. The added software categories are displayed while adding a new
software.

Editing Software Category
1. Click the Edit icon

beside the software category to edit.

2. Modify the Software Category name and Description fields.
3. Click Update Software Category to update the changes.

Deleting Software Category
1. Click the Delete icon
beside the software category to delete. A dialog box confirming the
delete operation appears.
2. Click OK to proceed. The software category is deleted from the list.
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License - Additional Fields
If you require any further additional information while adding the software license details, apart from
the pre-set fields in the Add software licenses form you can configure them under License - Additional
Fields. You can add text fields, numeric fields, date type fields and Cost fields as the additional
fields in the form.
To add license - additional fields,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under Software block. The License Additional
2. Click License - Additional Fields icon
page opens to view the following tabs namely, Text, Numeric, Date/Time and Cost. You can
add up to twelve text and cost fields, and four numeric and date/time fields.
Configuring Additional Text fields
1. By default, the Text tab is selected. Specify the Label for the Additional field.
2. Specify any relevant information about the additional field in the Description text field.
3. Select the Type of the text field by enabling the radio button. It can be either Single-Line,
Multi-Line or Pick List (drop down list).
4. You can also specify default values to be pre-filled in the software license form.
5. Save the settings.
Configuring Additional Numeric fields
1. Click the Numeric tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text field.
4. Save the settings.
Configuring Additional Date/Time fields
1. Click the Date/Time tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text fields.
4. Click Save to save the settings.
Configuring Cost fields
1. Click the Cost tab.
2. Specify the Label for the Additional field.
3. Specify any relevant information about the additional field in the Description text field.
4. You have two cost type fields, Add cost (for cost addition) and Subtract cost (for cost
subtraction). Click the corresponding radio button to select the cost fields and also specify the
Default values to be pre-filled in the software license form.
These additional fields will appear while adding a software license under the Additional Information
block. To delete a user-defined fields, instead of adding the label names, delete the existing label
names you wish to remove from the fields of the form and click Save. The fields are automatically
removed from the Software License form.
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Software License Types
Every software manufacturing company has their unique software license type apart from the several
common license types. Since it is not feasible to support all these license types, ServiceDesk Plus
helps you customize the license types for all software manufacturers based on the workstations and
users.
To access the Software License Types configuration page,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under Software block. The list of default license
2. Click Software License Types icon
types filtered by the manufacturer is displayed.
o

Individual: License type for single installation

o

OEM (Original Equipment Manufacturers): License type for software that is already
installed in the hardware.

o

Named User License: License Type for a specific user.

o

Volume: License Type supporting multiple users.

o

Client Access License (CAL): License type that gives a user the rights to access
the services of the server.

o

Trial License: License Type for trial versions of software.

o

Enterprise (Perpetual): License Type that does not require renewal and is for life
long.

o

Concurrent License: License Type for software that can be accessed by a specific
number of users at a time.

o

Free License: License Type for freeware software.

o

Enterprise Subscription: License Type that requires renewal for every specific
period.

o

Node Locked: License Type for workstations with specific configurations.

Apart from the default license types available in the application, you can add, edit and delete Software
License Types.

Adding New License Type
1. Click Add New License Type link.
2. Enter the License Type say Volume, Enterprise, Standard and so on. In general, each
manufacturer depicts their license types uniquely and so the license type needs to be
specified accordingly to the manufacturer. This field is mandatory.
3. Select the software Manufacturer from the drop down. If required, you can also add a new
icon.
manufacturer using the Add New Manufacturer
4. The software license can be tracked by workstations or users.
o

Workstations : The license is allocated to the workstation.

o

User: The license is allocated to the workstation as well as the user.

Select the corresponding option from Track By drop down.
5. Choose any one option from Installation allowed drop down.
o

Single : Similar to Individual license, only one installation is allowed for this license
type.
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o

Volume : Multiple installation(s) is allowed for this license type.

o

Unlimited : Unlimited installation(s) is allowed for this license type.

o

OEM (Original Equipment Manufacturers) : The software license is attached to the
hardware i.e. hardware say, laptops for which the software is installed. The software
cannot be transferred to another workstation and the license expires once the
workstation is moved to Disposed state.

6. If you have selected Workstation as the Track By option, the Is Node Locked option
appears. This option can be enabled for workstation with specific configurations. Enabling this
option automatically changes the Installation Allowed field to Single.
7. If you have selected Users, the Users Allowed field appears. From this field you can select
the number of users who can access the software, say, Single, Volume (multiple) or
Unlimited.
8. If the software is one time installation and does not require a renewal, enabled Is Perpetual
check box.
9. If the software is freeware with unlimited installations and no expiry date, enable Is Free
License check box.
10. Few software license types can be divided into sub license types say for instance, with Client
Access License (CAL) you can purchase license for every user who access the server (Per
User) or license for every device that accesses the server (Per Device).
Enter the License Option and click Add to add it in the pick list field. You also have an option
to delete the License Option from the pick list field. Select the license option and click the
.
delete icon

Editing License Type
1. From the Software - License Types page, click on the Edit icon
you wish to edit.

beside the License Type

2. The Software - License Types page opens with the values populated while adding the
License Type.
3. Modify the required details and Save the changes.

Deleting License Type
1. From the Software - License Types page, select the Manufacturer from the Filter drop down.
2. Select the check box beside the license type to be deleted.
3. Click Delete button. A dialog box confirming the delete operation appears.
4. Click OK to continue. The Software - License Type is deleted from the selected manufacturer
list.
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License Agreement- Additional Fields
If you require any further additional information while adding the software license agreement details,
apart from the pre-set fields in the license agreement form you can configure them under License
Agreement - Additional Fields. You can add text fields, numeric fields, date type fields and Cost
fields as the additional fields in the form.
To add license - additional fields,
1. Click the Admin tab in the header pane to open the configuration wizard page.
under Software block. The License
2. Click Agreement - Additional Fields icon
Agreement Additional page opens to view the following tabs namely, Text, Numeric,
Date/Time and Cost. You can add up to twelve text and cost fields, and four numeric and
date/time fields.
Configuring Additional Text fields
1. By default, the Text tab is selected. Specify the Label for the Additional field.
2. Specify any relevant information about the additional field in the Description text field.
3. Select the Type of the text field by enabling the radio button. It can be either Single-Line,
Multi-Line or Pick List (drop down list).
4. You can also specify default values to be pre-filled in the license agreement form.
5. Save the settings.
Configuring Additional Numeric fields
1. Click the Numeric tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text field.
4. Save the settings.
Configuring Additional Date/Time fields
1. Click the Date/Time tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text fields.
4. Click Save to save the settings.
Configuring Cost fields
1. Click the Cost tab.
2. Specify the Label for the Additional field.
3. Specify any relevant information about the additional field in the Description text field.
4. You have two cost type fields, Add cost (for cost addition) and Subtract cost (for cost
subtraction). Click the corresponding radio button to select the cost fields and also specify the
Default values to be pre-filled in the license agreement form.
These additional fields will appear while adding the license agreement details. To delete a userdefined fields, instead of adding the label names, delete the existing label names you wish to remove
from the fields of the form and click Save. The fields are automatically removed from the License
Agreement form.
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Importing License From CSV
Adding license information for each and every software scanned in ServiceDesk Plus application is
tedious and endless. Hence with the easy-to-use CSV import option, you can import software license
information from your existing database or even from other applications. The License Key is a pivotal
identifier to add or update the software license(s). So the license key should be unique to avoid
overwriting with the existing ones.
To import contacts from CSV file,
1. Click the Admin tab in the header pane to open the configurations wizard page.
2. Click Import License from CSV icon

under the Software block.

Step 1: Locate CSV file
1. Click Browse button to select the CSV file.
2. On locating the CSV file from the file chooser window, click Open. The path to the file
appears automatically in Locate CSV file field.
3. Click Submit.

Step 2: Customize Mapping
1. Map the application software license fields with the field names from the CSV file. If there are
any additional fields configured under License - Additional Fields, the same appears in the
customized mapping form.

Zoho Corporation Pvt. Ltd.
566

ManageEngine ServiceDesk Plus MSP – Admin Guide

2. Click Import button. The software license details from the CSV file is imported.
3. Once the import is complete, the data on the total number of license, the number of license
imported and the number of failed to import license is displayed.

Warning If there are any failure records while importing software license (s), don't re-import the
same CSV file. Instead download the FailedLicensesList.csv from the Imported Result
page and correct the errors on comparing with ErrorList.txt file. The Error List file
shows the failed software license records along with the corresponding error message.
This is to avoid duplication of the software license(s).
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User Survey
User Survey
You can easily configure the customer satisfaction survey to collect information on various key
parameters that you would like to measure about the support team and the response quality. You can
define your own survey and the reports will be generated based on the survey that you have defined.
You can also set the frequency of conducting the survey.
The various survey related configurations that you can perform are
1. Configuring Survey Settings
2. Defining a Survey
Apart from the above the you can also do the following survey related actions:
1. Sending Survey for a Request
2. Viewing the Survey Results
Once you have completed configuring and defining the survey, you can have a look at the preview of
the survey by clicking the Survey Preview link on the left menu or the Survey Preview icon in the
Admin tab.
To access the user survey related configurations
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane. The User Survey block is below the Users block.
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Configuring Survey Settings
Survey settings enables you to configure the default values for welcome message, survey success or
failure message, and thank you message. You can also choose to enable or disable a survey. If you
enable a survey you can also schedule the periodicity of conducting the survey.

To configure the survey settings
1. Log in to the ServiceDesk Plus - MSP application with the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
3. In the User Survey block, click the Survey Settings icon
displayed.

. The Survey Settings page is

4. To enable the survey, select the check box Enable User Survey.
5. Under the Survey Details block,enter the Welcome Message, which you wish to display as
soon as the user reaches the survey page. or when the user is taking the survey.
6. Email Content: Specify the purpose of the email in the Email Content text field. This content
will be displayed in the mail sent to the requesters. $RequesterName & $SurveyLink are
variables which changes based on the requester & application URL.
7. Success Message: Enter the message that will be displayed once the survey has been
successfully answered and submitted by the user.
8. Failure Message: When the survey is taken by a person who has already submitted the
answers for the survey, then you will have to display a failure message. You can enter the
same in the Failure Message text area.
9. Thanks Message: Enter the thanks message. This message will be displayed just before the
submit button in the survey form.
10. To schedule the survey, in the Schedule Survey block, choose the radio button that you wish
to set as a criteria for sending the survey. The options are,
o

A request is closed: For closing every one request a survey mail will be sent

o

Requests are closed: Specify the number of requests to be closed of all the
available requests in the text box. Once the specified number of requests is closed a
survey mail will be sent.

o

Requests from a requester are closed: Specify the number of requests to be
closed for a requester in the text box. Once the specified number is reached a survey
mail is sent to the requester. This text box can take only integer values as input.

11. Click Save to save the survey settings.
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Defining a Survey
You can define your own survey by adding your own questions and satisfaction levels that will suit the
needs of end users. You can also display the survey to the users in various languages supported by
ServiceDesk Plus - MSP, provided the multi language license is purchased.
To define your survey,
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Admin tab in the header pane.
3. In the User Survey block, click Define a Survey icon
your survey questions and satisfaction levels.

. Here you can add, edit, or delete

Add Survey Questions
To add a survey questions
1. Click the + Add Question button available in the Questions tab in the Define Survey page.
2. In the Question pop-up window, type your question in the text area provided.
3. Click Save. The question will get added in the Define Survey Questions tab.
You can add any number of questions to the survey by following the above steps. As you keep adding
questions it will get appended at the end of the list of questions. You can change the order of the
questions by clicking the Move Up and Move Down link that is available beside each question.

Edit a Survey Question
To edit the survey question
1. In the Questions tab, click the Edit link beside the question you wish to edit.
2. In the Question pop-up window, edit the question displayed in the text area.
3. Click Save. The Define Survey page is refreshed to display the modifications made.

Delete a Survey Question
1. In the Questions tab, click Delete link beside the question you wish to delete. A confirmation
dialog pops up.
2. Click OK to delete the question.
Note: If you delete a question from a survey, then it will have an impact on the survey results
that have been collected previously.

Add Satisfaction Levels
To add satisfaction levels that will be displayed as choices for each of the survey questions
1. Click the Satisfaction Levels tab in the Define Survey page.
2. Click + Add Level button.
3. In the satisfaction level pop-up window, enter the satisfaction level in the text area provided.
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4. Click Save. The satisfaction level is added and the Define Survey page is refreshed to
display the added satisfaction level.
You can add any number of satisfaction level to the survey by following the above steps. As you keep
adding, the levels will get appended at the end of the list of the existing levels. You can change the
order of the same by clicking the Move Up and Move Down link that is available beside each
question. Satisfaction levels scales from good to bad, good at the top bad at the bottom. Moving up or
down changes the satisfaction levels.

Edit a Satisfaction Level
To edit a Satisfaction level
1. In the Satisfaction Levels tab, click the Edit link beside the satisfaction level you wish to
edit.
2. In the satisfaction level pop-up window, edit the satisfaction level displayed in the text area.
3. Click Save. The Define Survey page is refreshed to display the modifications made.

Delete a Satisfaction Level
1. In the Satisfaction Levels tab, click the Delete link beside the satisfaction level you wish to
delete. A confirmation dialog pops up.
2. Click OK to delete the satisfaction level.
Note: If you delete a satisfaction level from a survey or change its order, then it will have an
impact on the survey results that have been collected previously.

Survey Translate
If you have purchased the license along with multi language, then the Survey Translate tab appears.
The survey can be displayed in various languages supported by ServiceDesk Plus - MSP to users
located in various locations.

Add New Translation
To add new translation,
1. In the Define Survey page, click on Survey Translate tab.
2. In Translate Languages list view page, select New Translation link. The New Translation
form appears.
3. Select the Survey Language from the drop down list. The languages supported by
ServiceDesk Plus - MSP is displayed. The languages for which a translation is added does
not appear again in the Survey Language drop down list.
4. Enter the Survey Questions in the language selected in Survey language drop down list.
5. Similarly, specify the Satisfactory Levels and Messages in the respective fields.
6. Click Save to save the new translation in the list view. By default, while adding a new
translation the language is enabled. To disable the language, select the check box beside the
language to be disabled and click Disable button.
The survey form for the requester consists of Display Language drop down listing all the enabled
languages configured under Survey Translate tab. Select the language to view the survey.
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Edit a Translation
While editing a translation, the Survey Language cannot be modified.
1. In the Translate Language page, click the Edit icon
The New Translation form appears

beside the language you wish to edit.

2. The Survey Language is in non editable text. Modify the details in Survey Question,
Satisfactory Levels and Messages.
3. Click Update to save the changes.

Delete a translation
1. In the Translation Language page, select the check box beside the language you wish to
delete.
2. Click Delete button. A confirmation box appears. Click Ok to continue. The translated
language is deleted from the list.
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Sending Survey
If the survey is enabled in the survey settings, then a technician or the ServiceDesk Plus - MSP
administrator can manually send a survey to the requesters once the survey is closed.
To send the survey
1. Log in to ServiceDesk Plus - MSP application using your user name and password or that of
the ServiceDesk Plus - MSP administrator.
2. Click the Requests tab.
3. In the Request list view, select the filter Closed Requests or My Closed Requests.
4. Click the request Title for which you wish to send the survey.
5. Click Send Survey for this Request link available under the Actions menu. A success
message that the survey has been sent for the request is displayed and the survey will be
sent to the requester who created the request as a mail with a URL which opens the survey.
Note: The following conditions need to be true for the Send Survey for this Request link to
be visible:
1. Either a technician or administrator should have logged in.
2. The request must be closed.
3. The User Survey must be enable in the Survey Settings.
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Viewing Survey Results
Once the requester completes the survey, the administrator and the requester who took the survey
can view the survey results.
To view the survey results
1. Log in to the ServiceDesk Plus - MSP application using the user name and password of a
ServiceDesk Plus - MSP administrator.
2. Click the Requests tab.
3. In the Requests list view select the Closed Requests or My Closed Requests filter.
4. Click the request Title for which you wish to see the survey results.
5. Click View Survey Results link available under the Actions menu. The survey results opens
in a pop-up window.
6. Once you have viewed the results, click the Close button.
You can view the survey results filled in by the requester from this page. A survey is defined and a
survey mail is sent to the requester. By sending the survey mail you ask the requester to answer the
survey questions to improve the service provided by the technicians. The survey results answered by
the requesters will be listed under this section.

Note:
1. The View Survey Results link appears only if the requester has completed taking the
survey. Else this link will not be present.
2. Once the survey is submitted, the responses cannot be changed.
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General Settings
General Settings
General Settings configurations are,
•

Self Service Portal

•

Backup Scheduling

•

Data Archiving

•

Desktop Central Integration
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Configuring Self Service Portal Settings
Self-Service Portal settings has ten different settings to be configured in ServiceDesk Plus - MSP
such as, Default Currency, Display Language, My Reminders, Requester List, Dynamic User Addition,
Alias URL, Customize ServiceDesk and so on.
To open the self service portal settings page,
1. Login to ServiceDesk Plus - MSP using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. Click Self Service Portal Settings icon

under the General block.

Default Currency
Specify the default currency in the given text field. This unit will be used in all the places where cost
calculation is done. The default currency specified is $.

Display Language
ServiceDesk Plus - MSP supports different languages as part of the application. You can choose
default language of your choice to be displayed in the application. To select the language of your
choice,
Click Browser default combo box. Select the language of your choice from the list.

Calendar Customization
You can customize the calendar view by selecting the start day of the week from the drop-down. The
selected day will be considered as the starting day of the week in all the calendar views.

My Reminder(s)
If you wish to show all your tasks as reminders to the requesters then select 'Yes' radio button else
select 'No' option. The reminders will be shown in the home page.

Reopening Request
You can allow requesters to Reopen their closed or resolved requests from the Self-Service Portal.
Click Yes radio button to enable this option. When the status of the request is moved to Closed or
Resolved, a Reopen tab is displayed in the request details page.
You can also allow requesters to Close their requests from the Self-Service Portal. Click Yes radio
button to enable this option. When the status of the request is moved to Resolved, a Close tab is
displayed in the request details page.

Request Feature List
Includes options to change the status of requests to Open when requesters reply to On Hold requests,
actions to perform when requesters reply to closed requests, stop timer for requests awaiting approval
and option to show site details in the request details page.
1. If you wish to change the request status to Open when a requester replies to an On Hold
request, click 'Yes' radio button.
2. Select the following options when a requester replies to a Closed request:
o

The request is reopened always.

o

If the requester replies within the specified number of days from the closed time, the
request is reopened. Else, the reply is created as a new request.
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o

The reply is appended as a conversation and notified to the technician. The status of
the request remains unchanged.

o

The reply is created as a new request.

3. In most cases, when a request is sent for approval to the concerned authority, the help desk
team may not be held responsible for the delay in approval process. In order to minimize the
SLA violations by the helpdesk team, you can stop the timer for requests with status as
‘pending approval’. Select the check box to avail this option. You can also select the request
status from the drop-down box.
1. The Status with Type as In Progress and with Stop Timer enabled is listed in the dropdown box.
Note

2. The Stop Timer is automatically disabled once the decision of the concerned authority
is recorded.
3. The Stop Timer is applicable for incident as well as service requests.
4. In case of incident requests, first the Business Rules is applied and the status set by
the Business Rule is overridden with the status set for Stop Timer.
5.

When Stop Timer is enabled, the option to open the on hold requests on requesters
reply will not be applied.

4. If you wish to view the Site details such as, site name, address and contact information from
the request details page, click 'Yes' radio button. A View Site details icon appears beside the
site parameter in the request details page to view the site details. To remove the View Site
details icon from the request details page, click 'No' radio button.

Dynamic User Addition
By default, when a user is not imported into the application but imported through Active Directory,
then the user can login to the application using the AD credentials. This will automatically provide
login access to the application. If you do not wish to provide dynamic user addition when the user is
not imported into the application then enable the 'No' radio button.

User Login Addition
By default, if a mail fetched by the ServiceDesk Plus - MSP application has a requester name and
email ID that is not available in the requester list already, then the name is automatically added in the
requester list and the login name and password is created. The first part of the e-mail ID is set as the
name and the entire e-mail ID is set as login name and password. The requester can log in to the selfservice portal and change his/her password. If you do not wish to provide login access to users
created through email requests then enable the 'No' radio button.

Override User based on Email ID
While importing users using Active Directory, CSV and LDAP, the existing user information is
overwritten based on two criteria - The first criteria is based on the username and Domain, and the
second criteria is based on email id. If you do not wish to override user information based on email id
then enable 'No' radio button else enable 'Yes'.

Enable Local Authentication Login
On enabling Active Directory, if you wish to allow users to login to the application using the password
configured in ServiceDesk Plus then enable 'Yes'. The user should select Local Authentication from
the Log on to drop down list in the Login screen. If you wish to allow users to login to the application
using the system password then enable 'No' option.
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Email from new users
Using this option, you can prevent mails, from a new email address to be fetched into the application.
To block mails from the email address that is unavailable in ServiceDesk Plus database, click 'No'
radio button. The mails are discarded and will not be logged in as a new request or appended as a
conversation in the application. To process mails from a new email address, click 'Yes' radio button.

Quick Create Settings
If you wish to show the quick create section to the technicians in the home page, then enable the
'Yes' radio button else select the 'No' button.

Auto Assign Asset
In ServiceDesk Plus, you can assign multiple workstations to a requester. So while creating a request
through email, by default, the first workstation is displayed. If you do not wish to display the
workstation information in the request details page, then enable 'No' radio button else enable 'Yes'.

Requester Details
If you wish to allow requesters to edit their profile select 'Allow to edit their profile' else select 'Not
allowed to edit their profile'. By default, all the workstations configured by the administrator will be
listed in add new request form of the self service portal. If you want the requester to view the
workstations associated to them then enable the check box 'Show workstation associated to
requester in Self-Service Portal'.

Solutions Settings
By default, the solutions approver can approve their own solutions rather than submitting it for
approval. If you wish the solution approver should not approve his own solution enable 'No' radio
button.

Remote Control Access
If you wish to enable Remote Desktop Access to all the workstations then select 'Yes' radio button
else select 'No' button.

Alias URL
To provide an alternate URL
1. In the text field provided beside the http:// text, enter the URL (along with the port number if
needed).
2. Click the Open alias URL in a new window link just below the text field, to test if the alias URL
works.

Usage Statistics
You can choose to disable usage statistics collection using this option.

Problems List
Requests from different accounts can be combined and created as a problem under MSP's account. If
you wish to allow this, choose the Yes option.
Click Save, to save the changes made in the settings.
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Backup Scheduling
You can configure backup scheduling to take back up of all the files at regular intervals.
1. Click Admin tab in the header pane. The configuration wizard page opens.
2. In the General block, select Backup Scheduling icon

.

Scheduling a Backup
1. Click Edit Scheduling link on the right hand side of the page. The Edit settings page opens.
2. Enable backup scheduling by selecting Enable radio button.
3. Select the number of days from the combo box to schedule the backup process. For every n
number of days selected the backup will be taken for the available data.
4. Select the date to start the backup on invoking the calender icon from Start Backup on field.
Also select the Time in hours and minutes from the combo box.
5. In case of any failure in the backup, you can notify it to a particular technician by specifying
their email address.
6. You can take a Backup of either the entire Database or only the File Attachments or both.
Select the check box accordingly.
7. Specify the location to store the backup data in Backup Location field.
8. Save the changes. If you do not wish to configure backup scheduling, click Cancel.

Deleting Backup Files
1. From the list of backup files, enable the check box beside the files you wish to delete.
2. Click Delete button. A confirmation dialog opens.
3. Click Ok to continue. The backup file is deleted from the list.
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Data Archiving
Data archiving enables the user to archive closed and/or resolved requests and move them to a
separate storage state. It is most useful since thousands of accumulating active requests could hinder
the performance of the help desk on a longer run.

Archived requests:
•

Requests that have been moved to the archived state (archived requests) will be removed
from the current active requests list. These archived requests are considered as a separate
set with separate search options and reports. The current active requests list, current active
requests search option and the current active requests report will not include the archived
requests.

•

The archived requests cannot be modified, deleted or moved back to the active state.

•

Any reply to an already archived request will be added as a new request and not as a thread
to the existing archived request.

To view Archived Requests,
•

To view the archived requests list, click on the Requests tab in the top header panel. Then
click on Archived Requests link at the top right side, below date and time.

•

You can also view the archived requests by clicking on Quick Actions at the top left side and
choosing Archived Requests from the drop down menu.

To configure Data Archiving,
1. Log in to ServiceDesk Plus - MSP using the Username and Password of the admin user.
2. Click the Admin tab in the header pane.
3. Click Data Archiving icon

under the General block.

4. Click on the check box Enable Schedule Data Archiving.
5. Set the parameters of the requests that need to be archived
•

The Status of the requests,

•

Time of creation/closure of the requests,

•

Column Name, Criteria and Values for the specific requests that need to be retained,
and

•

The Schedule Time for archiving process.

6. Click on Save to save the set parameters. The archiving process takes place as per the
configured schedule.
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Request status:
Request status reflects the current status of the requests that have to be archived.
•

Completed – Completed requests are those that have been resolved by the technicians and
closed by the end user.

•

Resolved – Resolved status reflects the requests that have been attended and answered by
the technicians but have not been closed by the end user.

•

Any status – All requests in any state (open, closed, resolved, on hold, feedback, follow up
and so on) will be considered for archiving.

Choose the status of the requests that have to be archived are in.
Time period:
Requests can be archived based on two factors of time:
•

Requests can be archived based either on the Created or Closed Time.

•

They can also be archived based on the Time Period during which they were created or
closed.

Requests can be archived by selecting a combination of the above two factors. The requests
Created/Closed before the configured time period will be moved to the Archived State during the next
scheduled archiving process.
* For example, if the archiving is to take place on 2006-11-20 (November) and you choose
“Closed requests”, “Closed Date” and “6 months” from the combo boxes, then the requests
closed by the technicians as well as the end users before 2002-06-20 (June) would be
archived.
* Similarly, if the archiving is to take place on 2006-11-20 and you choose “Any request”,
“Created Date” and “1 year” form the combo boxes, then all requests created before 2005-1120 would be archived irrespective of the state they are currently in.
Exceptions:
A small check box Allow Exception is available in the Data Archiving. This option allows certain
requests that fall under the archiving configurations to be retained in the current active request list
without being moved into archived folder. It follows the OR condition where requests matching the
any of the selected conditions are not archived.
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Exceptions are rules that are defined by certain parameters. These rules can be configured by
selecting parameters (Column Name, Criteria and Value) from the 3 combo boxes present in the
feature. The first 2 parameters are chosen from the drop down list box while the third parameter, an
attribute of the first parameter, is chosen from the pop up window by clicking on the choose/pick value
icon.
Multiple exceptions can be added to retain more specific requests by clicking on Add more
exception or by clicking the add icon and providing the necessary parameters.
For example, if you choose the first parameter as “Priority”, the second parameter as “is”, and
the third parameter as “High” from the pop up box, then requests that have high priority will not
be moved to the archived state.
An exception can be deleted by clicking on the cross/delete icon.
Process Schedule:
Schedule the archiving process by entering valid data in the “date”, “hours”, and “minutes” combo
boxes. This can be done by selecting the required date from the calendar pop up box, and the hours
and minutes from the drop down boxes. This process can be executed on a daily basis at the
scheduled time.
If you choose ‘2006-11-20’ from the calendar pop up box, ‘21’ from the hours drop down box, and ‘00’
from the minutes drop down box, then the Data Archiving process takes place at 9 o’clock in the night
of the scheduled date and repeats everyday at the same time.
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Desktop Central Integration
Desktop Central (DC) is a web - based Windows Server and Desktop Management Software from
ManageEngine. And, with Desktop Central Integration in ServiceDesk Plus - MSP (SDP - MSP), you
can configure and manage your Windows environment from a single point. Desktop Central
automates regular desktop management activities like installing software, patches and service packs
in the windows workstations and servers available in your network. You can also execute scripts for a
user or workstation.
Desktop Central Integration Requirement:
1. You should have installed both Desktop Central and ServiceDesk Plus - MSP products.
2. The ServiceDesk Plus - MSP version should be above 8 and should be running the
Enterprise Edition.
3. Desktop Central version should be build number #70211 and above.
NOTE: If you have installed ServiceDesk Plus - MSP version 8.0 and above, then the DC operation
works for Service Requests and not Incident requests.

Topics discussed under this section:
•

Prerequisites for performing Desktop Central activities
Lists the prerequisites for performing desktop central activities.

•

Getting Started with DC Integration
Step by step configuration to establish the integration and perform desktop management
activities.

•

Authentication Mechanism between the two applications
Authentication between SDP - MSP and DC application is through an application level key.
This section explains about generating this authentication key.

•

Handling Desktop Management activities from ServiceDesk Plus - MSP
Procedure on handling DC operations like install/uninstall software from ServiceDesk Plus MSP.

•

Enabling Notification to Technician
Send notification to the concern technician when the task is updated in Desktop Central.

•

Integration when DC is running in HTTPS mode
Steps to establish connection when Desktop Central is running in HTTPS mode.

Prerequisites for performing Desktop Central activities
Desktop Central activities are performed only if,
•

The Workstations and Servers are part of a Windows domain.

•

The domain should be managed by Desktop Central, and

•

A Desktop Central Agent should be installed in the workstations/servers.
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Getting Started with DC Integration
To get started with Desktop Central Integration, the following tasks should be performed to establish
the Integration and perform desktop management activities:1. Desktop Central Server Settings
2. Enabling access to Desktop Management Functionality
3. Enabling Template Actions in the Service Item form
Step 1: Desktop Central Server Settings
If you have installed both ServiceDesk Plus - MSP and Desktop Central servers, you just have to
provide the details of the computer where Desktop Central is installed along with its Port Number. On
entering these details and save, ServiceDesk Plus - MSP will try to establish a connection with the
Desktop Central server. Once the connection is established, the configured software details and
scripts from Desktop Central server are fetched.
1. Click Admin tab in the header pane.
2. Click Desktop Central Server Settings icon

under General block.

3. In the Desktop Central Server Settings page, enter the Server where Desktop Central
application is installed.
4. Enter the Port Number of the Desktop Central server.
5. Select the Protocol Settings. Say, http or https. If the Desktop Central Server is running in
HTTPS mode, refer SDPMSP-DC integration with DC in HTTPS mode, to know more on
establishing connection.
6. To display Desktop Central drop-down menu, select Enable Desktop Management Menu
check box. The Desktop Management menu will be displayed only for Desktop Central build
number #70242 and above.
7. Click Save. The settings are saved and ServiceDesk Plus - MSP tries to establish a
connection with Desktop Central server. When the connection is established, ServiceDesk
Plus - MSP fetches the software details and scripts from DC.
ServiceDesk Plus - MSP automatically sync with Desktop Central server for configured software
packages day-to-day. So, if you need to fetch the configured software packages instantly, select click
here link.
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Step 2: Enabling access to Desktop Management Functionality
While enabling login permission to a technician, you can also provide the technician with Desktop
Central login access and DC Role. The two DC Roles are DC Admin and DC Guest. Select the check
box Enable to access Desktop Management Functionality and provide either of the role to the
technician. When the technician logs into ServiceDesk Plus - MSP using his/her credentials, the
technician can view the Desktop Management drop-down menu, from where, the technician can
perform Desktop Management functionality from within ServiceDesk Plus - MSP web console.
NOTE:
1. Selecting the check box Enable to access Desktop Management Functionality and a DC
Role will create an user with same login credentials in Desktop Central application.
2. You will be able to select Enable to access Desktop Management Functionality check box
only when the connection between Desktop Central and ServiceDesk Plus - MSP is
established successfully. If the integration is not successful, then this option is greyed.

Step 3: Enabling Template Actions for a Service Request
Apart from providing technicians with the privilege to perform Desktop Central operations, you need to
enable Template Actions for a service item. The Template Action list the option 'Display Software
Install/Uninstall option in Service Request 'Actions' menu'.
Select the check boxes to provide these options in the Actions drop-down menu of the service
request. Since all service requests do not require Desktop Central operations, this activity is limited by
providing a Template Action check box in each service item form.
The Template Action option is available under the Work Flow tab of a service item.
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This functionality is available only when Desktop Central 70211 and above is integrated with
ServiceDesk Plus - MSP . If the integration is not established, then this option is grayed.

Authentication mechanism between the two applications
The authentication between ServiceDesk Plus - MSP and Desktop Central is through an application
level key that functions as a handshake mechanism between the two applications. A unique key is
generated for a technician in ServiceDesk Plus - MSP application.
1. Click Admin -> Technicians icon under User block.
beside the technician to generate the API key. Please note that the
2. Click the edit icon
technician should be enabled with login permission.
3. Click Generate. If a key is already generated for the technician, a Regenerate link appears.

The generated key is specified as the Authentication Key under ServiceDesk Settings in Desktop
Central application. So whenever Desktop Central contacts ServiceDesk Plus - MSP, the
authentication key is passed. This key is validated against ServiceDesk Plus - MSP database and if
found valid, the process continues, else an error is thrown.
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Handling desktop management activities from ServiceDesk Plus - MSP
Since the whole idea of this Integration is to perform regular desktop management activities from
ServiceDesk Plus - MSP application, the list of software and scripts are fetched from Desktop Central
periodically and populated in ServiceDesk Plus - MSP database.
So when an end-user raises a service request for "installing software", the technician with Desktop
Central role can log into ServiceDesk Plus - MSP application and perform the installation operation.

Performing desktop management activities
From the request details page of the service request, click Actions drop-down menu. The options
Install/Uninstall software and Run Script are listed as shown below,

Install/Uninstall Software
Click Install/Uninstall Software option. The Install/Uninstall Software window pops up
Package Settings
1. Select the Installer Type, whether the software to be installed is of the format MSI or EXE.
2. The list of software under the selected Installer Type is listed under Package Name. Choose
the software from the drop down.
3. Specify the name of the user for which the installation should run in Run As field.
4. Enter the Password of the specified user.
5. The type of operation, say Install or Uninstall is listed in Operation Type drop down. If the
Installer Type is MSI, the operation type consists of Install, Advertise and Uninstall. For EXE,
the operation type consists of Install and Uninstall.
6. If the execution file is in a network share, then the file or folder can be copied to the client
machine by selecting the option from Copy Option drop down.
Deployment Settings
1. The domains available in ServiceDesk Plus - MSP are listed under the Domain drop down.
Select the domain of the user/workstation.
2. The installation can be for a user or a workstation. Select the option from Install for drop
down.
3. You can set and schedule the installation operation. If the Install for is selected as User, the
installation can occur During or after Login into the machine, during login or after login.
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Similarly for a workstation, the installation can occur During Startup, After Startup, During or
After Startup.
4. You can also schedule a time for the deployment operation by enabling the check box beside
Schedule Operation check box. Select the Schedule Date and Time using the calendar icon.
5. Set the Reboot Policy from the drop down. You can either force a reboot when the user logs
into the machine, force a shut down when the user has logged in or allow the users to skip the
reboot/shut down.
Selecting Users/Workstations
. The
1. You can select the Users/Workstations for the installation from the icon
Users/Workstations under the selected domain is listed in a pop up window.
NOTE: Selecting Users/Workstations depends on the Install for option under
Deployment Settings. If you have selected Users, Select Users appears and
vice versa.
2. Enable the check box beside the user/workstation.
3. Click Select User/Workstation button. The users/workstations are listed under Selected
Users/Workstation. Click Select Users/Workstation and Close button to add the
users/workstations to the list and close the pop up window.
4. Save the details.

Enabling Notification to Technician
Once the software installation/uninstallation task is performed and the status is updated by Desktop
Central, you can enable notification to the concern technician regarding the update under Notification
Rules.
1. Click Admin -> Notification Rules icon under Helpdesk block.
2. In the Request section, Enable "Notify Technician when a software
Installation/Uninstallation task is updated" check box.
3. Save the details.

Integration when Desktop Central is running in HTTPS mode
If Desktop Central Server is running in HTTPS mode, then the following steps should be followed to
establish connection between ServiceDesk Plus - MSP and Desktop Central servers.
1. Download the .zip file from the link given below and extract it to
ManageEngine\ServiceDeskPlus-MSP
http://bonitas.zohocorp.com/servicedesk/11Mar2010/certgeneration.zip
2. Connect to the command prompt. Goto ManageEngine\ServiceDeskPlus-MSP and run the
batch file with following format:
C:>ManageEngine\ServiceDeskPlus-MSP>gencert.bat
dcservername:portnumber
3. On running the command, you will receive an exception PKIX and then it will ask you to enter
a value. Provide value 1 which will generate a file named jssecacerts under
ManageEngine\ServiceDeskPlus-MSP.
4. Copy the jssecacerts file under ManageEngine\ServiceDeskPlus-MSP\jre\lib\security folder
and then restart the ServiceDesk Plus - MSP application.

Zoho Corporation Pvt. Ltd.
589

ManageEngine ServiceDesk Plus MSP – Admin Guide

API
ServiceDesk Plus - MSP API

•

Purpose of API in ServiceDesk Plus - MSP

•

API Types and supported Operations

•

Procedure
•

Servlet API

•

REST API

•

Difference between Servlet and REST API

•

Future Enhancements

Purpose of API in ServiceDesk Plus - MSP
Application Programming Interface (API) is used to integrate various applications and facilitate sharing
of data between them. The integration can be achieved with any third party (external) applications or
web services that is capable of sending the data via http protocol.
With API, ServiceDesk Plus - MSP operations can be accessed from other applications or web
services. In case of request operations, it provides a convenient method to raise requests (other than
the default e-mail or web form) directly into ServiceDesk Plus - MSP without logging into the
application. If required, you can also have an option to create your own web form for using API.

API Types and supported Operations
ManageEngine ServiceDesk Plus - MSP supports both Servlet and REST API. While the functionality
are similar for both, Servlet consists of http form based submission whereas, REST conforms to the
REST specifications. Both the api methods can be implemented simultaneously in the application
provided, the operation is performed with the corresponding syntax definitions.
The servlet Http form submission based API supports operations such as,
•

Adding new request, editing, closing, deleting, viewing existing requests and adding notes for
existing requests.

•

Adding new site, editing and deleting the existing site.

•

Adding new technician, editing and deleting the existing technician.

•

Adding new requester, editing and deleting the existing requester.

•

Adding a workstation/server, updating a workstation/server, adding an asset, updating an
asset and deleting assets.

While the REST API supports only request related operations such as,
•

Adding new request, editing, closing, deleting and viewing existing requests.

•

Adding new notes to a request, editing, deleting and viewing existing notes.

•

Adding work log to a request, editing, deleting and viewing existing work logs.
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Difference between Servlet and REST API

Servlet API

REST API

The servlet is a form based input submission by the external
applications. While the output is exposed in XML format.

The input data is sent as an
XML string and the output
is exposed as an XML
string.

The http form is submitted to,

The general form of the api
url is,

http://<machine_name>:<port_number>/servlets/RequestServlet

http://<servername>:<port
number>/sdpapi/<module>
Authentication is through User Name and Password for every
API operation.

Authentication is through
Technician Key for every
API operation.

Supports operations on features such as Request, Site,
Technician, Requester and Assets.

Supports operations on
Requests alone.

Future Enhancements
•

Support the remaining modules namely problem,change, purchase, contracts, cmdb and
admin.
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Servlet API
Servlet API

•

About Servlet API

•

Servlet API Supported Operations

•

Troubleshooting Tips

About Servlet API
Servlet http form based submission is one of the methods of API in SDP - MSP. In this case, a html
form is created directly from the web browser or by plugging in small piece of code in the integrating
applications. This form helps users to access ServiceDesk Plus - MSP from other applications.

Scenario:
Say for instance, the html form for creating requests is exposed in your organization's intranet.
Users can use this form to raise requests instantly in ServiceDesk Plus - MSP without
accessing the application. The result of the operation contains the status of the operation and
key information such as the request ID.
Similar operations can be performed on requests, sites, technician, requesters and assets from
the external application, for which the sample forms are shown in the following documents.

The field values to be set in Request, Site, Technician, Requester and Assets are added as
parameters in HttpRequest details. The fields unavailable in the form are set as empty (or default).
The Operation performed is decided based on the http parameter 'operation'. The html form is
submitted to /servlets/RequestServlet as,
http://machine_name:Port_Number/servlets/RequestServlet
URL or submitting the request programmatically to the above link. Authorization to the ServiceDesk
Plus - MSP server is based on the username and password provided.
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Servlet API supported operations
The servlet Http form submission based API supports operations such as,
Adding new request, editing, closing, adding notes, deleting and viewing a request.
Adding new site, editing a site and deleting a site.
Adding new technician, editing and deleting technician.
Adding a new requester, editing and deleting requester.
Adding a workstation/server, updating a workstation/server, adding an asset, updating an
asset and deleting assets.

Troubleshooting Tips
If login failed for a correct userName and password,
1. Check if the user is imported from Active Directory.
2. If user is not imported from Active Directory, then submit only the username and password
to the below link for authentication.
http://machinename:portname/servlets/RequestServlet
3. If user is imported from Active Directory, then submit the username and password along
with DOMAIN_NAME and logonDomainName to the below link for authentication.
http://machinename:portname/servlets/RequestServlet
Note

DOMAIN_NAME represents the Domain to which the User belongs,
logonDomainName represents Authentication Mode,
Local Authentication or empty value refers to Local Authentication mode, and
AD_AUTH refers to Active Directory Authentication Mode.
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Request Attributes and xml Response
The request attributes for all request operations should be defined as mentioned. The operations on
requests are based on the "Roles" assigned to the users.

1. Attributes are case sensitive and should be used as defined.
Note 2. Operations on request can be performed based on the Roles assigned to the user.
3. While renaming the button in the sample html form, specify 'operation' as hidden
element.

•

Add Request

•

Updating Request

•

Assign Request

•

Close Request

•

Delete Request

•

Add Notes

•

Add WorkLog

•

Delete WorkLog

•

Get Request

Add Request
To create a new request, the targetURL attribute should be set to /servlets/RequestServlet and the
'operation' attribute should be 'AddRequest'. The 'account', 'site' and 'requester' parameters are
mandatory for creating a request.

Attribute

Comment

targetURL="/servlets/RequestServlet"

Operation target url for Adding Request

operation='AddRequest'

Operation command for Adding Request

reqTemplate

name of the Request Template

title

Subject of the request

description

Description of the request

resolution

Resolution

requester

Requester

requesterEmail

Email Id of Requester
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Attribute

Comment

priority

Priority

level

Level

status

Status

mode

Mode

urgency

Urgency

impact

Impact

impactDetails

Impact Details

requesttype

RequestType

account

Account

site

Site

category

Category

subcategory

SubCategory

item

Item

group

Group

technician

Technician Name

technicianEmail

Technician EmailID

asset

Name of the asset assigned to the request

assetId

ID of he asset assigned to the request

UDF Alias Name

name of the UDF field specified while creating the field.

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.
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Note:
1. Requester and Technician are set based on their User Name and Email ID.
2. While creating a request with a Requester Login credentials, the Site field is set with the site
of the requester.
3. While creating request through Requester Login credentials, the Requester is restricted to
creating requests for the assets associated to him/her only if the option Show workstations
associated to requester in Self-Service Portal is selected under Admin -> Self Service
Portal Settings.
4. While creating a request, if Subject field is left empty, then '(no subject)' is set as subject for
the Request.
5. If a field is not available for a request template but given through API, then the field is
discarded.
6. While creating a request, if the mandatory fields specified in Request Template are not
provided, then the request is created with the information provided by RequestServlet and a
System Log is populated with an error message.
The sample form to create request can be accessed here.
The html form should be submitted to http://machine_name:Port_Number/servlets/RequestServlet and
a response in xml format displays "Success" message along with the WorkOrder ID.
If the technician creating the request does not have permission to create new requests or has limited
access permissions a "Failure" message appears in the xml form.
Update Request
To update a request, the targetURL attribute should be set to /servlets/RequestServlet and the
'operation' attribute should be 'UpdateRequest'. The 'account', 'site', 'requester' and 'workOrderID'
parameters are mandatory for updating a request.

Attribute

Comment

targetURL="/servlets/RequestServlet"

Operation target url for updating Request

operation='UpdateRequest'

Operation command for Updating Request

workOrderID

Request ID of the request to update.

reqTemplate

name of the Request Template

title

Subject of the request

description

Description of the request

resolution

Resolution

requester

Requester

requesterEmail

Email Id of Requester

priority

Priority

level

Level
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Attribute

Comment

duebytime

Due By time to be applied for the request

status

Status

mode

Mode

urgency

Urgency

impact

Impact

impactDetails

Impact Details

requesttype

RequestType

account

Account

site

Site

category

Category

subcategory

SubCategory

item

Item

group

Group

technician

Technician Name

technicianEmail

Technician EmailID

asset

Name of the asset assigned to the request

assetId

ID of he asset assigned to the request

UDF Alias Name

name of the UDF field specified while creating the field.

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
"Local Authentication" or empty value refers to Local
Authentication.

Note:
1. Requester and Technician are identified based on their User Name and EmailID.
2. Empty Values can be updated to the request by passing the value as NULL .
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3. Requester cannot update a request.
A sample form for updating requests can be viewed here.
A Success message appears in a xml format if the request is updated successfully.
If the technician does not have permission to update the request ( Edit Request permission under
Roles), a Failure message appears in the xml form.
In some cases, the request may not fall under the technician's scope. For instance, a technician with
permission to view 'Requests assigned to him only' cannot update a request that is not assigned to
him although he has the 'Update Request' permission.
Click here to view the xml response for a update-failed request.
Assign Request to a Technician
To assign a request to a technician, use the same operation as described above for 'Update Request'.
Pass the 'Technician Name', 'Technician Email' and 'WorkorderID' parameters with the request. A
requester cannot assign a request to a technician.
The sample form for assigning/picking up request is similar to that of Updating requests. Requests are
assigned to technicians associated to the specified site. If Group is mentioned, the technician should
belong to the group. If the request is assigned to a technician unassociated to the site, the response
in xml format does not display an error message. But the request is not assigned to the technician.
Close Request
A request can be closed in two ways,
•

Set the 'status' parameter as 'Closed' along with the 'workOrderID' parameter (mandatory
parameter) and operation command as 'UpdateRequest'. (See above for 'UpdateRequest')

•

Set 'workOrderID' parameter (mandatory for request update) and 'operation' command as
'CloseRequest'. Set the 'Close comments' parameter as 'closeComment'. The Close
Comment can be added, if 'Confirm User Acknowledgment' is selected as 'YES' in 'Request
Closing Rules'. A Requester does not have permission to close a request.
Attribute

Comment

targetURL="/servlets/RequestServlet"

Operation target url for closing Request

operation='CloseRequest'

Operation command for closing Request

workOrderID

Request ID of the request to close.

closeComment

Close Comments

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.
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The sample form to close request can be accessed here.
A success message appears in xml format on submitting the form to
http://machine_name:Port_Number/servlets/RequestServlet.
If the specified request ID does not exist, the message "WorkOrder not found for ID : 20" appears in
the xml form.
If the technician has restricted access permission or does not have permission to close the request
then a Warning message appears in the xml form.
Delete Request
To delete a request, set the parameter value for 'operation' attribute as 'DeleteRequest' along with
'workOrderID'.

Attribute

Comment

targetURL="/servlets/RequestServlet"

Operation target url for deleting Request

operation='DeleteRequest'

Operation command for Deleting Request

workOrderID

Request ID of the request to delete.

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
"Local Authentication" or empty value refers to Local
Authentication.

The sample form to delete requests can be viewed here.
A Success message appears if the technician has permission to delete the request.
If a technician without delete permission or with restricted viewing permission, is trying to delete a
request then a Failure message appears as the xml response.
Add Notes
To add notes to a request, set the parameter value for 'operation' attribute as 'AddNotes' along with
'workOrderID'.

Attribute

Comment

targetURL="/servlets/RequestServlet"

Operation target url for adding notes to request

operation='AddNotes'

Operation command for closing Request
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Attribute

Comment

workOrderID

Request ID of the request to add notes

notesText

Notes to be added to the given Request Id

isPublic

isPublic=true denotes Public Notes
isPublic=false denotes Private NotesClose Comments

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.

The sample form to add notes can be accessed here.
Technicians with permission for the request module can add notes. A Success message appears if
the note is added successfully.
Conversely, technicians without permission (Edit permission under Roles) cannot add a note and a
'Failure message' appears if they try to add a note.
Add Worklog
To add worklog to a request, set the parameter value for 'operation' attribute as 'AddWorkLog'
along with 'workOrderID'.

Attribute

Comment

targetURL="/servlets/RequestServlet"

Operation target url for adding notes to request

operation='AddWorkLog'

Operation command for adding worklog to request

workOrderID

Request ID

technician

Technician Resolving the Request

technicianEmail

Email-ID of technician Resolving the Request

description

description

workHours

Time Taken To Resolve in hours

workMinutes

Time Taken To Resolve in minutes

cost

Incident Cost
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Attribute

Comment

executedTime

Executed Time

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.

Note:
1. If the fields, 'technician' and 'technicianEmail' are left blank, the logged in technician is
considered as the technician resolving the request.
2. If the 'cost' field remains empty, then 'cost per hour' will be taken as the Incident Cost.
3. If the execution time is left blank, the current time is taken as the 'execution time'.
4. The Execution Time should be in the format 'dd MMM yyyy, HH:mm:ss[01 Jul 2010,
18:02:26]'.
The sample form to add Worklog can be accessed here.
A Success message appears along with the 'requestChargeID' in xml format on submitting the form to
http://machine_name:Port_Number/servlets/RequestServlet.
If the technician is not provided with the role to add worklog, a Failure message appears in the xml
response.
If the technician does not have access to the request, a Failure message appears in XML format.
Click here to view the response.
Delete Worklog
To delete a worklog, set the parameter value for 'operation' attribute as 'DeleteWorkLog' along with
'requestChargeID'.

Attribute

Comment

targetURL="/servlets/RequestServlet" Operation target url for deleting worklog
operation='DeleteWorkLog'

Operation command for Deleting worklog

requestChargeID

WorkLog ID to delete

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name
needs to be specified on selecting AD authentication.
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Attribute

Comment

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
"Local Authentication" or empty value refers to Local
Authentication.

The Delete WorkLog sample form can be accessed here.
The worklog is deleted successfully if the technician has permission to delete the Worklog. Click here
to view the xml response.
Get Request
To view a request details, set the parameter value for 'operation' attribute as 'GetRequestDetails'
along with 'workOrderID'.

Attribute

Comment

GetRequestDetails

Operation command for Getting Request Details

workOrderID

Request ID

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name needs to be specified
on selecting AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local Authentication.

The sample form to view the request details can be accessed here.
The request details is displayed as the response in xml if the technician has permission to view
requests. The fields unspecified in the form are set as 'null' as shown.
A failure message appears as shown if the technician does not have permission to view requests or
has restricted access permission.
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Account Attributes and xml Response
The operations that can be performed on accounts are described below

Note

1. The operations that can be performed on an account through API are adding,
updating and deleting accounts.
2. Technicians with SDAdmin privilige can add / update / delete accounts.
3. Technicians with SDAccountAdmin privilige can update an account to which they
have access.
4. The attributes are case sensitive and should be used as defined.
5. When renaming the button in the sample html form, specify 'operation' as hidden
element.

•

Add Account

•

Update Account

•

Delete Account

Add Account
To create a new account, the targetURL attribute should be set to /servlets/AccountServlet and the
'operation' attribute should be 'AddAccount'. The 'accountName' and 'loginUrl' parameters are
mandatory for creating an account.

Attributes
targetURL=

Comments
target url for adding account

"/servlets/AccountServlet"
operation='AddAccount'

operation command for Adding account.

accountName

Name of the account

description

Description for the site

loginUrl

Login URL for the account.

doorNo

Address details for the account

street

Address details for the account

landmark

Address details for the account
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Attributes

Comments

city

Address details for the account

postalCode

Address details for the account

state

Address details for the account

country

Address details for the account

email

Email address for the account.

phone

Account phone number.

fax

Fax number of the account.

webUrl

website of the account.

supportEmail

Support E-Mail address for the account.

emailDomain

Email domains for the account (comma separated list)

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name should be
specified on enabling AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
'Local Authentication" or empty value refers to Local Authentication.

Note:
The sample form to add a new account can be viewed here.
The html form is submitted to http://machine_name:Portnumber/servlets/AccountServlet and a
response in xml format displays Success message along with the Account ID.
A failure message appears if,
•

The specified account name already exists [XML response]
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Update Account
To update an account, the targetURL attribute should be set to /servlets/AccountServlet and the
'operation' attribute should be 'UpdateAccount'. The 'accountName' and 'OldAccountName'
parameters are mandatory.

Attributes
targetURL=

Comments
target url for editing/updating an account

"/servlets/AccountServlet"
operation='UpdateAccount'

operation command for updating account.

oldAccountName

Existing account name

accountName

Name of the account

description

Description for the site

loginUrl

Login URL for the account.

doorNo

Address details for the account

street

Address details for the account

landmark

Address details for the account

city

Address details for the account

postalCode

Address details for the account

state

Address details for the account

country

Address details for the account

email

Email address for the account.

phone

Account phone number.

fax

Fax number of the account.

webUrl

website of the account.

supportEmail

Support E-Mail address for the account.

emailDomain

Email domains for the account (comma separated list)

username

Login Name for ServiceDesk Plus - MSP Authentication
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Attributes

Comments

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name should be
specified on enabling AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
'Local Authentication" or empty value refers to Local Authentication.

Note:
The sample form to update an account can be viewed here.
A Success message appears in the xml form when the site details are updated successfully.

Delete Account
To delete an account, the targetURL attribute should be set to /servlets/AccountServlet and the
'operation' attribute should be 'DeleteAccount'. 'accountName' is a mandatory parameter to delete
an account.

Attributes

Comments

targetURL="/servlets/AccountServlet" target url for deleting an account
operation='DeleteAccount'

operation command for deleting account

accountName

Name of the account

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.

The sample form to delete an account can be accessed here.
A Success message appears in xml format once the account is deleted successfully.

Site Attributes and xml Response
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The operations that can be performed on sites are described below

Note

1. The operations that can be performed on a site through API are adding, updating
and deleting sites.
2. Technicians with SDAdmin and SDAccountAdmin privilige can add / update / delete
a site.
3. Technicians with SDSiteAdmin privilige can update a site, but do not have
permission to set 'Related Settings'
4. The attributes are case sensitive and should be used as defined.
5. When renaming the button in the sample html form, specify 'operation' as hidden
element.

•

Add Site

•

Update Site

•

Delete Site

Add Site
To create a site, the targetURL attribute should be set to /servlets/SiteServlet and the 'operation'
attribute should be 'AddSite'. The 'accountName' and 'siteName' parameters are mandatory.

Attributes
targetURL=

Comments
target url for adding site

"/servlets/SiteServlet"
operation='AddSite'

operation command for Adding site.

accountName

Name of the account

siteName

Name of the site

description

Description for the site

region

The Region to which the site belongs

timeZone

Time Zone of the site

doorNo

Site address.

street

Site address

landmark

Provide a landmark if required.
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Attributes

Comments

city

City where the site is located.

postalCode

Postal code for the site

state

State/county/province where the site is located.

country

The country where the site is located

email

Email address for the site.

phone

Site phone number.

fax

Fax number of the site.

webUrl

website of the site.

OperationalHoursSettings

Related Settings for Operational hours of the site. Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

HolidaysSettings

Related Settings for Holidays setting of the site. Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

DepartmentsSettings

Related Settings for Departments setting of the site. Allowed values:
copy (Copy Default Settings),
custom (Custom Settings)

TechSiteAssociationSettings

Related Settings for Technicians/Site Association setting of the site.
Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

GroupsSettings

Related Settings for Groups setting of the site. Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

BusinessRulesSettings

Related Settings for Business Rules setting of the site. Allowed
values:
copy (Copy Default Settings),
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Attributes

Comments
refer (Refer Default Settings),
custom (Custom Settings)

SLASettings

Related Settings for Service Level Agreements setting of the site.
Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name should be
specified on enabling AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
'Local Authentication" or empty value refers to Local Authentication.

Note:
1. If the Region specified for the site is not configured in the ServiceDesk Plus - MSP, then the
region field does not get populated in the application.
2. If any of the Related Settings other than DepartmentSettings is left unselected, 'Refer Default
Settings' option is selected as default. In the case of DepartmentSettings, 'Custom' is selected
by default.
3. If any one of TechSiteAssociationSettings, GroupsSettings, BusinessRulesSettings or
SLASettings is selected as 'Refer Default Settings', the other three are also set to refer.
The sample form to add a new site can be viewed here.
The html form is submitted to http://machine_name:Portnumber/servlets/SiteServlet and a response in
xml format displays Success message along with the Site ID.
A failure message appears if,
•

A technician without admin permission is trying to add a new site. [xml response]

•

The specified site name already exists. [xml response]
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Update Site
To update a site, the targetURL attribute should be set to /servlets/SiteServlet and the 'operation'
attribute should be 'UpdateSite'. The 'accountName' and 'oldSiteName' parameters are mandatory.

Attributes
targetURL=

Comments
target url for editing/updating a site

"/servlets/SiteServlet"
operation='UpdateSite'

operation command for updating site.

accountName

Name of the account

oldSiteName

Existing site name

siteName

New name for the site

description

Description for the site

region

The Region to which the site belongs

timeZone

Time Zone of the site

doorNo

Site address.

street

Site address

landmark

Provide a landmark if required.

city

City where the site is located.

postalCode

Postal code for the site

state

State/county/province where the site is located.

country

The country where the site is located

email

Email address for the site.

phone

Site phone number.

fax

Fax number of the site.

webUrl

website of the site.

OperationalHoursSettings

Related Settings for Operational hours of the site. Allowed values:
copy (Copy Default Settings),
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Attributes

Comments
refer (Refer Default Settings),
custom (Custom Settings)

HolidaysSettings

Related Settings for Holidays setting of the site. Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

DepartmentsSettings

Related Settings for Departments setting of the site. Allowed values:
copy (Copy Default Settings),
custom (Custom Settings)

TechSiteAssociationSettings

Related Settings for Technicians/Site Association setting of the site.
Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

GroupsSettings

Related Settings for Groups setting of the site. Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

BusinessRulesSettings

Related Settings for Business Rules setting of the site. Allowed
values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

SLASettings

Related Settings for Service Level Agreements setting of the site.
Allowed values:
copy (Copy Default Settings),
refer (Refer Default Settings),
custom (Custom Settings)

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs. Domain Name should be
specified on enabling AD authentication.

logonDomainName

Authentication Mode [AD or Local Authentication].
"AD_AUTH" refers to Active Directory Authentication.
'Local Authentication" or empty value refers to Local Authentication.
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Note:
1. Technicians with SDSiteAdmin role have the privilege to edit the site information. However,
they cannot edit 'Related Settings.'
The sample form to update a site can be viewed here.
A Success message appears in the xml form when the site details are updated successfully.

Delete Site
To delete a site, the targetURL attribute should be set to /servlets/SiteServlet and the 'operation'
attribute should be 'DeleteSite'. The 'accountName' and 'siteName' parameters are mandatory.

Attributes

Comments

targetURL="/servlets/SiteServlet" target url for deleting a site
operation='DeleteSite'

operation command for deleting site

accountName

Name of the account

siteName

Site Name

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local Authentication.

The sample form to delete site can be accessed here.
A Success message appears in xml format once the site is deleted successfully.
A Failure message appears if,
•

A SiteAdmin is trying to delete the sites. [xml response]

•

If the site is used by a module. [xml response]
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Technician Attributes and xml Response
The operations that can be performed for technicians are described below

1. Technicians can be added, edited and deleted using the API.
Note

2. Technicians with roles of SDAdmin, SDAccountAdmin and SDSiteAdmin can
perform operations on technicians.
3. The attributes are case sensitive and should be used as defined.
4. When renaming the button in the sample html form, specify 'operation' as hidden
element.

•

Add Technician

•

Update Technician

•

Delete Technician

Add Technician
To add a technician, the targetURL attribute should be set to /servlets/TechnicianServlet and the
'operation' attribute should be 'AddTechnician'.

Attributes
targetURL=

Comments
target url for Adding technician

"/servlets/TechnicianServlet"
operation='AddTechnician'

operation command for Adding technician.

name

Technician name

employeeId

Employee ID of the technician

email

Email Address of the technician

phone

Phone Number of the technician

mobile

Mobile number of technician

smsMailId

SMS mail id of technician

costPerHr

Hourly cost of the technician

jobTitle

Job title of the technician.
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Attributes

Comments

techSiteName

Site to which technician belongs

departmentName

Department to which technician belongs

associateAccounts

Accounts to which the technician needs to be associated. Provide a
comma separated list of values.

associateSites

Sites to which the technician needs to be associated. Use the format
'accountname-sitename' as a comma separated list of values.

associateGroups

Groups to which the technician needs to be associated. Use the format
'accountname-sitename-group' as a comma separated list of vlaues.

defaultTechnician

To add this technician as part of the 'Default Technicians List'. Allowed
values are 'true', 'false'.

UDF aliases name

additional fields should be specified based on their column names

enableLogin

parameter for Enable Login for Technician
Allowed Values:true,false.

loginName

Technician's login name

pwd

Technician's password

associateRoles

roles associated with the technician

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs

logonDomainName

Authentication Mode [AD or Local Authentication].
“AD_AUTH” refers to Active Directory Authentication.
“Local Authentication” or empty value refers to Local Authentication.

Note:
1. If the technician is associated to many accounts, the accounts should be specified in comma
separated format in 'associateAccounts'
Eg: Acme, Manage Engine, Zoho.
2. If the technician is associated to many sites, the sites should be specified in comma
separated format in 'associateSites' along with the account name separated using a Eg: Acme-London, Acme-Paris, Manage Engine-Chennai
3. If the technician is assigned to more than one group, the groups should be specified in
comma separated format in 'associateGroups' along with the account and site names
separated using - (s)
Eg: Acme-London-Hardware, Acme-London-Software, Manage Engine-Chennai-Hardware
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4. To assign multiple roles to a technician, specify them as a comma separated list.
Eg: SDAccountAdmin, SDChangeManager
5. The values permitted for 'enableLogin' are 'true' and 'false'. By default, the value is 'false'.
6. If 'pwd' is not specified, the pwd for the technician is the same as the specified 'loginName'.
7. Login is not provided to the technician if 'loginName' is not specified.
8. Technicians with SDAccountAdmin or SDSiteAdmin privilege but restricted access
permissions can add technicians only for their associated sites.
9. A technician can be assigned only one of SDAdmin, SDAccountAdmin or SDSiteAdmin roles
The sample form to add a new technician can be viewed here.
The html form is submitted to http://machinename:Portnumber/servlets/RequestServlet and a
response in xml format displays Success message along with the User ID.
A failure message appears if,
1. A technician without admin privilege is trying to add a technician. [xml response]
2. A technician with restricted access is trying to create a technician not associated to his site or
account [xml response]
3. The specified technician login name already exists [xml response]

Update Technician
To update a technician, the targetURL attribute should be set to /servlets/TechnicianServlet and
the 'operation' attribute should be 'UpdateTechnician'. 'userid' parameter is mandatory.

Attributes
targetURL=

Comments
target url for Updating technician.

"/servlets/TechnicianServlet"
operation='UpdateTechnician'

operation command for Updating technician.

techUserName

Technician Name to update

techLoginName

Login Name of the technician

techEmailId

Email ID of the technician

userid

Technician ID

name

Technician name

employeeId

Employee ID of the technician

email

Email Address of the technician

phone

Phone Number of the technician
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Attributes

Comments

mobile

Mobile number of technician

smsMailId

SMS mail id of technician

costPerHr

technician's cost per hour

jobTitle

Job title of the technician.

techSiteName

Site to which technician belongs

departmentName

Department to which technician belongs

associateAccounts

Accounts to which the technician needs to be associated. Provide a
comma separated list of values.

associateSites

Sites to which the technician needs to be associated. Use the format
'accountname-sitename' as a comma separated list of values.

associateGroups

Groups to which the technician needs to be associated. Use the
format 'accountname-sitename-group' as a comma separated list of
vlaues.

defaultTechnician

To add this technician as part of the 'Default Technicians List'.
Allowed values are 'true', 'false'.

UDF aliases name

additional fields should be specified based on their column names

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs

logonDomainName

Authentication Mode [AD or Local Authentication].
“AD_AUTH” refers to Active Directory Authentication.
“Local Authentication” or empty value refers to Local Authentication.

Note:
1. When editing a technician, technicians are identified based on the order below
i.

The users are first identified based on the 'techLoginName'.

ii.

Then, the technician is identified using the 'techEmailid'.

iii.

Next, the 'techUserName' is used to identify the technician.

iv.

If the technician cannot be identified from the above criteria, then the technician is identified
based on 'userid'.

v.

If multiple technicians are found while searching using 'techLoginName' or 'techUserName',
then they are not updated.

2. Values in login details cannot be updated through API.
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The sample form to update technicians can be accessed here.
A success message appears if the technician is updated successfully.
A failure message appears if,
1. A technician without admin privilege is trying to update a technician. [xml response]
2. A technician with restricted access is trying to update a technician not associated to his site.
[xml response]

Delete Technician
To delete a technician, the targetURL attribute should be set to /servlets/TechnicianServlet and the
'operation' attribute should be 'DeleteTechnician'.

Attributes

Comments

targetURL=

target url for deleting technician

"/servlets/TechnicianOperationServlet"
operation='DeleteTechnician'

operation command for deleting technician

techUserName

technician Name

techLoginName

technician's loginName

techEmailId

technician's emailId

userid

technician id

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs.

logonDomainName

Authentication Mode [AD or Local Authentication].
“AD_AUTH” refers to Active Directory Authentication.
“Local Authentication” or empty value refers to Local
Authentication.

Note:
1. Technician with 'SDAdmin' can be deleted only by another 'SDAdmin'.
The sample form to delete a technician can be viewed here.
The response in xml displays a Success message if the technician has permission to delete
technicians.

Requester Attributes and xml Response
The operations that can be performed on requesters are described below
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1. The requester operations that can be performed through API are adding,
updating and deleting requester.
Note

2. Technicians with restricted access permission can perform add, edit and delete
operations on requesters associated to their sites.
3. The attributes are case sensitive and should be used as defined.
4. When renaming the button in the sample html form, specify 'operation' as hidden
element.

•

Add Requester

•

Update Requester

•

Delete Requester

Add Requester
To add a requester, the targetURL attribute should be set to /servlets/RequesterServlet and the
'operation' attribute should be 'AddRequester'. 'account', 'site' and 'name' are mandatory
parameters. If 'departmentmentName' parameter is not given, the requester is added to the
department 'General'.

Attributes
targetURL=

Comments
target url for Adding requester

"/servlets/RequesterServlet"
operation='Addrequester'

operation command for Adding requester

name

Requester name

employeeId

Employee ID of the requester

description

Description about employee

email

Email Address of the requester

phone

Phone Number of the requester

mobile

Mobile number of requester

account

Account to which the requester needs to be associated

site

site to which requester is associated to

departmentName

department name to which the requester is associated to
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Attributes

Comments

jobTitle

Job title of the requester.

requestViewPermission

permission for 'Requester allowed to view'.
Allowed Values:
OWN REQUEST: Requester can see his own requests [default]
DEPARTMENT REQUEST: Requester can see all requests that belong
to his department
SITE REQUEST: Requester can see all requests that belong to his site
ACCOUNT REQUEST: Requester can see all requests that belong to
his account

approvePurchaseOrder

Purchase Order Approver
Allowed Values:true, false.

UDF aliases name

additional fields should be specified based on their column names

loginName

login name

pwd

password

userDomainName

Domain with which the requester is associated to

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs

logonDomainName

Authentication Mode [AD or Local Authentication].
“AD_AUTH” refers to Active Directory Authentication.
“Local Authentication” or empty value refers to Local Authentication.

Note:
1. If 'requestViewPermission' value is vacant, then the value is set as 'Show only their request'.
2. By default, the value for approvePurchase Order is false.
3. 'approvePurchaseOrder' is enabled only when the email ID of the requester is available.
The sample form for adding a new requester can be viewed here.
The html form is submitted to http://machinename:Portnumber/servlets/RequesterServlet and a
response in xml format displays Success message along with the userID or Requester ID.
A failure message appears
•

If the technician adding the requester is not associated to the site and has restricted access
permissions.

•

A technician without administrator privilege is trying to add a requester. [Click here to view the
xml response]
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Update Requester
To update a requester, the targetURL attribute should be set to /servlets/RequesterServlet and the
'operation' attribute should be 'UpdateRequester'. 'reqUserName', 'reqLoginName', 'reqEmailId',
'account', 'site' and 'userid' are mandatory parameters.

Attributes
targetURL=

Comments
target url for Updating requester.

"/servlets/requesterServlet"
operation='Updaterequester'

operation command for Updating requester.

reqUserName

Requester Name to update

reqLoginName

Requester Login Name to update

reqdomainName

Domain Name to which the requester belongs to

reqEmailId

Requester Email-Id to update

userid

Requester Id

name

Requester name

employeeId

Employee ID of the requester

description

Description about employee

email

Email Address of the requester

phone

Phone Number of the requester

mobile

Mobile number of requester

account

Account to which the requester needs to be associated

site

Site to which the requester needs to be associated

departmentName

department name to which the requester is associated to

jobTitle

Job title of the requester

requestViewPermission

permission for 'Requester allowed to view'.
Allowed Values:
OWN REQUEST: Requester can see his own requests [default]
DEPARTMENT REQUEST: Requester can see all requests that
belong to his department
SITE REQUEST: Requester can see all requests that belong to his
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Attributes

Comments
site
ACCOUNT REQUEST: Requester can see all requests that belong to
his account

approvePurchaseOrder

Purchase Order Approver
Allowed Values:true,false.

UDF aliases name

additional fields should be specified based on their column names

loginName

login name

pwd

password

userDomainName

Domain with which the requester is associated to

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs

logonDomainName

Authentication Mode [AD or Local Authentication].
“AD_AUTH” refers to Active Directory Authentication.
“Local Authentication” or empty value refers to Local Authentication.

Note:
1. While performing the edit operation, requesters are identified based on the order below,
•

The users are first identified based on the 'reqLoginName' and 'reqDomainName'.

•

If the 'reqDomainName' is empty, the user is identified based on the 'reqLoginName'
with 'reqDomainName' as an empty value.

•

If the requester does not fall under the above criteria, the user is identified based on
the 'reqEmailid'.

•

If the requester is unavailable in the above specified criteria, the user is identified
based on the 'reqUserName'.

•

If the user cannot be identified from the above criteria, then the user is identified
based on 'userid'.

•

Based on the reqUserName or reqEmailId, if more than one users are identified then
the user is not updated nor deleted.

2. Login information of requesters cannot be edited through API.
3. To enable 'Purchase Order Approver' role while editing a requester, 'email' should be
specified along with 'approvePurchaseOrder' even if 'email' has been configured for the
requester.
The sample form to update requester can be accessed here.
The requester details are updated successfully indicated with a Success message in the xml form.

Delete Requester
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To delete a requester, the targetURL attribute should be set to /servlets/RequesterServlet and the
'operation' attribute should be 'DeleteRequester'.

Attributes
targetURL=

Comments
target url for deleting requester

"/servlets/requesterOperationServlet"
operation='Deleterequesters'

operation command for deleting requester

name

requester Name

loginName

Requester's loginName

domainName

Requester's login domain name

emailId

Requester's emailId

userid

Requester id

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs.

logonDomainName

Authentication Mode [AD or Local Authentication].
“AD_AUTH” refers to Active Directory Authentication.
“Local Authentication” or empty value refers to Local
Authentication.

The sample form to delete requesters can be viewed here.
A Success message appears as the xml response if the technician has permission to delete
requesters.
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Asset Attributes and xml Response
The operations that can be performed with assets are described below

Note

1. The asset operations that can be performed through API are adding, updating and
deleting assets.
2. Asset operations can be performed by technicians only with Inventory privilege.
3. The attributes are case sensitive and should be used as defined.
4. When renaming the button in the sample html form, specify 'operation' as hidden
element.

•

Add/Update Workstation and Server

•

Add/Update Asset

•

Delete Asset

•

Add/Update Asset type

Add/Update Workstation and Server
To add or update a workstation or a server, the targetURL attribute should be set to
/servlets/AssetServlet.
'operation' attribute be set to
AddAsset: Used to add a new workstation/server.
UpdateAsset: Used to update a new workstation/server.
SaveAsset: Used for both adding and updating a workstation/server.
'accountName', 'siteName', 'assetName' and 'assetType' are mandatory parameters.

Attributes
targetURL=

Comments
target url for adding/updating workstation/server

"/servlets/AssetServlet"
assetName

Name of the asset (workstation/server)

assetType

asset type

model

model no of the asset (workstation/server)

productName

Product Name of the asset (workstation/server)

accountName

account to which workstation/server is associated
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Attributes

Comments

siteName

site to which workstation/server is associated

ipAddress

ipaddress of workstation/server.

serviceTag

Service Tag of workstation/server

wsManufacturer

Workstation Manufacturer

proCount

proCount of workstation/server

proType

proType of workstation/server

proSpeed

proSpeed of workstation/server

proManufacturer

proManufacturer of workstation/server

ramSize

ramSize of workstation/server

virtualCapacity

virtualCapacity of workstation/server

osName

osName of workstation/server

osServicePack

osServicePack of workstation/server

resTag

resTag of workstation/server

resSlNo

resSlNo of workstation/server

barCode

barCode of workstation/server

location

location of workstation/server

vendor

vendor of workstation/server

acqDate

Acqisition Date of workstation/server

expiryDate

expiryDate of workstation/server

warrantyExpDate

warrantyExpiryDate of workstation/server

assetState

state of the of workstation/server

assetToAssociate

Associate the asset to other assets.(Valid only for Asset State 'In Use').

associateToUser

Associate the asset to user.(Valid only for Asset State 'In Use').
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Attributes

Comments

associateToDepartment

Associate the asset to department.(Valid only for Asset State 'In Use').

UDF Column Aliases

UDF aliases name should be specified

macAddress

macAddress of workstation/server

nicInfo

NicInfo of workstation/server

netAddress

netAddress of workstation/server

domain

domain of workstation/server

dnsServer

dnsServer of workstation/server

gateway

gateway of workstation/server

dhcpEnabled

dhcpEnabled of workstation/server

monitorType

monitorType of workstation/server

monitorSerialNumber

monitorSerialNumber of workstation/server

monitorManufacturer

monitorManufacturer of workstation/server

mouseType

mouseType of workstation/server

mouseSerialNumber

mouseSerialNumber of workstation/server

mouseManufacturer

mouseManufacturer of workstation/server

keyboardType

keyboardType of workstation/server

keyboardSerialNumber

keyboardSerialNumber of workstation/server

keyboardManufacturer

keyboardManufacturer of workstation/server

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication. Local Authentication
or empty value refers to Local Authentication.
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Note:
1. The 'assetName' is unique and hence cannot be duplicated and edited.
2. If 'ServiceTag' is specified, then the information provided for the workstation/server is
considered only for that Service Tag and not for the specified asset name.
3. Product Type should be specified as the 'assetType'. This field is mandatory.
4. Product of the asset should be specified as the 'productName'.
5. If the specified 'model' or 'productName' is invalid or empty, then the model is created as
'Unknown ProductType' say, Unknown Workstation.
6. If the specified 'vendor' is invalid and if the technician has permission to add a vendor, then
the Vendor is created as specified by the user.
7. The Resource State should be specified in 'assetState'.
8. Workstations/Servers with the 'assetstate' as 'In Use', can be associated to departments,
users or assets.
9. If the 'assetstate' is specified as 'In Use' then the values should be specified in the following
fields, 'assetToAssociate','associateToUser' or 'associateToDepartment'.
10. If the assetState is 'In Use' and if the invalid values are provided for the following fields
'assetToAssociate','associateToUser' or 'associateToDepartment', the state is set to 'In Store'
11. Workstations/Servers in disposed state cannot be assigned users or departments.
12. Workstations/Servers in disposed state cannot be assigned with other assets.
13. Technician with restricted access can create/update workstations/servers only for their
associated site.
14. Technician with restricted access can assign/ associate asset based on his access for that
site alone.
15. To configure the asset additional fields for a workstation, specify the attribute as
'asset_LabelName'
Add Workstation/Server
The sample form to Add Workstations/Servers can be accessed here. The 'AddAsset' operation
performs only the add operation.
The operation status is Success when the workstation/server is added successfully. The xml response
also displays the 'resourceid' and the 'resourcename' along with the message. Click here to view the
xml response.
The operation status is failure if
•

The mandatory fields are not specified

•

The technician with restricted access is trying to create a new workstation/server.

Update Workstation/Server
The sample form to Update Workstations/Servers can be accessed here. The 'UpdateAsset' operation
performs only the update of existing assets with the information provided.
The operation status is Success when the workstation/server is updated successfully. Click here to
view the xml response.
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Save Workstation/Server
The sample form to Save Workstation/Server can be accessed here.
While performing Save Asset operation, if the asset is already available with the specified criteria, the
asset is updated. Else, a new asset is created with the information provided.

Add/Update Asset
To add or update an asset, the targetURL attribute should be set to /servlets/AssetServlet.
'operation' attribute be set to
AddAsset: Used to add a new workstation/server.
UpdateAsset: Used to update a new workstation/server.
SaveAsset: Used for both adding and updating a workstation/server.
'accountName', 'siteName', 'assetName' and 'assetType' are mandatory parameters.

Attributes
targetURL=

Comments
target url for adding/updating asset

"/servlets/AssetServlet"
assetName

Name of the asset

assetType

type of asset

productName

Product Name of the asset

accountName

Account to which asset is associated

siteName

site to which asset is associated

assetTag

asset Tag

assetSlNo

Serial No of the asset

barCode

barCode of asset

location

location of asset

purchaseCost

PurchaseCost of the asset

vendor

vendor of asset

acqDate

Acqisition Date of asset

expiryDate

expiryDate of asset

warrantyExpDate

warrantyExpiryDate of asset

assetState

state of the of asset
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Attributes

Comments

assetToAssociate

Associate the asset to other assets.(Valid only for Asset State 'In Use').

associateToUser

Associate the asset to user.(Valid only for Asset State 'In Use').

associateToDepartment

Associate the asset to department.(Valid only for Asset State 'In Use').

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication. Local Authentication
or empty value refers to Local Authentication.

Note:
1. The 'assetName' is unique and hence cannot be duplicated or edited.
2. Product Type should be specified as the 'assetType'. This field is mandatory.
3. Product of the asset should be specified as the 'productName'.
4. If the specified 'model' or 'productName' is invalid or empty, then the model is created as
'Unknown ProductType' say, Unknown Workstation.
5. If the specified 'vendor' is invalid and if the technician has permission to add a vendor, then
the Vendor is created as specified by the user.
6. The Resource State should be specified in 'assetState'.
7. Assets with the 'assetstate' as 'In Use', can be associated to departments, users or assets.
8. If the 'assetstate' is specified as 'In Use' then the values should be specified in the following
fields, 'assetToAssociate','associateToUser' or 'associateToDepartment'.
9. If the assetState is 'In Use' and if the invalid values are provided for the following fields
'assetToAssociate','associateToUser' or 'associateToDepartment', the state is set to 'In Store'
10. Assets in disposed state cannot be assigned users or departments.
11. Assets in disposed state cannot be assigned with other assets.
12. Technician with restricted access can create/update Assets only for their associated site.
13. Technician with restricted access can assign/ associate asset based on his access for that
site alone.
Add Asset
Click here to access the sample form.
The operation status is Success when the asset details are added successfully. The xml response
also displays the 'asseteid' and the 'resourcename' along with the message. Click here to view the xml
response.
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The operation status is failure if,
•

The mandatory fields are not specified

•

The technician with restricted access is trying to create a new asset.

Update Asset
The sample form to Update Asset can be accessed here. The 'UpdateAsset' operation performs only
the update of existing assets with the information provided.
The operation status is Success when the asset is updated successfully. Click here to view the xml
response.
Save Asset
The sample form to Save Workstation/Server can be accessed here.
While performing SaveAsset operation, if the asset is already available with the specified criteria, the
asset is updated. Else, a new asset is created with the information provided.

Delete Asset
To delete an asset, the targetURL attribute should be set to /servlets/AssetServlet and the 'operation'
attribute should be 'DeleteAsset'. The 'accountName', 'siteName', 'assetName' and 'assetType'
parameters are mandatory.

Attributes

Comments

targetURL="/servlets/AssetServlet" target url for deleting asset
assetName

Name of the asset

assetId

ID of the asset

assetType

type of asset

accountName

Account to which the asset belongs

siteName

Site to which the asset belongs

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.
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The sample form to delete asset can be accessed here.
The operation status is a Success if the asset is deleted successfully. Click here to view the xml
response.

Add/Update Asset Type
To Add/Update asset type, the targetURL attribute should be set to /servlets/AssetServlet and the
'operation' attribute should be 'SaveAssetType'.The 'typeName', 'type' and 'category' parameters
are mandatory while adding an asset type and the parameter 'typeName' is mandatory while updating
an asset type.

Attributes

Comments

targetURL="/servlets/AssetServlet"

target url for Adding/updating an asset type

typeName

Asset type name(Eg.UPS)

type

type of the asset(Asset/Component)

category

Category of the asset type(IT/Non-IT)

description

Description about the asset type

username

Login Name for ServiceDesk Plus - MSP Authentication

password

Password for ServiceDesk Plus - MSP Authentication

DOMAIN_NAME

Domain Name to which the user belongs.

logonDomainName

Authentication Mode [AD or Local Authentication].
AD_AUTH refers to Active Directory Authentication.
Local Authentication or empty value refers to Local
Authentication.

The sample form to Add/Update asset type can be accessed here.
The operation status is a Success if the assettype is added successfully. Click here to view the xml
response.

Rest API
REST API

•

About REST API

•

Generating API Key
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•

REST API Supported Operations

About REST API
Representational State Transfer (REST) has similar functionality as that of Servlet API except for a
few distinctness [Refer Different between Servlet and REST API to know more]. The REST API is
completely automated, and users need not log into ServiceDesk Plus - MSP to perform operations.
The purpose of REST API can be explained with the help of a scenario.

Scenario:
Let's take the case of a network monitoring tool (external application) that is installed in your
network. In general, when an alarm is raised by the network monitoring tool, an e-mail
notification is sent as a ticket to ServiceDesk Plus - MSP application. The field values (priority,
level, impact, category and so on) should be filled by the technician manually in ServiceDesk
Plus - MSP. This mechanism is time consuming and eventually results as a dip in your
helpdesk productivity chart.
With REST API, you can automate this ticketing process. When an alarm is triggered, the
network monitoring tool provides the field details and raises a ticket automatically in
ServiceDesk Plus - MSP via http protocol. The ticket ID is sent back to the network monitoring
tool in order to perform any further operations over the request.
When the cause for the alarm is resolved, ServiceDesk Plus - MSP will invoke an URL
(callback URL) that was provided by the monitoring tool. The URL functions as a notification to
the external application indicating that the ticket is resolved. If this URL (callback URL) is not
provided, ServiceDesk Plus - MSP will not perform any additional operation on the ticket. When
ServiceDesk Plus - MSP invokes the callback URL, the network monitoring tool can perform
"any" internal operations based on the URL invocation. However, the expectation is that the
application will clear the alarm (which was raised as a ticket) at their end.
Note: Please note that the callback URL is applicable only while creating and editing requests.

The operations performed with REST API are based on the 'operation' parameter and is sent to the
url via HTTP POST method. The url format is as shown below,
http://<servername>:<port number>/sdpapi/<module>
Authentication to the ServiceDesk Plus - MSP application is key based i.e., an API key is sent along
with the url for every operation. This key is technician based and can be generate for technicians with
login privilege. The role given to the technician is also taken into consideration, so the key is valid only
for the role given to the technician. Once the key is generated, the key is manually transferred to the
integrated application so that the application can use the key for further API operations. If the key is
invalid (key is expired or the technician login is disabled), the operation fails and an error is
propagated to the integrated application.
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Note

1. Please note that the administrator alone has the privilege to generate the
authentication key for technicians with login permission.
2. If a login for the technician is disabled, then the technician key is deleted.
3. The operations can be performed based on the Role provided to the technician.

Currently, XML is the supported input and output format. The input data is sent as an XML string
along with the technician key and operation name, while the output is exposed as an XML string.

Generating API Key
The authentication between ServiceDesk Plus - MSP and integrated application is through an API
key. A unique key is generated for a technician with login permission in ServiceDesk Plus - MSP
application.
1. Click Admin -> Technicians icon under User block.
2. If you want to generate the API key to the existing technician, click the edit icon
the technician.

beside

If you want to generate the API key to a new technician, click Add New Technician link,
enter the technician details and provide login permission.
3. Click Generate link under the API key details block. You can select a time frame for the key
or simply retain the same key perpetually.
to expire using the calendar icon
If a key is already generated for the technician, a Re-generate link appears.

The key in the above image is generated for an existing technician. A time frame for the key is
selected which shows the date, month, year and the time (in hours and minutes) when the key will
expire.
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REST API supported operations
The REST API supports only request related operations which can be separated into:Operations on request: adding new request
Operations on a specific request:
editing, closing, deleting and viewing existing requests.
adding new notes to a request, editing, deleting and viewing existing notes.
adding worklog to a request, editing, deleting and viewing existing worklogs.
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Request Operations
The operations on request such as adding new request, updating, closing, deleting and viewing the
existing request are discussed under this section.
To perform operations on the request, the following URL patterns should be used.
For adding request:
http://<servername>:<port number>/sdpapi/request/
For operations on a specific request:
http://<servername>:<port number>/sdpapi/request/<request id>

Contents
•

Adding Request

•

Editing Request

•

Viewing Request

•

Deleting Request

•

Closing Request

Adding Request
Say, you are running ServiceDesk Plus - MSP with the server name "localhost" in the port "8080".
You are creating a new request for the requester Shawn Adams, who is unable to browse the internet.
The input and output XML formats for the above scenario are given below,
To add a new request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/
So for the scenario above, the URL is:
http://localhost:8080/sdpapi/request/
Key Points:
1. The operation name "ADD_REQUEST" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is an XML string sent as a "POST attribute" with key "INPUT_DATA".
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
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<Operation>
<Details>
<parameter>
<name>requester</name>
<value>Shawn Adams</value>
</parameter>
<parameter>
<name>subject</name>
<value>The subject of the request</value>
</parameter>
<parameter>
<name>description</name>
<value>The description of the request</value>
</parameter>
<parameter>
<name>callbackURL</name>
<value>http://localhost:8080/CustomReportHandler.do</value>
</parameter>
<parameter>
<name>requesttemplate</name>
<value>Unable to browse</value>
</parameter>
<parameter>
<name>priority</name>
<value>High</value>
</parameter>
<parameter>
<name>site</name>
<value>New York</value>
</parameter>
<parameter>
<name>group</name>
<value>Network</value>
</parameter>
<parameter>
<name>technician</name>
<value>Howard Stern</value>
</parameter>
<parameter>
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<name>level</name>
<value>Tier 3</value>
</parameter>
<parameter>
<name>status</name>
<value>Open</value>
</parameter>
<parameter>
<name>service</name>
<value>Email</value>
</parameter>
</Details>
</Operation>

Input - Format 2:
<Operation>
<Details>
<requester>Shawn Adams</requester>
<subject>Specify Subject</subject>
<description>Specify Description</description>
<callbackURL>http://localhost:8080/CustomReportHandler.do</callbackURL>
<requesttemplate>Unable to browse</requesttemplate>
<priority>High</priority>
<site>New York</site>
<group>Network</group>
<technician>Howard Stern</technician>
<level>Tier 3</level>
<status>open</status>
<service>Email</service>
</Details>
</Operation>

Output:
The Output format for the operation "Add Request" supports both the formats.
<?xml version="1.0" encoding="UTF-8"?>
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<operation name="ADD_REQUEST">
<result>
<status>Success</status>
<message>Request added successfully</message>
</result>
<Details>
<workorderid>25</workorderid>
</Details>
<Details>
<parameter>
<name>workorderid</name>
<value>25</value>
</parameter>
</Details>
</operation>

Editing Request
To edit a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>
Assume the Request ID to edit is 25, then the URL is: http://localhost:8080/sdpapi/request/25
Key Points:
1. The operation name "EDIT_REQUEST" should be sent as a "POST attribute" with key
"OPERATION_NAME"
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY"
3. Input is an XML string sent as "POST attribute" with key "INPUT_DATA".
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
<Operation>
<Details>
<parameter>
<name>level</name>
<value>Tier 3</value>
</parameter>
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</Details>
</Operation>
Input - Format 2:
<Operation>
<Details>
<level>Tier 3</level>
</Details>
</Operation>

Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="EDIT_REQUEST">
<result>
<status>Success</status>
<message>Request 25 successfully edited</message>
</result>
</operation>

Viewing Request
To view a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>
Assume the Request ID to view is 24, then the URL is: http://localhost:8080/sdpapi/request/24/
Key points:
1. The operation name "GET_REQUEST" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is not required for viewing requests.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
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<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_REQUEST">
<result>
<status>Success</status>
<message>Request details fetched successfully</message>
</result>
<Details>
<parameter>
<name>workorderid</name>
<value>24</value>
</parameter>
<parameter>
<name>requester</name>
<value>Howard Stern</value>
</parameter>
<parameter>
<name>createdby</name>
<value>Howard Stern</value>
</parameter>
<parameter>
<name>createdtime</name>
<value>31 May 2011, 20:52:26</value>
</parameter>
<parameter>
<name>duebytime</name>
<value>01 Jun 2011, 10:00:00</value>
</parameter>
<parameter>
<name>timespentonreq</name>
<value>0hrs 0min</value>
</parameter>
<parameter>
<name>subject</name>
<value>The subject of the request</value>
</parameter>
<parameter>
<name>requesttemplate</name>
<value>Unable to browse</value>
</parameter>
<parameter>
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<name>sla</name>
<value>High SLA</value>
</parameter>
<parameter>
<name>service</name>
<value>Email</value>
</parameter>
<parameter>
<name>technician</name>
<value>Howard Stern</value>
</parameter>
<parameter>
<name>status</name>
<value>Open</value>
</parameter>
<parameter>
<name>priority</name>
<value>High</value>
</parameter>
<parameter>
<name>level</name>
<value>Tier 3</value>
</parameter>
<parameter>
<name>group</name>
<value>Network</value>
</parameter>
<parameter>
<name>description</name>
<value>The description of the request</value>
</parameter>
<Notes URI="http://localhost:8080/sdpapi/request/24/notes/"/>
<Worklogs URI="http://localhost:8080/sdpapi/request/24/worklogs/"/>
</Details>
</Operation>

Deleting Request
To delete a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>
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Assume the Request ID to delete is 21, then the URL is: http://localhost:8080/sdpapi/request/21/
Key points:
1. The operation name "DELETE_REQUEST" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is not required for deleting requests.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="DELETE_REQUEST">
<result>
<status>Success</status>
<message>Request deleted successfully</message>
</result>
</operation>

Close Request
To close a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>
Assume the Request ID to close is 25, then the URL is given as:
http://localhost:8080/sdpapi/request/25
Key points:
1. The operation name "CLOSE_REQUEST" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. The input XML is optional. If specified, then the input is an XML string sent as "POST
attribute" with key "INPUT_DATA".
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Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
<Operation>
<Details>
<parameter>
<name>closeAccepted</name>
<value>Accepted</value>
</parameter>
<parameter>
<name>closeComment</name>
<value>The Closing Comment</value>
</parameter>
</Details>
</Operation>
Input - Format 2:
<Operation>
<Details>
<closeAccepted>Accepted</closeAccepted>
<closeComment>this is close comment</closeComment>
</Details>
</Operation>
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="CLOSE_REQUEST">
<result>
<status>Success</status>
<message>Request closed successfully</message>
</result>
</operation>
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Notes Related Operations
The notes related operations on specific request such as adding new notes, updating, deleting and
viewing the existing notes are discussed under this section.
To perform the notes related operations on an existing request, the following URL patterns should be
used.
For adding notes to a request:
http://<servername>:<port number>/sdpapi/request/<request id>/notes
For operations on a specific note for a request:
http://<servername>:<port number>/sdpapi/request/<request id>/notes/<notes id>

Contents
•

Adding Note

•

Editing Note

•

Viewing Note

•

Viewing all the Notes

•

Deleting Note

Adding Note
Say, you are running ServiceDesk Plus - MSP with the server name as "localhost" in the port "8080".
You are adding a note for an existing request for which the input and output XML format is given
below,
For adding a note to an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/notes
So for the above scenario, the URL is: http://localhost:8080/sdpapi/request/24/notes/
Key Points:
1. The operation name "ADD_NOTE" should be sent as a "POST attribute" with key
"OPERATION_NAME"
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY"
3. Input is an XML string sent as "POST attribute" with key "INPUT_DATA".
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
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<Operation>
<Details>
<Notes>
<Note>
<parameter>
<name>isPublic</name>
<value>false</value>
</parameter>
<parameter>
<name>notesText</name>
<value>Text added to the note</value>
</parameter>
</Note>
</Notes>
</Details>
</Operation>
Input - Format 2:
<Operation>
<Details>
<Notes>
<Note>
<isPublic>false</isPublic>
<notesText>Text added to the note</notesText>
</Note>
</Notes>
</Details>
</Operation>
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="ADD_NOTE">
<result>
<status>Success</status>
<message>Note added successfully for request 24</message>
</result>
</operation>
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Editing Note
To edit a note of an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/notes/<note id>
Assume the Note ID to edit the note is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/notes/301
Key Points:
1. The operation name "EDIT_NOTE" should be sent as a "POST attribute" with key
"OPERATION_NAME"
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY"
3. Input is an XML string sent as "POST attribute" with key "INPUT_DATA".
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
<Operation>
<Details>
<Notes>
<Note>
<parameter>
<name>notesText</name>
<value>edited the subject</value>
</parameter>
</Note>
</Notes>
</Details>
</Operation>
Input - Format 2:
<Operation>
<Details>
<Notes>
<Note>
<notesText>edited sub</notesText>
</Note>
</Notes>
</Details>
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</Operation>
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="EDIT_NOTE">
<result>
<status>Success</status>
<message>Note 301 successfully edited for request 24</message>
</result>
</operation>

Viewing Note
To view one of the notes of an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/notes/<note id>
Assume the Note ID to view the note is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/notes/301
Key Points:
1. The operation name "GET_NOTE" should be sent as a "POST attribute" with key
"OPERATION_NAME"
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_NOTE">
<result>
<status>Success</status>
<message>Note details fetched successfully</message>
</result>
<Details>
<Notes>
<Note>
<parameter>
<name>userid</name>
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<value>301</value>
</parameter>
<parameter>
<name>ispublic</name>
<value>false</value>
</parameter>
<parameter>
<name>notesText</name>
<value>Text added to the note</value>
</parameter>
<parameter>
<name>username</name>
<value>Shawn Adams</value>
</parameter>
<parameter>
<name>notesid</name>
<value>301</value>
</parameter>
<parameter>
<name>notesdate</name>
<value>1275373443722</value>
</parameter>
<parameter>
<name>workorderid</name>
<value>24</value>
</parameter>
</Note>
</Notes>
</Details>
</Operation>

Viewing all the Notes
To view all the notes of a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/notes/
Assume the Request ID to view all the notes is 24, then the URL is:
http://localhost:8080/sdpapi/request/24/notes
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Key Points:
1. The operation name "GET_NOTES" should be sent as a "POST attribute" with key
"OPERATION_NAME"
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_NOTES">
<result>
<status>Success</status>
<message>Notes details fetched successfully</message>
</result>
<Details>
<Notes>
<Note URI="http://localhost:8080/sdpapi/request/24/notes/302/">
<parameter>
<name>ispublic</name>
<value>false</value>
</parameter>
<parameter>
<name>notesText</name>
<value>Note added to the request</value>
</parameter>
<parameter>
<name>username</name>
<value>Shawn Adams</value>
</parameter>
<parameter>
<name>notesdate</name>
<value>1275373948835</value>
</parameter>
</Note>
<Note URI="http://localhost:8080/sdpapi/request/24/notes/301/">
<parameter>
<name>ispublic</name>
<value>false</value>
</parameter>
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<parameter>
<name>notesText</name>
<value>Text added to the note</value>
</parameter>
<parameter>
<name>username</name>
<value>Shawn Adams</value>
</parameter>
<parameter>
<name>notesdate</name>
<value>1275373443722</value>
</parameter>
</Note>
</Notes>
</Details>
</operation>

Deleting Note
To delete a note of an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/notes/<note id>
Assume the Note ID to delete the note is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/notes/301
Key Points:
1. The operation name "DELETE_NOTE" should be sent as a "POST attribute" with key
"OPERATION_NAME"
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="DELETE_NOTE">
<result>
<status>Success</status>
<message>Note deleted successfully</message>
</result>
</operation>
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Worklog Related Operations
The worklog related operations on specific request such as adding worklog, updating, deleting and
viewing the existing worklogs are discussed under this section.
To perform worklog related operations the following URL patterns should be used.
For adding worklog to an existing request:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogss
For operations on a specific worklog:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<worklog id>

Contents
•

Adding Worklog

•

Editing Worklog

•

Viewing Worklog

•

Viewing all the Worklogs

•

Deleting Worklog

Adding Worklog
To add a worklog for an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogs
So for the scenario above, the URL is: http://localhost:8080/sdpapi/request/24/worklogs/
Key Points:
1. The operation name "ADD_WORKLOG" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is an XML string sent as "POST attribute" with key "INPUT_DATA".
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
<Operation>
<Details>
<Worklogs>
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<Worklog>
<parameter>
<name>description</name>
<value>Adding a New Worklog</value>
</parameter>
<parameter>
<name>technician</name>
<value>Howard Stern</value>
</parameter>
<parameter>
<name>cost</name>
<value>25</value>
</parameter>
<parameter>
<name>workMinutes</name>
<value>20</value>
</parameter>
<parameter>
<name>workHours</name>
<value>6</value>
</parameter>
</Worklog>
</Worklogs>
</Details>
</Operation>

Input - Format 2:
<Operation>
<Details>
<Worklogs>
<Worklog>
<description>Adding a New Worklog</description>
<technician>Howard Stern</technician>
<cost>25</cost>
<workMinutes>20</workMinutes>
<workHours>6</workHours>
</Worklog>
</Worklogs>
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</Details>
</Operation>

Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="ADD_WORKLOG">
<result>
<status>Success</status>
<message>Work Log added successfully for request 24</message>
</result>
</operation>

Editing Worklog
To edit a worklog of an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>
Assume the Worklog ID to edit is 302, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/302
Key Points:
1. The operation name "EDIT_WORKLOG" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is an XML string sent as "POST attribute" with key "INPUT_DATA".
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Input - Format 1:
<Operation>
<Details>
<Worklogs>
<Worklog>
<parameter>
<name>description</name>
<value>Editing Worklog</value>
</parameter>
</Worklog>
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</Worklogs>
</Details>
</operation>

Input - Format 2:
<Operation>
<Details>
<Worklogs>
<Worklog>
<description>Editing Worklog</description>
</Worklog>
</Worklogs>
</Details>
</Operation>

Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="EDIT_WORKLOG">
<result>
<status>Success</status>
<message>Work Log 302 successfully edited for request 24</message>
</result>
</operation>

Viewing Worklog
To view one of the worklog of an existing request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>
Assume the Worklog ID to view worklog is 302, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/302
Key Points:
1. The operation name "GET_WORKLOG" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is not required in this case.
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Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_WORKLOG">
<result>
<status>Success</status>
<message>Work log details fetched successfully</message>
</result>
<Details>
<Worklogs>
<Worklog>
<parameter>
<name>dateTime</name>
<value>1275375445281</value>
</parameter>
<parameter>
<name>executedTime</name>
<value>1275375433484</value>
</parameter>
<parameter>
<name>cost</name>
<value>21.6666666666667</value>
</parameter>
<parameter>
<name>WORKORDERID</name>
<value>24</value>
</parameter>
<parameter>
<name>workHours</name>
<value>0</value>
</parameter>
<parameter>
<name>workMinutes</name>
<value>7800000</value>
</parameter>
<parameter>
<name>technician</name>
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<value>Howard Stern</value>
</parameter>
<parameter>
<name>description</name>
<value>Worklog 2</value>
</parameter>
<parameter>
<name>requestCostID</name>
<value>301</value>
</parameter>
</Worklog>
</Worklogs>
</Details>
</Operation>

Viewing Worklogs
To view all the worklogs of a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/
Assume the Request ID to view all the worklogs is 302, then the URL
is: http://localhost:8080/sdpapi/request/24/worklogs/
Key Points:
1. The operation name "GET_WORKLOGS" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is not required in this case.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_WORKLOGS">
<result>
<status>Success</status>
<message>Work log details fetched successfully</message>
</result>
<Details>
<Worklogs>
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<Worklog URI="http://localhost:8080/sdpapi/request/24/worklogs/301/">
<parameter>
<name>dateTime</name>
<value>1275375445281</value>
</parameter>
<parameter>
<name>executedTime</name>
<value>1275375433484</value>
</parameter>
<parameter>
<name>cost</name>
<value>21.6666666666667</value>
</parameter>
<parameter>
<name>WORKORDERID</name>
<value>24</value>
</parameter>
<parameter>
<name>workHours</name>
<value>0</value>
</parameter>
<parameter>
<name>workMinutes</name>
<value>7800000</value>
</parameter>
<parameter>
<name>technician</name>
<value>Howard Stern</value>
</parameter>
<parameter>
<name>description</name>
<value>Worklog 2</value>
</parameter>
<parameter>
<name>requestCostID</name>
<value>301</value>
</parameter>
</Worklog>
<Worklog URI="http://localhost:8080/sdpapi/request/24/worklogs/302/">
<parameter>
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<name>dateTime</name>
<value>1275375861188</value>
</parameter>
<parameter>
<name>executedTime</name>
<value>1275375861188</value>
</parameter>
<parameter>
<name>cost</name>
<value>25.0</value>
</parameter>
<parameter>
<name>WORKORDERID</name>
<value>24</value>
</parameter>
<parameter>
<name>workHours</name>
<value>0</value>
</parameter>
<parameter>
<name>workMinutes</name>
<value>22800000</value>
</parameter>
<parameter>
<name>technician</name>
<value>Howard Stern</value>
</parameter>
<parameter>
<name>description</name>
<value>Adding a New Worklog</value>
</parameter>
<parameter>
<name>requestCostID</name>
<value>302</value>
</parameter>
</Worklog>
<Worklogs>
</Details>
</operation>
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Delete Worklog
To delete a worklog from a request, the URL is given as:
http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>
Assume the Worklog ID to delete is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/301
Key Points:
1. The operation name "DELETE_WORKLOG" should be sent as a "POST attribute" with key
"OPERATION_NAME".
2. The technician key should be sent as a "POST attribute" with key "TECHNICIAN_KEY".
3. Input is not required in this case.
Note: Please note that the Input and Output XML formats have been changed. But for
compatibility reasons, the Input operation will support both the formats.
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="DELETE_WORKLOG">
<result>
<status>Success</status>
<message>Work Log deleted successfully</message>
</result>
</operation>

Zoho Corporation Pvt. Ltd.
658

ManageEngine ServiceDesk Plus MSP – Admin Guide

Reports
Reports
ManageEngine ServiceDesk Plus-MSP gives you a set of preset help desk and asset reports and so
on generated from the data available in the application.
To view the various reports available in application
1. Log in to the ServiceDesk Plus-MSP application using the user name and password of an
admin user.
2. Click the Reports tab in the header pane. The next page lists the various reports grouped
under different heads. Along with the default reports you also create New Custom Reports,
New Query Reports, New Scheduled Report.
The following sections explain the various reports and the kind of data that each of these
reports represents.
o

About ServiceDesk Plus-MSP

o

New Custom Report

o

New Query Report

o

New Scheduled Report

o

Custom Settings
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About ServiceDesk Plus-MSP Reports
Reports in ServiceDesk Plus-MSP can be classified as Helpdesk, Request Timespent, Survey, Asset,
Audit, Resources, Purchase, Contracts reports.

Helpdesk Reports
Reports by all requests
These reports provide you with graphical view of all open and closed requests by category,
group, created date, department, due date, level, priority, status, technician, status by category,
status by level, status by priority, status by technician.
Also they can be exported as HTML file, PDF file, XLS file and CSV file.
To save the report in a particular folder click Save report as button. This opens the Save
Report page. Specify the Report Name and if you wish the report to be viewed by all select
Every One (Public) report. If you wish to view the report by just yourself (Private), select Just
me button.
Select the Folder name from the Save-in-Folder combo box. If you wish to add new folder click
Add New Folder link.
Specify the Description about the report in the given text field and Save the details.
You can also Schedule reports, View query, mail this reports for these reports. These options
are available for all the report types under each report title.
Reports by completed requests
These reports show the distribution of completed and closed requests. Similar to Report by all
request, these reports are also generated based on various parameters such as category,
group, department, due date, level, mode, priority and request date.
Reports by SLA Violated requests
These reports display the distribution of the requests that have violated the SLA that was
applicable on them. You can view these violations based on the request category, group, the
department from which the request was generated, and the technician who handled the
request and so on.
Reports by pending requests
This shows the distribution of all pending requests for a specific period of time, based on
different parameters, such as priority, department, technician, category, due date, request date
and so on.
Request Summary requests
These reports provide you with a high level view of the requests received and closed during a
particular period, date-wise. The summary reports available are the received request summary
reports by date and closed request summary reports by date. These reports are generated on
the parameters of request received or closed by technicians, request received or closed in a
specific category, priority, and mode.

Request Timespent Reports
These reports provide information on the technician's time spent on requests and the cost per
technician based on the time spent. You can group the report information based on category,
department, requester and technician attending to the request. The time spent report by requester,
gives you an idea on the cost per requester and the number of request.
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By default, the help desk reports will be created for the current week. You can choose any custom
period of your choice or choose to create reports for last week, or this month, or for just this day. All
these reports can be used for analysis purposes. For example, the reports mapped against the
parameter technician can be used to measure the technician responsiveness and load handling
capability.

Survey Reports
These reports provide you with the summary details on the survey results based on various
parameters. All these reports help in measuring the efficiency and effectiveness of the support team
and take respective corrective actions.
Under Survey reports you have,
•

Survey Overview Report which gives you the overall ratings of each of the questions in the
survey based on the feedback of the users who took the survey. The ratings give you an idea
about the value that is associated with the corresponding question. This report provides both
tabular and a graphic representation of the results.

•

Survey Results by Category report has the survey information grouped based on the
category. Against each category, the points gained by each of the survey questions will be
tabulated. Depending on the kind of survey questions, this report will provide valuable
information based on individual request categories.

•

Survey Results by Department has the survey information grouped based on the
department from which the requests originated. The points for each question of the survey is
mapped against the department name from where the request originated.

•

Survey Results by Level has the survey information grouped based on the level of the
requests. The points for each question of the survey is mapped against the level of the
request for which the survey was sent.

•

Survey Results by Mode has the survey information grouped based on the mode of the
requests. The points for each question of the survey is mapped against the mode of the
request for which the survey was sent. This also gives you an idea on the mode of request
that is most frequently used to create a new request.

•

Survey Results by Priority has the survey information grouped based on the priority of the
requests. The points for each question of the survey is mapped against the priority of the
request for which the survey was sent.

•

Survey Results by Requester has the survey information grouped based on individual
requester. This helps you in finding out which requester has sent the maximum number of
requests and any other information based on your survey questions. This will give you an idea
of the users perspective and help you in deciding about the corrective actions that need to be
taken to make the support team more efficient and effective.

•

Survey Results by Technicians has the survey information grouped based on individual
technicians. Each of the survey questions will carry some value and based on this value, the
average value for the questions will be marked against the technicians. These points will
enable you to objectively measure the technicians efficiency and effectiveness from the users
perspective and take any corrective measures, if required.

Asset Reports
All Computers ( Workstation and Servers )
The workstation reports give you information about the various workstation-related metrics.
•

Computers by Domain report tells you the computers grouping based on domains. Thus
you get to know the number of computers in each of the domains in selected Account's
network.
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•

Computers by Manufacturer report gives you a high-level distribution view of the computers
used from different manufacturers.

•

Computers by OS report gives you an overview on the percentage of computers belonging
to each type of operating system. Thus you will also know the different types of Operating
Systems in use in selected Account.

•

Computers by Processor Manufacturer report gives you the graphical view as well as the
tabular view of the computers by processor manufacturer. Thus it gives a count of all
computers with processor vendor name used in selected Account.

•

Computers by Processor Type report will give a tabular view of all processor type in each
computers used in selected Account.

•

Computers by Vendor report gives a graphical as well as the tabular view of all vendors for
each the computers in selected Account.

•

Computers with less than 256MB RAM and more than 256MB RAM gives the report of all
computers in selected Account with more than 256MB RAM and less than 256MB RAM.

•

Operating System by Region gives you the list of workstations that are grouped under a
particular region but are not yet assigned to any user or department. The list of computers is
also displayed in the tabular form just below the graph.

•

Unassigned workstations by Domain gives you the number of computers that are
connected to the domains but are not assigned to any user or department or computer. The
list of computers is also displayed in the tabular form just below the graph.

Server
•

Server with less than 10% Free Disk space gives the report of all the servers in selected
Account with less than 10% free Disk space.

•

Servers with less than 512MB RAM gives the report of all the servers in selected Account
with less than 512MB RAM.

Software
Under software reports you have, Software Reports - Purchased Vs Installed software,
Software by Category and Software by Manufacturer. Under software reports - purchased Vs
Installed software you can view the list of all software purchased vs installed in each of the
workstation in selected Account. Under software by category you can view the list of all
software classified under default software category. Under Software by Manufacturer you can
have the tabular view of all software used in selected Account listed based on the manufacturer
of the software.
Workstation Summary Reports
Under workstation summary reports you have, Software Summary Report and Hardware
Summary Report. Software summary report provides you with the tabular view of all the
software installed in each workstation. This includes all managed, unmanaged software.
Hardware summary report provides you with all the hardware details of an workstation such
as, memory details, drive information, hard disk information, physical drive information, network
adapters and so on. Thus it gives a complete overview of all the software installed and
hardware details of an workstation.
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Audit Reports
Under audit reports you have audit history by workstation, audit history by time line, audit history by
changes. The updated audit reports are available only by scanning the workstation. Audit history by
workstation gives a complete report on the account of all actions taken place in a workstation. This
provides detail report on both hardware and software details. Audit history by time line gives a
detail overview of all actions taken place in a workstation for a specific time period. By default you can
get only the current week report. Audit history by changes gives a complete report on all changes
taken place in a workstation for the current week.
To get the audit report for previous weeks,
1. Click the Edit button. This opens the Custom Reports.
2. From the Date Filter block-> select the Scan Date option from the combo box -> select the
duration by clicking During combo box which provides you with the last week, last month, this
month, this quarter, last quarter or yesterday options to generate reports. (OR) if you wish to
generate reports for a specific time period then select the From and To radio button and
select the dates from the calender button.
3. Click Run Report button. You can get report for the specified time period.

Resources Reports
Under resources reports you have, resources by product type, resources by vendor, resources types
by site. Resources by product types gives the graphical view as well as the tabular view of all the
resources (assets) available for all default and newly added product types. Resources by Vendor
gives the graphical and tabular view of all the resources in the selected Account based on the vendor
name. The name of the vendor will be in X-axis and the resource count will be in Y-axis. Resource
Types by Site lists all the available resources in selected Account distributed across each sites of
your company.

Contract Reports
Under contracts reports you have reports based on Active contracts, Contracts by Max value,
Contracts by status, Contracts by vendor and Expired contracts. Active Contracts shows all the open
contracts in selected Account in a graphical and tabular view. Contracts by Max Value shows all the
contracts which costs above 1000$ will be displayed in both graphical and tabular view. Contracts by
Status shows the list of all contracts with its status level such as, open contracts, expired, expired in
the last 30 days, expiring in next 7 days and expiring in next 30 days in a graphical and tabular view.
Contracts by Vendor shows all the contracts with all status level but classified based on the vendor.
Expired Contracts shows the list of all the expired contracts in selected Account.

Purchase Reports
Under purchases you have reports based on PO Vendors, PO by Ordered Date, PO by Required
Date, PO by Status. Purchase orders by vendors gives the graphical view and tabular view of all the
approved, pending for approval, partially approved, closed, overdue, po's due in next 7 days, po's due
in next 30 days purchase orders classified based on the vendor name. Purchase orders by ordered
date gives the graphical view and tabular view of all the approved, pending for approval, partially
approved, closed, overdue, po's due in next 7 days, po's due in next 30 days purchase orders
classified based on the ordered date. Purchase orders by required date gives the graphical view
and tabular view of all the approved, pending for approval, partially approved, closed, overdue, po's
due in next 7 days, po's due in next 30 days purchase orders classified based on the required date.
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Custom Reports
ServiceDesk Plus-MSP enables you to create reports that meet your need if you are unable to find
them from the list of out-of-the-box reports already available. To create your custom reports,
1. Login to ServiceDesk Plus-MSP application with your user name and password.
2. Click Reports tab in the header pane.
3. Click New Custom Report button in the reports home page. This opens the Custom Report
page that will help you navigate through the various steps involved in the creation of a custom
report.
4. Specify the relevant Report Title in the given text field. This is a mandatory field.
5. Choose the Report Type by selecting the radio buttons. You can create Tabular Reports,
Matrix Reports, Summary Reports, Audit Reports.
6. Choose the module (Request, TimeSpent, Problem, Change and so on) for which you wish to
create the report. The audit History module will be enabled only for audit reports. This is
applicable only for the tabular and matrix reports. For summary reports, audit reports default
modules will be selected.
7. Click Proceed to Report Wizard >> button. This opens the Display Columns page. This page
differs for each report type. Each report type has to go through various steps before
generating it as a customized report.

To generate Tabular Reports
Tabular reports are simple reports that allow you to list your data based on certain criteria. If you had
selected the Tabular Reports option then you have five steps to create a complete customized
tabular report. If you wish to skip a particular option then click the next tab and move to the next
step.

Display Columns
The first step to create tabular reports is to select the display columns which need to be
displayed in the tabular report. Select the columns from the Available Columns list box and
click >> button to move them to Display Columns list box. Click the << button if you want to
remove any column from the Display Columns list box.
Click Next button. This leads you to the grouping of columns, where you can choose two
levels of grouping.

Filter Options
1. If you are using the date/time filter criteria, select the date column name from the
Select Column combo box.
2. Select the period for which you want to generate the report. If you would like to
generate report during this week, last week, this month, last month, this quarter, last
quarter or today, yesterday then select the During radio button and select the time
period from the combo box. (OR) If you wish to provide a custom period, then select
the From and To date using the calender button.
3. To use Advanced Filtering, select the column name such as, Requester name,
region site and so on from the combo box. Select the criteria (is, is not, contains and
so on) from the combo box. You can pick a value by invoking the icon . Select AND
or OR option from the combo box to add more than one criteria. You can delete a
criteria by clicking the delete icon .
4. Click the Choose button and select the value for the column to add as a filter
condition.
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5. Click as Add to Filter button to add the filter condition to the filter set which gets
listed under the Filter Set title.
6. Click Next button to go to the grouping of data.

Grouping Data
From the Group by combo box, select the column based on which you wish to group the
data.
Select the Order by from the combo box.
Click the Next button to go to the next stage.

Column Summary
You can get the column summary for all the columns in the report. If you wish to have the
column summary displayed in the report, select the column summary options available for
each column. The summary options differs for each column you have selected.
Click the Next button to go the next option.

Charts
In addition to the tabular chart, if you wish to have a chart displayed for a particular column
then, or you can skip this option and directly run the report.
1. Select the chart type to be displayed from the combo box.
2. Select the Axis column from the combo box to be displayed in the chart . This is a
mandatory field. The data will be grouped in the chart based on the column selected.
3. Select the Display Format from the combo box. For ex: in numbers or in percentage.
4. Click Run Report button.
On running the report you get a tabular report as well as the graphical view for the selected
column data.

To generate Matrix Reports
Matrix reports provides the data in a grid manner (m x n format). It allows you to study different
scenarios based on the chosen criteria. If you have selected matrix reports you have two steps to
generate a complete matrix report. Click the Proceed to Report Wizard button to go to next page.

Grouping Data
You have simple grouping and advanced grouping option for matrix reports.
Simple Grouping
1. Click the Simple grouping tab. You have two options Top column information and
left column information. Select the top column information from the combo box.
This is a mandatory field.
2. Select the left column information from the combo box. This is a mandatory field.
3. Select the summarize column count from the combo box to get the column
summary.
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Normal Grouping
1. Click the Advanced grouping tab. You have two options Column grouping and
Group by.
2. Select the Columns and Date format to be displayed from the combo box. Select
the group by from the combo box. You have three options for group by to be
displayed in the report. This is a mandatory field.
3. Select the summarize column from the combo box.
4. Select the period for which you want to generate the report. If needed you can also
provide a custom period by choosing the from and to date manually.
5. Click Next.
6. To use Advanced Filtering, you first need to select the radio button for matching
all the selected criteria or any one of them. Then from the column listing, select the
various columns and set the match operator and mention the values for matching.

Filter Options
1. If you are using the date/time filter criteria, select the date column name from the
Select Column combo box.
2. Select the period for which you want to generate the report. If you would like to
generate report during this week, last week, this month, last month, this quarter,
last quarter or today, yesterday then select the During radio button and select the
time period from the combo box. (OR) If you wish to provide a custom period, then
select the From and To date using the calender button.
3. To use Advanced Filtering, you first need to select the radio button for matching
all the selected criteria or any one of them. Then from the column listing, select
the various columns from the list and set the match operator and mention the
values for matching the column as (is, is not, contains and so on) from the combo
box.
4. Click the Choose button and select the value for the column to add as a filter
condition.
5. Click as Add to Filter button to add the filter condition to the filter set which gets
listed under the Filter Set title.
6. Click Run Report button. You get a matrix report

Request Summary Reports
Summary reports are detailed reports that allow you to list your data based on certain criteria. To
create a request summary report, select the corresponding radio button from the custom reports page
and click the Proceed to Report Wizard button to go to next page. You have two steps to generate a
complete request summary reports.

Display Columns
The first step to create request summary reports is to select the display columns which need
to be displayed in the request summary report. Select the columns from the Available
Columns list box and click >> button to move them to Display Columns list box. Click the
<< button if you want to remove any column from the Display Columns list box.
Click Next button. This leads you to the grouping of columns, where you can choose two
levels of grouping.
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Filter Options
1. If you are using the date/time filter criteria, select the date column name from the
Select Column combo box.
2. Select the period for which you want to generate the report. If you would like to
generate report during this week, last week, this month, last month, this quarter, last
quarter or today, yesterday then select the During radio button and select the time
period from the combo box. (OR) If you wish to provide a custom period, then select
the From and To date using the calender button.
3. To use Advanced Filtering, you first need to select the radio button for matching all
the selected criteria or any one of them. Then from the column listing, select the
various columns from the list and set the match operator and mention the values for
matching the column as (is, is not, contains and so on) from the combo box.
4. Click the Choose button and select the value for the column to add as a filter
condition.
5. Click as Add to Filter button to add the filter condition to the filter set which gets
listed under the Filter Set title.
6. Click Next button to go to the grouping of data.

Audit Reports
Audit reports are detailed history report that allow you to list your inventory history data based on scan
time criteria. Click Proceed to Report Wizard button to go to the next page. This opens the Audit
History Report page.
You have three audit history reports options, on scanning the workstation you get the updated version
of all the audit reports.
•

Audit history by workstation.
Audit history by workstation gives a complete audit reports of the hardware and software
details of the workstation.

•

Audit history by time line.
Audit history by time line gives a detail overview of all the actions taken place in a workstation
for a specific time period.

•

Audit history by changes.
Audit history gives a complete report on all changes taken place in a workstation.

Select any of the three audit history report options. Specify the scan date from the combo box.
Click Run Report button. You get the audit history report.
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Creating New Query Reports
1. Click on the Reports tab. This opens the All Reports page.
2. Only Administrator can see New Query Report button.
3. Click New Query Report button. This opens the Query Editor page.
4. Select the Table Schema from the combo box say, requests, timespent and so on. Click Get
to view the table schema for the selected option.
5. Specify the title of the report in the Report Title field. This is a mandatory field.
6. Specify the query to be executed for getting reports in the Query field. This is a mandatory
field.
7. The logs will display all error messages on providing any wrong query.
8. Click Run Report to run query report.

Tips
1. Date Formulae: DATE_FORMAT (FROM_UNIXTIME (COLUMN_NAME/1000),'%d-%m-%Y
%k: %i') 'Column Alias'.
2. Minutes Formulae: ROUND ((((COLUMN_NAME/1000)/60)) % 60) 'Minutes'.
3. Hours Formulae: ROUND (((COLUMN_NAME/1000)/3600)) 'Hours'.
4. Compare Date: COLUMN_NAME >= (UNIX_TIMESTAMP (DATE ('2006-07-24 00:00:00')) *
1000).
5. Convert Memory in GB: ((((MEMORY_COLUMN)/1024)/1024)/1024)
6. Default Value For Null Data: COALESCE (COLUMN_NAME, 'Unassigned')
7. Group by: Query statement will be ends with order by <column_index>

Additional Field tables
1. Request Additional Fields - WorkOrder_Fields
2. Requester Additional Fields - Requester_Fields
3. Technician Additional Fields - Technician_Fields
4. Asset Additional Fields - Asset_Fields
5. Workstation Additional Fields - Workstation_Fields
6. Problem Additional Fields - Problem_Fields
7. Change Additional Fields - Change_Fields
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Flash Report
Flash Reports help to get a quick and customizable overview of reports. Using Flash Reports we can
generate a high level picture on the status of the requests based on the selected criteria. It tells us the
number of requests that are present for a given condition.

To configure and view flash reports,
1. Login to ServiceDesk Plus - MSP application with your user name and password.
2. Click on Reports tab in the header pane
3. Click on Flash Reports button in the reports home page. This opens the Flash Reports page.
4. Select the filter parameters:
•

Select Created/Responded/Due-by/Completed time from the drop down box.

•

Select pre-defined time period from the drop down box by choosing During option or
customize the time period by selecting the From and To dates from the calendar.

5. Click on OK.
6. The report is loaded in the same page.

The report shows information pertaining to requests in the mentioned time period under conditions
such as Total requests, Pending Requests, Completed Requests and SLA Violated Requests. Based
on parameters such as SLA, Technicians, Priority, Category, Site, Level, Type, Urgency, Impact,
Mode and Status, the reports can be further scrutinized. These parameters can be viewed by clicking
on the button.
For example,
If you need to know the number of requests that have violated the SLA, then click on "SLA" option.
This shows number of violated/non-violated requests. For further information on the requests, click on
the downward arrow and choose from one of the given parameters. Say, you need to know
technicians handling the SLA violated requests, and then click on downward arrow and choose
"Technician" from the drop down list. The technicians along with the number of requests handled by
them are displayed in the next branch. Further if you want to know the priority of requests handled by
a particular technician, then click on downward arrow next to the technician name and select
"Priority". This displays the number of requests that have normal, high and low priorities.
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If you click on the number that is displayed along with the report, the list of requests will be displayed
in a new window. By clicking on the title of the request, you can view the request details in the space
below. The request details cannot be edited/modified in this screen.
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Scheduling Report Settings
1. Click Reports tab. This opens the All Reports page.
2. Click New Scheduled Report button. This opens Schedule Report Settings page.
3. To generate report once click Generate Once radio button. Specify the date using the
calendar button and Time from the combo box on which the report has to be generated.
4. Select the report to schedule from the combo box. The list will display all the available
reports such as, Reports by All requests, Reports by Completed requests, Reports by SLA
Violated reports and so on. This is a mandatory field.
5. Specify the E-mail ID of the person to whom the generated report has to be sent.
6. Save the details. Scheduled reports gets displayed in the Schedule Reports page.
7. To generate reports on a daily basis click Daily Report radio button and specify the From
Date, Time, report to be scheduled and the e-mail address of the person to whom the
report has to be sent. Save the details.
8. To generate weekly report click Weekly Report radio button. Specify the days of the week on
which you want to generate reports by selecting the check box. Or select Everyday check
box to generate reports on daily basis. Also specify the time, report to schedule, and E-mail
ID of the person to whom the generated report has to be sent. Save the details.
9. To generate reports on a monthly basis click Monthly Report radio button. Specify the month
on which the report has to be generated by enabling the check box. Or select Every Month
check box to generate reports on monthly basis. Also specify the time, report to schedule, and
E-mail ID of the person to whom the generated report has to be sent. Save the details.
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Custom Settings
The custom settings wizard helps you to customize the report column size. This helps to increase or
decrease the tabular column size, matrix column size and modify the date and time format of your
custom reports.
1. Click Reports tab. This opens the All Reports page.
2. Click the Custom Settings button. The Report Settings page pops up.
3. If you wish to customize the Tabular column size, specify the size of the small text, large
text, number size and date and time text. And update the changes.
4. If you wish to customize the Matrix column size, specify the size of the cell width and cell
height and update the changes.
5. You can also change the date and time format to be displayed in the report. If you specify the
format in the given text field as MM-dd-yyyy HH:mm then the result would be Date: 09-202007 Time:03:20.
6. To disable the links in reports enable the check box beside Disable links in report under
General Settings block. To view one Group per page, enable the check box beside the
same.
7. Click the Update button to update the changes. While generating reports the customized
report format will be
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Appendix
Appendix

This topic explains the various features that are not grouped under any of the modules but can be
used from the application.
•
•
•
•
•

System Log Viewer
Feedback
Personalize
Backup and Restore
Changing web server port
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System Log Viewer
You can view the error logs generated by the ServiceDesk Plus - MSP application online.
To view the error logs
1. Log in to the ServiceDesk Plus - MSP application using your user name and password. If you
have the permissions to view the support information, you will see a Support tab in the
header.
2. Click the Support tab in the header pane.
3. Click the System Log Viewer link available in the Support page.
To view the individual error details
1. In the Error Log list view page, click the hyperlinked Error Message. An error log window
with the details of the error is opened.
2. The Error Message field contains the complete error message.
3. The Module field indicates the module in which the error occurred.
4. The Occurred At field indicates the date and time when the error occurred.
5. If the probable cause of the error is known, then the cause is displayed in the Probable
Cause field.
6. The Performed By field indicates the origin of the error. For example, if it is a systemgenerated error, then the Performed By field contains System as its value.
7. Click Close after viewing the details of the error message.
None of these fields are editable. You can also search for a specific error log details with the help of
the Search in feature.
To search for error logs
1. In the left menu, the search block is found at the bottom. If you are in the Error Log list view
page, then by default, the System Log option is chosen in the Search in combo box. If not,
then choose System Log.
2. In the Enter Keyword text field, enter the search string.
3. Press Enter on your keyboard or click Go. The search results will display all the error logs
that match the search string.
4. Click the error log of your choice to view the same.
You can delete these error logs.
To delete individual error logs
1. In the Error Log list view, select check boxes beside the Error Messages that you wish to
delete.
2. Click Delete.
If you want to delete all the existing error messages, then click the Delete All button.

Zoho Corporation Pvt. Ltd.
674

ManageEngine ServiceDesk Plus MSP – Admin Guide

Feedback
If you are connected to the network you can send your feedback about ServiceDesk Plus - MSP
immediately to our support team.
To send your feedback,
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click Feedback link available at the top left corner of the page. This opens the Feedback pop
up window.
3. The To address will be in non-editable format to our support team . Specify Your Name, Your
email ID, Subject of the mail and Message mail content in their corresponding fields.
4. Click Submit button to send the mail.
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Personalize
You can localize your personalization such as display language, time zone and so on, as well as
change your login password using this option. Apart from the option of changing password from the
user management configurations, you can also change your individual password.
1. Log in to the ServiceDesk Plus - MSP application using your user name and password.
2. Click the Personalize link available at the top right corner of the page. This opens
Personalize page which has two tabs which are, Personalize and Change Password as
shown below,

Personalize
The personalize tab consists of display language, time zone, data format, time format and e-mail
signature.
•

Display Language
Select the language of your choice from the Choose Language combo box. The selected
language will be you default display language in the application. All the data will be displayed
in the language selected by you.

•

Time Zone
Since the organizations can be situated in various sites, every site has its particular time
zone. Select the time zone of the site of your organization from the Select Time Zone combo
box. The date and time will be set according to the selected time zone.
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•

Date/Time Format
Select the format of the date such as, Tue 16 Sep 2008, from the Set Date Format combo
box. Similarly you can also set the time format from Set Time Format combo box. The
selected date and time format will be displayed where ever date/time is considered
For example: While creating a request, the request created on and due by time will be
displayed in the selected date and time format corresponding to the selected time zone. The
same can be viewed under Problem, Change, Solution and Purchase modules.

•

E-mail Signature
You can have your own personalized signature while replying to the mails using this option.
Enter your signature in the text provided. Click Save.

Change Password
1. Click the Change Password tab in the personalize page. This displays the Change Password
form.
2. Enter your old password in the Current Password field.
3. Enter your new password in the New Password field.
4. In the Confirm New Password, enter the new password again.
5. Click Save button.
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Back up and Restore
•

In Windows

•

In Linux

In Windows
Follow the steps given below to take a back up of the ManageEngine ServiceDesk Plus - MSP data:
1. Click Start -> Programs -> ManageEngine ServiceDesk Plus - MSP -> Backup Data. A
back up of the data and the file attachments that have been added to the application will be
created.
The back up file will be created in the <ServiceDesk>\backup directory. The file name for the back up
file will be of the pattern BackUp_monthdate_year_hr_min.data. An example of the back up file name:
BackUp_May20_2005_23_15.data
To restore the back up data
1. Go to <ServiceDesk>\bin directory.
2. Execute the file restoreData.bat at command prompt as shown below:
restoreData.bat <backup file name>
The back up file name has to be the .data file from which you wish to restore the data. This will restore
the data from the back up file.

Note: The ServiceDesk Plus - MSP server needs to be shut down before you restore the
data.

In Linux
Follow the steps given below to take a back up of the ManageEngine ServiceDesk Plus - MSP data:
1. Go to <ServiceDesk>/bin directory.
2. Execute the backUpData.sh file as given below:
$ sh backUpData.sh
The back up file will be created in the <ServiceDesk>/backup directory. The file name for the back up
file will be of the pattern BackUp_monthdate_year_hr_min.data. An example of the back up file name:
BackUp_May20_2005_23_15.data
To restore the back up data
1. Go to <ServiceDesk>/bin directory.
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2. Execute the file restoreData.sh at command prompt as shown below:
$ sh restoreData.sh <backup file name>
The back up file name has to be the .data file from which you wish to restore the data. This will restore
the data from the back up file.

Note: The ServiceDesk Plus - MSP server needs to be shut down before you restore the
data.
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Changing Web Server Port
•

In Windows

•

In Linux

In Windows
Follow the steps given below to change the web server port where the ServiceDesk Plus - MSP
server will be running:
1. Go to <ServiceDesk>\bin directory.
2. Execute the file changeWebServerPort.bat at command prompt as shown below:
changeWebServerPort.bat <new port number> <http or https>
The web server port will be reset to the new port number that you have specified.
https - To start the ServiceDesk Plus - MSP server in https mode.
http - To start the ServiceDesk Plus - MSP server in http mode. By default, executing the file
as changeWebServerPort.bat <new port number>
will start the server in http mode.
3. If the port number is occupied, you will be prompted to enter a different port number. If you do
not wish to enter a different port number then press N on your keyboard to exit the
application. Else press Y and enter a different port number that is unoccupied.
This change will be effected only when you restart the server. To connect to the ServiceDesk Plus MSP server after restarting, the new port number must be used.

In Linux
Follow the steps given below to change the web server port where the ServiceDesk Plus - MSP
server will be running:
1. Go to <ServiceDesk>/bin directory.
2. Execute the file changeWebServerPort.sh at command prompt as shown below:
$ sh changeWebServerPort.sh <new port number> <http or https>
The web server port will be reset to the new port number that you have specified.
https - To start the ServiceDesk Plus - MSP server in https mode.
http - To start the ServiceDesk Plus - MSP server in http mode. By default, executing the file
as changeWebServerPort.bat <new port number>
will start the server in http mode.
3. If the port number is occupied, you will be prompted to enter a different port number. If you do
not wish to enter a different port number then press N on your keyboard to exit the
application. Else press Y and enter a different port number that is unoccupied.
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This change will be effected only when you restart the server. To connect to the ServiceDesk Plus MSP server after restarting, the new port number must be used.
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Troubleshooting
This section gives you solutions for the problems faced while scanning for workstations in
ServiceDesk Plus - MSP Inventory module.
1. Either access denied for the user or the remote DCOM option might be disabled in the
workstation.
2. User does not have the access privileges to perform this operation.
3. Remote DCOM option is disabled in the Server machine.
4. Connection to RPC server in the workstation failed.
5. One of the WMI components is not registered properly.
6. Execution failure in the WMI Service of workstation.
7. WMI Service is disabled in the workstation.
8. Request for scan operation rejected by the workstation.
9. Connection to Telnet Service in the workstation failed.
10. Either Username or Password is incorrect in the workstation.
11. Scan operation Timed out.
12. The operation invoked is not supported in the current platform.
13. General failure while performing the operation.
Error Message

Either access denied for the user or the remote DCOM option might be
disabled in the workstation
This error message is shown when scanning of a Windows workstation
fails due to any of the following reasons:

Cause

1. The login name and password provided for scanning might be
invalid in the workstation.
2. Remote DCOM option might be disabled in the remote
workstation.
1. Check if the login name and password are entered correctly.
2. Check if Remote DCOM is enabled in the remote workstation. If
not enabled, then enable the same.
To enable DCOM in Windows 2000 Computers:
1. Select Start > Run
2. Type DCOMCNFG in the text field

Resolution

3. Click OK.
4. Select Default Properties tab
5. Check the box "Enable Distributed COM in this machine"
6. Press OK
To enable DCOM in Windows XP Computers:
7. Select Start > Run
8. Type DCOMCNFG in the text field
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9. Click OK
10. Right Click on Component Services > Computers > My
Computer
11. Click Properties
12. Select Default Properties tab in the frame that pops
13. Check the box "Enable Distributed COM in this machine"
14. Press OK
3. Check if the user account is valid in the target workstation. For this
execute the following commands in the command prompt (of the
server machine).
net use \\<RemoteComputerName>\C$
/u:<DomainName\UserName> "<password>"
net use \\<RemoteComputerName>\ADMIN$
/u:<DomainName\UserName> "<password>"
Replace the relevant value within <>. Supply password within the
quotes.
If these commands show any error message, then the provided user
account is not valid in that remote computer.

Error Message

Cause

Resolution

Error Message
Cause

User does not have the access privileges to perform this operation
Such error messages are shown, if the User ID provided for scanning
does not have sufficient access privileges to perform the scanning
operation. Probably, this user does not belong to the Administrator
group of the workstation.
Move the user to the Administrator Group of the workstation (or) Scan
with an administrator (preferably a Domain Administrator) account.

Remote DCOM option is disabled in the Server machine
Remote DCOM option might be disabled in the machine running
ServiceDesk Plus - MSP Server.
ServiceDesk uses Windows Management Instrumentation (WMI) to
scan the remote workstations. WMI works over Remote DCOM and
hence this option must be enabled for scanning the remote machines.

Resolution
To know how to enable DCOM in Windows system refer to resolution
of the error message Either access denied for the user or the remote
DCOM option might be disabled in the workstation.

Top
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Error Message
Cause

Connection to RPC server in the workstation failed
This message is shown when a firewall is configured on the remote
computer. Such exceptions mostly occur in Windows XP (SP-2), when
the default Windows Firewall is enabled.
Disable the default Firewall in the workstation. To disable the Firewall in
Windows XP (SP2)
1. Select Start->Run
2. Type Firewall.cpl
3. Click OK.
4. In the General tab, click Off.
5. Click OK.

Resolution

If Firewall cannot be disabled then, we can lauch Remote
Administration feature for administrators in the remote computer. The
following command when executed in the target computer, can enable
the feature:

netsh friewall set service RemoteAdmin
After scanning the computer, if required, the Remote Administration
feature can also be disabled. The following command disables the
feature:
netsh friewall set service RemoteAdmin disable

Error Message
Cause

Resolution

One of the WMI components is not registered properly
This message is shown if WMI is not available in the remote windows
workstation. This happens in the Windows 9x, Windows NT and
Windows ME. Such error codes might also occur in higher versions of
Windows if the WMI Components are not registered properly.
Install WMI core in the remote workstation. This can be downloaded
from the Microsoft web site. If the problem is due to WMI Components
registration, then register the WMI dlls by executing the following
command at command prompt:
winmgmt /RegServer

Error Message
Cause

Resolution

Execution failure in the WMI Service of workstation
Such error messages are shown, when there are some internal
execution failures in the WMI Service (winmgmt.exe) running in the
remote workstation. Probably the last update of the WMI Repository in
that workstation could have failed.
Restart the WMI Service in the remote workstation. To restart the WMI
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service in the workstation
1. Click Start -> Run.
2. Type Services.msc
3. Click OK.
4. In the Services window that pops-up, select "Windows
Management Instrumentation" service and right-click on that.
5. Click Restart.

Error Message
Cause

WMI Service is disabled in the workstation
This error message is shown when the WMI Service (winmgmt.exe) is
not enabled in the remote workstation.
Modify the property of WMI Service to Manual or Automatic from
Disabled.
1. Click Start -> Run.
2. Type Services.msc
3. Click OK.

Resolution

4. In the Services window that pops-up, select "Windows
Management Instrumentation" service and right-click on that.
5. Click Properties.
6. If the Startup type is "Disabled", change it to
"Automatic/Manual" and start the service.
7. Restart the service.

Error Message
Cause

Request for scan operation rejected by the workstation
DCOM settings in Registry of the target workstation reject the scan request.
Edit the Registry key value, as described below:
1. Use Regedit to navigate to:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\OLE.

Resolution

2. Double-click the EnableDCOM value Name, a string (REG_SZ) data
type. Set its data value to Y, even if it is already SET to Y.
3. Click OK
4. Shutdown and restart the computer.
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Error Message
Cause
Resolution

Error Message
Cause
Resolution

Error Message
Cause
Resolution

Error Message
Cause
Resolution

Error Message
Cause

Resolution

Connection to Telnet Service in the workstation failed
Telnet Service might not be running in the target computer (or) Telnet
Service is not running in default port 23.
Discovering remote Linux Machines by ServiceDesk is done using
Telnet. Ensure that Telnet is running in the remote workstations in the
default port 23.

Either Username or Password is incorrect in the workstation
The username and password provided to scan the remote workstation
is incorrect.
Discovering Linux Workstations, in ServiceDesk Plus - MSP is done
using the Telnet. Provide a valid username and password that can
successfully establish a telnet session with the target workstation.

Scan operation Timed out
Target workstation did not respond within the default time limit. This
might be due to some delay in the network.
Try scanning the workstation, sometime later. If the same error message
repeats, contact ServiceDesk Plus - MSP Support Team at mspservicedeskplus-support@manageengine.com.

The operation invoked is not supported in the current platform
Such error codes are shown if the workstation has an Operating
System other than Windows or Linux.
Currently, Network Discovery in ServiceDesk Plus - MSP supports
Windows or Linux machines, only.

General failure while performing the operation
Some unexpected exception occurred while, scanning the workstation.
Contact the ServiceDesk support team at msp-servicedeskplussupport@manageengine.com with the Error log files. You can obtain the
error log files from Support tab by clicking on the Support File link in the
ServiceDesk Plus - MSP application.

Zoho Corporation Pvt. Ltd.
686

